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各部の名称と働き
電源部
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1. LIGHT（ビデオライト動作モード切り換え）
スイッチ

LIGHT端子（4ページ）に接続したビデオラ
イトのオン／オフのしかたを選択します。
AUTO：ビデオライトの POWERスイッチを

ONにしておくと、本機で記録しているとき
にライトが点灯する。

MANUAL：ビデオライトの POWERスイッチ
でライトをオン／オフする。

［ご注意］
ピクチャーキャッシュレックモードでの記録時は、記録開
始の操作をする前（メモリーにデータを蓄積している期間）
にライトを点灯させることはできません。

2. POWER（電源）スイッチ
主電源をオン（）／オフ（）します。

3. DC IN（DC電源入力）端子（XLR 4ピン、凸）

4. DC OUT 12V（DC電源出力）端子（4ピン、
凹）

UHFシンセサイザーダイバーシティーチュー
ナーWRR-855S/860C/861/862（別売）および
HDVF-L750用の電源を供給します（最大1.8 A）。

5. バッテリー取り付け部
バッテリーパックBP-FLX75を取り付けます。
また、ACアダプター AC-DN2B/DN10を取り付
けて、AC電源で本機を動作させることもできま
す。

 ˜「電源の準備」（24ページ）

［ご注意］
本機を安全かつ正常な動作状態でお使いいただくために、
バッテリーパックBP-FLX75の使用を推奨します。

6. カメラアダプター接続端子
カバーを外してHDカメラアダプター CA-TX70/
FB70を接続できます。

［ご注意］

本機はリターンビデオの表示には対応していません。
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1. ワイヤレスレシーバー挿入部（29ページ）

 ˜「ワイヤレスレシーバーを取り付ける」（29ページ）

2. ショルダーベルト取り付け金具（31ペー
ジ）

3. アクセサリーシュー（31ページ）

4. ビューファインダー前後位置固定レバー
（25ページ）

5. ビューファインダー左右位置固定リング
（25ページ）

6. ビューファインダー取り付けシュー（25
ページ）

7. VF（ビューファインダー）端子（角型26ピン
および丸型20ピン）

HDVFシリーズビューファインダー用のアナロ
グインターフェース端子（20ピン）と、HDビュー
ファインダー CBK-VF02用のデジタルインター

フェース端子（26ピン）です。
使用するビューファインダーに対応する端子に、
ビューファインダーの接続ケーブルを接続しま
す。

［ご注意］

ˎˎ 両方の端子に同時にビューファインダーを接続しない
でください。
ˎˎ 本機にインターフェースケーブルの接続／取り外しを
行うときは、本機の電源を切ってから行ってください。

8. レンズマウントゆるみ止めゴム
レンズ固定レバーでレンズを固定した後に、こ
のゴムを2つある突起の下側の突起にはめ込み
ます。レンズマウントが固定され、レンズマウ
ントがゆるむのを防ぎます。

9. ビューファインダー前後位置LOCKつまみ
（25ページ）

10. 別売マイクホルダー（29ページ）および
同梱ガード（67ページ）取り付け部

11. LIGHT（ライト）端子（2ピン、凹）（31ペー
ジ）

12. ショルダーパッド（31ページ）

13. レンズケーブルクランプ
レンズケーブルを固定します。

14. MIC IN（マイク入力）（＋48V）端子（XLR型、
5ピン、凹）

ステレオマイクを接続する端子です。マイク用
の電源（＋48V）はこの端子から供給されます。

15. LENS（レンズ接続用）端子（12ピン）（28
ページ）

［ご注意］
本機にレンズケーブルの接続／取り外しを行うときは、本
機の電源を切ってから行ってください。

16. 三脚マウント
本機を三脚に固定するとき、三脚アタッチメン
ト（別売）を取り付けます。

17. レンズマウント（特殊バヨネット型）（28
ページ）

18. レンズ固定レバー（28ページ）

19. レンズマウントキャップ
レンズ固定レバーを押し上げると取り外せます。
レンズを取り付けていないときは、はめ込んで
おきます。
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1. REC START（記録開始）ボタン
押すと記録が始まり、もう一度押すと止まりま
す。レンズにあるVTRボタンと同じ動作をしま
す。

2. SHUTTER（シャッター）スイッチ
電子シャッターを使うときにONにします。
SELECT側に押すと、シャッタースピードと
シャッターモードの表示が切り替わります。ス
イッチの設定を切り換えると、新しい設定が
ビューファインダー画面に約3秒間表示されま
す。

 ˜「電子シャッターの設定」（45ページ）

[ご注意]
Flash Band Reduceがオンのとき、シャッタースイッチ
をオンにすると 、Flash Band Reduce機能はオフとなり、
ビューファインダー画面のFBR表示が消えます。この状態
からシャッターをオフに戻すと、Flash Band Reduce機
能がオンに戻り、ビューファインダー画面にFBRが表示さ
れます。

3. FILTER（フィルター切り換え）つまみ
本機に内蔵されている4種類のNDフィルターを
切り換えるためのつまみです。

このつまみの設定を切り換えると、新しい設定
がビューファインダー画面に約3秒間表示され
ます。

FILTERつまみ
の設定

NDフィルターの種類

1 CLEAR（素通し）
2 1/4 ND（光を約1/4に減衰させ

る）
3 1/16 ND（光を約1/16に減衰さ

せる）
4 1/64 ND（光を約1/64に減衰さ

せる）

Maintenanceメニューの設定を変更すること
により、つまみの各位置にホワイトバランスの
設定値を個別に記憶させておくことができるた
め、フィルターの切り換えに連動して、撮影条
件に応じた最適なホワイトバランスが得られま
す。

 ˜「ホワイトバランスを調整する」（43ページ）

4. MENUつまみ（99ページ）

5. AUTO W/B BAL（ホワイトバランス／ブ
ラックバランス自動調整）スイッチ

次のようにホワイトバランスやブラックバラン
スを自動調整します。
WHITE：ホワイトバランスを自動調整する。こ
のとき WHITE BALスイッチ（7ペー
ジ）を Aまたは Bにしておくと、調整され
た値がメモリー Aまたは Bに記憶される。
WHITE BALスイッチが PRSTのときは動作
しない。

BLACK：ブラックセットとブラックバランスを
自動調整する。

自動追尾ホワイトバランス（ATW）時も動作し
ます。
オートホワイトバランス実行中に再度WHITE側
に倒すと、オートホワイトバランスは中止され、
元のホワイトバランス状態に戻ります。
オートブラックバランス実行中に再度BLACK側
に倒すと、オートブラックバランスは中止され、
元のブラックバランス状態に戻ります。

6. MIC LEVEL（マイクレベル）つまみ（48
ページ）
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1. ASSIGN.（アサイナブル）1/2/3スイッチ
メニューのOperation >Assignable Switchで

機能を割り当てます（131ページ）。

ASSIGN. 1/3スイッチには、オン／オフが確認
できるインジケーターが付いています。

2. ONLINE（オンライン）ボタン
あらかじめネットワーククライアントモード、
またはストリーミング機能がアサインされてい
る場合、ボタンを長押しするとボタンがオレン
ジ色に点灯します。その後にもう一度押すと、
青色点灯に変わり、ネットワーククライアント
モード、またはストリーミング機能が実行され
ます。
上記の状態でボタンを長押しすると実行中の機
能が終了し、ボタンが消灯します。
また、上記以外の機能を割り当てたアサイナ
ブルスイッチとして使用することもできます
（132ページ）。

3. ALARM（警告音量調節）つまみ
内蔵スピーカーやイヤホンから聞こえる警告音
の音量を調節します。最小にすると、警告音は
聞こえなくなります。
ただし、メニューのMaintenance >Audio 
>Min Alarm VolumeをSetに変更すると、この
つまみが最小の位置でも警告音が聞こえるよう
になります。

ALARM

最小 最大

4. MONITOR（音量調節）つまみ
内蔵スピーカーやイヤホンから聞こえる警告音
以外の音声の音量を調節します。最小にすると、
音声は聞こえなくなります。

5. MONITOR（オーディオモニター選択）ス
イッチ

2つのスイッチの組み合わせによって、内蔵ス
ピーカーやイヤホンから聞こえる音声を以下の
ように選択します。

下側のスイッチをCH-1/2にした場合

上側のスイッチ 音声出力
CH-1/CH-3 チャンネル1の音声
MIX チャンネル1と2の混合音声（ス

テレオ）a)

CH-2/CH-4 チャンネル2の音声

下側のスイッチをCH-3/4にした場合

上側のスイッチ 音声出力
CH-1/CH-3 チャンネル3の音声
MIX チャンネル3と4の混合音声（ス

テレオ）a)

CH-2/CH-4 チャンネル4の音声

a)  EARPHONE端子にステレオヘッドホンを接続すると、
音声をステレオで聞くことができます。（メニューの
Maintenance >Audio >Headphone OutをStereoに
設定する必要があります。）

6. ASSIGN.（アサイナブル）0スイッチ
メニューのOperation >Assignable Switchで
機能を割り当てます（131ページ）。
工場出荷時には、Offが割り当てられています。
押すたびに動作が切り替わるモーメンタリータ
イプのスイッチです。

7. GAIN（ゲイン切り換え）スイッチ
撮影時の照明状態に合わせて、映像アンプのゲ
イン（利得）を切り換えます。L、M、Hの設定
に対応するゲイン値は、あらかじめメニュー
のOperation >Gain Switch（108ページ）で
指定します（工場出荷時の設定は、L=0dB、
M=6dB、H=12dB）。
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このスイッチの設定を切り換えると、新しい設
定がビューファインダー画面に約3秒間表示さ
れます。

8. OUTPUT（出力信号切り換え）／ DCC（ダ
イナミックコントラストコントロール機能
切り換え）スイッチ

カメラ部から出力する信号を以下の2つから選
択します。
BARS：カラーバー信号を出力する。
CAM：撮影中の映像信号を出力し、DCC機能 1)

のオン／オフを切り換えることができる。
1)  DCC（Dynamic Contrast Control）機能：高輝度の背
景で人物や風景などにレベルを合わせて撮影すると、
背景が白くつぶれ、背景にある建物や風景がぼやける。
このようなときに DCC 機能を動作させると、高輝度部
分を自動的に抑え、背景をくっきりと再現できる。次
のような場面の撮影に効果を発揮する。
ˎˎ 晴天時に日陰の人物を撮るとき
ˎˎ 車内または屋内の人物と窓越しの屋外の風景を同時
に撮影したいとき
ˎˎ コントラストの強い場面を撮るとき

9. WHITE BAL（ホワイトバランスメモリー切
り換え）スイッチ

以下のようにホワイトバランスの調整方法を切
り換えます。
PRST：色温度をプリセット値（工場出荷時の設
定は 3200K）に調整する。ホワイトバラン
スを調整する時間がないときなどに合わせ
る。

Aまたは B：あらかじめ Aまたは Bに保存して
おいたホワイトバランスの調整値を呼び出
す。AUTO W/B BALスイッチ（5ページ）
をWHITE側に押すと、ホワイトバランスを
自動的に調整し、調整値をメモリー Aまた
はメモリー Bに記憶する。

B（ATW 1)）：OperationメニューのWhite 
SettingでWhite Switch <B>を ATWに設
定しておくと、ATWが動作する。 
なお、ATWが動作中でも、AUTO W/B BAL
スイッチは機能する。 
このスイッチの設定を切り換えると、新し
い設定がビューファインダー画面に約 3秒
間表示されます。

1)  ATW（Auto Tracing White balance）：照明条件の変化
に応じて画像のホワイトバランスを自動的に追従させ
る機能

［ご注意］
照明や被写体の条件によっては、ATWを使用しても適切
な色に調整できないことがあります。
例：
ˎˎ 空、海、地面、草花など単一色の被写体が大部分を占
める場合 
ˎˎ 色温度が非常に高い／非常に低い光源下の被写体 

ATWの自動追従の時間が遅かったり、適切な効
果が得られない場合は、AWBを実行してくださ
い。

10. スイッチカバー
MENU ON/OFFスイッチ、またはMENU 
CANCEL/PRST/ESCAPEスイッチを操作すると
き、このカバーを開けます。

11. MENU ON/OFF（メニュー表示オン／オフ）
スイッチ

スイッチカバーを開けると使用できるようにな
ります。
ビューファインダー画面やテスト出力画面上に
設定メニューを表示するときに使用します。ス
イッチを押し下げるたびに、メニューの表示／
非表示が切り替わります。
サムネイル画面操作部のMENUボタンも同じ働
きです。

［ご注意］
スイッチカバーを閉じても、メニューは非表示にはなりま
せん。

12. MENU CANCEL/PRST/ESCAPE（メニュー
設定取消し／プリセット／戻る）スイッチ

スイッチカバーを開けると使用できるようにな
ります。
メニューが表示されている場合と表示されてい
ない場合で機能が異なります。

メニューが表示されているときは、次のように
使用します。
CANCEL/PRST：メニューの設定変更後にこの
位置へ押し上げると、変更した設定を取り
消すかどうかを確認する表示が出る。再度
押し上げると設定が取り消される。 
メニューの設定変更前または設定変更を取
り消した後にこの位置へ押し上げると、現
在の設定を標準設定（初期設定値）にリセ
ットするかどうかを確認する表示が出る。
再度押し上げると現在の設定が標準設定に
リセットされる。

ESCAPE：階層構造を持つメニューを開いてい
るときに使用する。この位置に押し下げる
たびに、現在の階層から1つ上の階層に戻る。

メニューが表示されてないときは、次のように
使用します。
CANCEL/PRST：この位置に押し上げると、本
機の各種設定や状態を確認するための画面
がビューファインダーに表示される（14
ページ）。この画面は複数ページあり、押し
上げるごとに、ページが変わる。

ESCAPE：画面を消したいとき、この位置に押
し下げる。

13. UTILITY SDカードスロット
本機の設定データ保存用SDカードを挿入しま
す。

14. ACCESS（アクセス）ランプ
SDカードアクセス中にオレンジ色で点灯しま
す。
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1. 内蔵スピーカー
記録中はE-E音 1)を、再生中は再生音をモニター
できます。警告ランプや警告表示の点滅・点灯
に合わせて警告音も聞こえます（153ページ）。
なお、EARPHONE端子にイヤホンをつなぐと、
内蔵スピーカーからは音が聞こえなくなります。
1)  E-E：「Electric to Electric」の略。本機に入力され、本
機内部の電気回路のみを通って出力端子から出てくる
映像信号または音声信号のこと。これによって入力信
号を確認できる。

2. LCDモニター
バッテリー残量、メディア残量、音声レベル、
タイムデータなどを表示します。また、カメラ
画や再生画を確認できます（14ページ）。
LCDモニターは位置や角度を調整することがで
きます。

3. WARNING（警告）ランプ
異常が発生すると、点滅または点灯します（153
ページ）。

4. ACCESS（アクセス）ランプ
記録メディアに書き込みや読み出しが行われて
いるときに青で点灯します。

5. オーディオ調整部（10ページ）

6. サムネイル画面操作部（10ページ）

7. F REV（逆高速再生）ボタンとランプ
逆方向に高速再生します。再生速度は、ボタン
を押すたびに約4倍速約15倍速約24倍速の
順に切り替わります。逆方向高速再生中はラン
プが点灯します。

8. PLAY/PAUSE（再生／一時停止）ボタンとラ
ンプ

再生するときに押します。再生中はランプが点
灯します。
再生中に再度このボタンを押すと一時停止状態
となり、静止画が出力されます。このとき、ラ
ンプが毎秒1回の速さで点滅します。
再生／一時停止中にF REVボタンまたはF FWD
ボタンを押すと、逆方向または順方向の高速再
生になります。

9. F FWD（高速再生）ボタンとランプ
順方向に高速再生します。再生速度は、ボタン
を押すたびに約4倍速約15倍速約24倍速の
順に切り替わります。順方向高速再生中はラン
プが点灯します。

10. PREV（逆方向クリップジャンプ）ボタン
現在のクリップの先頭にジャンプします。
F REVボタンと同時に押すと、記録メディア内
で最初に記録されたクリップの先頭画にジャン
プします。
このボタンをすばやく2回押すと、直前のクリッ
プ（存在しない場合は現在のクリップ）の先頭画
にジャンプします。

11. STOP（停止）ボタン
再生をやめるときに押します。

12. NEXT（順方向クリップジャンプ）ボタン
次のクリップの先頭にジャンプします。
F FWDボタンと同時に押すと、記録メディア内
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の最後に記録されたクリップの最終画にジャン
プします。

13. DISP SEL/EXPAND（表示選択／エクスパン
ド）ボタン

ボタンを押すごとに、LCDモニターの表示内容
が次表のように切り替わります。

表示内容 説明
文字情報付きの映像
（CHAR）

ビューファインダー画面と
同様の文字情報が表示され
る。

文字情報なしの映像
（MONI）

映像のみ表示される。

ステータス表示
（STATUS）
（14ページ）

カウンター、各種の警告、
音声レベルなどが表示され
る。映像は表示されない。

また将来のバージョンアップでEXPAND（エク
スパンド）ボタンとしても使用できるようにな
ります。

14. HOLD（データ表示保持）ボタン
押した瞬間に、LCDモニターのタイムデータの
表示が保持されます。（ただし、タイムコードジェ
ネレーターは歩進し続けます。）もう一度押すと、
保持状態が解除されます。

 ˜ タイムデータ表示について詳しくは、14ページをご
覧ください。

15. RESET/RETURN（リセット／リターン）ボ
タン

LCDモニターのタイムデータ表示部に表示され
ている値をリセットします。PRESET/REGEN/
CLOCKスイッチ（10ページ）とF-RUN/SET/
R-RUNスイッチ（10ページ）の設定に応じて、
次のように働きます。

スイッチの設定 RESET/RETURNボタンの
働き

DISPLAYスイッチ：
COUNTER

カウンターを 
00：00：00：00にリセッ
トする。

DISPLAYスイッチ：
TC

PRESET/REGEN/
CLOCKスイッチ：

PRESET
F-RUN/SET/R-RUN
スイッチ：

SET

タイムコードを 
00：00：00：00にリセッ
トする。

DISPLAYスイッチ：
U-BIT

PRESET/REGEN/
CLOCKスイッチ：

PRESET
F-RUN/SET/R-RUN
スイッチ：

SET

ユーザービットa) データを
00 00 00 00にリセットす
る。

a)  メディアに記録されるタイムコードビットのうち、ユー
ザーが必要な情報を記録するために使うことのできる
ビット。

 ˜「タイムデータの設定」（50ページ）
エッセンスマークサムネイル画面の表示中に押
すと、1つ前の画面に戻ります。

16. DISPLAY（タイムデータ表示切り換え）ス
イッチ

LCDモニターのタイムデータ表示部の表示を
COUNTER、TC、U-BITの順に切り換えます
（14ページ）。
COUNTER：記録・再生経過時間のカウンター
を表示する。

TC：タイムコードを表示する。
U-BIT：ユーザービットを表示する。

17. BRIGHT（明るさ設定）ボタン
LCDモニターのバックライトの明るさを切り換
えます。
ボタンを押すたびに、次表の順番で明るさが切
り替わります。LCDモニターの消灯時にこのボ
タンを押すと、Hの状態でLCDのバックライト
が点灯します。

設定 LCDモニターのバックライト
H 高輝度（日中の屋外でLCDモニターの表

示をみるときに選択する）
M HとLの中間の明るさ
L 低輝度（室内または夜間の屋外でLCDモ

ニターの表示をみるときに選択する）
OFF 消灯（表示も消える）
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サムネイル画面操作部とオーディオ調整部

1 2 3 5

8

6

9 1011 12

74

1. サムネイルインジケーター
サムネイル画面が表示されているときに点灯し
ます。

2. THUMBNAIL（サムネイル）ボタン
サムネイル操作を行うとき、このボタンを押し
てサムネイル画面（90ページ）を表示します。
もう一度押すと、元の画面に戻ります。

3. SET（設定）ボタンと矢印ボタン
タイムコードやユーザービットの数値の設定、
およびサムネイル画面での操作に使用します。
セットアップメニューを表示しているときは、
このボタンを押して項目の選択や設定変更を確
定します。

4. MENU（メニュー）ボタン
押すたびに、セットアップメニューの表示／非
表示が切り替わります。
MENU ON/OFFスイッチと同じ働きです。

5. F-RUN/SET/R-RUN（フリーラン／セット／
レックラン切り換え）スイッチ

内蔵タイムコードジェネレーターの歩進モード
を選択します。スイッチの位置によって、歩進
モードは以下のように変わります。
F-RUN：連続してタイムコードが歩進する。タ
イムコードを外部ロックさせるときなどに
合わせる。

SET：タイムコードやユーザービットを設定す
る。

R-RUN：記録中のみタイムコードが歩進する。
記録メディア上のタイムコードを、連続し
て記録する。

 ˜「タイムコードを設定する」（50ページ）

 ˜「ユーザービットを設定する」（50ページ）

6. LEVEL CH1/CH2/CH3/CH4（音声チャンネ
ル1/2/3/4録音レベル調整）つまみ

AUDIO SELECT CH1/CH2スイッチ、および
AUDIO SELECT CH 3-4スイッチをMANUALに

すると、音声チャンネル1、2、3、4に記録する
音声レベルを調整できます。

7. AUDIO SELECT CH 3-4（音声チャンネル
3-4自動／手動レベル調整切り換え）スイッ
チ

音声チャンネル3と4の音声レベル調整方法を個
別に選択します。
AUTO：自動
MANUAL：手動

8. ESSENCE MARK（エッセンスマーク）ボタ
ン

サムネイル画面表示中に押すと、リストの選択
項目に応じて、選択したクリップのエッセンス
マークサムネイル画面を表示することができま
す。
All：エッセンスマークが打たれたすべてのフレ
ームの一覧を表示する。

Rec Start： レックスタートマークが打たれたフ
レームおよび、先頭フレームにレックスタ
ートマークが付いていないクリップがある
場合は、その先頭フレームも加えて一覧を
表示する。

Shot Mark1：ショットマーク 1が設定された
フレームの一覧

Shot Mark2：ショットマーク 2が設定された
フレームの一覧

Shot Mark0とShot Mark3～ Shot Mark9も選
択できます。
ショットマーク0～ショットマーク9の名前を
定義したプランニングメタデータを使用してク
リップを記録した場合は、リストの選択項目が
定義した名前になります。

9. SHIFT（シフト）ボタン
各種のボタンと組み合わせて使用します。

10. PRESET/REGEN/CLOCK（プリセット／リ
ジェネレート／クロック）スイッチ

タイムコードを記録する方法を選択します。
PRESET：新たに設定されたタイムコードをメデ
ィアに記録する。

REGEN：メディアに記録されたタイムコードを
読み取り、その値に連続するようにタイム
コードを記録する。F-RUN/SET/R-RUN ス
イッチの設定に関わらず、本機は R-RUNモ
ードで歩進する。

CLOCK：タイムコードを内蔵の時計と合わせる。
F-RUN/SET/R-RUN スイッチの設定に関わ
らず、本機は F-RUNモードで歩進する。

11. AUDIO SELECT CH1/CH2（音声チャンネ
ル1/2自動／手動レベル調整切り換え）ス
イッチ

音声チャンネル1と2の音声レベル調整方法を個
別に選択します。
AUTO：自動
MANUAL：手動

12. AUDIO IN CH1/CH2/CH3/CH4 （音声入力
切り換えチャンネル1/2/3/4）スイッチ

音声チャンネル1、2、3、4に記録する入力信号
を選択します。
FRONT：MIC IN端子に接続したマイクからの
音声入力信号

REAR：AUDIO IN CH-1/CH-2端子に接続した
オーディオ機器からの音声入力信号

WIRELESS：本機にスロットイン UHFポータブ
ルチューナーを装着したときの音声入力信
号
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ハンドル部・メモリーカードスロット側面

1

7

23

98

456
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13 14

11 12

メモリーカードスロット部
（32ページ）

1. ASSIGNABLE（アサイナブル）4/5スイッチ
メニューのOperation >Assignable Switchで
機能を割り当てます（132ページ）。

工場出荷時には、Offが割り当てられています。

2. GPSモジュール
この部分にGPSモジュールが内蔵されています。

 ˜「測位情報の取得（GPS）」（65ページ）

［ご注意］
GPS機能使用中は、この部分を握らないでください。

3. PC接続端子
本機をUSB接続モードに切り換えてコンピュー
ターの外部記憶装置として使用するための端子
です。コンピューターとこの端子を接続すると、
本機に挿入されたメモリーカードが、カードご
とにドライブとして認識されます。

4. 外部機器接続端子
ポータブルストレージHDD PSZ-HA/HB/HCシ
リーズ（別売）、ポータブルストレージSSD PSZ-
SA25（別売）、汎用の外付けのUSB HDD、およ
びUSBメモリーを接続すると、本機のSxSカー
ドスロットに挿入された記録メディア内のク
リップをUSBメディアにコピーすることができ
ます。

［ご注意］
この端子は、上記の機器の接続にだけ使用してください。
USBハブなどほかの機器を接続して使用することはできま
せん。

5. USBワイヤレスLANモジュール用端子
USBワイヤレスLANモジュールIFU-WLM3（付
属）、ネットワークアダプターキットCBK-NA1
（別売）、ワイヤレスLANアダプター CBK-WA02
（別売）、またはモデム（別売）を接続することに
より、無線LAN機器やネットワークとの通信が
可能になります。

 ˜「本機とデバイスのワイヤレスLAN接続」（67ページ）

 ˜「インターネット接続」（71ページ）

6. PROXY SDカードスロット（60ページ）
プロキシデータ記録用SDカードを挿入します。

7.  (NFC)マーク 
NFCアンテナが内蔵されています。

8. SLOT SELECT（SxSメモリーカード選択）ボ
タン

スロットAとBの両方に記録メディアが装着され
ているとき、使用する記録メディアを切り換え
ます（33ページ）。

9. ネットワーク端子
LANケーブル（別売）を接続することで、有線
LAN接続によるネットワークとの通信が可能に
なります。

［ご注意］

ˎˎ 安全のために、周辺機器を接続する際は、過大電圧を
持つ可能性があるコネクターをこの端子に接続しない
でください。 
接続については本書の指示に従ってください。

ˎˎ LANケーブルご使用の際は、輻射ノイズによる誤動作を防
ぐため、シールドタイプのケーブルを使用してください。

 ˜「インターネット接続」（71ページ）

10. HDMI端子
HDMIモニターやレコーダーなどを接続し、HD
またはSD HDMIによる映像・音声信号を出力し
ます。

［ご注意］
4K(QFHD)出力には対応していません。
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11. GENLOCK IN（ゲンロック用入力）端子
（BNC型）

カメラ部にゲンロックをかけるとき、またはタ
イムコードを外部ロックさせるとき、基準信号
を入力します。入力できる基準信号は、設定さ
れているシステム周波数によって次表のように
異なります。

システム周波数 入力できる基準信号
59.94i 1080/59.94i、480/59.94i
59.94P 1080/59.94i、480/59.94i
50i 1080/50i、576/50i
50P 1080/50i、576/50i
29.97P 1080/59.94i、480/59.94i
25P 1080/50i、576/50i
23.98P 1080/23.98PsF

12. TC IN（タイムコード入力）端子（BNC型）
タイムコードを外部ロックさせるとき、基準と
なるタイムコードを入力します。

 ˜「タイムコードを設定する」（50ページ）

13. VIDEO OUT（ビデオ出力）端子（BNC型）
ビデオモニター用のビデオ信号を出力します。

14. TC OUT（タイムコード出力）端子（BNC型）
外部VTRのタイムコードを本機のタイムコード
にロックさせるとき、外部VTRのタイムコード
ロック用TC IN（タイムコード入力）端子と接続
します。

タリー部・接続端子部

43

1 8 9 10 117

65

AES/
EBULINE MIC

SDI IN

SDI OUT

REMOTEAUDIO OUTAUDIO IN

CH2
3/4

CH1

12V 1.8A

+48V
OFF

1/2

1

2
SDI OUT

3

4

AES/
EBULINE MIC

+48V
OFF

2

1

1. TALLY（バックタリー）ランプ（赤）
記録中に点灯します。ただし、TALLYス
イッチがOFFになっていると点灯しません。
WARNINGランプが動作しているときは点滅し
ます。なお、ビューファインダー前面のタリー
ランプ、ビューファインダー画面のREC表示も
同様に点灯／点滅します。

 ˜「エラー／警告システム」（153ページ）

2. TALLY（タリー） スイッチ
TALLYランプを使用するとき、ONに設定します。

3. EARPHONE（イヤホン）端子（ステレオ、ミ
ニジャック）

イヤホンを接続すると、記録中はE-E音を、再生
中は再生音をモニターできます。警告ランプや
警告表示の点滅・点灯に合わせて警告音も聞こ
えます。内蔵スピーカーからの音は自動的に聞
こえなくなります。
メニューのMaintenance >Audio 
>Headphone Outでモノラル／ステレオを切
り換えることができます。

［ご注意］

ˎˎ イヤホンはモノラル（2極）またはステレオ（3極）タイプ
を使用してください。それ以外を使用すると本機が故
障することがあります。
ˎˎ インピーダンス16Ωのイヤホンを使用してください。

4. AUDIO IN（音声入力）切り換えスイッチ
AUDIO IN CH-1/CH-2端子に入力される音声の
音源を切り換えます。
LINE：ステレオアンプなど、外部のオーディオ
信号源を接続する場合

AES/EBU：外部のデジタルオーディオ信号源を
接続する場合

MIC：マイクを接続する場合
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5. +48V/OFF（+48V外部電力供給オン／オフ）
スイッチ

音声入力に使用するマイクによって、以下のよ
うに切り換えます。
+48V：外部電源供給方式のマイク
OFF：内部電源供給方式のマイク

6. SDI IN（SDI入力端子）（BNC型）
外部からのSDI信号を本機に入力するときに使
用する端子です。

7. AUDIO IN CH-1/CH-2（音声入力チャンネ
ル1/2）端子（XLR型、3ピン、凹）

オーディオ機器やマイクを接続します。

8. ボトムカバー
後面の端子に接続するケーブル類を保護するた
めのパーツです。
カムコーダー底面の取り付けネジをゆるめると、
接続するマイクケーブルまたはオーディオケー
ブルのプラグの形状に応じて、ボトムカバーの
位置を調整することができます。調整後は、ネ
ジを締めてカバーを固定してください。

9. AUDIO OUT（音声出力）端子（XLR型、5ピ
ン、凸）

オーディオチャンネル1、2または、オーディオ
チャンネル3、4に記録された音声信号を出力し
ます。
出力する音声信号は、MONITORスイッチで選
択します。

10. REMOTE（リモートコントロール）端子（8
ピン）

本機の遠隔操作が可能なリモートコントロール
ユニットを接続します。

［ご注意］
本機にリモートコントロールユニットの接続／取り外しを
行うときは、本機の電源を切ってから行ってください。

11. SDI OUT 1/2/3/4端子（BNC型）
3G/HD SDI信号（エンベデッドオーディオ）ま
たはSD SDI信号（エンベデッドオーディオ）を
出力します。本端子からの出力信号は、メニュー
のOperation >Input/Output >SDI Out1/3 
Output、または>SDI Out2/4 Outputでオン／
オフを切り換えることができます。
接続には市販の75Ω同軸ケーブルを使用してく
ださい。

［ご注意］

ˎˎ QFHDのQuad Linkを出力するためには、CBKZ-
Z450QL（別売のQUAD-LINK 3G-SDI Upgrade 
License）のインストールが必要です。
ˎˎ 本機と外部機器の間のアースが確実に設置されている
ことを確認してから、電源を入れてください。 
（75Ω同軸ケーブルを接続した後に、本機と外部機器の
電源を入れることをおすすめします。） 
やむを得ず、電源投入状態で外部機器を接続する場合
は、75Ω同軸ケーブルを外部機器に接続した後に、本
機と接続してください。
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LCDモニター情報画面（ステータス表示）

LCDモニター情報画面は、DISP SEL/EXPAND
（表示選択/エクスパンド）ボタンを押して表示
します（9ページ）。

1 2 3 4 5

6

78

910
11

1213

1. ファイルシステム表示

2. ファイルフォーマット表示

3. 状態表示
PB：メディアを再生しているとき表示されます。
NDF：タイムコードがノンドロップフレームモ
ードのとき表示されます。

EXT-LK：内蔵のタイムコードジェネレーターが
TC IN端子に接続した外部信号にロックして
いるとき表示されます。

HOLD：タイムコードジェネレーターの歩進モ
ードがレックランで、歩進が止まっている
とき表示されます。

4. システム周波数表示
記録時のシステム周波数または再生中のクリッ
プのシステム周波数が表示されます。

5. 音声フォーマット表示
記録時の音声フォーマットまたは再生中のク
リップの音声フォーマットが表示されます。

表示 記録フォーマット
16bit HD420 HQ

DVCAM
MPEG IMX 50

24bit HD422 50
MPEG IMX 50
XAVC Intra
XAVC Long

6. 音声レベルメーター
音声記録レベルまたは再生レベルが表示されま
す。「1」～「4」は音声チャンネル1～ 4を示し
ます。

7. バッテリー残量表示
バッテリー残量がアイコンと記録可能な残り時
間で表示されます。

8. メディア残量表示
記録メディアの残量がスロットごとにバーグラ
フで表示されます。

9. 警告表示エリア
記録異常が発生したときに内容を表示します。

 ˜ 詳しくは、「エラー／警告システム」（153ページ）を
ご覧ください。

10. クリップ名表示
記録中は、記録中のクリップに付けられるクリッ
プ名、記録待機中は、次に記録されるクリップ
に付けられるクリップ名が表示されます。

11. タイムデータ表示
DISPLAYスイッチのポジションにより、デュ
レーション、タイムコード、ユーザービットを
切り換えて表示します。
タイムデータに現在表示しているデータの種類
は、次のように表示されます。
TCG：記録タイムコード
TCR：再生タイムコード
UBG：記録ユーザービット
UBR：再生ユーザービット
CNT：カウンター
DUR：デュレーション
CLK：時刻表示（PRESET/REGEN/CLOCKスイ
ッチが CLOCKに設定されている）

タイムコード表示中にHOLDボタンが押され
たときは、次のフォーマットで表示されます。
HOLDボタンを再度押して保持状態を解除する
と、通常の表示に戻ります。

タイムコード、カウンター歩進が保持状態で
あることを3つのドットで表す

12. 解像度表示
出力映像の解像度が表示されます。

13. 記録フォーマット表示
記録フォーマットまたは再生中のクリップの記
録フォーマットが表示されます。

ステータス画面

ステータス画面では、本機の設定や状態を確認
することができます。
メニューが表示されていないとき、MENU 
CANCEL/PRST/ESCAPEスイッチをCANCEL/
PRST側に押し上げると、ステータス画面が表示
されます。押し上げるごとに、ステータス画面
が切り換わります。
ステータス画面は、次の画面で構成されています。

ステータス画面
の種類

表示内容

Camera Status
画面

撮影に関する設定と状態

Audio Status
画面

オーディオ入出力に関する設定
と状態

System Status
画面

記録に関する設定と状態

Video Output 
Status画面

ビデオ出力に関する設定と状態

Assignable 
Button Status
画面

アサイナブルスイッチに割り当
てられている機能の名称

画面表示
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ステータス画面
の種類

表示内容

Battery Status
画面

装着されているバッテリーの状
態

Media Status
画面

記録メディアの状態

Network 
Status 1画面

ネットワークに関する設定と状
態

Network 
Status 2画面

ストリーミングに関する設定と
状態

Camera Status画面

表示項目 説明
Gain dB単位のゲインアップ量
Shutter 電子シャッターの状態
Gamma Gammaカテゴリーとカーブ
White ホワイトバランスモードの設定

Gain Switch GAINスイッチの状態
Zebra ゼブラの状態
Iris アイリスのF値
Focal Length 焦点距離
Focus 
Distance

フォーカス距離

Depth Of 
Field

被写界深度

Zoom Speed レンズのZOOMボタンに設定さ
れたズームスピード

HDR Setting HDRの設定

Audio Status画面

表示項目 説明
CH 1/CH 2/
CH 3/CH 4

各チャンネルのオーディオレベ
ル、入力ソース、基準入力レベル、
および風音低減フィルターの設
定

System Status画面

表示項目 説明
System 
Frequency

システム周波数

File System ファイルシステム
Rec Format 記録フォーマット
Clip 
Continuous 
Rec

クリップコンティニュアスレッ
ク機能のオン／オフ設定

Title Prefix クリップ名の前半文字部分
Picture Size 画サイズ
Simul Rec 2スロット同時記録機能のオン／

オフ設定
Rec Function Onになっている特殊記録とその

設定

表示項目 説明
Picture Cache 
Rec

ピクチャーキャッシュレック機
能のオン／オフ設定

Number クリップ名の後半数値部分の設
定

Gamma 適用されるGammaカテゴリー

4K&HD (Sub) 
Rec

1スロット同時記録機能のオン／
オフ設定

XAVC Proxy 
Rec

プロキシデータ記録機能のオン
／オフ設定

Video Output Status画面

表示項目 説明
SDI SDI OUT端子の出力設定（出力画

サイズ、出力形態、出力レート、
スーパーインポーズ）

HDMI HDMI端子の出力設定（出力画サ
イズ、出力形態、出力レート、スー
パーインポーズ）

Video VIDEO OUT端子の出力設定（出
力画サイズ、スーパーインポー
ズ）

Assignable Button Status画面

Battery Status画面

表示項目 説明
Detected 
Battery

検出されたバッテリーの種類

Remaining 残容量（%）
Charge 
Count 

充電を行った回数

Capacity 残容量（Ah）
Voltage 電圧
Manufacture 
Date 

バッテリー製造年月日

Power Source 電源供給源
Supplied 
Voltage 

供給電源電圧
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Media Status画面

表示項目 説明
SxSA スロットAのメディアの残容量

（バーと残り時間表示）、メディ
ア寿命（0～ 100％を表示。0％
で交換を推奨。この機能のサポー
トしているメディアのみ表示）

SxSB スロットBのメディアの残容量
（バーと残り時間表示）、メディ
ア寿命（0～ 100％を表示。0％
で交換を推奨。この機能のサポー
トしているメディアのみ表示）

SD Proxy PROXY SDカードスロットのメ
ディアの残容量（バーと残り時間
表示）、メディア寿命（取得でき
た場合のみ表示）

SD Utility UTILITY SDカードスロットのメ
ディアの残容量（バーと残容量）、
メディア寿命（取得できた場合の
み表示）

メディアがプロテクトされている場合は、
マークが表示されます。

Network Status 1画面

表示項目 説明
Setting ネットワークの設定状態
Wireless 
Network

ワイヤレスネットワークの設定
状態

Device Name 装着されているUSBワイヤレス
LANモジュール機器の名称

IP Address 
(Wireless)

ワイヤレスLAN接続のIPアドレ
ス

MAC Addr. 
(Wireless)

USBワイヤレスLANモジュール
接続端子に装着されている機器
のMACアドレス

Wireless 
Network

モデムの設定状態

Device Name 装着されているモデム機器の名
称

IP Address 
(Modem)

装着されているモデムのIPアド
レス

Wired LAN 有線LANネットワークの接続状
態

Wired LAN 
Remote

LANケーブルを使用した接続状
態のリモート操作の有効／無効
状態表示

IP 
Address(Wired)

有線LAN接続のIPアドレス

Network Status 2画面

表示項目 説明
NW Client 
Mode Status

ネットワーククライアントモー
ドの状態
状態の詳細説明は、「ネットワー
ククライアントモード状態の詳
細」（16ページ）を参照

表示項目 説明
CCM Name ネットワーククライアントモー

ド時に接続中のCCMの名称
Streaming 
Status

ストリーミングの配信状態

Streaming 
Size

現在選択しているストリーミン
グ設定の画サイズ

Streaming Bit 
Rate

現在選択しているストリーミン
グ設定のビットレート

Streaming 
Type

現在選択しているストリーミン
グ設定の種別

Streaming 
Dest. Add.

ストリーミングの送信先アドレ
ス

Streaming 
Dest. Port

ストリーミングの送信先ポート

Number of 
Distribution

現在配信中のストリーミングの
送信先数

File Transfer ファイル転送の転送進捗状態

Transfer to: ファイル転送先のサーバー名

ネットワーククライアントモード状態の詳細

状態表示 状態 説明
Off CCM非接

続状態
ネットワーククライア
ントモードがオフの状
態です。

Connected CCM接続
済状態

ネットワーククライア
ントモードがオンで
CCMに接続しており、
CCMからの制御が可能
な状態です。

状態表示 状態 説明
Connecting CCM接続

中（切断
中）状態

CCMへの接続（または
切断）をしようとしてい
る状態です。接続（また
は切断）完了まで、し
ばらくお待ちください。
Connectingのまま状
態が変化しない場合は
CCMのアドレス設定が
間違っている可能性が
あります。正しいアド
レスが設定されている
か確認してください。

Awaiting CCM接続
待機状態

ネットワーククライア
ントモードはオンです
がネットワーク設定が
オフの状態です。CCM
に接続するにはネット
ワーク設定を有効にし
てください。

Address 
Error

CCMア
ドレスエ
ラー

接続先のCCMのホスト
名またはIPアドレスが
間違っている可能性が
あります。正しく設定
されているか確認して
ください。

Auth. 
Failed

CCMユー
ザー名／
パスワー
ドエラー

CCMに接続するための
ユーザー名またはパス
ワードが間違っている
可能性があります。正
しく設定されているか
確認してください。

No Inet 
Access

インター
ネット接
続エラー

ネットワークに接続で
きません。ネットワー
クの設定が間違ってい
る可能性があります。
ネットワークの設定を
確認してください。

Cert. not 
Valid

CCM証明
書無効エ
ラー

CCMの証明書が有効で
はありません。日付設
定が不正である可能性
があります。日付設定
を確認してください。
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ビューファインダー画面

撮影中（記録中／記録待機中）および再生中、
ビューファインダー画面には本機の情報が映像
に重ねて表示されます。
情報の表示／非表示はビューファインダーの

DISPLAYスイッチで切り換えます。
表示する情報はメニューのOperation >Super 
Imposeの設定や、関連するスイッチでの設定
に連動しています。

1 2 5 6 843
7

9 10 11 12

13 14
15 16
17
19
21

24
23

25

18
20
22

2629

30
31

32

34

36
38

33

2728

35
37

1. エクステンダー表示
レンズのエクステンダー機能がオンのとき、
“EX”が表示されます。

2. ズームポジション表示（レンズ装着時のみ）
ズームレンズのズームポジションが0～ 99の範
囲で表示されます。
ご使用のレンズによって表示される値は変わり
ます。

3. 色温度表示
ホワイトバランスの色温度が表示されます。

4. フォーカスポジション表示（レンズ装着時の
み）

フォーカスポジションが被写体までの距離（単
位：m）で表示されます。

5. アイリスポジション表示（レンズ装着時の
み）

アイリスポジションの設定状態が表示されます。

6. 電気色温度フィルター表示
CC5600K機能がオンのとき表示されます。

7. 被写界深度表示（シリアルレンズ装着時の
み）

被写界深度がバーで表示されます。表示の単
位は、メニューのOperation >Display On/
Off >Lens Infoの設定により、メートルまたは
フィートを選択できます。

8. 記録動作状態表示
本機の記録動作状態が次のように表示されます。

表示 意味
●Rec 記録中
Stby 記録待機中
●Cont Rec クリップコンティニュアスレック

記録中
Cont Stby クリップコンティニュアスレック

時に記録待機中
●S&Q Rec スロー &クイックモーションモー

ドで記録中
S&Q Stby スロー &クイックモーションモー

ドで記録待機中
●Rec ピクチャーキャッシュレックモー

ドで記録中
●Cache ピクチャーキャッシュレックモー

ド時に記録待機中
●Int Rec インターバルレックで記録中
Int Stby インターバルレックで記録待機中

●Int Stby インターバルレックで記録一時停
止中（インターバル期間中）

●Sml Rec 同時記録モードで記録中
Sml Stby 同時記録モードで記録待機中
CALL 外部接続機器からのコール時

本機が次の状態のときにグリーンタリー表示表
示されます。

ˎˎ メニューのMaintenance >Camera Config 
>HD SDI Remote I/FがGreen Tallyに設定さ
れており、SDI OUT端子から記録の制御信号
が出力されているとき

ˎˎ グリーンタリー信号を受信したとき（本機に
カメラアダプターを取り付けて、カメラエク
ステンションユニットと接続している場合）

9. ワイヤレスレシーバー機能表示
本機にスロットインレシーバーが装着されてい
るとき「W」が表示され、レシーバーが使用でき
るチャンネル数（1ch、2ch、または4ch）に応
じて、各チャンネルの受信レベルがアイコンで
表示されます。
通常：白色セグメントの表示数で受信レベルの
強度を示す

アナログレシーバーのミューティング時／デジ
タルレシーバーのエラーレート悪化時：灰
色セグメントの表示数で受信レベルの強度
を示す

受信レベルがピークを越えたとき：インジケー
ターの代わりに「P」と表示される 1)

送信機がパワーセーブ中：「S」が表示される
送信機のバッテリー消耗時：該当するチャンネ
ル番号とインジケーターが点滅する 1)

1)   別売のDWR-S02DN使用時のみ

10. S&Q Motion（スロー &クイック）撮影フ
レームレート設定表示

本機がスロー＆クイックモーション記録モード
に設定されている場合、撮影フレームレートが
表示されます。

11. GPS状態表示（65ページ）

12. バッテリー残量／電圧表示
本機を駆動している電源の種類に応じて次のよ
うに表示されます。

電源の種類 表示
インフォバッテ
リー

バッテリー残量アイコンと記
録可能な残り時間
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電源の種類 表示
アントンバウアー
社製バッテリー

バッテリー残量（%表示）

その他の電源 入力電圧

13. 記録フォーマット（画サイズ）表示
SxSメモリーカードに記録される画サイズが表
示されます。

14. 記録フォーマット（システム周波数とスキャ
ン方式）表示

現在設定されている本機のシステム周波数と、記
録フォーマットのスキャン方式が表示されます。

15. 記録フォーマット（コーデック）表示／ 1ス
ロット同時記録表示

SxSメモリーカードに記録されるフォーマット
名称が表示されます。
1スロット同時記録時は、「/Sub」が表示されま
す（58ページ）。

16. ガンマ表示
ガンマ設定値が表示されます。

メニュー設定 表示

Operation 
>Display 
On/Off 
>Gamma

Paint >Gammaの設定

Gamma Gamma 
Category

Gamma 
Select

Off ― ― ― ―

メニュー設定 表示

Operation 
>Display 
On/Off 
>Gamma

Paint >Gammaの設定

Gamma Gamma 
Category

Gamma 
Select

On Off ― ― Gamma 
Off

On STD STD1 
DVW

STD1

STD2 x4.5 STD2

STD3 x3.5 STD3

STD4 
240M

STD4

STD5 
R709

STD5

STD6 x5.0 STD6

HG HG1 
3250G36

HG1

HG2 
4600G30

HG2

HG3 
3259G40

HG3

HG4 
4609G33

HG4

User User 1 User 1
User 2 User 2
User 3 User 3
User 4 User 4
User 5 User 5

メニューのOperation >Base Setting 
>Shooting ModeがHDR、かつOperation 
>Display On/OFF >GammaがOnの場合の表
示は次のとおりです。

メニュー設定 表示

メニューのOperation 
>HDR Setting

メニューのPaint 
>Gamma

4K(QFHD) 
Rec/Out

HD Rec/
Out

Gamma Gamma 
Category

HDR 
(HLG)

HDR 
(HLG)

― ― HLG

SDR Off ― HLG
On STD1 

DVW
HLG 
STD1

STD2 
x4.5

HLG 
STD2

STD3 
x3.5

HLG 
STD3

STD4 
240M

HLG 
STD4

STD5 
R709

HLG 
STD5

STD6 
x5.0

HLG 
STD6

HG1 
3250G36

HLG 
HG1

HG2 
4600G30

HLG 
HG2

HG3 
3259G40

HLG 
HG3

HG4 
4609G33

HLG 
HG4

User 1 HLG 
User1

User 2 HLG 
User2

User 3 HLG 
User3

User 4 HLG 
User4

User 5 HLG 
User5

メニュー設定 表示

メニューのOperation 
>HDR Setting

メニューのPaint 
>Gamma

4K(QFHD) 
Rec/Out

HD Rec/
Out

Gamma Gamma 
Category

HDR 
(S-Log3)

SDR Off ― S-Log3
On STD1 

DVW
S-Log3 
STD1

STD2 
x4.5

S-Log3 
STD2

STD3 
x3.5

S-Log3 
STD3

STD4 
240M

S-Log3 
STD4

STD5 
R709

S-Log3 
STD5

STD6 
x5.0

S-Log3 
STD6

HG1 
3250G36

S-Log3 
HG1

HG2 
4600G30

S-Log3 
HG2

HG3 
3259G40

S-Log3 
HG3

HG4 
4609G33

S-Log3 
HG4

User 1 S-Log3 
User1

User 2 S-Log3 
User2

User 3 S-Log3 
User3

User 4 S-Log3 
User4

User 5 S-Log3 
User5

17. タイムコード外部ロック状態表示
タイムコードが外部から入力されているときに
表示されます。
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18. 有線LAN／モデム接続状態表示
有線LANネットワーク、またはモデムの設定／
接続状態がアイコン表示されます。

有線LANの設定／接続状態

条件 ネットワー
ク接続状態
／アイコン
表示

メニューの
Operation 
>Display 
On/Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Wired LAN

Off ― ― ―

On Off ― ―

On ― ―

Disable ―

Enable LAN準備中

（点滅表示）

LAN接続中

LAN 
接続エラー

3G/4Gモデムの設定／接続状態

条件 ネットワー
ク接続状態
／アイコン
表示

メニューの
Operation 
>Display 
On/Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Modem

Off ― ― ―

On Off ― ―

条件 ネットワー
ク接続状態
／アイコン
表示

メニューの
Operation 
>Display 
On/Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Modem

On On ― ―

Off ―

On 3G/4G 
準備中

（点滅表示）

3G/4G 
接続中 

3G/4G 
接続エラー

19. ストリーミング状態表示
ストリーミングの状態がアイコン表示されます。

条件 ストリーミ
ング状態／
アイコン表
示

メニューの
Operation 
>Display 
On/Off 
>Streaming 
Status

メニューの
Maintenance 
>Streaming 
>Setting

メニューの
Maintenance 
>Network 
Client Mode 
>Setting

Off ― ― ―

On Off Off ―

On Off 未配信

映像配信中

エラー

CCMからのストリーミング操作中の場合のアイ
コン表示は次のようになります。

条件 ストリーミ
ング状態／
アイコン表
示

メニューの
Operation 
>Display 
On/Off 
>Streaming 
Status

メニューの
Maintenance 
>Streaming 
>Setting

メニューの
Maintenance 
>Network 
Client Mode 
>Setting

On Off On 未配信

映像配信中

［ご注意］
ストリーミング開始前、アイコンは表示されません。

20. Wi-Fiモード状態表示
ワイヤレスLANの設定／接続状態がアイコン表
示されます。

条件 ネットワー
ク接続状態
／アイコン
表示

メニューの
Operation 
>Display 
On/Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Wi-Fi Mode

Off ― ― ―
On Off ― ―

On Wi-Fi Access 
Point

Wi-Fi準備中 

（点滅表示）
Wi-Fiスタン
バイ 
（接続中） 

条件 ネットワー
ク接続状態
／アイコン
表示

メニューの
Operation 
>Display 
On/Off 
>Network 
Condition

メニューの
Maintenance 
>Network 
>Setting

メニューの
Maintenance 
>Network 
>Wi-Fi Mode

On On Wi-Fi 
Station

Wi-Fi準備中 

（点滅表示）
アクセス 
ポイント 
探索中

アクセス 
ポイント 
接続中

電波強度に
よりアイコ
ンが変化
アクセスポ
イント接続
エラー

Off ―

21. ファイル転送状態表示
ファイル転送中は、 と転送率（%）が表示され
ます。転送が完了すると  が消え、100%と表
示されます。

22. プロキシ状態表示
プロキシ記録がオン（メニューのOperation 
>XAVC Proxy Rec Mode >SettingがOn）のと
きに“Proxy”と表示されます。準備中は“Proxy”
表示が点滅します。プロキシ記録中は“Proxy 
Rec”と表示されます。
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23. ネットワーククライアントモード状態表示
ネットワーククライアントモードをオンにす
ると、CCM（ネットワークRXステーションの
Connection Control Manager）への接続状態
がアイコン表示されます。

条件 アイコン

メニューの
Operation 
>Display 
On/Off 
>NW Client 
Mode 
Status

メニューの
Maintenance 
>Network 
Client Mode 
>Setting

状態

Off ― ― ―

On Off ― ―

On CCM接続
済

CCM接続
中（切断中）

（点滅表示）

CCM接続
待機中

―

CCM接続
エラー

エラー内容
については
16ページ
参照。

24. ビデオ信号表示
出力映像信号の状態をウェーブフォーム、ベク
トルスコープ、ヒストグラム化してリアルタイ
ムで表示されます。

条件 ビデオ信号
表示メニューの

Operation 
>Input/Output > 
Output Format > 
SDI Out

メニューの
Operation > HDR 
Setting

3840x2160 4K(QFHD) Rec/Out設定時の表示

HDR(HLG) HDR(HLG)
HDR(S-Log3) HDR

(S-Log3)
1920x1080 HD Rec/Out設定時の表示

HDR(HLG) HDR(HLG)
SDR SDR

25. 各メディアスロットの記録メディア状態／
残量表示

SxSスロットA、SxSスロットBおよびPROXY 
SDカードスロット内のメディアの状態と残量が
表示されます。

SxSスロットアイコン表示
※  SxS スロットAの例です。SxS スロットBはアイコンの

AがBに変わります。

アイコン メディア状態
表示なし メディアが挿入されていない／マウ

ントされていない
メディアがマウントされている

（点滅）
メディアマウント処理中

（オレンジ
色バー点
灯）

記録アクティブ

（緑色ラン
プ点灯）

再生アクティブ

アイコン メディア状態

（オレンジ
色バー +緑
色ランプ点
灯）

記録／再生アクティブ

プロキシデータ記録用SDカードアイコン表示

アイコン メディア状態
表示なし メディアが挿入されていない／マウ

ントされていない
メディアがマウントされている

（点滅）
メディアマウント処理中

（オレンジ
色バー点
灯）

記録アクティブ

残量は記録可能時間が数値で表示されます。

26. オーディオレベルメーター表示
音声チャンネル1、2のレベルが表示されます。

27. クリップ名表示
記録中は、記録中のクリップに付けられるクリッ
プ名、記録待機中は、次に記録されるクリップ
に付けられるクリップ名が表示されます。

28. フォーカスアシスト表示
フォーカスの合焦度を検出する領域を示す検出
枠（Focus Area Marker）と、検出枠内のフォー
カス合焦度を示すレベルバー（Focus Assist 
Indicator）を表示します。

29. タイムデータ表示
DISPLAYスイッチ（9ページ）の設定に応じ
て、記録・再生経過時間、タイムコード、ユーザー
ビットなどが表示されます。

30. 設定データ保存用SDカード状態表示
UTILITY SDカードスロットに挿入された設定
データ保存用SDカードの状態が表示されます。

アイコン メディア状態
― SDカードが挿入されていない、ま

たはマウントされていない
SDカードがマウントされている

マウントされているSDカードがプ
ロテクトされている

（点滅表示）

SDカードのマウント処理中

31. SDI出力RECトリガー表示
SDI端子出力への記録コマンドの重畳状態が表
示されます。
メニューのMaintenance >Camera Config 
>HD SDI Remote I/Fが「Characters」に設定さ
れている場合に表示されます。

32. ALAC状態表示
ALAC（倍率色収差補正）が自動的に実行される
状態になっていると、「ALAC」が表示されます。
ALACが自動的に実行されるのは、ALACに
対応しているレンズが取り付けられ、かつ
ALACの機能が有効になっており、メニュー
のMaintenance >Camera Config >ALACが
「Auto」に設定されている場合です。

33. AE（オートアイリス）モード表示
現在のオートアイリス機能の動作モードをアイ
コンとオートアイリスのオーバーライド量で表
示します。

アイコン 意味
バックライトモード

標準モード
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アイコン 意味
スポットライトモード

34. オートフォーカスモード表示（オートフォー
カスレンズ装着のみ）

本機のフォーカス調整モードが表示されます。

ˎˎ AF（オートフォーカス）
ˎˎ MF（マニュアルフォーカス）
ˎˎ MF*（マニュアルフォーカス、MFアシスト機
能がON）
ˎˎ Full MF（フルマニュアルフォーカス）

35. NDフィルター表示
現在選択されているNDフィルターのポジショ
ン番号が表示されます（5ページ）。
Electrical CCをアサイナブルスイッチに割り当
てているときは、NDフィルター表示（1～ 4）
の右側に電気的CCフィルターのポジション（A/
B/C/D）が表示されます。

36. ゲイン表示
GAINスイッチによる映像アンプのゲイン設定
値（dB）が表示されます。

37. シャッターモード／シャッタースピード表示
/Flash Band Reduce（フラッシュバンド軽
減機能）状態表示

シャッタースピードまたはシャッターモードが
表示されます。

 ˜「電子シャッターの設定」（45ページ）

またシャッターが非動作状態で、Operationメ
ニューのFlash Band Reduce（112ページ）が
Onの場合、FBRが表示されます。

38. ホワイトバランスモード表示
現在選択されているホワイトバランスの自動調
整メモリーが表示されます。

ATW：ATW（自動追尾ホワイトバランス）モード
W:A：メモリー Aモード
W:B：メモリー Bモード
W:C：メモリー Cモード
W:P：プリセットモード
3200K：Color Temp SW 3200Kを割り当てた
アサイナブルスイッチがオンのとき

4300K：Color Temp SW 4300Kを割り当てた
アサイナブルスイッチがオンのとき

5600K：Color Temp SW 5600Kを割り当てた
アサイナブルスイッチがオンのとき

6300K：Color Temp SW 6300Kを割り当てた
アサイナブルスイッチがオンのとき 
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付属レンズとビューファインダー
PXW-Z450KC付属レンズ

レンズの操作方法については、取扱説明書（CD-ROM）のZoom Lens Manual（PDF）をご覧ください。

15
16

18
17

14

6
7

8
9

10

11
12

5
4
3
2
1

13

1. アイリスゲイン調整トリマー（47ページ）

2. アイリス瞬時オートスイッチ
アイリス動作モード切換えスイッチをM（マニュ
アル）側にして絞りを手動で調整している間に
一時的に自動調整を行いたいとき、このスイッ
チを押します。スイッチを押している間、絞り
が自動調整されます。

3. アイリス動作モード切換えスイッチ
A（オート）：絞りが自動調整されます。
M（マニュアル）：アイリスリングで絞りを調整
します。

4. ズームシーソースイッチ
ズームサーボ／マニュアル切換えノブがSERVO
側に設定されているとき有効です。広角にした

いときW（ワイド）側、望遠にしたいときT（テレ）
側を押します。
スイッチを深く押すとズーム速度が速くなり、
浅く押すと遅くなります。

5. RETスイッチ
ボタンを押している間、記録した最後の数秒間
をビューファインダーで確認（レックレビュー）
することができます。

6. MEMOスイッチ（22ページ）
シャトルショットに使用します。

7. AUXスイッチ

8. F.B.ロックネジ／ F.B.調整リング（47ペー
ジ）

9. 位置決めピン
レンズ取り付け時に、このピンを本体のレンズ
マウント上部中央の凹部に合わせます。

10. マクロボタン／マクロリング
マクロボタンを押しながらマクロリングを回し
て焦点を合わせます（接写：最短10 mm）。

11. アイリスリング
マニュアルで絞りを調整するとき、アイリス動
作モード切換えスイッチをM（マニュアル）側に
切り換えてから、このリングを回します。

［ご注意］
必ずアイリス動作モード切換えスイッチをM（マニュアル）
側に切り換えてから操作してください。

12. ズームレバー／ズームリング
マニュアルでズームを調整するとき、ズームサー
ボ／マニュアル切換えノブをMANU側に切り換
えてから、このレバー／リングで操作します。

13. フォーカスリング
フォーカスを調整するとき、このリングを回し
ます。

14. ズームサーボ／マニュアル切換えタブ
SERVO（サーボ）：電動ズームを選択します。ズ
ームシーソースイッチを使って操作します。

MANU（マニュアル）：手動ズームを選択します。
ズームレバー／ズームリングを使って操作
します。

15. フードロックノブ

16. ズーム、フォーカスリモート、バーチャル
用コネクター（20ピン）

ズーム、フォーカスコントロール、および用ア
クセサリー（20ピン）を接続します。

［ご注意］

バーチャル出力は中央のコネクターのみ有効です。

17. VTRスイッチ
記録の開始／停止に使用します。一度押すと記
録が始まり、もう一度押すと停止します。

18. 最高ズームスピード調整ボリューム

シャトルショットについて

ユーザーが任意に記憶させたズームポジション
に高速で移動する撮影方法です。

1	記憶させたい任意のズームポジションを決
める。

2	 MEMOスイッチを押しながらshtl（シャト
ル）機能を割り当てたスイッチを押す。
ズームポジションがシャトルポジションと
して記憶されます。
shtl（シャトル）機能を割り当てたスイッチ
を押し続けると、最高速でシャトルポジショ
ンへ移動します。
shtl（シャトル）機能を割り当てたスイッチ
を放すと、最高速での元のズームポジショ
ンに戻ります。
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現在のズーム
ポジション

shtl（シャトル）機能を割り当
てたスイッチを押し続ける

shtl（シャトル）機能を割
り当てたスイッチを放す

シャトル 
ポジション

元のズーム 
ポジション

情報ディスプレイ部（デジタルドライ
ブユニット）

DISPLAY

1
2
3

1. ディスプレイスイッチ
ディスプレイの表示をオン／オフします。

2. ディスプレイ
操作しない状態が2分以上続くと表示が消えま
す。

3. 操作キー
カーソルを上下左右に動かします。中央部分を
押して確定します。

PXW-Z450KC付属ビュー
ファインダー

付属ビューファインダーについては、ビューファ
インダーの取扱説明書（CD-ROM）をご覧くだ
さい。
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電源の準備
安全のため、下記ソニー純正以外のバッテリー
を使用しないでください。

ˎˎ リチウムイオンバッテリーパック：BP-FLX75

バッテリーパックを使用す
る

バッテリーパック側面のラインを本体のライン
に合わせて本体後面に押し当て、バッテリーパッ
クの「LOCK」表示部の矢印が本体のラインに合
うところまで押し下げてロックします。
取り外すときは、解除ボタンを押し込んだまま
バッテリーパックを押し上げます。

［ご注意］

ˎˎ バッテリーパックは、正しく取り付けないと端子を破
損することがあります。
ˎˎ 記録・再生が行われているときは（右側面のACCESSラ
ンプが青で点灯、カードスロット部のACCESSランプが
オレンジで点灯）、絶対にバッテリーパックを抜かない
でください。 
メモリーカード内のデータが壊れることがあります。
ˎˎ バッテリーは、必ず本機の電源をオフにしてから交換
してください。

バッテリーパックBP-FLX75を使った場合、連
続記録での動作時間は約150分です。

直射日光の下や火気の近くなど、高温のところ
にバッテリーを置かないでください。

［ご注意］
バッテリーパックの動作時間は、バッテリーパックの使用
頻度や使用時の周囲温度によって変化します。

ご使用になる前に、各バッテリーパックに適し
たバッテリーチャージャーで充電してください。

 ˜ 充電方法について詳しくは、バッテリーチャージャー
の取扱説明書をご覧ください。

バッテリーパック使用上のご注意
使用直後、バッテリーパックの温度が上昇した
状態で充電すると、完全に充電されないことが
あります。

AC電源を使用する

ACアダプター AC-DN2B/DN10をバッテリーと
同様に本体に装着し、AC電源に接続します。
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ビューファインダーの取り付け
ビューファインダーを取り付けたあと、接眼レンズを太陽
に向けて放置しないでください。
太陽光が接眼レンズを通して焦点を結び、火災の原因にな
ることがあります。

ビューファインダーは別売です。
ここではCBK-VF02を取り付ける場合を例に示
します。

 ˜ 各ビューファインダーの取り付けかたについては、使
用するビューファインダーのマニュアルをご覧くださ
い。

ビューファインダーを取り
付ける

［ご注意］
ビューファインダーを取り付けるときは、以下の点にご注
意ください。
ˎˎ 必ず本機の電源をオフにしてから、ビューファインダー
コネクターを本機のVF端子（26ピン）に差し込んでく
ださい。電源がオンの状態でコネクターを差し込むと、
ビューファインダーが正常に動作しないことがありま
す。
ˎˎ ビューファインダーコネクターを本機のVF端子（26ピ
ン）の奥まで確実に差し込んでください。コネクターが
確実に接続されていないと、画像が乱れたり、タリー
ランプが正常に点灯しないことがあります。

1	 [1]左右位置固定リングをゆるめる。[2]
ビューファインダー取り付けシューに
ビューファインダーを取り付け、[3]左右位
置固定リングを締める。

[2]
[1]

[3]

スライドストッパー

左右位置固定リング

2	ビューファインダーコネクターをVF端子
（26ピン）に接続する。
VF端子（26ピン）

上

ビューファインダーの取り外しは、取り付けと
逆の手順で行います。ただし、ビューファイン
ダーを取り付けシューから取り外すときに、ス
ライドストッパーを引き上げてください。

視度を調整する

視度調整リングを回して、ビューファインダー
内の画像がはっきり見えるように調整します。

視度調整リング
市販の口径52 mmのプロテクトフィルターやク
ローズアップレンズなどを取り付けることがで
きます。

画面を調整する

ビューファインダー画面の状態を、次の項目に
ついて調整できます。
輪郭：PEAKINGつまみで調整する。
濃淡：CONTRASTつまみで調整する。
明るさ：BRIGHTつまみで調整する。

ビューファインダー回転収
納機構BKW-401を取り付
ける

ビューファインダー回転収納機構BKW-401（別
売）を取り付けると、ビューファインダーを垂
直位置まで回転させることができます。ビュー
ファインダーをこの位置にしておけば、本機の
グリップを持ったときにビューファインダーが
脚に当たらないため、速やかに移動できます。

1	ビューファインダー前後位置固定レバーと
ビューファインダー前後位置LOCKつまみを
ゆるめ、ビューファインダースライドAssy
を手前に引き出す。

2	対辺2.5ミリの六角レンチを使用して、
ビューファインダースライドAssyを取り外
す。
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ビューファインダー
スライドAssy

六角穴付きボルト

3	 BKW-401を付属のボルトで取り付ける。
BKW-401に付属のボルト

4	 BKW-401のアームを跳ね上げたとき、ハン
ドルと干渉しないように前後位置を調整す
る。

ハンドルと干渉しない
位置に調整する
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本機を初めて使用するときは、メニューで次の
設定を行ってください。

 ˜ メニューの操作については、「セットアップメニューの
基本操作」（99ページ）をご覧ください。

タイムゾーンを設定する

タイムゾーンを設定します。工場出荷時は「UTC 
Greenwich」です。

1	メニューのOperation >Time Zone >Time 
Zoneを選択する。

2	使用するタイムゾーンを選択する。

内蔵時計の日付と時刻を設
定する

内蔵時計の年、月、日、および時刻を設定します。

1	メニューのMaintenance >Clock Set 
>Dateを選択する。
Date画面が表示されます。

2	 MENUつまみを回して年、月または日を選
択し、つまみを押す。
年、月または日が変更できる状態になりま
す。

3	つまみを回して、年、月または日を設定して、
つまみを押す。

4	手順2、3を繰り返して残りの設定を行う。

5	 SETボタンを押す。
手順2～ 4で設定した日付が内蔵時計に反映
されます。
次に時刻を設定します。

6	メニューのMaintenance >Clock Set 
>Timeを選択する。
Time画面が表示されます。

7	日付の場合と同様の操作で時刻を設定する。

8	 SETボタンを押す。
時刻が内蔵時計に反映されます。

設定を取り消すには、画面の「Cancel」を選択
します。

本機を初めて使用するとき
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レンズの取り付けと調整
［ご注意］
本機にレンズケーブルの接続／取り外しを行うときは、本
機の電源を切ってから行ってください。

レンズを取り付ける

レンズは別売です。
取り付けかたの例を以下に示します。

 ˜ レンズの取り扱いについては、レンズの取扱説明書を
ご覧ください。

1	レンズ固定レバーを押し上げて、レンズマ
ウントからレンズマウントキャップを外す。

2	レンズマウント上部中央の凹部にレンズの
センターピンを合わせ、レンズをマウント
に差し込む。

1

1
2

3	レンズを支えながら、レンズ固定レバーを
押し下げてレンズを固定する。

レンズがしっかり固定されていないと、本
機の使用中にレンズが外れて、大きな事故

につながることがあります。レンズが固定
されているか充分に確認してください。次
図のように、レンズマウントゆるみ止めゴ
ムをはめ込んで使用することをおすすめし
ます。

3

レンズマウント
ゆるみ止めゴム

4	レンズケーブルをLENS端子に接続する。

5	レンズケーブルをケーブルクランプに押し
込む。

収差補正対応レンズを取り付けた場
合

自動的に収差補正機能が働きます1)。本機の起
動時にデータ読み込みを行うため、起動に時間
がかかることがあります。
収差補正対応レンズについては、ソニーのサー
ビス担当者、または営業担当者にお問い合わせ
ください。
1) メニューのMaintenance >Camera Config >ALACを

Offに設定していると、収差補正機能は働きません。

フランジバックを調整する

ズーム操作の際に望遠・広角の両方でフォーカ
スがきちんと合わない場合は、フランジバック
（レンズ取り付け面から結像面までの距離）の調
整を行います。
一度調整すれば、レンズを交換しない限り再調
整の必要はありません。
調整を行うときは、フランジバック調整用チャー
トを被写体として使用してください。

約3ｍ

［ご注意］

ˎˎ コントラストの不鮮明な被写体を使用したり、調整中
に本機や被写体を動かすと、調整がエラーになります
ので、ご注意ください。
ˎˎ テレ端では画面中央になるように被写体（フランジバッ
ク調整用チャート）を置いてください。ワイド端では被
写体よりもカムコーダーとの距離が近いものが画面内
に入らないようにしてください。

1	レンズの絞りを手動にする。

2	カメラフロントから3 mの位置に付属のフ
ランジバック調整チャートなどを置く。

3	アイリスを開放にする。
開放の方が深度が浅く調整しやすくなりま
す。

4	 F.fまたはF.B（フランジバック調整）リング固
定ネジをゆるめる。

5	手動または電動でズームリングを望遠位置
にする。

6	フランジバック調整用チャートを写し、
フォーカスリングを回して焦点を合わせる。

7	ズームリングを広角位置にする。

8	 F.fまたはF.Bリングを回し、チャートに焦点
を合わせる。このときフォーカスリングは
動かさないように注意する。

9	望遠と広角の両方で焦点が合うようになる
まで、手順5～ 8の操作を繰り返す。

10	F.fまたはF.Bリング固定ネジをしっかり締め
る。
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オーディオ入力の準備
MIC IN端子にマイクロホ
ンを接続する

ビューファインダー（別売）のマイクホルダー
にステレオマイクロホン（別売）を取り付けるこ
とができます。
取り付けかたの例を以下に示します。

 ˜ 各ビューファインダーへの取り付けかたについては、
使用するビューファインダーのマニュアルをご覧くだ
さい。

1	ネジをゆるめてマイクホルダーのクラン
パーを開く。

[1]
[2]

マイクホルダーのクランパー

2	マイクロホンをマイクホルダーに取り付け
る。
[1] 「UP」の文字を上に向けてマイクを入れ
る。

[2] マイクホルダーを閉める。
[3] ネジを締める。

[2] [3]

[1]

3	マイクケーブルをMIC IN端子に接続し、こ
のマイクロホンの音声を記録したいチャン
ネルのAUDIO INスイッチをFRONTに設定
する。

4	マイクケーブルをケーブルクランプに固定
する。

AUDIO IN端子にマイクロ
ホンを接続する

マイクホルダー CAC-12（別売）でAUDIO IN 
CH-1/CH-2端子に、モノラルのマイクロホンを
2本まで接続できます。
接続可能マイクロホン：エレクトレットコンデ
ンサーマイクロホン ECM-674/678

 ˜ マイクホルダー、マイクロホンの取り付けかたについ
ては、製品の取扱説明書をご覧ください。

ワイヤレスレシーバーを取
り付ける

ソニーワイヤレスマイクロホンシステムを使用
するときは、本機の電源をオフにしてからワイ
ヤレスレシーバーを取り付けます。

ˎˎ デジタルワイヤレスレシーバー DWR-S02DN
ˎˎ UHFシンセサイザーチューナーユニット
WRR-855S 
URX-S03D
 ˜ ワイヤレスレシーバーの取り付けかたについては、製
品の取扱説明書をご覧ください。

ライン入力用オーディオ機
器を接続する

1	ライン入力信号源として使うオーディオ
機器の音声出力端子を、本機のAUDIO IN 
CH-1またはCH-2端子に接続する。

2	音声信号源を接続したチャンネルに対応す
るAUDIO IN切り換えスイッチをLINEに設
定する。

XLR接続自動検出機能

ˎˎ XLR接続自動検出機能がOFFの場合（工場出
荷時）は、オーディオ機器をつないだチャン
ネルに該当するAUDIO IN CH1/CH2/CH3/
CH4スイッチをREARに設定します。
ˎˎ XLR接続自動検出機能をON にすると、
AUDIO IN CH-1またはCH-2 端子へのケーブ
ル接続時、AUDIO IN CH1/CH2/CH3/CH4
スイッチの設定に関わらず、記録音声として
これらの端子からの入力が自動的に選ばれる
ようになります。

ˎˎ AUDIO IN切り換えスイッチがLINEまたは
MICに設定されている場合、音声チャンネル
3、および4に記録される音声の種類は、XLR
自動検出機能には依存しません。スイッチの
選択操作のみで決まります。

［ご注意］
CH-1でREAR XLR接続を検出すると、CH-1とCH-3が常
にREARに切り換わります。
CH-2でREAR XLR接続を検出すると、CH-2とCH-4が常
にREARに切り換わります。
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XLR接続自動検出機能のON/OFFは、メニュー
のMaintenance >Audio >Rear XLR Autoで切
り換えることができます。

[2][1] [3]

[4]

[1] AUDIO IN CH1/CH2/CH3/CH4スイッチ
[2] AUDIO IN CH-1またはCH-2端子へ
[3] モノラルマイク
[4] AUDIO IN切り換えスイッチ
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周辺機器の取り付け・調整
三脚への取り付け

1	三脚アタッチメントVCT-14/U14（別売）を
雲台に取り付ける。

2	本機を三脚アタッチメントに取り付ける。

アタッチメントの溝に沿って、
カチッと音がするまで本機を
前方へスライドさせる

3	本機を前後に動かして、外れないことを確
認する。

三脚アタッチメントから本機を取り外すには、
赤いボタンを押したまま、レバーを矢印の方向
へ動かします。

赤いボタン

レバー

［ご注意］
本機を取り外した後、三脚アタッチメントのピンが元の位
置に戻らないときは、赤いボタンを押したままレバーを矢
印の方向へ動かして、ピンを元の位置に戻します。ピンが
残ったままでは、取り付けができません。

ビデオライトを接続する

本機には、アントンバウアー社製のウルトララ
イト2または同等品のビデオライト（電源電圧
12V、最大消費電力50W）を取り付けて使用で
きます。

ˎˎ ビデオライトのコネクターを本機のLIGHT
端子に接続した場合は、LIGHTスイッチを
AUTO側に設定すると、本機のスタート／ス
トップに連動して、ライトを点灯／消灯でき
ます。

ˎˎ 本機のLIGHT端子は、入力電圧（DC入力また
はバッテリー電圧）が12V以上の場合は12Vに
安定化されるため、バッテリー電圧の変化に
よってライトの明るさや色温度が変化するこ
とはありません。

［ご注意］

ˎˎ 消費電力が50Wより大きいビデオライトを接続しない
でください。
ˎˎ 入力電圧（DC入力またはバッテリー電圧）が12V以下に
なった場合は、入力電圧の変化によってライトの明る
さや色温度が変化します。

ビデオライトを取り付けるには、ビデオライト
を取っ手のアクセサリーシューに取り付け、ビ
デオライトコネクターをLIGHT端子に接続しま
す。

［ご注意］
アクセサリーシューは1/4型ネジタイプです。スライド
シュータイプに変更する場合は、本機に付属のコールド
シューキットを使用してください。

ショルダーベルトを取り付
ける

1	片方のクリップをショルダーベルト取り付
け金具に取り付ける。

ベルトを上に引っ張って
きちんと固定する

クリップ

2	同様にもう一方のクリップを、反対側のショ
ルダーベルト取り付け金具に取り付ける。

ショルダーベルトの取り外しは、下記の図
のように行います。
ここを押したまま矢印の方向へ引く

ショルダーパッドの位置を
調整する

ショルダーパッドは、前後に40mmの範囲でス
ライドさせることができます。本機を肩にのせ
た状態で操作しやすくなるように、ショルダー
パッドの位置を調整してください。

1,3

2

ショルダーパッド

1	ショルダーパッドの中央のレバーを引き上
げてロックを外す。

2	前後方向にスライドして、適当な位置を選
ぶ。

3	レバーを倒して固定する。
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本機では、撮影した映像・音声を、カードスロッ
ト内のSxSメモリーカード（別売）に記録します。
なお、本機ではSxSメモリーカード以外にも、
XQD ExpressCardアダプター QDA-EX1（別売）
を使用してXQDメモリーカード（別売）、または
メディアアダプターMEAD-SD02（別売）を使用
してSDXC/SDHCカード（別売）を使用して記録
を行うことができます。
各メディアカードの対応ファイルシステムは以
下のとおりです。

メモリーカード ファイルシステム
exFAT UDF FAT

SxSメモリーカード ○ ○ ×
XQDメモリーカード ○ ○ ×
SDXCカード ○ × ×
SDHCカード × × ○

SxSメモリーカードについ
て

SxSメモリーカード

本機では、ソニー製SxS PRO X、SxS PRO+、
SxS PROまたはSxS-1メモリーカードをご使用
ください。

SxS PRO Xシリーズ 
SxS PRO+シリーズ 
SxS PROシリーズ 
SxS-1シリーズ

これらのメモリーカードは、ExpressCard規格

に準拠したメモリーカードです。

ˎˎ SxS、SxS PRO X、SxS PRO+、SxS PRO、お
よびSxS-1はソニー株式会社の商標です。
ˎˎ ExpressCardワードマークとロゴは、
Personal Computer Memory Card 
International Association (PCMCIA) の所有
であり、ソニーへライセンスされています。
他のトレードマークおよびトレード名称につ
いては、個々の所有者に帰属します。

［ご注意］
XAVC-I 3840×2160Pで記録する場合は、SxS PRO X、ま
たはSxS PRO+メモリーカードを使用してください。

SxSメモリーカードを入れ
る

1	カバーを左にスライドさせて開ける。

2	 SxSメモリーカードをカードスロットに差し
込む。

スロットA

スロットB

 ［ご注意］
SxSカードの差す方向を間違えないでください。図の
ように矢印が印刷してあるカード面を手前にして、矢
印の向きに差し込んでください。

ACCESSランプがオレンジで点灯し、使用可
能な状態になると緑で点灯します。

3	カバーを閉める。
ACCESSランプによる状態表示

AとBのカードスロットの状態を示すために、そ
れぞれにACCESSランプがあります。

スロットAアクセスランプ

スロットBアクセスランプ

ランプ スロットの状態
オレンジで
点灯

装着されているSxSメモリーカード
にアクセス中（データの書き込み／
読み出し中）

緑で点灯 スタンバイ状態（装着されている
SxSメモリーカードを使用して記
録・再生を行います。）

消灯 SxSメモリーカードが装着されてい
ない。
使用できないカードが装着されてい
る。
SxSメモリーカードは装着されてい
るが、別のスロットのカードが選択
されている。

SxSメモリーカードを取り
出す

1	カバーを開け、EJECTボタンを押してロッ
クを解除してボタンを引き出す。

一度ボタンを押して、
ロックを解除する。

2	もう一度EJECTボタンを押し込んでカード
を抜く。

 ［ご注意］
EJECTボタンを押すときに、SxSメモリーカードの排
出を妨げないように気を付けてください。SxSメモ
リーカードの排出が妨げられると、ロック解除の故障
原因になります。

SxSメモリーカードの取り扱い
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［ご注意］
メモリーカードへのアクセス中に本機の電源を切ったりメ
モリーカードを抜いた場合、データは保証されません。カー
ドに記録されたすべてのデータが壊れる可能性がありま
す。電源を切ったりカードを抜くときは、必ずACCESSラ
ンプが緑で点灯または消灯していることを確認してから操
作してください。

使用するSxSメモリーカー
ドを切り換える

カードスロットAとBの両方にSxSメモリーカー
ドが装着されているときは、SLOT SELECTボタ
ンを押して使用するカードを切り換えることが
できます。
記録中のSxSメモリーカードの記録可能時間が
60秒以下になると、ビューファインダー画面の
該当メディアスロットの残量表示が点滅して、
間もなく使用するSxSメモリーカードが切り換
わることを知らせます。
その後、カードがフルになったときは、自動的
にもう1枚のカードに切り換わり、記録は継続
されます。

［ご注意］

ˎˎ 再生中は、SLOT SELECTボタンは無効になります。ボ
タンを押しても切り替わりません。サムネイル画面
（90ページ）が表示されている場合は、ボタン操作が
有効です。
ˎˎ 1スロット同時記録を行う場合、切り換え先のカードに
クリップが200個以上あると、切り換え先のカードで記
録を継続できないことがあります。

SxSメモリーカードを
フォーマット（初期化）す
る

フォーマットされていないSxSメモリーカード、
または別の仕様でフォーマットされたSxSメモ
リーカードを装着すると、ファイルシステムが
異なることを知らせるメッセージが表示されま
す。その場合は、以下の操作を行ってメモリー
カードをフォーマットします。
メモリーカードは、出荷時にはexFATまたはFAT
でフォーマットされています。

［ご注意］
exFATおよびUDFファイルシステム対応のXDCAM機器お
よび本機でフォーマットしたSxSメモリーカード以外は使
用できません。

1	メニューのOperation >Format Mediaを選
択する。

2	 Media(A)（スロットA）またはMedia(B) （ス
ロットB）を選択する。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
フォーマットを実行するかどうかの確認画
面が表示されます。

4	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。
フォーマットが始まります。
実行中メッセージが表示され、ACCESSラン
プがオレンジで点灯します。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUつまみを押して
メッセージを消します。

フォーマットできなかったときは

プロテクトされたSxSメモリーカードや本機で
使用できないメモリーカードはフォーマットさ
れません。
警告メッセージが表示されますので、メッセー
ジに従って、使用できるSxSメモリーカードに
交換してください。

［ご注意］

ˎˎ メモリーカードをフォーマットすると、記録された映
像データ、セットアップファイルなどを含む、すべて
のデータが消去されます。 
ˎˎ 本機で使用するSxSメモリーカードは、本機のフォー
マット機能を使用してフォーマットしてください。他
の機器でフォーマットした場合は、異なるフォーマッ
トとみなされ、本機で再度フォーマットする必要があ
ります。

記録中のフォーマット

記録中でも、もう一方のカードスロットに装着
したSxSメモリーカードのフォーマットが可能
です。

［ご注意］

ˎˎ 1スロット同時記録中、再生中およびサムネイル画面表
示中にフォーマットはできません。
ˎˎ フォーマット中には、もう一方のカードスロットに装
着したSxSメモリーカードへの記録操作は受け付けませ
ん。

残りの記録可能時間を確認
する

ビューファインダー画面の記録メディア残量表
示部で、各スロットに装着したSxSメモリーカー
ドの残量を確認することができます。
現在設定されているビデオフォーマット（記録

ビットレート）で撮影した場合に記録可能な時
間を、それぞれのスロット内のメディアの残量
から計算して分単位で表示します。
Media Status画面（16ページ）を表示させる
と、残量をメーター形式で確認することもでき
ます。

［ご注意］

メモリーカードがプロテクトされている場合は、  マー
クが表示されます。

SxSメモリーカードの交換時期

ˎˎ 記録中に2枚のメモリーカードの残記録可能
時間の合計が5分をきると、警告メッセージ
Media Near Fullが表示され、WARNINGラン
プおよびビューファインダー画面のREC表示
の点滅とブザー音で警告します。 
空きのあるメディアに交換してください。

ˎˎ 記録を継続して、残記録可能時間の合計が0
になると、メッセージがMedia Fullに変わり
記録が停止します。

［ご注意］
1枚のSxSメモリーカードに約600個までのクリップを記録
できます。
記録できるクリップ数の上限に達すると、残時間表示が「0」
になり、 メッセージMedia Fullが表示されます。

SxSメモリーカードを修復
する

何らかの原因でメモリーカード内のデータに異
常が発生した場合は、メモリーカードの修復が
必要になります。
修復が必要なSxSメモリーカードを挿入したと
きは、修復を実行するかどうかを確認するメッ
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セージがビューファインダー画面に表示されま
す。
修復を実行するには、MENUつまみを回して
Executeを選択し、つまみを押します。
修復が始まります。
実行中メッセージが表示され、ACCESSランプ
がオレンジで点灯します。
修復が終了すると、完了メッセージが表示され
ます。MENUつまみを押してメッセージを消し
ます。

修復できなかったときは

ˎˎ プロテクトされたSxSメモリーカードや、エ
ラーが発生したSxSメモリーカードは修復で
きません。警告メッセージが表示されますの
で、メッセージに従って、プロテクトを解除
するか、別のSxS メモリーカードに交換して
ください。

ˎˎ エラーが発生したSxSメモリーカードは、
フォーマットをし直すと再利用できる場合が
あります。

ˎˎ 一部のクリップのみが修復できない場合もあ
ります。修復できたクリップは再生可能にな
ります。

ˎˎ 修復を実行しても繰り返し Could not 
Restore Some Clips とメッセージが表示さ
れるようになったSxSメモリーカードは、以
下の手順で正常に戻せる場合があります。

[1] 専用アプリケーションソフトウェア
（181ページ）を用いて、必要なクリッ
プを他のSxSメモリーカードへコピーす
る。

[2] 問題のあるSxSメモリーカードを本機で
フォーマットする。

[3] 必要なクリップをフォーマットしたSxS
メモリーカードにコピーして戻す。
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設定データ保存用SDカードの取り扱い
設定データの保存に使用できるSDカードは次の
とおりです。

SDHCメモリーカード*（Speed Class：4以上/
UHS非対応／容量：4～ 32 GB）
* 本書ではSDカードと表現しています。

SDカードをフォーマット
（初期化）する

本機で初めてSDカードを使用するときは、
フォーマットが必要です。
本機で使用するSDカードは、本機のフォーマッ
ト機能を使用してフォーマットしてください。
SDカードを装着したときに注意メッセージが表
示された場合も、フォーマットして使用してく
ださい。

1	メニューのOperation >Format Media 
>SD Card(Utility)を選択する。
フォーマットを実行するかどうかの確認画
面が表示されます。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
フォーマットが始まります。
実行中メッセージが表示され、ACCESSラン
プがオレンジで点灯します。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUつまみを押して
メッセージを消します。

［ご注意］
SDカードをフォーマットすると、すべてのデータが消去
され、復元できません。

残容量を確認する

Media Status画面（16ページ）でSDカードの
残量を確認することができます。
本機でフォーマットしたSDカードを他の機器の
スロットで使用するにはあらかじめバックアッ
プを取り、お使いになる機器でフォーマットし
直して使用してください。
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［ご注意］

ˎˎ プロフェッショナル用途のSxSメモリーカードと同等の
高い信頼性・耐久性を得られるものではありません。
ˎˎ すべてのメモリーカードの動作を保証するものではあ
りません。動作確認済みのメモリーに関してはお買い
上げ店にお問い合わせください。

XQDメモリーカード

別売のXQD ExpressCardアダプター QDA-EX1
を使用することによって、XQDメモリーカード
をSxSメモリーカードスロットに入れて、SxSメ
モリーカードと同様に記録・再生が行えます。

 ˜ XQD ExpressCardアダプター QDA-EX1の使いかたに
ついて詳しくは、アダプターに付属の取扱説明書をご
覧ください。

［ご注意］
使用するXQDメモリーカードの種類によっては、以下の
操作を正常に行えないことがあります。
ˎˎ XAVC-I 3840×2160PやXAVC-L 3840×2160Pなどの
高レートフォーマット記録
ˎˎ 高速再生
ˎˎ スロー＆クイックモーション撮影

フォーマット（初期化）するには

本機で初めてXQDメモリーカードを使用すると
きは、フォーマットが必要です。
本機で使用するXQDメモリーカードは、本機の
フォーマット機能を使用してフォーマットして
ください。XQDメモリーカードを装着したとき
に注意メッセージが表示された場合も、フォー
マットして使用してください。
フォーマットされていないXQDメモリーカー
ド、または別の仕様でフォーマットされたXQD
メモリーカードを装着すると、フォーマット実
行の確認メッセージ、またはファイルシステム

が異なることを知らせるメッセージが表示され
ます。

1	メニューのOperation >Format Mediaを選
択する。

2	 Media(A)（スロットA）またはMedia(B) （ス
ロットB）を選択する。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
フォーマットを実行するかどうかの確認画
面が表示されます。

4	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。
フォーマットが始まります。
実行中メッセージが表示され、ACCESSラン
プがオレンジで点灯します。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUつまみを押して
メッセージを消します。

［ご注意］
XQDメモリーカードをフォーマットすると、プロテクト
された画像も含めて、すべてのデータが消去され、復元で
きません。

本機とコンピューターの接続

記録済みのXQDメモリーカードを本機側のス
ロットに装着して、本機とコンピューターを
USBケーブルで接続して使用してください。

本機でフォーマットしたメディアを
他の機器のスロットで使用するには

あらかじめバックアップを取り、お使いになる
機器でフォーマットし直して使用してください。

SDカード

本機では、別売のメディアアダプターMEAD-
SD02を使用することによってSDカードをSxS
メモリーカードスロットに入れて、記録・再生
が行えます。

［ご注意］
SDカードと他のメディアを、それぞれメモリーカードス
ロットに入れた場合、先に入れたメディアのみ認識され、
後から入れたメディアは認識されません。

使用可能なSDカードの次のとおりです。
SDXCメモリーカード（SDスピードクラス：
Class10）1)

SDHCメモリーカード（SDスピードクラス：
Class10）2)

1) ファイルシステムがexFATのときに使用可能です。
2) ファイルシステムがFATのときに使用可能です。

 ˜ メディアアダプターMEAD-SD02の使いかたについて
詳しくは、メディアアダプターMEAD-SD02の取扱説
明書をご覧ください。

［ご注意］

ˎˎ SDカードを使用して高速再生を行う場合、正しく動作
しないことがあります。
ˎˎ クリップをまたいでのシームレス再生はできません。
ˎˎ SDカードを使用して、すべてのXAVC-I、および

XAVC-L 3840×2160Pフォーマットでの記録・再生は
できません。
ˎˎ SDXCカードを使用してスロー＆クイックモーション撮
影を行うときは、スローモーション撮影はできません。

フォーマット（初期化）するには

本機で初めてSDカードを使用するときは、
フォーマットが必要です。
本機で使用するSDカードは、本機のフォーマット機
能を使用してフォーマットしてください。SDカード

を装着したときに注意メッセージが表示された場合
も、フォーマットして使用してください。
フォーマットされていないSDカード、または別
の仕様でフォーマットされたSDカードを装着す
ると、フォーマット実行の確認メッセージ、ま
たはファイルシステムが異なることを知らせる
メッセージが表示されます。
次の手順でフォーマットしてください。

1	メニューのOperation >Format Mediaを選
択する。

2	 Media(A)（スロットA）またはMedia(B) （ス
ロットB）を選択する。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
フォーマットを実行するかどうかの確認画
面が表示されます。

4	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。
フォーマットが始まります。
実行中メッセージが表示され、ACCESSラン
プがオレンジで点灯します。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUつまみを押して
メッセージを消します。

［ご注意］
SDカードをフォーマットすると、プロテクトされた画像
も含めて、すべてのデータが消去され、復元できません。

本機とコンピューターの接続

記録済みのSDカードを本機側のスロットに装着
して、本機とコンピューターをUSBケーブルで
接続して使用してください。

メディアアダプターを使う
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本機でフォーマットしたメディアを
他の機器のスロットで使用するには

あらかじめバックアップを取り、お使いになる
機器でフォーマットし直して使用してください。
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フォーマットの設定
メニューのOperation >Formatで、ファイルシ
ステム、システム周波数、およびビデオフォー
マットを設定します。

 ˜ メニューの操作について詳しくは、「セットアップメ
ニューの基本操作」（99ページ）をご覧ください。

ファイルシステムを選択す
る

ファイルシステムを選択します。

1	メニューのOperation >Format >File 
Systemを選択する。

2	 MENUつまみを回して、ファイルシステム
を選択し、つまみを押す。
確認画面が表示されます。

3	実行するにはExecuteを、中止するには
Cancelを選択し、MENUつまみを押す。
Execute実行後、本機は自動的に再起動しま
す。

［ご注意］
記録・再生中またはサムネイル画面表示中にファイルシス
テムを切り換えることはできません。

システム周波数を切り換え
る

必要に応じてシステム周波数を切り換えます。

［ご注意］

ˎˎ 記録・再生中またはサムネイル画面表示中にシステム
周波数を切り換えることはできません。

ˎˎ 周波数29.97と59.94間、および25と50間での切り換え
後は、自動的には再起動されません。
ˎˎ システム周波数を切り換えた場合、その周波数で以前
に使用していたビデオフォーマットに自動的に切り換
わります。

1	メニューのOperation >Format 
>Frequencyを選択する。

2	 MENUつまみを回してシステム周波数を選
択し、つまみを押す。
確認画面が表示されます。

3	実行するにはExecuteを、中止するには
Cancelを選択し、MENUつまみを押す。
Execute実行後、本機は自動的に再起動しま
す。

ビデオフォーマットを切り
換える

「ビデオフォーマット設定表」（38ページ）を
参照し、必要に応じてビデオフォーマットを切
り換えます。

1	メニューのOperation >Format >Rec 
Formatを選択する。

2	 MENUつまみを回してビデオフォーマット
を選択し、つまみを押す。
確認画面が表示されます。

3	実行するにはExecuteを、中止するには
Cancelを選択し、MENUつまみを押す。

ビデオフォーマット設定表

ビデオ解像度やシステム周波数の組み合わせによって、以下のビデオフォーマットの設定が可能で
す。

システム周波数 
メニューのOperation 
>Format >Frequency

ファイルシステム 
メニューのOperation 
>Format >File System

ビデオフォーマット 
メニューのOperation 
>Format  >Rec Format

画サイズ

exFAT UDF FAT
59.94/50 ○ – – XAVC-I 3840×2160P 3840×2160

○ – – XAVC-I 1920×1080P 1920×1080
○ – – XAVC-I 1920×1080i
○ – – XAVC-I 1280×720P 1280×720
○ – – XAVC-L 3840×2160P 3840×2160
○ – – XAVC-L 50 1920×1080P 1920×1080
○ – – XAVC-L 50 1920×1080i
○ – – XAVC-L 50 1280×720P 1280×720
○ – – XAVC-L 35 1080P 1920×1080
○ – – XAVC-L 35 1080i
○ – – XAVC-L 25 1080i
○ ○ – HD422 50 1080i 1920×1080
○ ○ – HD422 50 720P 1280×720
○ ○ ○ HQ 1920×1080i 1920×1080
○ ○ ○ HQ 1440×1080i 1440×1080
○ ○ ○ HQ 1280×720P 1280×720
– – ○ SP 1440×1080i 1440×1080
○ ○ – MPEG IMX 50 720×486/720×576
○ ○ – DVCAM 720×480/720×576

29.97/25/23.98 ○ – – XAVC-I 3840×2160P 3840×2160
○ – – XAVC-I 1920×1080P 1920×1080
○ – – XAVC-L 3840×2160P 3840×2160
○ – – XAVC-L 50 1920×1080P 1920×1080
○ – – XAVC-L 35 1080P
○ ○ – HD422 50 1080P 1920×1080
○ ○ – HD422 50 720P 1280×720
○ ○ ○ HQ 1920×1080P 1920×1080
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SDI OUT端子、HDMI出力端子およびVIDEO OUT端子の出力フォーマット設定表

SDI OUT端子、HDMI出力端子およびVIDEO OUT端子からの出力信号は、メニューのOperation >Formatの設定に応じて下表のように出力されます。
SDI OUT1 ～ 4端子から出力される信号がQuad Link出力の場合は1系統、Dual Link出力の場合は最大2系統、Single出力の場合は最大4系統での出力が可能です。
太字とアンダーラインで表示されている設定値は、出荷時の設定です。

［ご注意］

ˎˎ XAVCプロキシ記録時（表中では「プロキシ記録」と表記）、ネットワーク機能使用時、またはアサイナブルスイッチにXAVC Proxy Rec Startを登録しているときは、以下の制限があります。
ˋˋ 3840×2160P記録時、3840×2160PのSDI出力フォーマット設定は選択できません。
ˋˋ 1440×1080i記録時、720×486または720×576iのSDI出力フォーマット設定は選択できません。

ˎˎ 3840×2160PのSDI出力フォーマット設定で運用時、プロキシ記録またはネットワーク機能を有効にすると、SDI出力設定は1920×1080P (Level B)に切り替わります。

メニューのOperation  
>Format(コーデックは省略）

プロキシ記録または
ネットワーク機能

メニューのOperation >Input/Output>Output Format
SDI Out 1/3 Ouput 
または 
SDI Out 2/4 Output

HDMI Output VIDEO OUT SDI OUT 1～ 4端子 説明
OFF ON プロキシ記録またはネットワーク機能

OFF ON
59.94 3840×2160P ○ 選択不可 3840×2160P Square a) － HD Sync － Quad Link出力：3840×2160 59.94P Square (Level-B)

○ 選択不可 3840×2160P 2SI a) － HD Sync － Quad Link出力：3840×2160 59.94P 2SI (Level-A)
○ 選択不可 3840×2160P b) － HD Sync － Dual Link出力：3840×2160 29.97P 2SI (Level-B)
○ ○ 1920×1080P (Level A) 1920×1080P HD－Y HD－Y Single出力
○ ○ 1920×1080P (Level B) － HD－Y HD－Y Single出力
○ ○ 1920×1080i 1920×1080i HD－Y HD－Y Single出力
○ ○ 720×486i 720×480i Composite Composite f ) Single出力

1920×1080P ○ ○ 1920×1080P (Level A) 1920×1080P HD－Y HD－Y Single出力
○ ○ 1920×1080P (Level B) － HD－Y HD－Y Single出力
○ ○ 1920×1080i 1920×1080i HD－Y HD－Y Single出力
○ ○ 720×486i 720×480i Composite Composite e) Single出力

1920×1080i ○ ○ 1920×1080i 1920×1080i HD－Y HD－Y Single出力
○ ○ 720×486i 720×480i Composite Composite e) Single出力

1440×1080i ○ ○ 1920×1080i 1920×1080i HD－Y HD－Y Single出力
○ 選択不可 720×486i 720×480i Composite － Single出力

1280×720P ○ ○ 1280×720P 1280×720P HD Sync c) HD Sync c) Single出力
○ ○ 720×486i 720×480i Composite Composite e) Single出力

720×480i ○ ○ 720×486i 720×480i Composite Composite e) Single出力
○ ○ － 720×480P Composite HD－Y 無信号
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メニューのOperation  
>Format(コーデックは省略）

プロキシ記録または
ネットワーク機能

メニューのOperation >Input/Output>Output Format
SDI Out 1/3 Ouput 
または 
SDI Out 2/4 Output

HDMI Output VIDEO OUT SDI OUT 1～ 4端子 説明
OFF ON プロキシ記録またはネットワーク機能

OFF ON
29.97 3840×2160P ○ 選択不可 3840×2160P 2SI a) － HD Sync － Dual Link出力：3840×2160 29.97P 2SI (Level-B)

○ 選択不可 3840×2160P b)

○ ○ 1920×1080PsF 1920×1080i HD－Y HD－Y Single出力
○ ○ 720×486i 720×480i Composite Composite f ) Single出力

1920×1080P ○ ○ 1920×1080PsF 1920×1080i HD－Y HD－Y Single出力
○ ○ 720×486i 720×480i Composite Composite e) Single出力

1280×720P ○ ○ 1280×720P 1280×720P HD－Y d) HD－Y d) Single出力
○ ○ 720×486i 720×480i Composite Composite e) Single出力

23.98 3840×2160P ○ 選択不可 3840×2160P 2SI a) － HD Sync － Dual Link出力：3840×2160 23.98P 2SI (Level-B)
○ 選択不可 3840×2160P b)

○ ○ 1920×1080PsF － HD－Y HD－Y Single出力
○ ○ 1920×1080i (2－3PD) 1920×1080i (2－3PD) HD－Y HD－Y Single出力
○ ○ 720×486i (2－3PD) 720×486i (2－3PD) Composite Composite f ) Single出力

1920×1080P ○ ○ 1920×1080PsF － HD－Y HD－Y Single出力
○ ○ 1920×1080i (2－3PD) 1920×1080i (2－3PD) HD－Y HD－Y Single出力
○ ○ 720×486i (2－3PD) 720×486i (2－3PD) Composite Composite Single出力

1280×720P ○ ○ 1280×720P (2－3PD) 1280×720P (2－3PD) HD－Y d) HD－Y d) Single出力
○ ○ 720×486i (2－3PD) 720×486i (2－3PD) Composite Composite e) Single出力
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メニューのOperation  
>Format(コーデックは省略）

プロキシ記録または
ネットワーク機能

メニューのOperation >Input/Output>Output Format
SDI Out 1/3 Ouput 
または 
SDI Out 2/4 Output

HDMI Output VIDEO OUT SDI OUT 1～ 4端子 説明
OFF ON プロキシ記録またはネットワーク機能

OFF ON
50 3840×2160P ○ 選択不可 3840×2160P Square a) － HD Sync － Quad Link出力：3840×2160 50P Square (Level-B)

○ 選択不可 3840×2160P 2SI a) － HD Sync － Quad Link出力：3840×2160 50P 2SI (Level-A)
○ 選択不可 3840×2160P b) － HD Sync － Dual Link出力：3840×2160 25P 2SI (Level-B)
○ ○ 1920×1080P (Level A) 1920×1080P HD-Y HD-Y Single出力
○ ○ 1920×1080P (Level B) - HD-Y HD-Y Single出力
○ ○ 1920×1080i 1920×1080i HD-Y HD-Y Single出力
○ ○ 720×576i 720×576i Composite Composite f ) Single出力

1920×1080P ○ ○ 1920×1080P (Level A) 1920×1080P HD-Y HD-Y Single出力
○ ○ 1920×1080P (Level B) - HD-Y HD-Y Single出力
○ ○ 1920×1080i 1920×1080i HD-Y HD-Y Single出力
○ ○ 720×576i 720×576i Composite Composite e) Single出力

1920×1080i ○ ○ 1920×1080i 1920×1080i HD-Y HD-Y Single出力
○ ○ 720×576i 720×576i Composite Composite e) Single出力

1440×1080i ○ ○ 1920×1080i 1920×1080i HD-Y HD-Y Single出力
○ 選択不可 720×576i 720×576i Composite － Single出力

1280×720P ○ ○ 1280×720P 1280×720P HD Sync c) HD Sync c) Single出力
○ ○ 720×576i 720×576i Composite Composite e) Single出力

720×576i ○ ○ 720×576i 720×576i Composite Composite e) Single出力
○ ○ － 720×576P Composite HD-Y 無信号

25 3840×2160P ○ 選択不可 3840×2160P 2SI a) － HD Sync － Dual Link出力：3840×2160 25P 2SI (Level-B)
○ 選択不可 3840×2160P b)

○ ○ 1920×1080PsF 1920×1080i HD-Y HD-Y Single出力
○ ○ 720×576i 720×576i Composite Composite f ) Single出力

1920×1080P ○ ○ 1920×1080PsF 1920×1080i HD-Y HD-Y Single出力
○ ○ 720×576i 720×576i Composite Composite e) Single出力

1280×720P ○ ○ 1280×720P 1280×720P HD-Y d) HD-Y d) Single出力
○ ○ 720×576i 720×576i Composite Composite e) Single出力

a) CBKZ-Z450QL (QUAD-LINK 3G-SDI Upgrade License、別売)がインストールされているときに有効です。
b) CBKZ-Z450QL (QUAD-LINK 3G-SDI Upgrade License、別売)がインストールされているときは無効または表示されません。
c) 1080i Sync信号を出力します。
d) 1080PsF信号を出力します。
e) 文字情報（スーパーインポーズ）はSDI Out2/4/HDMI Superの文字情報表示オン／オフに連動します。
f ) 文字情報（スーパーインポーズ）は4K(QFHD) SDI Out Superの文字情報表示オン／オフに連動します。
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撮像ダイナミックレンジの拡大
記録フォーマットに4K QFHDまたはHDを設定
している場合、撮像ダイナミックレンジをハイ
ダイナミックレンジ（HDR）モードにすると、ダ
イナミックレンジを拡大し、BT.2020相当の色
域で記録や出力を行えます。
本機能と1スロット同時記録機能を併用すれば、
4K QFHDのメインクリップ映像をハイダイナ
ミックレンジで記録し、HDのサブクリップ映
像を通常のダイナミックレンジ（SDR）で記録す
ることが可能になります。
ハイダイナミックレンジ機能はファイルシステ
ムがexFATの場合に有効です。

［ご注意］

ˎˎ MPEG IMXおよびDVCAMのファイルフォーマットには
対応していません。
ˎˎ HDR設定中は、SDフォーマット信号は出力できません。
信号フォーマットがSDの場合、HDRに設定した時点で
HDフォーマットの初期値で出力されます。
ˎˎ ダイナミックレンジモードの設定を変更する場合は、
ピクチャーキャッシュレック機能がOffの状態で行って
ください。 
Operation >Rec Function >Picture Cache Rec >Off

ダイナミックレンジモード
を設定する

1	メニューのOperation >Base Setting 
>Shooting Modeを選択する。

2	 MENUつまみを回してダイナミックレンジ
モードを選択する。
HDRを選択するとハイダイナミックレンジ
モード、SDRを選択すると従来のダイナミッ
クレンジモードに設定されます。

HDRの設定

ダイナミックレンジモードをHDRに選択した
場合、メニューのOperation >HDR Settingで
HDRを設定します。詳しくは、104ページをご
覧ください。

HDR(HLG)

HDR(HLG)は4K(QFHD)、HDともに設定が可能
です。
ハイダイナミックレンジモードにHDR(HLG)を
選択した場合、色域はITU-R BT.2020に設定さ
れます。またHLG(LOOK)種類を設定することが
できます。詳しくは、113ページをご覧くださ
い。

HDR(S-Log3)

HDR(S-Log3)は4K(QFHD)時のみ設定できま
す。
ハイダイナミックレンジモードにHDR(S-Log3)
を選択した場合、色域はITU-R BT.2020または
S-Gamut3/S-Gamut3.Cineから選択すること
ができます。詳しくは、104ページをご覧くだ
さい。

SDR Gain

HD Rec/Out設定がSDRの場合、4K(QHFD)-
HDR側に対しHD-SDR側のゲインを設定しま
す。この設定はHD-SDR側の記録・出力、およ
びビューファインダー、LCDモニター表示に反
映されます。

HLGディスプレイアシスト機能

HDR(HLG)機能を使用しているとき、ビューファ

インダーやLCDモニターに表示される映像のコ
ントラストが従来のダイナミックレンジ使用時
より低く見えることがあります。このような場
合、HLGディスプレイアシスト機能で、ビュー
ファインダーやLCDモニターに表示する映像の
コントラストを適切に調整することができます。
HLGディスプレイアシスト機能はHDR Setting
のHD Rec/OutがHDR(HLG)に設定されている
ときに自動的に適用されます。
またHLGディスプレイアシスト機能をアサイナ
ブルスイッチに割り当てて、必要に応じて機能
のオン／オフをワンタッチで切り換えることが
できます。

［ご注意］
本機能はビューファインダーやLCDモニターのみに適用さ
れ、記録画像や出力画像には適用されません。
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ブラックバランス／ホワイトバランスの調整
本機を使用し、常に高画質の映像を得るために
は、状況に応じたブラックバランスとホワイト
バランスの調整が必要です。
本機で自動調整される調整値や各設定値は、本
機のメモリーに記憶され、電源を切っても保持
されます。

ブラックバランスを調整す
る

次のような場合に調整が必要です。

ˎˎ 本機を初めて使用するとき

ˎˎ 長時間使用しなかった後に使用するとき

ˎˎ 周囲の温度が大幅に変化した状況で使用する
とき

ˎˎ メニューのOperation >Gain SwitchでGAIN
スイッチに設定しているゲイン値（L/M/H/
Turbo）を変更したとき
通常は、電源を再び入れた場合でも調整し直す
必要はありません。

ブラックバランスの自動調整は、ブラックセッ
ト、ブラックバランスの順に実行されます。ブ
ラックバランスは、設定メニューの操作によっ
て手動調整することもできます。

以下の場合は、ブラックバランスの自動調整が
できません。

ˎˎ 記録中

ˎˎ 特殊記録モード時

ˎˎ シャッターモードがSLSモードの場合

1	 OUTPUT/DCCスイッチをCAMにする。

2	 AUTO W/B BALスイッチをBLACK側に押し
て、指を離す。
調整中は「Executing...」と表示され、「OK」
に変われば終了です。
調整値は自動的にメモリーに記憶されます。

［ご注意］

ˎˎ ブラックバランス調整中、絞りは自動的に遮光状態に
なります。
ˎˎ ブラックバランス調整中、ゲイン切り換え回路が自動
的に働き、ビューファインダー画面上にフリッカーが
数回現れますが、故障ではありません。

ブラックバランスの自動調整ができ
ないときは

ブラックバランスの調整が正常に終了しなかっ
たときは、ビューファインダー画面に約3秒間
エラーメッセージが表示されます。

エラーメッセージ 意味

NG: Iris not Closed レンズの絞りが閉まらな
かったため、調整できな
かった。

NG: Timeout 規定された調整回数以内で
調整が終了しなかった。

上記のエラーメッセージが表示されたら、再度
ブラックバランスの調整を試みてください。
繰り返し調整を試みてもエラーメッセージが表
示されるときは、内部点検をする必要がありま
す。

 ˜ 内部点検については、メンテナンスマニュアル（別売）
をご覧ください。

［ご注意］
レンズの接続ケーブルがLENS端子にしっかり接続されて
いないと、レンズの絞りが遮光状態にならず、ブラックバ
ランスはエラーになります。

ホワイトバランスを調整す
る

照明条件が変わったときには、必ず調整し直し
てください。

1	以下のようにスイッチを設定する。
ˎˎ GAINスイッチ：L（できるだけ小さいゲイ
ン値に設定）

ˎˎ OUTPUT/DCCスイッチ：CAM
ˎˎ WHITE BALスイッチ：AまたはB 1)

1) メモリー Bに設定値が記憶されるのは、メニューの
Operation >White Setting >White Switch<B>
がMemoryに設定されているときのみです。

2	照明条件に合わせて、FILTERつまみの設定
を切り換える。

3	被写体の照明光源と同じ条件のところにホ
ワイトパターンを置き、ズームアップして
画面に白を映す。
被写体の近くの白いもの（白布、白壁）で代
用することもできます。
最小限必要な白の面積は、図のとおりです。

画面センターを中心とする長方形
各辺の長さは、画面の高さ、または幅の70%。
この長方形内に、画面面積の10%以上の画面
の白が必要。

［ご注意］
長方形内に高輝度スポットを入れないようにしてくだ
さい。

4	レンズの絞りを調整する。
手動で絞りを調整する場合：絞りを適正値
に合わせる。

オートアイリスで絞りを調整する場合：レ
ンズ側の絞り自動／手動切換スイッチを
自動に設定する。

5	 AUTO W/B BALスイッチをWHITE側に押し
て、指を離す。
調整中は「Executing...」と表示され、「OK: 
（被写体の色温度）」と表示されれば終了で
す。
調整値は、手順1で選択したメモリー（Aま
たはB）に自動的に記憶されます。

［ご注意］
レンズを絞ると、ハンチング 1) を起こすことがありま
す。このような場合は、レンズに付いている絞りのゲ
インつまみ（IG、IS、Sなどと表示されている）を調整
してください。

1) ハンチング：オートアイリスの応答を繰り返し、
映像が暗くなったり明るくなったりすること。

 ˜ 詳しくは、レンズの取扱説明書をご覧ください。

ホワイトバランスの自動調整ができ
ないときは

ホワイトバランスの調整が正常に終了しなかっ
たときは、ビューファインダー画面に約3秒間
エラーメッセージが表示されます。

エラーメッセージ 意味
NG: Low Light 白の映像レベルが低すぎる。

レンズの絞りを開けるか、ゲ
インを上げる。
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エラーメッセージ 意味
NG: High Light 白の映像レベルが高すぎる。

レンズを絞るか、NDフィル
ターを変える。

NG: Color Temp. 
High

被写体照明の色温度が高すぎ
て調整できなかった。照明の
色温度を調整して、メモリー
を更新する。

NG: Color Temp. 
Low

被写体照明の色温度が低すぎ
て調整できなかった。照明の
色温度を調整して、メモリー
を更新する。

NG: Out of 
Range

現在値と基準値の差が大き
く、調整範囲を超えていたた
め、調整できなかった。

NG: Poor White 
Area

被写体の白の面積が狭すぎて
調整できなかった。

NG: Timeout 規定時間内で調整が終了しな
かった。

上記のエラーメッセージが表示されたら、再度
ホワイトバランスの調整を試みてください。繰
り返し調整を試みてもエラーメッセージが表示
されるときは、内部点検をする必要があります。

 ˜ 内部点検については、メンテナンスマニュアルをご覧
ください。

ホワイトバランスを調整する時間が
ないときは

WHITE BALスイッチをPRSTにします。

NDフィルターの切り換えに合わせて
色温度を変更する

電気的CC（色補正）フィルターをNDフィルター
（5ページ）に割り当てることによって、ND
フィルターの切り換えに合わせて色温度を変更
することができます。

1	メニューのMaintenance >White Filter 
>ND Filter C.TempをOnに設定する（123
ページ）。

2	電気的CCフィルターをFILTERつまみのポ
ジション番号1に割り当てるときはND FLT 
C.Temp<1>を、ポジション番号2～ 4に割
り当てるときはND FLT C.Temp<2-4>を選
択する。

3	 MENUつまみを回して希望の色温度を選択
する。

4	必要に応じて、手順2と3を繰り返す。

電気的CC（色補正）フィルターをア
サイナブルスイッチで切り換える

電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てることによって、ア
サイナブルスイッチを押すたびに最大で4つ
のポジション（A～ D）に設定された色温度
（3200K/4300K/5600K/6300K）を切り換えるこ
とができます。

1	メニューのMaintenance >White Filterを
選択する。

2	 CCフィルターを設定したいポジション
Electrical CC<A>～ <D>を選択し、
MENUつまみを回して希望の色温度を選択
する。
色温度を設定しないときは、Electrical 
CC<C>、<D>の設定時に「-----」を選択し
ます。

アサイナブルスイッチを押しても、そのポ
ジションの設定は表示されません。たとえ
ば、1つのポジションに「-----」を設定したと
きは、3つのポジションの切り換えになりま
す。

3	必要に応じて、手順2を繰り返す。

4	アサイナブルスイッチに電気的CCフィル
ターの切り換え機能（ELECTRICAL CC）を割
り当てる（133ページ）。

ホワイトバランスのメモリーについ
て

メモリーに記憶された値は、本機の電源を切っ
た状態でも、再度ホワイトバランスを調整する
まで保存されます。
ホワイトバランスのメモリーは、A、Bの2系統
があり、WHITE BALスイッチの設定（AまたはB）
に対応するメモリーに、NDフィルターごとの調
整値を自動的に記憶させることができます。本
機は4つのNDフィルターを内蔵しているので、
合計8個（4×2）の調整値を記憶できます。ただ
し、次の場合、メモリーの内容はNDフィルター
に連動しません。

ˎˎ メニューのOperation >White Setting 
>Filter White MemoryをOffに設定すること
によって、A、B両系統のメモリー数を1個に
限定したとき
また、メニューのOperation >White Setting 
>White Switch<B>をATWに設定すると、
WHITE BALスイッチがBの位置でATW（自動追
尾ホワイトバランス）が動作し、照明条件の変
化に応じて画像のホワイトバランスが自動追従
します。
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電子シャッターの設定
シャッターモードについて

本機の電子シャッターで使用できるシャッター
モードと、選択できるシャッタースピードは次
のとおりです。

［ご注意］
RM-B170などのリモートコントロールユニット接続時は、
標準モード（Speed）のみ選択できます。

標準モード

動きの速い被写体を鮮明に撮影したい場合など
に使用します。
秒数でシャッター速度を設定するSpeed（ス
ピード）モードと開角度でシャッター速度を設
定するAngle（角度）モードを選択できます。

Speedモード

システム
周波数

シャッタースピード（単位：秒）

59.94i 
59.94P
50i
50P

1/60、1/100、1/120、1/125、
1/250、1/500、1/1000、1/2000

29.97P 1/40 a)、1/50 a)、1/60、1/100、
1/120、1/125、1/250、1/500、
1/1000、1/2000

25P 1/33 a)、1/50 a)、1/60、1/100、
1/120、1/125、1/250、1/500、
1/1000、1/2000

23.98P 1/32 a)、1/48 a)、1/50 a)、1/60、
1/96、1/100、1/120、1/125、
1/250、1/500、1/1000、1/2000

a) スロー＆クイックモーション撮影時、メニューの
Operation >Rec Function >Frame Rateをシステム周
波数より大きい値に設定している場合は選択できませ
ん。

Angleモード
180°、90°、45°、22.5°、11.25°

ECS（拡張クリアスキャン）モード

モニター画面を、水平方向の縞模様が出ないよ
うに走査したい場合などに使用します。
設定可能なシャッタースピードの範囲は、スロー
＆クイックモーション（S&Q）機能のオフ／オン
によって、次表のように変わります。

システム
周波数

シャッタースピード（単位：Hz）
S&Q：オフ S&Q：オン

59.94i 60.00～ 7000 ̶
59.94P 60.00～ 8000 60.00～ 8000
29.97P 30.00～ 8000 30.00～ 8000
23.98P 23.99～ 6000 30.03～ 6000
50i 50.00～ 7000 ̶
50P 50.00～ 7000 50.00～ 7000
25P 25.02～ 7000 30.00～ 7000

SLS（スロースピードシャッター）
モード

低照度の被写体を撮影したいときに使用します。
スロースピードシャッター機能の蓄積フレーム
数は、メニューのOperation >Slow Shutter 
>Number of Framesで2、3、4、5、6、7、8、
16から選択します。

［ご注意］

ˎˎ スロー＆クイックモーション撮影時は、SLSモードを使
用することができません。
ˎˎ 記録中にSLSモードをオン／オフしたり、蓄積フレーム
数を変更することができません。

シャッターモード／シャッ
タースピードを設定する

［ご注意］

ˎˎ 絞りが自動のときは、シャッタースピードが速くなる
につれ、絞りが開き、被写界深度も浅くなります。
ˎˎ 選択できるシャッタースピードは、設定されているシ
ステム周波数によって異なります。

SpeedモードとAngleモードの切り
換え

1	メニューのOperation >Shutter >Modeを
選択する。

2	 MENUつまみを回して、Speedまたは
Angleを選択し、つまみを押す。

シャッターモードおよびシャッター
スピード（標準モード）の設定

一度選択したシャッタースピードは、本機の電
源を切った状態でも保持されます。

1	 SHUTTERスイッチを、ONの位置から
SELECT側に押す。
シャッターの現在の設定がビューファイン
ダー画面に約3秒間表示されます。

2	手順1の表示が消える前に、もう一度
SHUTTERスイッチをSELECT側に押す。希
望のモードまたはスピードが表示されるま
で、この操作を繰り返す。
すべてのモードとスピードが表示される場
合は、以下の順序で表示が切り替わります。

Speedモード（システム周波数：59.94iの場合）
の表示例

ECSモード
［ご注意］
スロー＆クイックモーションモード時のフレームレート
の設定によっては（56ページ）、特定のシャッタース
ピードが選択できなくなることがあります。選択できない
シャッタースピードは、選択可能な最も遅いシャッタース
ピードに置き換わります。

XAVC-I 1080P/29.97P、フレームレート60でス
ロー＆クイックモーション撮影を行う場合の例：

ˎˎ スロー＆クイックモーションモード：オフ 
1/401/501/601/100...
ˎˎ スロー＆クイックモーションモード：オン 
1/601/100...

シャッタースピード（ECSモード）の
設定

1	シャッターモードをECSに設定する（前項参
照）。

2	 MENUつまみを回して、希望の周波数を表
示させる。

シャッタースピード（SLSモード）の
設定

1	メニューのOperation >Slow Shutter 
>Settingで、シャッターモードをOnに設定
する。

2	メニューのOperation >Slow Shutter 
>Number of Framesで、希望のフレーム数
を選択する。
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オートアイリスの設定
逆光の被写体を適正な明るさで撮るときや、ス
ポットライトが当てられた被写体の白つぶれな
どを防ぐときなど、被写体の照明条件によって
はオートアイリスの設定を変更する必要があり
ます。

オートアイリスの動作モー
ドを設定する

オートアイリスでレベル調整するときに使用す
る動作モードを設定します。

1	メニューのOperation >Auto Iris >Modeを
選択する。

2	 MENUつまみを回して動作モードを選択し、
つまみを押す。

動作モード 説明
Backlight 逆光状態の撮影に適したモー

ド
Standard 標準のモード
Spotlight 中心となる被写体にスポット

ライトがあたっているとき、
白潰れを軽減するモード

オートアイリスでの収束目
標レベルを設定する

1	メニューのOperation >Auto Iris >Levelを
選択する。

2	 MENUつまみを回してレベルを－99～ +99
の範囲で選択し、つまみを押す。

収束目標レベル 説明
－99 2絞り分以上暗めに設定す

る
±0 標準のレベル
+99 2絞り分以上明るめに設定

する

オートアイリスのスピード
を設定する

オートアイリスでレベルを調整するときの動作
速度を設定します。

1	メニューのOperation >Auto Iris >Speed
を選択する。

2	 MENUつまみを回して動作速度を 
[－99]（最も遅い）～ [+99]（最も速い）の範
囲で選択し、つまみを押す。

レンズ絞りの基準値を変更
する

レンズ絞りの基準値は、標準値に対して次の範
囲に設定できます。

ˎˎ +0.25～ +1（0.25刻み）：約+0.25～ +1絞り
分開きぎみになる。

ˎˎ －0.25～－1（0.25刻み）：約0.25～ 1絞り分
閉じぎみになる。

また、オートアイリスの対象となる範囲を設定
しておくこともできます。

1	メニューのOperation >Auto Iris >Iris 
OverrideをOnに設定する。

2	 MENU ON/OFFスイッチをOFFにする。

3	 MENUつまみを回して基準値を変更する。

［ご注意］
このとき、シャッターモードがECS以外のモードに
なっていることを確認してください。

現在の基準値は、ビューファインダー画面
のアイリスポジション表示（17ページ）で
確認することができます。

ˎˎ 絞りを開きぎみにする場合は、MENUつ
まみを本機正面から見て反時計方向に回
します。 
+0.25、+0.5、+0.75、+1のいずれかに
設定します。

ˎˎ 絞りを閉じぎみにする場合は、MENUつ
まみを本機正面から見て時計方向に回し
ます。 
－0.25、－0.5、－0.75、－1のいずれか
に設定します。

変更した基準値は電源を切るまで保持され
ます。基準値を変更しても、電源を入れる
たびに標準値に戻ります。

オートアイリス検出ウィン
ドウを設定する

1	メニューのOperation >Auto Iris >Detect 
Window IndicationをOnに設定する。
ビューファインダー画面上に現在選択され
ているオートアイリスウィンドウが表示さ
れます。
オートアイリスウィンドウを常に表示して
おく必要がない場合は、Offに設定します。

2	メニューのOperation >Auto Iris >Detect 
Windowを選択する。

3	 MENUつまみを回して希望のオートアイリ
スウィンドウを選択し、つまみを押す。

図の網掛け部で光を検出する

Varを選ぶと、次表の項目が有効となり、希
望の大きさのウィンドウを作成できます。
メニューのOperation >Auto Iris >Iris Var 
Width、Iris Var Height、Iris Var、Iris Var 
H Position、Iris Var V Positionで設定して
ください。

項目 設定
Iris Var Width ウィンドウの幅
Iris Var Height ウィンドウの高さ
Iris Var H 
Position

ウィンドウの横方向の位置

Iris Var V 
Position

ウィンドウの縱方向の位置



000 3章　設定と調整：オートアイリスの設定47

メニューを終了すると、手順3で選択したオー
トアイリスウィンドウが表示されます。
常に表示しておく必要がない場合は、メニュー
のOperation >Auto Iris >Detect Window 
Indicationの設定をOffに変更します。

高輝度の外乱による影響を
軽減させる

高輝度の画像が入ってきたためオートアイリス
が閉じすぎて全体的に暗くなりすぎ、黒つぶれ
という状態になることがあります。このような
場合は、ハイライトクリップ機能をONに設定
すると、あるレベル以上のものにクリップをか
けて、オートアイリスへの影響を低減すること
ができます。
メニューのOperation >Auto Iris >Clip High 
LightをOnに設定します。

PXW-Z450KC付属レンズ
のアイリスゲイン調整

1	アイリス動作モード切換えスイッチをA
（オート）側にする。

2	アイリスゲイン調整トリマーのゴムキャッ
プをめくる。

3	アイリスゲイン調整トリマーをドライバー
などで回し、調整する。
時計方向に回すと、ゲインが上がります。

反時計方向に回すと、ゲインが下がります。
レンズ本体のアイリスリングを見ながら、
調整してください。

4	ゴムキャップを元に戻す。
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音声レベルの調整
AUDIO SELECTスイッチをAUTOにすると、各
チャンネルに記録されるアナログ音声信号の入
力レベルは自動的に調整されます。また、手動
で調整することもできます。

［ご注意］
AUDIO SELECTスイッチをAUTOにしても、デジタル音声
信号の入力レベルは自動調整されません。

手動調整時の音声レベルの
目安

－20 dBを目安に調整します。
音声レベルメーターが0 dBまで表示されるとき
は、入力音量が過大です。

過大入力

調整の目安

AUDIO IN CH-1/CH-2端
子からの音声レベルを手動
調整する

1	 AUDIO IN CH-1/CH-2端子への入力信号
を記録、調整したいチャンネルに相当する
AUDIO IN CH1/CH2スイッチをREARにす
る。

1、2チャンネルとも記録、調整する場合
は、両方のAUDIO IN CH1/CH2スイッチを
REARにする。

2	手順1で選んだチャンネルのAUDIO SELECT
スイッチをMANUALにする。

3	手順1で選んだチャンネルのLEVELつまみ
で、通常の入力音量のときの音声レベルメー
ターが－20 dBまで表示されるように調整す
る。

記録レベルの調整に使用するつまみ
の選択

メニューのMaintenance >Audioで、AUDIO 
IN CH-1/CH-2端子に入力される音声の記録レ
ベルの調整をどのつまみで行うか、選択するこ
とができます。各メニュー項目の設定値とつま
みの対応は以下のとおりです。

［ご注意］
AES/EBUデジタルオーディオ信号を入力する場合は、本
機で記録レベル調整を行うことはできません。

Rear1/WRR Level：チャンネル 1の記録レベル

設定値 つまみ
Side1 LEVEL（CH1）つまみ
Front MIC LEVELつまみ
Front+Side1 LEVEL（CH1）つまみとMIC 

LEVELつまみの連動

Rear2/WRR Level：チャンネル 2の記録レベル

設定値 つまみ
Side2 LEVEL（CH2）つまみ
Front MIC LEVELつまみ

設定値 つまみ
Front+Side2 LEVEL（CH2）つまみとMIC 

LEVELつまみの連動

［ご注意］
LEVEL（CH1/CH2）つまみとMIC LEVELつまみの連動を選
択した場合、MIC LEVELつまみが「0」に絞られているとチャ
ンネル1、2の音声を記録できません。MIC LEVELつまみ
の位置を確認してから、LEVEL（CH1/CH2）つまみで調整
してください。

MIC IN端子からの音声レ
ベルを手動調整する

1	使用するチャンネルのAUDIO INスイッチを
FRONTに設定する。

2	手順1で選んだチャンネルのAUDIO SELECT
スイッチをMANUALに設定する。

3	 MIC LEVELつまみを回して、通常の入力音
量のとき音声レベルメーターが－20 dBまで
表示されるように調整する。

記録レベルの調整に使用するつまみ
の選択

メニューのMaintenance >Audioで、フロント
マイクから入力する音声の記録レベルの調整を
どのつまみに割り当てるかを設定できます。各
メニュー項目の設定値とつまみの対応は以下の
とおりです。
MIC CH1 Level：チャンネル 1の記録レベル

設定値 つまみ
Side1 LEVEL（CH1）つまみ

設定値 つまみ
Front MIC LEVELつまみ
Front+Side1 LEVEL（CH1）つまみとMIC 

LEVELつまみの連動

MIC CH2 Level：チャンネル 2の記録レベル

設定値 つまみ
Side2 LEVEL（CH2）つまみ
Front MIC LEVELつまみ
Front+Side2 LEVEL（CH2）つまみとMIC 

LEVELつまみの連動

［ご注意］
MIC LEVELつまみとLEVEL（CH1/CH2）つまみの連動を選
択した場合、LEVEL（CH1/CH2）つまみが「0」に絞られて
いるとチャンネル1、2の音声が記録できません。LEVEL
（CH1/CH2）つまみの位置を確認してから、MIC LEVELつ
まみで調整してください。

チャンネル3、4に音声を
記録する

1	音声チャンネル3、4に記録される音声を、
AUDIO IN CH3/CH4スイッチで選択する。

CH3スイッチ チャンネル3の記録対象
FRONT フロントマイクロホンの音声
REAR AUDIO IN CH-1端子に入力

される音声信号
WIRELESS ワイヤレスマイクロホンの音

声

CH4スイッチ チャンネル4の記録対象
FRONT フロントマイクロホンの音声
REAR AUDIO IN CH-2端子に入力

される音声信号
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CH4スイッチ チャンネル4の記録対象
WIRELESS ワイヤレスマイクロホンの音

声

2	自動調整するには、AUDIO SELECT CH 3-4
スイッチをAUTOにする。
手動調整するには、AUDIO SELECT CH 3-4
スイッチをMANUALにして、続けて以下の
設定をする。

3	レベル調整を行うつまみを、メニューの
Maintenance >AudioのAudio CH3 Level
およびAudio CH4 Levelで選択する。

Audio CH3 Level：チャンネル3の記録レベ
ル

設定値 つまみ
Side3 LEVEL（CH3）つまみ
Front MIC LEVELつまみ
Front+Side3 LEVEL（CH3）つまみとMIC 

LEVELつまみの連動

Audio CH4 Level：チャンネル4の記録レベ
ル

設定値 つまみ
Side4 LEVEL（CH4）つまみ
Front MIC LEVELつまみ
Front+Side4 LEVEL（CH4）つまみとMIC 

LEVELつまみの連動

音声チャンネル3、4の音声レベルが、ここ
で選択したつまみで調整できるようになり
ます。
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タイムデータの設定
タイムコードを設定する

タイムコードの設定可能範囲は、00:00:00:00
～ 23:59:59:29（時：分：秒：フレーム）です。

1	 DISP SEL/EXPANDボタンを押して、LCDモ
ニターをステータス表示に切り換える。

2	 DISPLAYスイッチをTCにする。

3	 PRESET/REGEN/CLOCKスイッチをPRESET
にする。

4	 F-RUN/SET/R-RUNスイッチをSETにする。
タイムコードの最上桁が点滅します。

5	上下矢印ボタンで数値を変更し、左右矢印
ボタンで桁を移動して、すべての桁を設定
する。
数値を00:00:00:00にリセットするには、
RESET/RETURNボタンを押します。

6	希望の数値に設定した後、F-RUN/SET/
R-RUNスイッチを切り換える。
F-RUN：タイムコードは常に歩進する
R-RUN：タイムコードは記録時に歩進する

［ご注意］
ピクチャーキャッシュレックモードが有効なときは、
F-RUN/SET/R-RUNスイッチをSETにしてもタイムデータ
の設定を行うことはできません。タイムデータを設定する
場合は、ピクチャーキャッシュレックモードをオフにして
ください。

DF/NDFの切り換え

メニューのMaintenance >Timecode >DF/
NDFで、DF（ドロップフレームモード）／ NDF

（ノンドロップフレームモード）を切り換えるこ
とができます。

タイムコードを連続させるには

F-RUN/SET/R-RUNスイッチがR-RUNに設定さ
れているときは、タイムコードは連続して記録
されます。ただし、途中でメディアを交換して
記録を行うと、再び元のメディアを入れてもタ
イムコードは連続しません。
このようなときは、PRESET/REGEN/CLOCKス
イッチをREGENにするとタイムコードを連続さ
せることができます。

タイムコードに実時刻を入れるには

PRESET/REGEN/CLOCKスイッチをCLOCKにす
ると、タイムコードに実時刻が入ります。実時
刻には本機の内蔵時計の時刻が反映されます。

 ˜ 内蔵時計の調整について詳しくは、「内蔵時計の日付と
時刻を設定する」（27ページ）をご覧ください。

ユーザービットを設定する

ユーザービットを設定することにより、16進数
8桁までのメモ（日付、時刻、シーン番号）など
の情報をタイムコードトラックに記録すること
ができます。

1	 DISP SEL/EXPANDボタンを押して、LCDモ
ニターをステータス表示に切り換える。

2	 DISPLAYスイッチをU-BITにする。

3	 F-RUN/SET/R-RUNスイッチをSETにする。
ユーザービットの最上桁が点滅します。

4	上下矢印ボタンで数値を変更し、左右矢印
ボタンで桁を移動して、すべての桁を設定
する。
数値を00 00 00 00にリセットするには、
RESET/RETURNボタンを押します。

5	希望の数値に設定した後、F-RUN/SET/
R-RUNスイッチを希望のタイムコードの歩
進モードに応じてF-RUNまたはR-RUNにす
る。

ユーザービットのメモリー機能につ
いて

ユーザービットの設定内容（実時刻以外）は自動
的にメモリーに記憶され、電源を切った後も保
持されます。

タイムコードを外部ロック
させる

本機の内部タイムコードジェネレーターを外部
ジェネレーターにロックさせることができます。
また、外部VTRのタイムコードジェネレーター
を本機の内部ジェネレーターにロックさせるこ
ともできます。

1	次図のように、リファレンスビデオ信号と
基準タイムコードの両方を接続する。
例1：外部の信号にロックさせる場合

[2][1] 基準タイムコード

リファレンスビデオ信号

[1] GENLOCK IN端子
[2] TC IN端子

例2：本機を複数台接続し、1台をリファレ
ンスとする場合

次のカムコーダーへ

[1] VIDEO OUT端子
[2] TC OUT端子
[3] TC IN端子
[4] GENLOCK IN端子
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2	 POWERスイッチをONにする。

3	 PRESET/REGEN/CLOCKスイッチをPRESET
にする。

4	 F-RUN/SET/R-RUNスイッチをF-RUNにす
る。

5	 DISPLAYスイッチをTCにする。

6	 SMPTEタイムコードの規格を満たした位相
関係にある基準タイムコードとリファレン
スビデオ信号を、TC IN端子とGENLOCK IN
端子へそれぞれ入力する。
これで内部タイムコードジェネレーターは、
基準タイムコードにロックします。ロック
してから約10秒経過した後は、外部からの
基準タイムコードの接続を外しても、外部
ロック状態は保たれます。

外部ロックを解除するには、外部タイム
コードの入力を停止してから、F-RUN/SET/
R-RUNスイッチをR-RUNに設定します。

［ご注意］

ˎˎ 外部ロックの操作をすると、タイムコードは瞬時に外
部のタイムコードにロックし、外部タイムコードの値
と同じ値がタイムデータ表示部に表示されますが、シ
ンクジェネレーターが安定するまでの数秒間は、記録
を開始しないでください。
ˎˎ リファレンスビデオ信号の周波数と本機のシステム周
波数が一致しないと、正しくゲンロックできません。
この場合、タイムコードも外部のタイムコードに正し
くロックできません。

外部ロック時のユーザービットの設
定

タイムコードの外部ロック時は、タイムデータ
のみが外部からのタイムコードのタイムデータ
にロックされます。

外部ロック中に、電源をバッテリー
パックから外部電源に切り換えると
きの注意

タイムコードジェネレーターの電源の連続性を
保つため、DC IN端子に外部電源をつないでか
ら、バッテリーパックを外してください。バッ
テリーパックを先に外したときは、タイムコー
ドの外部ロックの連続性は保証されません。

外部ロック中のカメラ部のゲンロッ
クについて

外部ロック中、カメラ部はGENLOCK IN端子に
入力されるリファレンスビデオ信号によってゲ
ンロックがかかります。
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基本操作
ここでは、撮影・記録の基本操作手順を説明し
ます。
実際に撮影に出発する際は、事前に点検を行っ
て、カメラシステムが正常に機能することを確
認してください。

1	充電したバッテリーパックを取り付ける
（24ページ）。

2	 SxSメモリーカードを入れる（32ページ）。
2枚入れておくと、1枚目がフルになった時
点で自動的に2枚目に切り換わります。

3	本機のPOWERスイッチ（3ページ）を
ONにする。

4	次の設定を行う。
マーカー表示：オン（108ページ）
アイリス：オート（46ページ）
ズーム：オート
カメラ出力：撮影中の映像（カメラ画）を選
択し、DCC機能オン（7ページ）

タイムコードの歩進：F-RUN（フリーラン）
またはR-RUN（レックラン）（50ペー
ジ）

オーディオ入力チャンネルの選択：オート
（10ページ）

5	 AUTO W/B BALスイッチを BLK側に押し
て、ブラックバランスを調整する（43ペー
ジ）。

6	照明条件に合わせてフィルターを選び、ホ
ワイトバランスを調整する（43ページ）。

7	本機を被写体に向け、フォーカスとズーム
を調整する。

8	電子シャッターを使用する場合は、適切な
シャッターモード／スピードに設定する
（45ページ）。

9	次のいずれかの操作を行って記録を開始す
る。

 – REC STARTボタン（5ページ）を押す。
 – レンズのVTRボタンを押す。
 – Rec機能が割り当てられたアサイナブルス
イッチをオンにする（131ページ）。

記録中は、TALLYランプ、ビューファインダー
前面のタリーランプ、ビューファインダー
画面のREC表示が点灯します。必要に応じ
て、ズームとフォーカスを調整してくださ
い。

 ［ご注意］

ˎˎ 記録中は（右側面のACCESSランプが青で点灯、カー
ドスロット部のACCESSランプがオレンジで点灯）、
絶対にバッテリーパックを取り外さないでくださ
い。もし取り外すと、記録処理が正常に終了しな
いため、記録中断直前の数秒間のデータが失われ
るおそれがあります。
ˎˎ 記録中は、再生コントロールボタン（EJECT、F 

REV、F FWD、NEXT、PREV、PLAY/PAUSE、
STOP）は働きません。

10	記録を停止するには、手順9のいずれかの操
作を行う。
TALLYランプ、ビューファインダー前面のタ
リーランプ、ビューファインダー画面のREC
表示が消えます、本機は記録待機（Stby）状
態になります。

手順9と10の間に記録した画像・音声と付随
データが、1つのクリップとして記録されま
す。

記録内容を確認するには（レック
レビュー）

記録待機中（Stby時）に、Rec Review機能
が割り当てられたアサイナブルスイッチを
押すと、クリップの最終フレームの2秒前か
ら1倍速で再生します。Rec Review機能が
割り当てられたアサイナブルスイッチを1秒
以上押し続けると、クリップの最終フレー
ムの2秒前から4倍速で逆再生を開始し、ス
イッチを離すとその位置から1倍速で再生
します。クリップの終わりまで再生すると、
レックレビューは終了し、Stby状態に戻り
ます。
レンズのRETボタンにRec Review機能が割
り当てられている場合は、レンズのRETボタ
ンを押してレックレビューすることもでき
ます。

11	手順9と10を繰り返して、記録を繰り返す。
メモリーカード上に順次クリップが作成さ
れます。

クリップ1 クリップ2 クリップ3

［ご注意］

ˎˎ 記録を停止してから約1秒間は次の記録を再開できませ
ん。
ˎˎ 1枚のメモリーカードに記録できるクリップ数は、最大

600個です。クリップが600個記録されると、メモリー
カードに空き容量があっても、記録できなくなります。
ˎˎ 2秒以下のクリップを作成することはできません。たと

えば記録を開始してから2秒以内に停止しても、2秒間
は記録が継続します。また、記録開始後すぐに停止し、
最初の記録から2秒以内に再び記録を開始すると、ク
リップが2つ作成されます。
ˎˎ 複数のメモリーカードに渡って連続記録できる最長時
間は24時間です。24時間に達すると記録は停止します。

クリップ名について

本機で記録されるクリップには、自動的に8文
字のクリップ名（前半4文字の英数字＋後半4桁
の番号）が生成されます。
例：ABCD0001
クリップ名の前半部分（文字の英数字）は、メ
ニューのOperation >Clip >Title Prefixで設定
開始前に任意の文字列（4～ 46文字）にするこ
とも可能です。（記録後に変更することはできま
せん。）
クリップ名の後半部分（4桁の番号）は、記録順
に自動的にカウントアップされます。

記録したクリップを再生す
る

1	再生するSxSメモリーカードを入れる（32
ページ）。

2	 PREVボタン（8ページ）またはF REVボ
タン（8ページ）を押して、再生したいク
リップを頭出しする。

3	 PLAY/PAUSEボタンを押す。
PLAY/PAUSEインジケーターが点灯し、
ビューファインダー画面に再生画が表示さ
れます。
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シームレス再生

SxS PRO+、SxS PRO X、およびXQD-Gシリー
ズ以降に記録した各クリップが以下の状態の場
合、クリップをまたいでのシームレス再生が可
能です。

ˎˎ ビデオフォーマットがXAVC-I/XAVC-L 
(QFHD/HD)でクリップ長が4秒以上
ˎˎ ビデオフォーマットがMPEG HDでクリップ
長が2秒以上

［ご注意］

ˎˎ SxS-1の場合は上記の約2倍のクリップ長が必要です。
ˎˎ SDカードでのシームレス再生はできません。

再生の一時停止

PLAY/PAUSEボタンを押します。
一時停止中はPLAY/PAUSEインジケーターが点
滅します。
もう一度押すと再生モードに戻ります。

高速再生

F FWDボタン（8ページ）またはF REVボタ
ン（8ページ）を押します。
標準再生に戻るには、PLAY/PAUSEボタンを押
します。

再生の終了

STOPボタンを押す：再生が停止し、本機は E-E
モードになります。

THUMBNAILボタンを押す：再生が停止し、ビ
ューファインダー画面にサムネイル画面
（90ページ）が表示されます。

再生中に記録を開始したりSxSメモリーカード
を取り出した場合も、再生が停止し、ビューファ
インダー画面にカメラ画が表示されます。

メモリーカードの切り換え

メモリーカードを2枚装着しているときは、
SLOT SELECT ボタン（33ページ）を押して切
り換えます。
再生中にメモリーカードを切り換えることはで
きません。
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ショットマークを記録する

本機では、記録したクリップに対して、2種類
のショットマークを任意の位置に記録できま
す。ショットマークを記録しておくと、編集時
にすばやく頭出しすることができます。
1つのクリップに記録できるショットマークの
最大数は999です。

 ˜ Thumbnailメニューを使用して、任意のクリップに
ショットマークを追加／削除することもできます。詳
しくは、「クリップにエッセンスマークを付ける／削除
する」（95ページ）をご覧ください。

ショットマークを記録するには、Shot Mark 1
またはShot Mark 2機能が割り当てられたアサ
イナブルスイッチをオンにします。
ショットマークが記録されると、ビューファ
インダー画面のタイムコード表示付近に
「ShotMark1」または「ShotMark2」が約3秒間
表示されます。

［ご注意］
メディアアダプターMEAD-SD02（別売）を使用してSxS
スロットに挿入したSDカードには記録できません。

クリップフラグを設定する

編集時にクリップを選別する目安として、記録
したクリップに対してクリップフラグを設定す
ることができます。
クリップフラグの設定は、Thumbnailメニュー
で行います。詳しくは、「クリップにクリップフ
ラグを付ける」（94ページ）または「クリップ
フラグを削除する」（94ページ）をご覧くだ
さい。

［ご注意］
メディアアダプターMEAD-SD02（別売）を使用してSxS
スロットに挿入したSDカードには記録できません。

数秒前の映像から記録す
る（ピクチャーキャッシュ
レック機能）

本機では、内蔵の大容量メモリーに、本機で撮
影している映像／音声データを常時数秒間（最
大15秒間）分蓄えておくことにより、記録を開
始したとき、その数秒前からの映像を記録する
ことができます。
本機能に対応するビデオフォーマットにつ
いては、「フォーマット別の特殊記録対応」
（173ページ）をご覧ください。

ピクチャーキャッシュレックモードで記録を
始めるには、あらかじめOperationメニューで
ピクチャーキャッシュレックモードおよびメ
モリーへの画像の蓄積時間（ピクチャーキャッ
シュレック時間）を選択しておく必要がありま
す。
記録を開始したときに、記録開始操作の実行か
ら何秒前にさかのぼって記録できるかは、ピク
チャーキャッシュレック時間によって決まりま
す。次の［ご注意］に挙げるような特殊な場合で
は、さかのぼって記録できる時間が短くなる場
合があります。

［ご注意］

ˎˎ メモリーへの画像の蓄積は、ピクチャーキャッシュレッ
クモードを選択してから開始されます。したがって、
選択後すぐに記録を開始した場合は、ピクチャーキャッ
シュレックモード選択以前に撮影した映像は記録され
ません。

ˎˎ 再生、レックレビュー、およびサムネイル表示を行っ
ている間は、メモリーに画像を蓄えないため、再生や
レックレビューを行っていた間の映像をさかのぼって
記録することはできません。

ピクチャーキャッシュレック時間の
設定

1	メニューのOperation >Rec Function 
>Picture Cache Recを選択する。

2	 MENUつまみを回してOnを選択し、つまみ
を押す。

3	メニューのOperation >Rec Function > 
Cache Rec Timeを選択する。

4	 MENUつまみを回してピクチャーキャッ
シュレック時間を選択し、つまみを押す。
選択値は記録フォーマット、およびシステ
ム周波数の設定により変わります。付録の
「ピクチャーキャッシュレックモード設定」
（174ページ）をご覧ください。

一度選択したピクチャーキャッシュレックモー
ドは、設定を変更するまで保持されます。
手順1、2を行う代わりに、ピクチャーキャッシュ
レック機能を割り当てたアサイナブルスイッチ
を使用して（131ページ）ピクチャーキャッシュ
レックモードを選択することもできます。

［ご注意］

ˎˎ 一部の機能a)を除き、ピクチャーキャッシュレックなど
の特殊記録機能を複数同時に使用できません。
ˎˎ 一部の機能a)を除き、ピクチャーキャッシュレック使
用中に他の特殊記録機能を有効にすると、ピクチャー
キャッシュレックは自動的に解除されます。
ˎˎ ビデオフォーマットなどのシステム設定を変更すると、
メモリーに蓄えられていた画像がクリアされます。変

更直後に記録を開始しても、変更前に撮影した映像は
記録されません。ピクチャーキャッシュレックモード
は自動的に解除されます。
ˎˎ 記録中にピクチャーキャッシュレック時間を設定する
ことはできません。

a) XAVC-L QFHDフォーマットが選択されている場合は、
1スロット同時記録時にもピクチャーキャッシュレック
が有効になります。

ピクチャーキャッシュレック撮影の
開始

「基本操作」（52ページ）にしたがって、撮影
を行います。

記録を開始すると、ビューファインダー画面の
REC表示位置の「●Cache」が「●Rec」になりま
す。通常の記録時と同様に、TALLYランプ、ビュー
ファインダー前面のタリーランプも点灯しま
す。

撮影を終了するには、記録停止の操作を行いま
す。

ピクチャーキャッシュレックモード
の解除

記録待機中に、メニューのOperation >Rec 
Function >Picture Cache RecをOffに設定し
ます。

ピクチャーキャッシュレックモード
で記録する場合の本機の動作につい
て

記録の手順は通常とほぼ同じですが、本機の動
作には通常と異なる点がありますので、以下の
点に充分ご注意ください。

ˎˎ メディアへのアクセスが行われている間に記

応用操作
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録を開始した場合、実際に記録される映像の
開始点が、設定されたピクチャーキャッシュ
レック時間よりも遅くなる場合があります。
記録クリップ数が多いほど遅くなるため、ピ
クチャーキャッシュレックモードでは、すば
やい記録停止、記録開始操作はなるべく避け
てください。

ˎˎ F-RUN/SET/R-RUNスイッチの設定に関わら
ず、F-RUNモードになります。
ˎˎ ピクチャーキャッシュレックモードでは、
F-RUN/SET/R-RUNスイッチをSETにしてタ
イムデータの設定を行うことはできません。 
タイムデータを設定する場合は、いったんピ
クチャーキャッシュレックモードを解除して
ください。

ˎˎ 現在選択されているスロット内のメディアの
記録可能残量がピクチャーキャッシュレック
時間よりも少ない場合は、選択されていない
スロット内のメディア（充分な記録可能残量
があれば）に対して記録が行われます。 
ただし、選択されていないスロット内にメディ
アがない場合や、スロット内のメディアの記
録可能残量が不充分な場合は、記録は行われ
ません。（ビューファインダー画面に、メディ
ア残量が不足している旨を知らせるメッセー
ジが表示されます。）

ˎˎ 記録開始操作前にショットマークを設定して
も、ショットマークは記録されません。

記録中に本機の電源が切れた場合

ˎˎ 本機のPOWERスイッチをOFFにした場合は、
その瞬間までメモリーに蓄えられていた映像
を記録するため、数秒間メディアにアクセス
してから、自動的に電源が切れます。

ˎˎ 記録中にバッテリーを取り外したり、DCケー

ブルを引き抜いたり、ACアダプター側の電源
を切ったりした場合は、メモリーに蓄積され
ている映像／音声データが消滅するため、そ
の瞬間までの映像は記録されません。バッテ
リー交換の際は、充分ご注意ください。

間欠的に映像を記録する
（インターバルレック機能）

本機のメモリーを利用して間欠的に映像を取り
込み、記録するインターバルレック機能は、主
に動きの少ない被写体を撮影するときに有効で
す。 
記録を開始すると、設定したフレーム数
（Number of Frames）分の映像を、任意のイン
ターバル（Interval Time）で自動記録できます。
本機能は、下記のビデオフォーマット（38ペー
ジ）に設定されている場合に有効です。

XAVC-I
XAVC-L
MPEG HD 422

撮影の間隔（Interval Time）

1回に記録する画像フレーム数
（Number of Frames）

インターバルレックを有効にしているときは、
撮影開始前にビデオライトを自動的に点灯させ、
光量、色温度を安定させた状態で撮影を行うこ
とができます（プリライティング機能）。

［ご注意］

ˎˎ インターバルレックなどの特殊記録機能を複数同時に
使用できません。 
インターバルレック使用中に他の特殊記録機能を有効
にすると、インターバルレックは自動的に解除されま
す。
ˎˎ 記録中にインターバルレックの設定を変更することは
できません。

インターバルレックの設定

1	メニューのOperation >Rec Function 
>Interval Recを選択する。

2	 MENUつまみを回してOnを選択し、つまみ
を押す。
インターバルレックモードになり、ビュー
ファインダー画面のREC表示位置に「Int 
Stby」が表示されます。（HDVFシリーズ
ビューファインダー内のグリーンタリーラ
ンプも点滅します。）

3	 Number of Framesを選択し、MENUつま
みを回して1回に記録する希望のフレーム数
を選択し、つまみを押す。
フォーマットが50P、59.9Pの場合、2/6/12
から選択できます。
フォーマットが23.98P、25P、29.97P、
50i、59.94iの場合、1/3/6/9から選択でき
ます。

4	 Interval Timeを選択し、MENUつまみを回
して希望の録画間隔（インターバル）を選択
し、つまみを押す。
1～ 10/15/20/30/40/50 sec、1～
10/15/20/30/40/50 min、1～ 4/6/12/24 
hourから選択できます。

5	必要に応じてPre-Lightingを選択し、
MENUつまみを回して記録開始前のビデオ
ライト点灯時間を選択し、つまみを押す。
2/5/10 sec、またはOff（点灯しない）から
選択できます。

 ［ご注意］

ˎˎ ビデオライトを記録前に点灯させる場合は、本機
のLIGHTスイッチをAUTOに設定してください。ビ
デオライトのスイッチもオンにしておく必要があ
ります。このときビデオライトが自動点灯／消灯
します。ただし、消灯時間が5秒以下の場合、ビデ
オライトは連続して点灯します。
ˎˎ LIGHTスイッチをMANUALに設定し、ビデオライ
トのスイッチをオンにすると、ビデオライトは常
時点灯します。（ビデオライトは自動点灯／消灯し
ません。）

本機の電源を切るとインターバルレックモー
ドは解除されますが、Number of Frames、
Interval Time、Pre-Lightingの設定は保持され
ます。次回インターバルレックモードで撮影す
るときに再設定する必要はありません。

インターバルレック撮影の開始

「基本操作」（52ページ）にしたがって、記録
のための設定や準備を行った後、本機が動かな
いように固定して撮影を行います。
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インターバルレックモードをOnにすると、
ビューファインダー画面のREC位置に「Int 
Stby」が表示されます。記録を開始すると「●
Int Rec」と「●Int Stby」が交互に表示されます。
通常の記録時と同様に、TALLYランプとビュー
ファインダー前面のタリーランプが点灯します。
（HDVFシリーズビューファインダー内のグリー
ンタリーランプが高速で点滅します。）
プリライティング機能を使用する場合は、記録
が始まる前にビデオライトが点灯します。

撮影を終了するには、記録停止の操作を行いま
す。
撮影を終了すると、その瞬間までメモリーに蓄
えられていた映像がメディアに記録されます。

インターバルレックモードの解除

次のいずれかを実行します。

ˎˎ POWERスイッチをOFFにする。
ˎˎ 記録待機中に、メニューのOperation >Rec 
Function >Interval RecをOffに設定する。

［ご注意］
本機を再起動すると、インターバルレックモードは自動的
に解除されます。

記録中の動作制限

ˎˎ 内蔵タイムコードジェネレーターの歩進モー
ドは、F-RUN/SET/RRUNスイッチの設定に関
わらず、R-RUNモードになります。
ˎˎ 音声は記録されません。

ˎˎ レックレビュー操作は行えません。

ˎˎ ゲンロックはかかりません。

本機の電源が切れた場合

ˎˎ 本機のPOWERスイッチをOFFにした場合は、
その瞬間までメモリーに蓄えられていた映像
を記録するため、メディアにアクセスしてか
ら、自動的に電源が切れます。

ˎˎ 記録中にバッテリーを取り外したり、DC電源
コードを引き抜いたり、ACアダプター側の電
源を切ったりした場合は、その瞬間以前に撮
影したショット（最大10秒）が記録されないこ
とがあります。バッテリー交換の際は充分ご
注意ください。

スロー＆クイックモーショ
ン撮影する

記録時のフレームレートを再生時のフレーム
レートと異なる値に設定することができます。

［ご注意］
XAVCの記録フォーマットで撮影を行う場合、SxSメモリー
カードは、SxS PRO+を使用してください。

記録 
フォーマット

システム 
周波数

S&Qフレーム
レート

XAVC-I 
3840P

59.94P/50P/ 
29.97P/23.98P/ 
25P

1FPS～ 60FPS
（1FPS単位）

XAVC-I 
1080P
XAVC-L 
3840P
XAVC-L 50 
1080P

XAVC-L 35 
1080P

HD422 50 
1080P a)

29.97P 1FPS～ 30FPS
（1FPS単位）23.98P

25P 1FPS～ 25FPS
（1FPS単位）

a) exFAT、およびUDFのファイルシステムに対応していま
す。これ以外の記録フォーマットではexFATにのみ対応
しています。

再生フレームレートと異なるフレームレートで
撮影することによって、通常の速度で撮影した
映像を低速再生したり高速再生するよりも、滑
らかなスローモーション、クイックモーション
映像が得られます。

スロー＆クイックモーションの設定

1	メニューのOperation >Rec Function 
>Slow & Quick Motionを選択する。

2	 MENUつまみを回してOnを選択し、つまみ
を押す。
スロー＆クイックモーションになり、ビュー
ファインダー画面の記録動作状態表示部に
「S&Q Stby」が表示されます。
次にフレームレートを設定します。

3	メニューのOperation >Rec Function 
>Slow & Quick Motion >Frame Rateを選
択する。

4	 MENUつまみを回してフレームレートを選
択し、つまみを押す。

設定完了後、ビューファインダー画面上部にシ
ステム周波数とフレームレートが表示されます。
この表示を見ながら、MENUつまみでフレーム
レートを変更することもできます。
本機の電源を切ってもスロー＆クイックモー
ションモードとフレームレートの設定は保持さ
れます。

［ご注意］

ˎˎ スロー＆クイックモーションなどの特殊記録機能を複
数同時に使用できません。
ˎˎ スロー＆クイックモーション使用中に他の特殊記録機
能を有効にすると、スロー＆クイックモーションは自
動的に解除されます。
ˎˎ 記録中、再生中、サムネイル表示中は、スロー＆クイッ
クモーションを設定できません。
ˎˎ スローシャッター設定時は、スロー＆クイックモーショ
ンを設定できません。

スロー＆クイックモーション撮影の
開始

「基本操作」（52ページ）に従って撮影を行い
ます。

記録を開始すると、ビューファインダー画面の
「S&Q Stby」表示が「●S&Q Rec」になります。
通常の記録時と同様に、TALLYランプ、ビュー
ファインダー前面のタリーランプも点灯します。

撮影を終了するには、記録停止の操作を行いま
す。
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［ご注意］
フレームレートを小さい値（遅いフレームレート）に設定
すると、記録停止操作を行ってから記録を停止するまでの
時間が長くなります。

スロー＆クイックモーションモード
の解除

記録待機中に、メニューのOperation >Rec 
Function >Slow & QuickをOffに設定します。

記録中の動作制限

ˎˎ 内蔵タイムコードジェネレーターの歩進モー
ドは、F-RUN/SET/RRUNスイッチの設定に関
わらず、R-RUNモードになります。
ˎˎ 再生フレームレートと異なる記録フレーム
レートを選択した場合、音声は記録されませ
ん。

ˎˎ レックレビュー操作は行えません。

ˎˎ 記録フレームレートを現在のシャッタース
ピードの設定値より速い値に変更すると、
シャッタースピードは撮影可能な最も遅い値
に変更されます。 
例：フレームレート32でシャッタースピード
1/40のときに、フレームレートを55に変更
するとシャッタースピードは1/60に変更され
る。 
また、記録フレームレートより遅いシャッター
スピードを選択することはできません。

ˎˎ ゲンロックはかかりません。

クリップコンティニュアス
レック機能を使って撮影す
る

通常は記録開始、停止のたびに1つのクリップ
が独立したファイルとして生成されますが、ク
リップコンティニュアスレック機能を使用する
と、記録と停止を繰り返しても、機能が停止ま
たは解除されるまで連続した1つのクリップを
生成することができます。短いクリップを数多
く生成したくないとき、または記録できるクリッ
プ数の上限を意識しないで記録したいときに便
利な機能です。
記録の開始点にはレックスタートマークが記録
されるため、記録開始位置の検索も容易です。
本機能は、下記のビデオフォーマット（38ペー
ジ）に設定されている場合に有効です。

XAVC-I（XAVC-I 3840×2160Pを除く）
XAVC-L（XAVC-L 3840×2160Pを除く）
MPEG HD 422

クリップコンティニュアスレックの
設定

1	メニューのOperation >Rec Function 
>Clip Continuous Recを選択する。

2	 MENUつまみを回してOnを選択し、つまみ
を押す。
本機はコンティニュアスレックモードに
なり、ビューファインダー画面で「Cont 
Stby」の表示が点灯します。

［ご注意］

ˎˎ クリップコンティニュアスレックなどの特殊記録機能
を複数同時に使用することはできません。
ˎˎ クリップコンティニュアスレック使用中に他の特殊記
録機能を有効にすると、クリップコンティニュアスレッ
クは自動的に解除されます。

ASSIGN. 1/2/3スイッチ、ASSIGNABLE 4/5
スイッチとONLINEボタンにクリップコンティ
ニュアスレック機能のオン／オフを割り当てる
こともできます。

 ˜ 詳しくは、「アサイナブルスイッチに機能を割り当てる」
（131ページ）をご覧ください。

クリップコンティニュアスレック撮
影の開始

「基本操作」（52ページ）に従って撮影を行い
ます。
記録を開始すると、ビューファインダー画面の
「Cont Stby」表示が「●Cont Rec」表示に変わ
ります。
通常の記録時と同様に、TALLYランプ、ビュー
ファインダー前面のタリーランプも点灯します。

［ご注意］
記録中または記録待機中（「Cont Stby」表示が点灯した状
態）に、メディアを取り出したりバッテリーや電源を抜く
と、メディアの修復が必要になります。本機以外の機器を
使ってメディアを修復することはできません。
クリップコンティニュアスレックモードを終了してからメ
ディアを取り出してください（57ページ）。
なお、「Cont Stby」が点滅（1回／秒）しているときは、メ
ディアを取り出すことができます。

撮影を終了するには、記録停止の操作を行いま
す。

［ご注意］
最低2秒間記録してから記録を停止してください。

クリップコンティニュアスレック
モードの解除

記録待機中に、メニューのOperation >Rec 
Function >Clip Continuous RecをOffに設定
します。

記録中または記録待機中の動作制限

記録中または記録待機中に以下の操作を行うと、1
つのつながったクリップが作成されません。（次に
記録を行うと、新たなクリップが生成されます。）

ˎˎ クリップ操作（クリップのロック、削除、ま
たは名前の変更）

ˎˎ スロットの切り換え

ˎˎ 記録フォーマットの変更

ˎˎ POWERスイッチオフ
ˎˎ 再生

ˎˎ サムネイル画面への切り換え

2枚のSxSメモリーカード
に同時に映像を記録する
（2スロット同時記録機能）

ビデオフォーマット（38ページ）が下表のい
ずれかに設定されているときは、同じ映像を2
枚のSxSメモリーカードに記録することができ
ます。撮影を行いながら映像のバックアップを
取る場合などに使用する機能です。

［ご注意］

ˎˎ SxSメモリーカードは、使用前に両方のカードを本機で
フォーマット（初期化）することを推奨します。
ˎˎ ファイルシステムがUDFのときには、同時記録はでき
ません。
ˎˎ SDカードは使用できません。
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メニューの
Operation >Format 
>Rec Format

メニューのOperation 
>Format >Frequency

XAVC-I 1920×
1080P

59.94/59/29.97/25/23.98

XAVC-I 1920×
1080i

59.94/50

XAVC-I 1280×720P 59.94/50
XAVC-L 50 1920×
1080P

59.94/50/29.97/25/23.98

XAVC-L 50 1920×
1080i

59.94/50

XAVC-L 50 1280×
720P

59.94/50

XAVC-L 35 1080P 59.94/50/29.97/25/23.98
XAVC-L 35 1080i 59.94/50
XAVC-L 25 1080i 59.94/50
HD 422 50 1080P 29.97/25/23.98
HD 422 50 1080i 59.94/50
HD 422 50 720P 59.94/50/29.97/25/23.98
HQ 1920×1080P 29.97/25/23.98
HQ 1920×1080i 59.94/50
HQ 1440×1080i 59.94/50
HQ 1280×720P 59.94/50

2スロット同時記録機能の設定

1	メニューのOperation >Rec Function 
>Simul Recを選択する。

2	 MENUつまみを回してOnを選択し、つまみ
を押す。

［ご注意］

ˎˎ 2スロット同時記録機能などの特殊記録機能を複数同時
に使用することはできません。
ˎˎ 2スロット同時記録機能使用中に他の特殊記録機能を有
効にすると、2スロット同時記録機能は自動的に解除さ

れます。
ˎˎ 記録中、再生中、サムネイル表示中は、2スロット同時
記録機能を設定できません。

2スロット同時記録撮影の開始

1	カードスロットAとBの両方にSxSメモリー
カードを装着する。
SxSスロットAおよびB のACCESSランプが
点灯します。またビューファインダー画面
にSxSスロットAおよびBのアイコンが表示
されます（20ページ）。

2	「基本操作」（52ページ）に従って撮影を
行う。

［ご注意］

ˎˎ どちらかのメディアに不良があったり、書き込み禁止
になっていたりする場合は、同時記録を行うことはで
きません。
ˎˎ 同時記録中に、どちらか一方のメディアがフルになっ
た場合や、エラーが発生して記録を継続できなくなっ
たときは、そのメディアへの記録は中止されますが、
残りのメディアへの記録は継続されます。

撮影を終了するには、記録停止の操作を行いま
す。

2スロット同時記録の機能の解除

記録待機中に、メニューのOperation >Rec 
Function >Simul RecをOffに設定します。

1枚のSxSメモリーカード
に4KサイズとHDサイズの
クリップを同時に記録する
（1スロット同時記録）

1枚のSxSメモリーカードにファイルサイズの大
きな4K QFHD映像をメインクリップ、および事
前編集などに活用できるサイズの小さなHD映
像をサブクリップとして、同時に記録する機能
です。
1スロット同時記録に使用できるSxSメモリー
カードの記録フォーマットは、4K QFHD
（XAVC-I QFHDまたはXAVC-L QFHD）です。
サブクリップの画サイズ／記録フォーマットは
システム周波数に異なります。
メインクリップ記録
フォーマット

システム
周波数

サブクリップ記
録フォーマット

ˎˎ XAVC-I 
3840×2160P
ˎˎ XAVC-L 
3840×2160P

29.97、
25、
23.98

MPEG HD422 
1920×1080P

59.94、
50

MPEG HD422 
1920×1080i

［ご注意]
1スロット同時記録にSDカードは使用できません。

1スロット同時記録機能の設定

1	メニューのOperation >Rec Function >4K 
& HD (Sub) Recを選択する。

2	 MENUつまみを回してOnを選択し、つまみ
を押す。

 ［ご注意]

ˎˎ  一部の機能a)を除き、1スロット同時記録機能など
の特殊記録機能を複数同時に使用することはでき
ません。
ˎˎ  一部の機能a)を除き、1スロット同時記録機能使用
中に他の特殊記録機能を有効にすると、1スロット
同時記録機能は自動的に解除されます。
ˎˎ  記録中、再生中、サムネイル表示中は、1スロット
同時記録機能を設定できません。

a) XAVC-L QFHDフォーマットが選択されている場合
は、1 スロット同時記録時にもピクチャーキャッ
シュレックが有効になります。

1スロット同時記録機能の開始

「基本操作」（52ページ）に従って撮影を行い
ます。
撮影中は、ビューファインダー画面の記録フォー
マット（コーデック）の右横に「/Sub」と表示さ
れます（18ページ）。
撮影を終了するには、記録停止の操作を行いま
す。

1スロット同時記録機能の解除

記録待機中に、メニューのOperation >Rec 
Function >4K & HD (Sub) RecをOffに設定し
ます。

サブクリップ記録フォーマットの再
生

1	メニューのOperation >Input/Output 
>Output Format >HD 1920x1080を選択
する。

2	メニューのOperation >Rec Function >HD 
(Sub) Playback Mode >Onを選択する。

3	 PLAYボタンを押して再生する。
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このとき、再生できるクリップは、サブク
リップのみです。メインクリップである4K 
QFHDのクリップはスキップされます。
サブクリップの選択はサムネイル画面でも
可能です。

［ご注意］

ˎˎ 1スロット同時記録機能がOffのときにはサブクリップ
の再生はできません。
ˎˎ  サムネイル画面でのThumbnailメニューのクリップ操
作（90ページ）は、メインクリップが操作対象になり
ます。サブクリップの操作はできません。サブクリッ
プを操作する場合は、下記の「サブクリップをメインク
リップとしてコピー保存する」を参考にして、メインク
リップとしてコピーしてから行ってください。

サブクリップをメインク
リップとしてコピー保存す
る

1スロット同時記録で作成したサブクリップを、
別のメディアにメインクリップとしてコピー保
存することができます。

1	 1スロット同時記録で作成したサブクリップ
が記録されているメディアをカードスロッ
トに装着する。

2	もう一方のカードスロットにメディアを装
着する。

3	メニューのThumbnail >Copy Sub Clip 
>All Clipsを選択する。

[ご注意]
サブクリップを個別に選択することはできません。

4	 MENUつまみを回してExecuteを選択し、
つまみを押す。
確認画面が表示されます。

5	 MENUつまみを回してExecuteを選択し、
つまみを押す。
すべてのサブクリップがメインクリップと
してコピー保存され、完了メッセージが表
示されます。

6	 MENUつまみを押してメッセージを消す。
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プロキシデータは、低解像度の映像データ
（H.264）と音声データ（AAC-LC）で構成されて
います。オリジナルデータの代わりに、高速転
送が可能なプロキシデータを利用することによ
り、編集、閲覧作業を効率化することができます。
プロキシデータはクリップの記録時にPROXY 
SDカードスロットに挿入したSDカードに記録
されます。

PROXY SDカードスロット

SDカードに記録されたプロキシデータをコン
ピューターに読み込んで、迅速に撮影内容を確
認したり、短時間でオフライン編集を行うこと
ができます。
プロキシデータの記録はSxSメモリーカードと
同期して行うだけでなく、SxSメモリーカード
への記録とは別に、単独で記録を実行すること
ができます。

本機でのプロキシ記録につ
いて

ˎˎ 同期記録時はSxSメモリーカードが挿入され
ていないと、プロキシ側の記録は開始されま
せん。

ˎˎ 本機の電源を入れてから約30秒後、LCDモニ

ター／ビューファインダー画面に （Proxy 
SDスロットメディア状態表示）が点灯し、プ
ロキシ記録ができるようになります。 

が点滅中、または消灯中に撮影を開始し
た場合、プロキシファイルは記録されません。

ˎˎ SDカードを本機から抜くときは、必ず
PROXY SDカードスロットのACCESSランプ
が消灯していることを確認してから、本機の
電源を切るか、またはプロキシ記録／ワイヤ
レスLAN接続機能をオフにしてください。 
プロキシ記録／ワイヤレスLAN接続機能を
OFFにするにはセットアップメニューで次の
設定を行ってください。
- Operation >XAVC Proxy Rec Mode 

>SettingをOff
- Maintenance >Network >SettingをOff
ˎˎ プロキシ記録、またはワイヤレスLAN接続機
能を有効にしている状態でSDカードの抜き差
しを行うと、まれに警告表示（E91-1C0）が表
示される場合があります。記録中にこの警告
が表示された場合、SxSメモリーカードへの
記録は正常に行われますが、プロキシファイ
ルは記録されませんのでご注意ください。こ
の警告表示は本機の電源をオフ／オンすると
クリアされます。

ˎˎ ピクチャーキャッシュレック、インターバル
レック、スロー＆クイックモーション記録お
よびストリーミングを有効にすると、プロキ
シ記録は開始されません。

ˎˎ SDI出力フォーマットが3840×2160Pに設定
されているとプロキシ記録は行えません。

SDカードについて

プロキシデータ記録用に使用可能な
SDカード

ˎˎ SDHCメモリーカード*（Speed Class：4以上
/UHS非対応／容量：4～ 32 GB）
ˎˎ SDXCメモリーカード*（Speed Class：4以上/
UHS非対応／容量：64～ 256 GB）

* 本書ではSDカードと表現しています。

SDカードのフォーマット（初期化）

本機で初めてSDカードを使用するときは、
フォーマットが必要です。
本機で使用するSDカードは、本機のフォーマッ
ト機能を使用してフォーマットしてください。
SDカードを装着したときに注意メッセージが表
示された場合も、フォーマットして使用してく
ださい。

1	メニューのOperation >XAVC Proxy Rec 
Mode >Settingを選択する。

2	 MENUつまみを回してOnを選択し、つまみ
を押す。

3	メニューのOperation >Format Media 
>SD Card(Proxy)を選択する。

4	 MENUつまみを回してExecuteを選択し、
つまみを押す。
フォーマットを実行するかどうかの確認画
面が表示されます。

5	 MENUつまみを回してExecuteを選択し、
つまみを押す。
フォーマットが始まります。
実行中メッセージと進捗状況（%）が表示さ
れ、ACCESSランプがオレンジで点灯します。
フォーマットが終了すると、完了メッセー
ジが表示されます。MENUつまみを押して
メッセージを消します。

［ご注意］
SDカードをフォーマットすると、すべてのデータが消去
され、復元できません。

残容量の確認

Media Status画面（16ページ）でSDカードの
残量を確認することができます。

本機でフォーマットしたSDカードを
他の機器のスロットで使用するには

あらかじめバックアップを取り、お使いになる
機器でフォーマットし直して使用してください。

プロキシデータを記録する

プロキシデータを同時記録するには

SxSメモリーカードと同期してSDカードにプロ
キシデータを記録することができます。

1	メニューのOperation >XAVC Proxy Rec 
Mode >Settingを選択する。

2	 MENUつまみを回してOnを選択し、つまみ
を押す。

プロキシデータ
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3	プロキシデータ記録用SDカードをPROXY 
SDカードスロットに挿入する。

4	撮影を開始する。
SxSメモリーカードにオリジナルデータが記
録されると同時に、プロキシデータファイ
ルがSDカードの「/PRIVATE/PXROOT/Clip」
ディレクトリーに保存されます。
撮影を終了すると、プロキシデータの記録
も自動的に終了します。

［ご注意]
SDI出力フォーマットを3840×2160Pの設定で使用してい
るときにプロキシ同時記録を行うと、SDI出力フォーマッ
トの設定は自動的に1920×1080P(Level-B)に切り換わり
ます。

プロキシデータをオリジナルデータ
とは別に単独で記録するには

アサイナブルスイッチにXAVC Proxy Rec Start
機能を割り当てることにより、SxSメモリーカー
ドとは連動せずに、単独でSDカードにプロキシ
データを記録することができます。

［ご注意］

ˎˎ プロキシデータ単独記録動作中にプロキシ同時記録開
始操作された場合は、記録中のプロキシデータは途切
れずにそのまま記録が継続されます。その後、同時記
録終了操作が行われたときに、プロキシデータの記録
が止まります。
ˎˎ プロキシ同時記録中はプロキシ単独記録の終了操作は
受け付けません。

プロキシ記録の制限事項

以下の状態のときは、プロキシ記録はできませ
ん。

ˎˎ ストリーミング中（メニューのMaintenance 
>Streaming >SettingがOnのとき）

ˎˎ Interval Rec中（メニューのOperation >Rec 
Function >Interval RecがOnのとき）
ˎˎ Picture Cache Rec中（メニューのOperation 
>Rec Function >Picture Cache RecがOnの
とき）

ˎˎ Slow & Quick Motion中（メニューの
Operation >Rec Function >Slow & Quick 
MotionがOnのとき）
ˎˎ ネットワーククライアントモード（メニュー
の Maintenance >Network Client Mode 
>SettingがOnのとき）。かつ、メニュー
のMaintenance >Network Client Mode 
>Preset 1、Preset 2、またはPreset 3 
>NCM with ProxyがDisableのとき。
ˎˎ メニューのOperation >Format 
>Frequencyが23.98P、かつOperation 
>XAVC Proxy Rec Mode >SizeがHD 
Auto(9Mbps)、またはHD Auto(6Mbps)の
とき

ˎˎ 外部機器接続端子に電源を供給中（メニュー
のOperation >USBを操作中）

記録されるファイルについて

ˎˎ 拡張子は「.mp4」となります。
ˎˎ タイムコードも同時に記録されます。

ˎˎ 先頭フレームの静止画も同時に記録されます。

ˎˎ GPS機能が有効な場合に、測位した情報、お
よびLogファイルが同時に記録されます。
Logファイルは「Root/PRIVATE/SONY/GPS」
に保存されます。

プロキシデータの記録設定の解除

メニューのOperation >XAVC Proxy Rec 
Mode >SettingをOffに設定します。

SDカードの空き容量が不足している
ときは

空き容量の不足を知らせる警告が表示されます。

プロキシ記録時の設定変更

メニューのOperation >XAVC Proxy Rec 
ModeのSize、Audio Channelでそれぞれ、プ
ロキシ記録フォーマットのサイズ、プロキシに
記録するオーディオチャンネルの設定を変更す
ることができます。

［ご注意］
メニューのOperation >XAVC Proxy Rec Mode >Sizeを
HD Auto(9Mbps)またはHD Auto(6Mbps)にして、シス
テム周波数を29.97、25、23.98のいずれかにした場合は、
記録ビデオフォーマットの画サイズが1280×720であっ
ても、プロキシデータの画サイズは、1920×1080になり
ます。

プロキシ記録の設定確認

メニューのOperation >XAVC Proxy Rec 
ModeのFrame Rate、Bit Rateでそれぞれ、映
像フレームレート、映像ビットレートの設定を
確認することができます。
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プランニングメタデータとは、撮影・記録の計
画情報が記述されているXMLファイルです。
プランニングメタデータファイルで、あらかじ
め定義したクリップ名やショットマーク名を使
用して、撮影を行うことができます。
プランニングメタデータは「Content Browser 
Mobile」アプリケーションを使用して送受信す
ることができます。

［ご注意］

ˎˎ クリップ名やショットマーク名の定義には、メニュー
のMaintenance >Languageで設定した言語のフォン
トセットを使用してください。本機の言語設定と異な
る言語を使用すると、文字が正常に表示されない場合
があります。
ˎˎ 日本語でクリップ名やショットマーク名を定義すると、
一部の文字が他のフォントに置き換えられ、ビューファ
インダー画面に正しく表示されないことがあります。
LCDモニター（ステータス表示時）には、アルファベッ
ト、数字、記号のみ表示できます。

クリップ記録時にプランニ
ングメタデータファイルを
カムコーダーのメモリーに
読み込む

1	事前にSxSメモリーカードにプランニングメ
タデータファイルを保存する。
プランニングメタデータファイルは
「General/Sony/Planning」のディレクト
リーに保存されています。

2	 SxSメモリーカードをスロットAまたはBに
挿入する。

3	メニューのOperation >Planning 
Metadata >Load Media(A)またはLoad 
Media(B)を選択する。
ファイルリスト画面が表示されます。
リストには最大64個のプランニングメタ
データファイルが表示されます。

4	 MENUつまみを回してファイルリストから読
み込みたいファイルを選択し、つまみを押す。

5	 MENUつまみを回してLoadを選択し、つま
みを押してから、Executeを選択して、つま
みを押す。

［ご注意］
別売りのメディアアダプターMEAD-SD02を使用して
SDXCカードからプランニングメタデータファイルを読み
込めます。ただし、SDHC/SDカードからの読み込みはで
きません。

読み込んだプランニングメ
タデータの詳細情報を確認
する

本機のメモリーに読み込んだプランニングメタ
データのファイル名や作成日時、タイトルなど
の詳細情報を確認することができます。

1	メニューのOperation >Planning 
Metadata >Propertiesを選択する。

2	 MENUつまみを回してExecuteを選択して、
つまみを押す。
プランニングメタデータの詳細情報が表示
されます。

項目 情報
File Name ファイル名
Assign ID アサインID
Created ファイルの生成日時
Modified ファイルの最終更新日時
Modified by ファイルの更新者
Title ファイルで指定されたTitle1

の内容（ASCII形式のクリッ
プ名）

Title2 ファイルで指定されたTitle2
の内容（UTF-8形式のクリッ
プ名）

Material 
Group

マテリアルグループa)の数

Shot Mark0～
Shot Mark9

ファイルで定義された
ショットマーク0～ショット
マーク9の名前

a) マテリアルグループ：同じプランニングメタデー
タを使用して収録したクリップ群

MENUつまみを回してリストをスクロール
することができます。

読み込んだプランニングメ
タデータを消去する

1	メニューのOperation >Planning 
Metadata >Clear Memoryを選択する。

2	 MENUつまみを回してExecuteを選択して、
つまみを押す。
消去が始まります。 
消去が完了すると、「Clear Planning 
Metadata File done」が表示されます。

プランニングメタデータで
クリップ名を設定する

プランニングメタデータには、次の2種類のク
リップ名文字列を記述することができます。

ˎˎ ビューファインダー画面上に表示されるASCII
形式の名称

ˎˎ 実際にクリップ名として登録されるUTF-8形
式の名称

メニューのOperation >Planning Metadata 
>Clip Name Dispでどちらのクリップ名を表示
するか選択することができます。
プランニングメタデータでクリップ名を設定す
ると、クリップ名が表示されます。

［ご注意］
プランニングメタデータでクリップ名を設定するときに、
ASCII形式の名称とUTF-8形式の名称が両方とも定義さ
れている場合はUTF-8形式の名称がクリップ名となりま
す。プランニングメタデータで、ASCII形式の名称または
UTF-8形式の名称のどちらか一方しか定義していない場合
は、メニューの設定に関わらず定義されているクリップ名
が表示されます。

クリップ名文字列の記述例

テキストエディターを使用して、<Title>タグの
内容を変更します。
網掛け部分がクリップ名文字列です。
「Typhoon」はASCII形式（44文字以下）で記述し
ています。「台風東京上陸」はUTF-8形式（44バ
イト以下）で記述しています。
「sp」はスペース、は改行を表します。

プランニングメタデータ
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<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadataspxmlns="http://
xmlns.sony.net/pro/metadata/
planningmetadata"spassignId="
P0001"spcreationDate="
2016-11-30T17:00:00+09:00"sp

lastUpdate="
2016-12-06T17:00:00+09:00"sp

version="1.00">
<PropertiessppropertyId="
assignment"spupdate="
2016-12-06T17:00:00+09:00"sp

modifiedBy="Chris">
<TitlespusAscii="Typhoon"sp

xml:lang="ja">台風東京上陸
</Title>
</Properties>

</PlanningMetadata>

［ご注意］

ˎˎ 実際にファイルを作成する場合は、改行位置でのみ改
行し、「sp」が表示されていない位置にはスペースを入
れずに1つの文として記述してください。
ˎˎ 以下の文字はクリップ名に使用できません。使用する
と”_”に変換されます。 
"  *  /  :  <  >  ?  \  |
ˎˎ クリップ名に使用できる有効文字数は44バイト（また
は44文字）です。 
UTF-8形式で44バイトを超えるクリップ名を定義する
と、44バイトまでの文字列がクリップ名に使用されま
す。 
ASCII形式のクリップ名のみ定義している場合は、ASCII
形式の44文字までの文字列がクリップ名に使用されま
す。 
ASCII形式で記述した文字列、UTF-8形式で記述した文
字列が、いずれもクリップ名として使用できない場合、
クリップ名は標準形式となります。

クリップ名の設定

1	クリップ名を記述したプランニングメタ
データファイルを本機のメモリーに読み込
む（112ページ）。

2	メニューのOperation >Clip >Clip Naming
をPlanに設定する。
記録を行うたびに、プランニングメタデー
タファイルに記述したクリップ名が、アン
ダーバー（_）と5桁の通し番号（00001～
99999）が付加された形式で自動生成されま
す。 
例：台風東京上陸_00001、台風東京上陸
_00002、... 
 
通し番号が99999に達したら、次の記録操
作で00001に戻ります。

［ご注意］
他のプランニングメタデータを読み込んでも、通し番号は
継続します。通し番号の変更は、メニューの Operation 
>Clip >Number Setで行ってください。

クリップ名の表示形式の選択

ASCII形式とUTF-8形式の両方の名前を定義し
ているときは、どちらの形式の名前をLCDモニ
ター画面またはビューファインダー画面に表示
するかを、メニューのOperation >Planning 
Metadata >Clip Name Dispで選択することが
できます。
ASCII形式の名前を表示するときは： 

Title1(ASCII)を選択します。 
クリップ名は「台風東京上陸 _通し番号」
となりますが、画面には「Typhoon_通し
番号」が表示されます。

UTF-8形式の名前を表示するときは： 
Title2(UTF-8)を選択します。 
クリップ名は「台風東京上陸 _通し番号」
となり、画面に表示されます。

プランニングメタデータで
ショットマーク名を設定す
る

プランニングメタデータでショットマークを設
定する場合、Shot Mark0～ Shot Mark9の名
前を設定することができます。
ショットマークを記録するときに、プランニン
グメタデータで定義したショットマーク名文字
列を付けて記録することができます。

［ご注意］
ショットマーク1、2のみ本機の操作で記録できます。

ショットマーク名文字列の記述例

テキストエディターを使用して、<Meta 
name>タグの内容を変更します。
網掛け部分がショットマーク名文字列です。
ASCII形式（32文字以下）、またはUTF-8形式（16
文字以下）で記述します。
「sp」はスペース、は改行を表します。

［ご注意］
ASCII形式以外の文字が1文字以上含まれていれば、その文
字列の最大長は16文字になります。

<?xmlspversion="1.0"spencoding="
UTF-8"?>
<PlanningMetadata xmlns="http://
xmlns.sony.net/pro/metadata/

planningmetadata"spassignId="
H00123"spcreationDate="
2016-11-30T08:00:00Z"splastUpdate="
2016-11-30T15:00:00Z"spversion=
"1.00">
<PropertiessppropertyId=
"assignment"spclass="original"sp

update="2016-11-30T15:00:00Z"sp

modifiedBy="Chris">
<TitlespusAscii="Football
Game"spxml:lang="ja">
Football Game 30/11/2016</
Title>

<Metaspname="_ShotMark1"sp

content="Goal"/>
<Metaspname="_ShotMark2"sp

content="Shoot"/>
<Metaspname="_ShotMark3"sp

content="Corner Kick"/>
<Metaspname="_ShotMark4"sp

content="Free Kick"/>
<Metaspname="_ShotMark5"sp

content="Goal Kick"/>
<Metaspname="_ShotMark6"sp

content="Foul"/>
<Metaspname="_ShotMark7"sp

content="PK"/>
<Metaspname="_ShotMark8"sp

content="1st Half"/>
<Metaspname="_ShotMark9"sp

content="2nd Half"/>
<Metaspname="_ShotMark0"sp

content="Kick Off"/>
</Properties>

</PlanningMetadata>
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［ご注意］
実際にファイルを作成する場合は、改行位置でのみ改行し、
ショットマーク名文字列以外では「sp」が表示されていな
い位置にスペースを入れずに1つの文として記述してくだ
さい。
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測位中に撮影した動画の位置情報や測位時刻が
本機に記録されます。またSDI信号にもそれら
の情報が重畳されて出力されます。
工場出荷時、GPS機能はOffになっています。

GPS記録対応フォーマット

XAVC-IまたはXAVC-Lの記録フォーマットが
GPS記録に対応しています。
また、対応フォーマット以外の設定されている
場合でもSDI出力がオン（Operation >Input/
Output >SDI Out1/3 OutputまたはSDI Out 
2/4 OutputがOn）の場合は、SDI出力で測位情
報を取得することができます。

［ご注意］
フォーマットがSD SDIのときは測位情報は出力されませ
ん。また、再生時も出力されません。

1	本機がスタンバイ状態であることを確認す
る。

2	メニューのOperation >GPSをOnに設定す
る。
ビューファインダー画面に  が表示され、
測位準備が行われます。測位できた場合、
動画の撮影時に測位情報を記録します。

GPS衛星からの電波の受信状況によって、画面
に表示されるアイコンが変わります。

測位状況 画面表示 GPS受信状況
機能切 非表示 GPSがOffになってい

る、またはエラーが起
きている。

測位状況 画面表示 GPS受信状況
測位困難 GPS信号を受信できな

いため、測位情報が取
れない。空の開けた場
所に移動してください。

衛星検索中 衛星を検索中です。測
位中になるまで数分か
かることがあります。

測位中 弱いGPS信号を受信中。

GPS信号を受信中。測
位情報を取得できる。
強いGPS信号を受信中。
測位情報を取得できる。

ˎˎ 電源を入れてから測位を始めるまで時間がか
かることがあります。

ˎˎ 数分待ってもアイコンが測位中にならないと
きは、受信困難な状態です。そのまま撮影を
始めるか、空の開けた場所に移動してくださ
い。そのまま撮影すると測位情報は記録され
ません。

ˎˎ 屋内や高い建物のそばでは電波をうまく受信
できません。空の開けた場所に移動してくだ
さい。

ˎˎ「測位中」になっていても、電波の受信状況に
よりGPS情報の記録が途切れることがありま
す。

測位情報の取得（GPS）
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本機で使用できるネットワーク機能
本機は、さまざまなネットワーク機能に対応し
ています。ネットワークの接続および機能の概
要と詳細説明の参照先を以下に示します。
ネットワークを使用するには、Basic 
Authentication >Passwordでパスワードを設
定してください。

［ご注意］

ˎˎ ネットワーク機能を初めて使用する場合や、ソフトウェ
アをバージョン5.0にアップデートした場合は、Basic 
Authentication >Passwordの設定は空欄になってい
ます。
ˎˎ パスワードを設定しないと、セットアップメニューの

Network項目は選択できない状態（グレーアウト状態）
になり、ネットワーク設定が行えません。

ネットワーク接続の概要

本機とデバイスをワイヤレスLANで
接続する

USBワイヤレスLANモジュールIFU-WLM3（付
属）、またはワイヤレスLANアダプター CBK-
WA02（別売）を使用して本機とスマートフォン
やタブレットなどのデバイスをワイヤレスLAN
接続します。

1	ワイヤレス接続機器を選択する。
USBワイヤレスLANモジュールIFU-WLM3
（付属）を使用する場合⇒（67ページ）
ワイヤレスLANアダプター CBK-WA02（別
売）を使用する場合⇒（67ページ）

2	ワイヤレスアクセスLANのアクセスモード
を選択する。
本機をアクセスポイントにする（Wi-Fi 

Access Pointモード）⇒（68ページ）
本機をクライアントにする（Wi-Fi Station
モード）⇒（69ページ）

本機をLANケーブルでインターネッ
トに接続する

本機のネットワーク端子を使用して、ルーター
経由でインターネットに接続します。

1	本機とルーターをLANケーブルで接続する。
⇒（71ページ）

本機をワイヤレスLANでインター
ネットに接続する

USBワイヤレスLANモジュール IFU-WLM3（付
属）、ワイヤレスLANアダプター CBK-WA02（別
売）、またはモデム（別売）でインターネットに
接続します。

［ご注意］
ワイヤレスLANアダプター CBK-WA02（別売）、またはモ
デム（別売）での接続には、ネットワークアダプターキッ
トCBK-NA1（別売）が必要です。

IFU-WLM3（付属）を使用する場合

1	 IFU-WLM3を本機に取り付ける。
⇒（67ページ）

2	ワイヤレスLANのアクセスモードをWi-Fi 
Stationモードに設定して、インターネット
に接続する。
⇒（73ページ）

CBK-WA02（別売）を使用する場合

1	 CBK-WA02を本機に取り付ける。
⇒（67ページ）

2	ワイヤレスLANのアクセスモードをWi-Fi 
Stationモードに設定して、インターネット
に接続する。
⇒（73ページ）

モデムを使用する場合

1	 CBK-NA1（別売）のUSB延長アダプターを取
り付ける。
⇒（72ページ）

2	モデムを接続する。
⇒（72ページ）

ネットワーク機能の概要

本機で記録したファイルをインター
ネット上のサーバーに転送する

SDカードに記録したプロキシファイルやSxSメ
モリーカードのオリジナルファイルを3G/4G/
LTE回線やアクセスポイント、または有線LAN
ルーター経由でインターネット上のサーバーに
転送します。
⇒（75ページ）

映像・音声をストリーミング伝送す
る

カムコーダーで撮像・再生している映像・音声を、
インターネットやローカルネットワークを通じ
て伝送します。

本機のストリーミング設定の設定を使用
してストリーミングを行う場合
⇒（79ページ）

ソニー製ネットワークRXステーショ
ン（別売）のConnection Control 
ManagerまたはXDCAM airを使用して
高画質なストリーミングを行う場合
⇒（80ページ）

Wi-Fiリモコンを使用する

ワイヤレスLAN接続時、スマートフォンやタブ
レットなどのデバイスから、本機に内蔵された
Wi-Fiリモコンにアクセスすることができます。
⇒（82ページ）

Webメニューから設定する

ワイヤレスLAN接続したデバイスのブラウザー
から本機にアクセスすると、本機のWebメ
ニューが表示されます。
⇒（84ページ）

ネットワーク機能の対応状況と動作
制限について

⇒（89ページ）
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本機にUSBワイヤレスLANモジュール IFU-
WLM3（付属）またはワイヤレスLANアダプター
CBK-WA02（別売）を取り付けると、スマート
フォンやタブレットなどのデバイスと本機をワ
イヤレスLAN接続することができます。
ワイヤレスLAN接続されたデバイスと本機の間
では、次の操作が可能です。

［ご注意］
IFU-WLM3またはCBK-WA02以外のUSBワイヤレスLAN
モジュール／アダプターは使用できません。

ワイヤレスLAN経由でのリモート操作
本機とワイヤレスLAN接続されたスマートフォ
ンやタブレット、コンピューターから本機をリ
モート操作することができます。

ワイヤレスLAN経由でのファイル転送
本機のSD カードに記録されたプロキシファイ
ル（低解像度）や本機で記録したオリジナルファ
イル（高解像度）を、ワイヤレスLAN経由でサー
バーに転送することができます。

ワイヤレスLAN経由で映像をモニタリング
本機のカメラ映像や再生映像からストリーム
(H.264)を作成し、ワイヤレスLAN経由でデバイス
から「Content Browser Mobile」アプリケーショ
ンを使ってモニタリングすることができます。

「Content Browser Mobile」はデバイスの画面
で本機をストリーミングしながらリモート操作
をしたり、本機の設定をすることができるアプ
リケーションです。
また、プロキシデータのイン点／アウト点を指
定し、切り出した部分を転送（76ページ）す
ることもできます。

「Content Browser Mobile」アプリケーション
は、最新のバージョンをご確認の上ご使用くだ
さい。

 ˜「Content Browser Mobile」アプリケーションについ
て詳しくは、お買い上げ店またはソニーのサービス窓
口にご確認ください。

［ご注意］

ˎˎ 本機のSD カードに記録されたプロキシファイル（低解
像度）はワイヤレスLAN経由ではストリーミングできま
せん。
ˎˎ ビデオフォーマットがMPEG IMX、およびDVCAMの場
合は、ストリーミング再生には対応していません。
ˎˎ 本機とワイヤレスLANアクセスポイント、または端末
機器間の障害物や電波状況、壁の材質など周囲の環境
によって、通信可能距離が短くなったり、接続できな
くなることがあります。本機の場所を移動したり、本
機とアクセスポイントまたは端末機器の距離を近づけ
て、接続／通信状態を確認してください。

対応デバイスについて

本機の設定や操作にはスマートフォン、タブレッ
トまたはコンピューターを使用することができ
ます。使用できるデバイス、OS、ブラウザーは
次のとおりです。

デバイス OS ブラウザー
スマートフォン Android 

9.0/10.0
Chrome

iOS 13.x Safari
タブレット Android 9.0 Chrome

iPadOS 13.x Safari
コンピューター Microsoft 

Windows 8.1/
Microsoft 
Windows 10

Chrome

macOS 
10.14/10.15

Safari

［ご注意］
お使いの端末機器のOS、ブラウザーのバージョンによっ
ては再生できない場合があります。この場合は「Content 
Browser Mobile」を使用してください。

IFU-WLM3を取り付ける

1	 USBワイヤレスLANモジュール接続端子の
カバーを開ける。

ガード（付属品）

2	 IFU-WLM3に保護キャップを取り付ける。

3	 IFU-WLM3を端子に差し込む。

［ご注意］
IFU-WLM3の取り付け／取り外しは、本機の電源を切った
状態で行ってください。

IFU-WLM3を使用しない場合

ネジ（2本）を外してガードを取り外し、端子カ
バーを閉じます。

CBK-WA02を取り付ける

1	ハンドルの下図の位置にアタッチメント金
具を取り付ける。
アタッチメント金具（サービスパーツ番号：
A-2092-367-）の取り付けは、サービス担当
者にお問い合わせください。
アタッチメント金具

本機とデバイスのワイヤレスLAN接続
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2	 CBK-WA02（別売）に付属しているUSB延長
アダプターをアタッチメント金具に取り付
ける。

3	固定ネジを時計方向に回して、USB延長ア
ダプターを固定する。

固定ネジ

USB延長アダプター

USB延長アダプターは、図に示す範囲で取
り付け位置を調節することができます。

4	 USB延長アダプターのUSB端子に保護
キャップ（付属）を取り付ける。

5	 USBワイヤレスLANモジュール接続端子の
カバーを開ける。

ガード（付属品）

6	 USB延長アダプターのUSB端子をUSBワイ
ヤレスLANモジュール接続端子に差し込む。

7	 CBK-WA02をUSB延長アダプターのUSB端
子に差し込む。

8	メニューのMaintenance >Network 
>Channelで、ワイヤレスLANチャンネルを
設定する（124ページ）。

 ˜ CBK-WA02の使いかたについて詳しくは、CBK-WA02
に付属の取扱説明書をご覧ください。

［ご注意］

ˎˎ CBK-WA02の取り付け／取り外しは、本機の電源を切っ
た状態で行ってください。
ˎˎ CBK-WA02を装着して、メニューのMaintenance 

>Network >Wi-Fi ModeでWi-Fi Stationを選択する
と、5GHz対応のアクセスポイントと接続できるように
なります。
ˎˎ Wi-Fi Access PointモードのCh設定のAuto(5GHz)は、
ご使用のCBK-WA02によっては、メニューに表示され
ない場合があります。
ˎˎ CBK-WA02を5GHz帯の屋外使用が禁止されている国
／地域でご使用の場合、Auto(5GHz)はメニューに表
示されません。CBK-WA02が、ご使用になる国／地域
に対応しているかをご確認ください。詳しくは、CBK-
WA02の取扱説明書をご覧ください。

CBK-WA02を使用しない場合

ネジ（2本）を外してガードを取り外し、端子カ
バーを閉じます。

ワイヤレスLANアクセス
ポイントモード（Wi-Fi 
Access Pointモード）で接
続する

本機をアクセスポイントとしてデバイスとワイ
ヤレスLAN接続します。

スマートフォン／
タブレット

コンピューター

接続設定を開始する前に、「Content Browser 
Mobile」をお使いのデバイスにインストールし
てください。

NFC機能搭載のデバイスでワンタッ
チ接続する

デバイスがNFCをサポートしている場合には、
NFCを利用したワンタッチ接続が可能です。

1	デバイスの「設定」を起動して「その他の設
定」を選び、「NFC/おサイフケータイ設定」
の「NFC R/W P2P」または「Reader/Writer, 
P2P」にチェックを入れる。
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2	本機の電源を入れ、メニューの
Maintenance >Network >SettingをOnに
する。

3	メニューのMaintenance >Network >Wi-
Fi ModeをWi-Fi Access Pointにする。

4	 NFC機能を有効にする。
メニューのMaintenance >Network >NFC
を実行するか、NFC機能がアサインされた
アサイナブルスイッチを長押し（3秒間）し
て、NFC接続モードにしてください。
画面に が表示されているときのみNFC機
能を使用できます。

［ご注意］

画面に が表示されるまでに時間がかかる（30秒から90
秒）場合があります。ビューファインダー画面のワイヤレ
スネットワーク状態表示（19ページ）が「AP」点滅から
「AP」点灯に変わるまでお待ちください。

5	本機とデバイスをタッチする。
デバイスが本機に接続され、「Content 
Browser Mobile」が起動します。

［ご注意］

ˎˎ 一部の が付いているデバイスはNFCに対応していま

す。詳しくはデバイスの取扱説明書でご確認ください。
ˎˎ あらかじめデバイスのスリープおよび画面ロックを解
除してください。
ˎˎ デバイスで「Content Browser Mobile」が起動するま
で（1～ 2秒）動かさずにタッチし続けてください。
ˎˎ お使いのデバイスにすでに同一のSSIDが登録されてい
る場合、デバイスのOSバージョンによっては、接続で
きないことがあります。この場合には、登録されてい
るSSIDをデバイスから削除することにより、接続でき
ます。

WPS機能搭載のデバイスで接続する
場合

デバイスがWPSをサポートしている場合には、
WPSでの接続が可能です。

1	メニューのMaintenance >Network 
>SettingをOnにする。

2	メニューのMaintenance >Network > 
Wi-Fi ModeをWi-Fi Access Pointにする。

［ご注意］
アクセスポイントモードになるまでに時間がかかる（30秒
から90秒）場合があります。LCDモニター画面／ビュー
ファインダー画面のネットワーク状態表示（19ページ）
が「AP」点滅から「AP」点灯に変わるまでお待ちください。

3	メニューのMaintenance >Network >WPS
を選択する。

4	 MENUつまみを回してExecuteを選択し、
つまみを押す。

5	デバイスのNetwork設定／Wi-Fi設定を開
き、Wi-FiをOnにする。

6	 Wi-Fi NetworkのSSID一覧から、本機の
SSIDを選択し、詳細Optionを表示し、WPS 
Push Buttonを選択する。

［ご注意］
使用する機器によっては、操作が異なる場合があります。

デバイスでSSID、Passwordを入力
して接続する場合

デバイス側でSSIDとPasswordを入力して接続
します。

1	メニューのMaintenance >Network 
>SettingをOnにする。

2	メニューのMaintenance >Network > 
Wi-Fi ModeをWi-Fi Access Pointにする。

［ご注意］
アクセスポイントモードになるまでに時間がかかる（30秒
から90秒）場合があります。LCDモニター画面／ビュー
ファインダー画面のネットワーク状態表示（19ページ）
が「AP」点滅から「AP」点灯に変わるまでお待ちください。

3	デバイスのNetwork設定／Wi-Fi設定を開
き、Wi-FiをOnにする。

4	 Wi-Fi NetworkのSSID一覧から、本機の
SSIDを選択し、Passwordを入力して接続す
る。
本機のSSIDおよびPasswordについては、メ
ニューのMaintenance >Network >SSID & 
Password（124ページ）でご確認ください。

［ご注意］
使用する機器によっては、操作が異なる場合があります。

ワイヤレスLANステー
ションモード（Wi-Fi 
Stationモード）で接続す
る

本機をクライアントとして既存のワイヤレス
LANのアクセスポイントに接続します。
デバイスとはアクセスポイント経由で接続しま
す。
接続はセットアップメニューによる方法とWeb
メニューによる方法があります。ここではセッ
トアップメニューのWPS機能を使用する方法で
説明します。
Webメニューによる接続方法は「WPS機能を使
用しないステーションモードでアクセスポイン
トに接続する」（86ページ）をご覧ください。
ネットワーク自動検出機能、または手動入力機
能による接続方法は「セットアップメニューか
らアクセスポイントに接続する」（73ページ）
をご覧ください。
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スマートフォン／
タブレット

コンピューター

アクセス
ポイント

WPS機能を使ってアクセスポイント
に接続する

アクセスポイントがWPS機能対応の場合は、簡
単な設定で接続することができます。

1	アクセスポイントの電源を入れる。

2	本機の電源を入れる。

3	メニューのMaintenance >Network 
>SettingをOnにする。

4	メニューのMaintenance >Network > 
Wi-Fi ModeをWi-Fi Stationにする。

［ご注意］
ステーションモードになるまでに時間がかかる（30秒から
1分）場合があります。LCDモニター画面／ビューファイ
ンダー画面のネットワーク状態表示（19ページ）の電波
強度アイコン表示が点滅から点灯に変わるまでお待ちくだ
さい。

5	メニューのMaintenance >Network >WPS
を選択する。

6	 MENUつまみを回してExecuteを選択し、
つまみを押す。

7	アクセスポイントのWPS ボタンを押す。
WPSボタンの操作については、アクセスポ
イントの取扱説明書をご覧ください。
接続が完了すると、LCDモニター画面／
ビューファインダー画面のネットワーク状
態表示（19ページ）の電波強度アイコン表
示が強度1以上で点灯します。

［ご注意］
接続に失敗した場合は手順1からやり直してください。

8	デバイスをアクセスポイントに接続する。
接続のしかたについては、各機器の取扱説
明書をご覧ください。
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本機は有線LAN、またはワイヤレスLANでイン
ターネットに接続することができます。
有線の場合は、本機のネットワーク端子にLAN
ケーブル（別売）を接続し、ルーター経由でイン
ターネットに接続します。
ワイヤレスの場合は、USBワイヤレスLANモ
ジュール IFU-WLM3（付属）、ワイヤレスLANア
ダプター CBK-WA02（別売）、またはモデム（別
売）でインターネットに接続します。

ネットワーク接続に必要な機器

ワイヤレスLAN接続
次のいずれかの機器が必要です。

ˎˎ USBワイヤレスLANモジュール IFU-WLM3
（付属）

ˎˎ ワイヤレスLANアダプター CBK-WA02（別売）
＋ネットワークアダプターキットCBK-NA1
（別売）に同梱のUSB延長アダプター CBK-
NA1E
ˎˎ モデム（別売）＋ネットワークアダプターキッ
トCBK-NA1（別売）に同梱のUSB延長アダプ
ター CBK-NA1E

有線LAN接続
ˎˎ LANケーブル（別売）

［ご注意］

ˎˎ ワイヤレスLAN モジュールは国・地域によって利用で
きない場合があります。
ˎˎ ワイヤレスLAN モジュールが使用する周波数帯は、さ
まざまな機器が共有して使用する電波帯です。使用環
境によっては、他の機器の影響によって、通信速度や
通信距離が低下することや、通信が切断することがあ
ります。
ˎˎ 3G/4G/LTE 回線を利用するには、携帯電話事業者との
契約が必要です。

ˎˎ 本機に対応しているネットワーク接続に必要な機器に
ついては、お買い上げ店またはソニーのサービス窓口
にお問い合わせください。

ネットワーク接続機能同時使用の制
限について

本機では複数の方法で、ワイヤレス、または有
線LANでネットワークに接続することができま
す。
ただし、それらの接続機能を同時使用について
は、一部動作に制限があります。
詳しくは、「ネットワーク機能同時使用時の動作
制限」（89ページ）をご覧ください。

LANケーブルを使用して
接続する（有線LAN接続）

本機のネットワーク端子を使用して、ルーター
経由で有線LAN接続によりインターネットに接
続することができます。

［ご注意］

ˎˎ 安全のために、周辺機器を接続する際は、過大電圧を
持つ可能性があるコネクターをこの端子に接続しない
でください。接続については本書の指示に従ってくだ
さい。
ˎˎ LANケーブルご使用の際は、輻射ノイズによる誤動作
を防ぐため、シールドタイプのケーブルを使用してく
ださい。

インターネット

ルーター

コンピューター

1	本機ネットワーク端子とルーターをLAN
ケーブルで接続する。

2	メニューのMaintenance >Network 
>SettingをOnにする。

3	メニューのMaintenance >Network 
>Wired LANをEnableにする。
自動的に本機にIPアドレスが割り当てられ
ます。

［ご注意］

ˎˎ 有線LAN接続が有効になるまでに時間がかかる（30秒か
ら1分）場合があります。液晶画面／ビューファインダー
画面のネットワーク接続状態表示（19ページ）のLAN
アイコンが点滅から点灯に変わるまでお待ちください。
ˎˎ 本機に記録したオリジナルファイル／プロキシファイ
ルの転送、Wi-Fiリモコンの使用、Webメニューの操
作、および「Content Browser Mobile」アプリケー
ションでの映像モニタリングをするには、メニューの
Maintenance >Network >Wired LAN RemoteをOn
にしてください（125ページ）。
ˎˎ インターネットからの不正アクセスを防ぐため、LAN
ケーブルを使用したネットワークがインターネットに
接続していないときにWired LAN RemoteをOnにする
ことを推奨します。インターネットに接続する場合は、
接続先がセキュアなネットワークであることをご確認
の上、使用してください。
ˎˎ USBワイヤレスLANモジュール接続端子にモデム（別
売）を装着していた場合、有線LAN接続はできません。
有線LAN接続する場合は、事前にモデム（別売）を取り
外してから使用してください。
ˎˎ Wi-Fi Stationモードでインターネットに接続の場合、
有線LAN がインターネットに接続していない場合は、
エラーとなりインターネット経由の機能が動作しませ
ん。この場合はWired LAN >Disableにして、Wi-Fi 
Stationモードのみでインターネット接続してくださ
い。

インターネット接続
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モデムを使用してインター
ネットに接続するための準
備

本機のUSBワイヤレスLANモジュール接続端子
を使用して、3G/4G回線経由でインターネット
に接続する場合は、準備として以下の方法で、
ネットワークアダプターキットCBK-NA1（別売）
に同梱のUSB延長アダプター CBK-NA1Eを本機
のUSBワイヤレスLANモジュール端子に取り付
けます。

1	ハンドルの下図の位置にアタッチメント金
具を取り付ける。
アタッチメント金具（サービスパーツ番号：
A-2092-367-）の取り付けは、サービス担当
者にお問い合わせください。

アタッチメント金具

2	 USB延長アダプターをアタッチメント金具
に取り付ける。

3	固定ネジを時計方向に回して、USB延長ア
ダプターを固定する。

固定ネジ

USB延長アダプター

USB延長アダプターは、図に示す範囲で取
り付け位置を調節することができます。

4	 USB延長アダプターのUSB端子に保護
キャップ（付属）を取り付ける。

5	 USBワイヤレスLANモジュール接続端子の
カバーを開ける。

ガード（付属品）

6	 USB延長アダプターのUSB端子をUSBワイ
ヤレスLANモジュール接続端子に差し込む。

モデムを使用して接続する

ネットワークアダプターキットCBK-NA1（別売）
経由でモデム（別売）を本機に取り付けることに
よって、3G/4G回線経由でインターネットに接
続することができます。

インターネット

CBK-NA1
＋
モデム

接続する

1	 USB延長アダプター CBK-NA1EのUSB端子
にモデム（別売）を接続する。

 ˜ モデム側の接続方法は、モデムに付属の取扱説明
書をご覧ください。

2	メニューのMaintenance >Network 
>SettingをOnにする。

3	メニューのMaintenance >Network 
>ModemをOnにする。

［ご注意］

ˎˎ CBK-NA1およびモデムの取り付け／取り外しは、本機
の電源を切った状態で行ってください。
ˎˎ モデムモードになるまでに時間がかかる（30秒から1分）
場合があります。液晶画面／ビューファインダー画面
のネットワーク接続状態表示（19ページ）が「3G/4G」
点滅から「3G/4G」点灯に変わるまでお待ちください。
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ワイヤレスLANステー
ションモード（Wi-Fi 
Station モード）で接続す
る

USBワイヤレスLANモジュール IFU-WLM3（付
属）、またはワイヤレスLANアダプター CBK-
WA02（別売）を本機に取り付け、3G/4G/LTE対
応アクセスポイント（別売）またはデバイスのテ
ザリングを使用することによって、Wi-Fi ステー
ションモードでインターネットに接続すること
ができます。
取り付け方法は、「IFU-WLM3を取り付ける」
（67ページ）、または「CBK-WA02を取り付け
る」（67ページ）をご覧ください。

インター
ネット

インター
ネット

アクセス
ポイント

スマートフォン
／タブレット

スマートフォン
／タブレット

コンピューター

デバイスを使用して接続す
る

アクセスポイントまたはデバイスがWPS 機能対
応の場合は「「WPS機能を使ってアクセスポイン
トに接続する」（70ページ）」、WPS機能に対
応していない場合は「WPS機能を使用しないス

テーションモードでアクセスポイントに接続す
る」（86ページ）の手順で接続します。
接続の操作の前に、アクセスポイントまたはデ
バイスの電源を入れ、デバイスの場合はテザリ
ング機能が使用できるようにしておいてくださ
い。

セットアップメニューから
アクセスポイントに接続す
る

セットアップメニューからアクセスポイントに
接続できます。
接続は、ネットワーク自動検出機能を使用する
か、または手動入力で行います。

ネットワーク自動検出機能での接続

1	「WPS機能を使ってアクセスポイントに接続
する」（70ページ）の手順1～ 4を行う。

2	メニューのMaintenance >Network 
>Wi-Fi Station Detail SettingsのScan 
NetworksでExecuteを選択する。
本機が接続先の検出を開始します。接続先
を検出すると、Scan Networksの結果リス
トが表示されます。

 ［ご注意］
本機の電源を切る場合、リスト表示は閉じてください。

3	 MENUつまみで接続先を選択し、つまみを
押す。
接続先を決定すると、Password入力画面に
遷移します。

4	 Password入力画面でPasswordを設定する。
Passwordを設定後、Wi-Fi Station Detail 
Settings詳細設定画面に戻ります。
なお、以前に接続したことがある接続先の
情報が本機の履歴に残っていた場合、その
とき使用していたSSIDを選択すると、Wi-Fi 
Station Detail Settings詳細設定画面に戻り
ます。

5	 Wi-Fi Station Detail Settings詳細設定画面
で以下の接続設定を行う。

項目 内容
DHCP DHCPを設定する。

Onにすると、自動的に本機
にIPアドレスを割り当てる。
手動で本機のIPアドレスを
入力する場合は、Offにする。

IP Address 本機のIPアドレスを入力す
る。
DHCPがOffのときに有効

Subnet mask 本機のサブネットマスクを
入力する。
DHCPがOffのときに有効

Gateway アクセスポイントのゲート
ウェイを入力する。
DHCPがOffのときに有効

DNS Auto DNS自動取得設定する。
Onにすると、自動的にDNS
サーバーのアドレスを取得
する。

Primary DNS 
Server

アクセスポイントのプライ
マリー DNSサーバーを入力
する。
DNS AutoがOffのときに有
効
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項目 内容
Secondary 
DNS Server

アクセスポイントのセカン
ダリー DNSサーバーを入力
する。
DNS AutoがOffのときに有
効

6	設定入力が完了したらSetのExecuteを選択
し、設定内容を確定する。

［ご注意］

ˎˎ 接続設定を変更した場合、必ずSetのExecuteを選択し
てください。Executeを選択しなかった場合は設定した
内容が反映されません。
ˎˎ ステーションモードになるまでに時間がかかる（30秒～

1分）場合があります。LCDモニター画面／ビューファ
インダー画面のネットワーク状態表示（19ページ）の
電波強度アイコン表示が点滅から点灯に変わるまでお
待ちください。
ˎˎ 接続したStation設定情報は履歴として保存されます。
この履歴はALL Reset、Network Resetで消去されます。

手動入力での接続

1	「WPS機能を使ってアクセスポイントに接続
する」（70ページ）の手順1～ 4を行う。

2	メニューのMaintenance >Network >Wi-
Fi Station Detail Settingsで、以下の接続
設定を行う。

項目 内容
SSID 接続先のアクセスポイント

のSSIDを入力する。
Password 接続先のアクセスポイント

のパスワードを入力する。
入力したパスワードは*で表
示されるが、SHIFTキーを
押している間は、入力した
文字が表示される。

項目 内容
DHCP DHCPを設定する。

Onにすると、自動的に本機
にIPアドレスを割り当てる。
手動で本機のIPアドレスを
入力する場合は、Offにする。

IP Address 本機のIPアドレスを入力す
る。
DHCPがOffのときに有効

Subnet mask 本機のサブネットマスクを
入力する。
DHCPがOffのときに有効

Gateway アクセスポイントのゲート
ウェイを入力する。
DHCPがOffのときに有効

DNS Auto DNS自動取得設定する。
Onにすると、自動的にDNS
サーバーのアドレスを取得
する。

Primary DNS 
Server

アクセスポイントのプライ
マリー DNSサーバーを入力
する。
DNS AutoがOffのときに有
効

Secondary 
DNS Server

アクセスポイントのセカン
ダリー DNSサーバーを入力
する。
DNS AutoがOffのときに有
効

3	設定入力が完了したらSetのExecuteを選択
し、設定内容を確定する。

［ご注意］

ˎˎ 接続設定を変更した場合、必ずSetのExecuteを選択し
てください。Executeを選択しなかった場合は設定した
内容が反映されません。
ˎˎ ステーションモードになるまでに時間がかかる（30秒～

1分）場合があります。LCDモニター画面／ビューファ
インダー画面のネットワーク状態表示（19ページ）の
電波強度アイコン表示が点滅から点灯に変わるまでお
待ちください。
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SDカードに記録したプロキシファイルやSxSメ
モリーカードのオリジナルファイルを3G/4G/
LTE回線やアクセスポイント、または有線LAN
ルーター経由で接続したインターネット上の
サーバーへ転送することができます。

転送先を設定する

1	「本機とデバイスのワイヤレスLAN接続」
（67ページ）、および「インターネット接
続」（71ページ）の手順に従って、本機を
インターネットに接続する。

2	あらかじめファイルを転送するサーバーを
登録しておく。
サーバーの登録のしかたについては、
「転送先のサーバーを登録するには」
（88ページ）をご覧ください。

Webメニューでプロキシ
ファイルを転送する

WebメニューでSDカードに記録したプロキシ
ファイルをサーバーに転送します。

1	本機とデバイスをワイヤレスLAN接続し、
デバイスのブラウザーを起動して本機にア
クセスする。

2	ファイルを選択するためのファイルリスト
画面を表示させる。

3	  をタップしてMedia Infoを選択し、SD 
Cardをタップする。
SD Card画面が表示されます。

「Content Browser Mobile」アプリケーショ
ンのバージョン2.0 以降を使用すると、先
頭フレームの静止画ファイルを使用し、SD 
カードのプロキシファイルのサムネイルを
すばやく表示することができます。

4	転送したいファイルを選択する。
ファイルをタップして選びます。もう一度
タップすると、キャンセルします。ダブル
タップすると、ファイルを再生して内容を
確認することができます。

5	 Transferをタップする。
「転送先のサーバーを登録するには」
（88ページ）のDefault Settingでデフォ
ルト設定された転送先が表示されます。
転送先を変更する場合は、転送先をタップ
してリストを表示させ、転送先を選択しま
す。必要に応じて、転送先のディレクトリー
を入力します。
転送先の選択は、本機メニューの
Maintenance >File Transfer >Default 
Upload Serverで設定することもできます。

6	 Transferをタップする。
選択したファイルの転送が開始されます。
転送を中止するときは、Cancelをタップし
ます。

本機のサムネイル画面でプ
ロキシファイルを転送する

本機のサムネイル画面でSDカードに記録したプ
ロキシファイルをサーバーに転送します。

プロキシファイルの個別転送

1	あらかじめWebメニューに登録した転送先
を選択する。
Webメニュー、または本機メニューの
Maintenance >File Transfer >Default 
Upload Serverで選択できます。

2	 THUMBNAILボタンを押して、サムネイル
画面を表示する。

3	メニューのThumbnail >Transfer 
Clip(Proxy)で、Select Clipを選択する。
転送ファイル選択画面が表示されます。

4	 MENUつまみを回して転送するファイル（ク
リップ）にカーソルを移動し、つまみを押す。
選択したクリップにチェックマークが付き
ます。
チェックマークを外すには、選択済みのク
リップ上でMENUつまみを押します。

5	 SHIFTボタンを押しながら、SETボタンを押
す。
確認画面が表示されます。

6	 MENUつまみを回して、確認画面のExecute
を選択し、つまみを押す。
選択したファイルがジョブリストに登録さ
れ、登録完了メッセージが表示されます。

プロキシファイルの一括転送

SDカードに記録したプロキシファイルをまとめ
て転送することができます。

［ご注意］

ˎˎ オリジナルファイルがないプロキシファイルはサムネ
イル画面で転送ファイルとして選択できません。
ˎˎ 転送ファイル選択画面に表示されないプロキシファイ
ルは転送対象外です。

1	メニューのThumbnail >Transfer 
Clip(Proxy)で、All Clipsを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
すべてのファイルがジョブリストに登録さ
れ、登録完了メッセージが表示されます。

ファイルの転送
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ファイルの転送はジョブリストに登録でき
たファイルから順に転送を開始します。
登録したファイルは、メニューの
Maintenance >File Transfer >View Job 
Listを選択して、転送ジョブ一覧を表示して
確認できます。

記録終了時の自動転送

あらかじめメニューのMaintenance >File 
Transfer >Auto Upload(Proxy)をOnに設定す
ると、プロキシ記録が完了した時点で、設定さ
れたサーバーにファイルが自動的に転送されま
す。
オリジナルファイルの情報を継承した同一デュ
レーションのプロキシファイルをプランニング
メタデータに基づいて記録した場合、このプラ
ンニングメタデータの<Title>タグの内容で転
送先のフォルダーが作成され、このフォルダー
の下に転送されます。
また転送時に記録メディアのIDがプランニング
メタデータファイルのファイル名に自動で付加
されます。

プロキシファイルの部分転送

「Content Browser Mobile」アプリケーション
のバージョン2.0 以降を使用すると、プロキシ
ファイルのイン点／アウト点を指定し、切り出
した部分を転送することができます。
また、ストーリーボードを使用すると、複数ファ
イルから切り出した部分を転送することができ
ます。

［ご注意］

ˎˎ 生成されるファイルには、切り出し位置の前後に最大
15 フレームのマージンが付加されます。
ˎˎ ネットワーク機能ソフトウェア（V1.25）以前で記録した

プロキシファイルから切り出した場合には、ノンリニ
ア編集機に取り込めない場合があります。
ˎˎ ストーリーボードに基づいて部分転送を行った場合に
は、ノンリニア編集機へストーリーボードの情報を伝
達するためのファイルがJob Listに表示されます。
ˎˎ 転送時にSDカードにGeneral/Sony/tmpフォルダーが
自動で作成されます。ファイルはこのフォルダーに一
時的に保存され、転送完了後に自動的に削除されます。
ˎˎ 次の状態のときは、ファイルの転送は行えません。

 – セットアップメニューのMaintenance >Network 
>Wi-Fi ModeがWi-Fi Access Point、かつWired 
LAN >Disableのとき

 – ストリーミング機能が有効のとき（Maintenance 
>Streaming >SettingがOn）

 – ネットワーククライアントモードを有効に
し、高品質なストリーミングを行っているとき
（Maintenance >Network Client Mode >Setting
がOnでストリーミング中）

Webメニューでオリジナ
ルファイルを転送する

WebメニューでSxSメモリーカードに記録した
オリジナルファイルをサーバーに転送します。

1	本機とデバイスをワイヤレスLAN接続し、
デバイスのブラウザーを起動して本機にア
クセスする「本機とデバイスのワイヤレス
LAN接続」（63ページ）。

2	メニューのMaintenance >File Transfer 
>File Transferを選択する。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
オリジナルファイルの転送モードに設定さ
れます。

4	デバイスのブラウザー上でファイルを選択
するためのファイルリスト画面を表示させ
る。

5	  をタップしてMedia Infoを選択し、Slot 
A（スロットAのメディアに記録されている
ファイル）またはSlot B（スロットBのメディ
アに記録されているファイル）をタップす
る。
Slot AまたはSlot B画面が表示されます。

例：Slot A画面

6	転送したいファイルを選択する。
ファイルをタップして選びます。もう一度
タップすると、キャンセルします。

7	 Transferをタップする。
「転送先のサーバーを登録するには」
（88ページ）のDefault Settingでデフォ
ルト設定された転送先が表示されます。
転送先を変更する場合は、転送先をタップ
してリストを表示させ、転送先を選択しま
す。
Directoryに転送先のディレクトリーを入力
します。
転送先の選択は、本機メニューの
Maintenance >File Transfer >Default 
Upload Serverで設定することもできます。

8	 Transferをタップする。
選択したファイルの転送が開始されます。
転送を中止するときは、Cancelをタップし
ます。
すべてのファイルの転送が完了したら、自
動的に転送モード設定が解除され、カメラ
撮像画面に切り替わります。

本機のサムネイル画面でオ
リジナルファイルを転送す
る

本機のサムネイル画面でSxSメモリーカードに
記録したオリジナルファイルをサーバーに転送
します。

オリジナルファイルの個別転送

1	あらかじめWebメニューに登録した転送先
を選択する。
Webメニュー、または本機メニューの
Maintenance >File Transfer >Default 
Upload Serverで選択できます。

2	 THUMBNAILボタンを押して、サムネイル
画面を表示する。
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3	メニューのThumbnail >Transfer Clipで、
Select Clipを選択する。
転送ファイル選択画面が表示されます。

4	 MENUつまみを回して転送するファイル（ク
リップ）にカーソルを移動し、つまみを押す。
選択したクリップにチェックマークが付き
ます。
チェックマークを外すには、選択済みのク
リップ上でMENUつまみを押します。

5	 SHIFTボタンを押しながら、SETボタンを押
す。
確認画面が表示されます。

6	 MENUつまみを回して、確認画面のExecute
を選択し、つまみを押す。
選択したファイルがジョブリストに登録さ
れ、登録完了メッセージが表示されます。

オリジナルファイルの一括転送

SxSカードに記録したオリジナルファイルをま
とめて転送することができます。

1	メニューのThumbnail >Transfer Clipで、
All Clipsを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
すべてのファイルがジョブリストに登録さ
れ、登録完了メッセージが表示されます。

ファイルの転送はジョブリストに登録でき
たファイルから順に転送を開始します。
登録したファイルは、メニューの
Maintenance >File Transfer >View Job 
Listを選択して、転送ジョブ一覧を表示して
確認できます。

あらかじめメニューのMaintenance >File 
Transfer >Remote File TransferをEnableに設
定すると、ファイルの転送モードに設定しなく
ても、自動的にオリジナルファイルの転送モー
ド設定になります。

［ご注意］
次の状態のときは、ファイルの転送は行えません。
ˎˎ 記録、再生、サムネイル画面表示中
ˎˎ メニューのMaintenance >Network >Wi-Fi Modeが

Wi-Fi Access Point、かつWired LAN >Disableのとき
ˎˎ ストリーミング機能が有効のとき（Maintenance 

>Streaming >SettingがOn）
ˎˎ ネットワーククライアントモードを有効にし、高品質
なストリーミングを行っているとき（Maintenance 
>Network Client Mode >SettingがOnでストリーミ
ング中）

オリジナルファイルの部分転送

「Content Browser Mobile」アプリケーション
のバージョン2.0 以降を使用すると、本機で記
録したオリジナルファイルにイン点／アウト点
を指定し、切り出した部分を転送することがで
きます。
また、ストーリーボードを使用すると、複数ファ
イルから切り出した部分を転送することができ
ます。
対応するオリジナルファイルのフォーマットは、
以下のとおりです。

ˎˎ XAVC-I
ˎˎ XAVC-L

ˎˎ HD422（exFAT/UDF共通）
ˎˎ HD420HQ（exFAT/UDF共通）

［ご注意］
「Content Browser Mobile」を使用してオリジナルファイ
ルを部分転送するには、オリジナルファイルと同一ファイ
ル名のプロキシファイルが必要になります。
あらかじめプロキシファイルを作成する設定に
してから、記録を開始してください。
設定は以下のとおりです。
ˎˎ メニューのOperation >XAVC Proxy Rec Mode 

>SettingをOnにする。
ˎˎ ネットワーククライアントモードが有効のときは、
メニューのMaintenance >Network Client Mode 
>Preset 1、Preset 2、またはPreset 3 >NCM with 
ProxyをEnableにする。

ファイルの転送状態を確認
する

Webメニューでの確認

SD Card、Slot AまたはSlot B画面のJob Listを
タップして表示されるJob List画面でファイル転
送の状態を確認することができます（88ペー
ジ）。

本機セットアップメニューでの確認

メニューのMaintenance >File Transfer >View 
Job Listを選択すると、Job List画面が表示され
ます。
Job List画面でファイル転送の状態を確認する
ことができます。

項目 内容
Src. 転送クリップのソースメディアの

表示
A：スロットAのメディア
B：スロットBのメディア
P：PROXY SDカードスロットの
メディア

Clip Name 転送クリップのクリップ名の表示
Destination 転送クリップの転送先サーバーの

表示
Status 転送状態の表示

Completed：転送完了
Transferring：転送中
Aborted：転送中止
Waiting：転送待ち
Server Cap. Over：転送先サー
バー容量超過（Webメニュー
のJob List（88ページ）に
E03-006が表示される。）

Upload Error：転送先サーバー
アップロードエラー（Webメ
ニューのJob List（88ペー
ジ）にE03-003が表示される。）

Dest. Auth. Failed：転送先サー
バー認証エラー（Webメ
ニューのJob List（88ペー
ジ）にE03-005が表示される。）

Dest. Cert. Err.：転送先証明書エ
ラー（WebメニューのJob 
List（88ページ）にE03-008
が表示される。
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本機セットアップメニュー
のJob List画面で転送ファ
イルを削除する

Job List画面で登録した転送ファイルを任意に
選択して、削除することができます。

［ご注意］

ファイルは1ファイルずつ削除してください。
複数まとめての削除はできません。

1	 Job List画面で、MENUつまみを回して、削
除したいファイルにカーソルを移動する。

2	 MENUつまみを押す。
削除するかどうかの確認メッセージが表示
されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
削除完了メッセージが表示されます。

登録した転送ファイルの全削除

Job List画面のClear All jobsをタップします。

転送完了済みのジョブの全削除

Job List画面のClear Completed jobをタップ
します。
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カムコーダーで撮像・再生している映像・音声を、
インターネットやローカルネットワークを通じ
て伝送することができます。

ストリーミング伝送の準備
をする

1	「本機とデバイスのワイヤレスLAN接続」
（67ページ）、および「インターネット接
続」（71ページ）の手順に従って、本機を
インターネットに接続する。

2	メニューのMaintenance >Streamingで、
Preset1（またはPreset2、Preset3）を選択
する。
ストリーミングの接続先設定画面が表示さ
れます。

3	ストリーミングの接続先設定画面でSize、
Bit Rate、TypeおよびTypeに応じた設定項
目を設定する。
設定項目の詳細、制限事項などについては、
「ストリーミング設定」（85ページ）をご
覧ください。

4	メニューのMaintenance >Streaming 
>Preset Selectで、手順1、2で設定した
Preset1（またはPreset2、Preset3）を選択
する。

ストリーミングを開始する

1	メニューのMaintenance >Streaming 
>SettingをOnにする。
設定に応じてストリーミングが開始されま
す。
Streamingはアサイナブルスイッチに割り
当てることができます。割り当て方法につ
いては、「アサイナブルスイッチに機能を割
り当てる」（131ページ）をご覧ください。

［ご注意］

ˎˎ メニューの設定が以下の場合、ストリーミングを開始
できません。

 – メニューのMaintenance >Network >SettingがOff
のとき

 – メニューのMaintenance >Network Client Mode 
>SettingがOnのとき

 – メニューのMaintenance >Network >SettingはOn
だがMaintenance >Network >Wi-Fi ModeがOff、
Maintenance >Network >Wired LANがDisableの
とき

ˎˎ ストリーミングを開始してから実際に映像・音声がス
トリーミングされるまでに数十秒かかる場合がありま
す。
ˎˎ SDフォーマットのクリップの再生時はストリーミング
を開始できません。
ˎˎ ストリーミングの伝送先設定が間違っている場合や
ネットワークに接続できていない場合には、ストリー
ミング状態表示に×が表示されます。
ˎˎ ストリーミングに移行すると、ネットワーククライア
ントモードによるストリーミング（80ページ）、モニ
タリング、プロキシ記録およびファイル転送はできま
せん。
ˎˎ モニタリング中、プロキシ記録中またはファイル転送
中にストリーミングを開始すると、これらの機能は停
止します。

ストリーミングを停止する

メニューのMaintenance >Streaming 
>SettingをOffにすると、ストリーミングを停
止します。
StreamingがOnのときに、Streamingがアサ
インされたアサイナブルスイッチを押すことで
もストリーミングを停止できます。

デバイスとワイヤレスLAN接続している場合
（67ページ）、およびワイヤレスLANステー
ションモードでインターネット接続している場
合（69ページ）には、ストリーミング伝送先
の設定、ストリーミングの開始／停止をWebメ
ニュー（84ページ）から行うこともできます。

映像・音声をストリーミング伝送する
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ネットワーククライアントモードを有効にし、
本機とソニー製ネットワークRXステーション
（別売）のConnection Control Manager（以降
「CCM」）またはXDCAM airを接続して使うこ
とで、ソニーのQoS技術を使った高品質なスト
リーミングが可能になります。また複数のネッ
トワークを経由することで、より高画質で安定
したストリーミングが行えます。

［ご注意］

ˎˎ ネットワークRXステーションには V1.12.0以降をご使
用ください。
ˎˎ 複数のネットワークを使用して安定したストリーミン
グを行うには、それぞれのネットワークに異なるキャ
リアの回線を使用してください。
ˎˎ 複数のネットワークを使用した場合、映像シーンによっ
ては、ターゲットビットレートを超えることあります。
ˎˎ XDCAM air は、ソニーが提供するクラウドサービスで
す。 
このサービスをご利用になるには、別途契約が必要で
す。 
一部対応していない地域がありますので、サービス対
象地域についてXDCAM air のサイトをご確認くださ
い。 
https://www.xdcam-air.com 
また、XDCAM airのプライバシーポリシーについては、
以下のサイトを参照してください。

 – 利用規約 
https://www.xdcam-air.com/site/tos_eu.html

 – XDCAM airのプライバシーポリシー 
https://sony-imaging-products-solutions.co.jp/
pp/sips/en/index.html

 – プロフェッショナルIDのプライバシーポリシー 
https://www.pro-id.sony.net/#/privacyPolicy

ˎˎ 詳しくは、ソニー法人営業窓口にお問い合わせください。

1	本機をネットワークに接続する。
詳しくは、「本機とデバイスのワイヤレス
LAN接続」（67ページ）、および、「インター
ネット接続」（71ページ）をご覧ください。

2	メニューのMaintenance >Network Client 
Mode >Preset 1、Preset 2、またはPreset 
3で接続先のネットワークを設定する。
接続先のネットワーク設定はプリセット設
定としてPreset 1、Preset 2、またはPreset 
3に設定できます。

項目 内容
CCM 
Address

接続先のCCMのアドレスを入
力する。（ホスト名またはIPア
ドレス）

CCM Port 接続先のCCMのポート番号を
入力する。

User Name ユーザー名を入力する。
Password パスワードを入力する。

入力したパスワードは*で表示
されるが、SHIFTキーを押して
いる間は、入力した文字が表示
される。

NCM With 
Proxy

CCM接続時のプロキシ記録の
有効／無効を設定する。

Camera 
Control

CCM接続時のカメラコントロー
ル許可／不許可を設定する。

Camera 
Setting

CCM接続時のAll Fileのハンドリ
ング許可／不許可を設定する。

［ご注意］

ˎˎ すべての項目に値が入力されないと、ネットワー
ククライアントモードを設定できません。
ˎˎ メニューのMaintenance >Network Client Mode 

>Preset 1、Preset 2、またはPreset 3 >NCM 
with ProxyをEnableに設定すると、ネットワーク
クライアントモードが有効な場合でも、プロキシ
記録ができます。NCM with Proxyの設定を有効
にするには、メニューのOperation >XAVC Proxy 
Rec Mode >SettingをOnにしてください。
ˎˎ メニューのMaintenance >Network Client Mode 

>Preset 1、Preset 2、またはPreset 3 >NCM 
with ProxyがDisableに設定されている場合、記録
中にネットワーククライアントモードをOnにする
と、プロキシ記録は停止します。 
オリジナルファイルの記録を継続している場合、

同設定をOffにするとプロキシ記録を再開します。
ˎˎ メニューのOperation >XAVC Proxy Rec Mode 

>Proxy File >SizeをHD Auto(9Mbps)またはHD 
Auto(6Mbps)に設定している場合、NCM with 
Proxyは設定できません。 
NCM with ProxyがEnableに設定済みで、HD 
Auto(9Mbps)またはHD Auto(6Mbps)に設定した
場合、設定値は保持されますが、プロキシ記録は
行われません。

3	メニューのMaintenance >Network Client 
Mode >Preset Selectで手順1で設定したプ
リセットのいずれか1つを選択する。

4	メニューのMaintenance >Network Client 
Mode >SettingをOnにする。
ネットワーククライアントモードが有効に
なり、ネットワークRXステーションまたは
XDCAM airと接続します。
ネットワークRXステーションの操作により、
ライブストリーミングが開始されます。ま
た、ネットワークRXステーションからの本
機リモートコントロール、Allファイルの保
存/呼び出しができます。
操作について詳しくは、ネットワークRXス
テーションの取扱説明書またはXDCAM air
のヘルプをご覧ください。
なお、Network Client ModeのSetting（On/
Off）は、本機のアサイナブルスイッチに割
り当てることができます。割り当て方法に
ついては、「アサイナブルスイッチに機能を
割り当てる」（131ページ）をご覧ください。

［ご注意］

ˎˎ 通常のストリーミング（79ページ）中はネットワーク
クライアントモードに移行できません。
ˎˎ ネットワーククライアントモードに移行すると、通常
のストリーミング（79ページ）、モニタリングはでき
ません。

ˎˎ モニタリング中にネットワーククライアントモードに
移行すると、モニタリングは停止します。
ˎˎ ネットワーククライアントモードでのストリーミング
中は、ファイルを転送できません。ストリーミングを
停止するとファイルを転送できます。
ˎˎ ファイル転送中にネットワーククライアントモードで
のストリーミングを開始すると、ファイル転送は停止
します。ストリーミングを停止するとファイル転送を
再開します。
ˎˎ ネットワークRXステーションで設定可能なストリーミ
ングのビットレートが、プロキシ記録のフォーマット
により、以下のように制限されます。

 – プロキシ記録のフォーマットが、1280×720 
9Mbps/6Mbpsの場合：ストリーミングのビットレー
トは、1Mbps以下になります。

 – プロキシ記録のフォーマットが、640×360 3Mbps
以下の場合：ストリーミングのビットレートは、
3Mbps以下になります。

ˎˎ ネットワーククライアントモード時は、プロキシのフォー
マット変更はできません。変更する場合は、一度ネット
ワーククライアントモードをオフにしてください。

ネットワーククライアントモードで
ファイルを転送する

ネットワークRXステーションのCCMと本機を
ネットワーククライアントモードで接続して、
CCMで設定されたサーバーへファイル転送する
ことができます。

1	転送したいファイルを選ぶ。
ˎˎ プロキシ記録を転送する場合 
「Webメニューでプロキシファイルを転送
する」の手順1～ 5（75ページ参照）
ˎˎ オリジナルファイルを転送する場合 
「Webメニューでオリジナルファイルを転
送する」の手順1～ 6（76ページ参照）

2	 Transferをタップする。
転送先に「NCM：RX Server」が表示されます。
「NCM：RX Server」を転送先に指定します。

高品質なストリーミングを行う
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3	 Transferをタップする。
CCMで設定されたサーバーへ、選んだファ
イルの転送を開始します。

［ご注意］
ネットワーククライアントモードでないときも、転送先を
「NCM：RX Server」にできます。 
この場合は、転送は保留となり、ネットワーククライアン
トモードでCCMに接続後、CCMで設定されたサーバーへ
転送を開始します。
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ワイヤレスLAN接続時、スマートフォンやタブ
レットなどのデバイスから、本機に内蔵された
Wi-Fiリモコンにアクセスすることができます。
Wi-Fiリモコンを使用すると遠隔から本機を操作
できます。記録の開始／停止や撮影設定を遠隔
操作で調整できるため、本機を離れた場所に固
定する場合や、本機をクレーンに装着して使用
する場合などに有効です。

Wi-Fiリモコンを表示する

Wi-Fi Remote画面は、デバイスの画面サイズに
応じて自動で切り替わります。

1	「本機とデバイスのワイヤレスLAN接続」
（67ページ）、および「インターネット接
続」（71ページ）の手順に従って、本機を
インターネットに接続する。

2	デバイスでブラウザーを起動し、「http://本
機のIPアドレス（Maintenance >Network 
>IP Address(Wireless)）/rm.html」にアク
セスする。
例：IPアドレスが「192.168.1.1」の場合
は、アドレスバーに「http://192.168.1.1/
rm.html」と入力します。

3	ブラウザー画面に、ユーザー名とパス
ワード（メニューのMaintenance >Basic 
Authentication（124ページ））を入力する。
接続が完了すると、デバイスにWi-Fi 
Remote画面が表示されます。
以降は、画面表示のとおりに操作してくだ
さい。

画面のLockつまみを右にスライドすると、
RECボタンの操作を禁止することができま
す。
Wi-FiリモコンはWebメニューのCam 
Remote Control（84ページ）からも表示
できます。

［ご注意］

ˎˎ スマートフォン用のページを表示したい場合は、アド
レスの最後を「rms.html」に、タブレット用のページを
表示したい場合は「rmt.html」に置き換えて入力してく
ださい。通常は「rm.html」と入力すれば、各ページに
自動的に移動します。デバイスによっては正常に動作
しない場合があります。
ˎˎ 次の場合は、Wi-Fi Remote画面と本機の状態が一致し
なくなることがあります。その場合は、ブラウザーの
表示を更新してください。

 – 接続中に本機を再起動した場合
 – 接続中に本機を操作した場合
 – デバイスを再接続した場合
 – ブラウザーで進む／戻る操作した場合

ˎˎ 電波状態が著しく悪い場合、Wi-Fi Remoteが機能しな
くなることがあります。

Wi-Fi Remote画面（スマー
トフォン表示）

Main画面

ˎˎ ステータス表示
ˎˎ 撮影設定表示 

Iris、Focus、Zoom、S&Q 
FPS、Shutter、White、
Gamma、Auto Iris、Gain、
ATW、Color Bars、Auto 
Black、Auto White

Playback画面

ˎˎ ステータス表示
ˎˎ 再生操作ボタン 

F Rev、Play/Pause、F Fwd、
Prev、Stop、Next

Cursor画面

ˎˎ ステータス表示
ˎˎ カーソル操作ボタン、メ
ニュー／ステータス表示 
Up、Left、Set、Right、
Down、Cancel/
Back、Menu、Status、
Thumbnail、Option 
（SHIFT+SET）

Assign画面

ˎˎ ステータス表示
ˎˎ アサイナブルスイッチ表示 
アサイナブルスイッチ0、1、3、
4、5

Wi-Fiリモコンを使用する
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Wi-Fi Remote画面（タブ
レット表示）

Main画面

ˎˎ ステータス表示
ˎˎ アサイナブルスイッチ表示 
アサイナブルスイッチ0、1、3、4、5
ˎˎ 撮影設定表示 

S&Q FPS、Shutter、White、Gamma、Auto Iris、
Gain、ATW、Color Bars、Auto Black、Auto White

Playback画面

ˎˎ ステータス表示
ˎˎ 再生操作ボタン 

F Rev、Play/Pause、F Fwd、Prev、Stop、Next

Cursor画面

ˎˎ ステータス表示
ˎˎ カーソル操作ボタン、メニュー／ステータス表示 

Up、Left、Set、Right、Down、Cancel/Back、
Menu、Status、Thumbnail、Option（SHIFT+SET）

Assign画面

ˎˎ アサイナブルスイッチ表示 
アサイナブルスイッチ0、1、3、4、5
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Webメニューから設定する
ワイヤレスLAN接続したデバイスのブラウザー
から本機にアクセスすると、本機のWebメ
ニューが表示されます。Webメニューでワイヤ
レス機能に関する各種設定やファイルの転送操
作を行うことができます。

Webメニューを表示する

1	「本機とデバイスのワイヤレスLAN接続」
（67ページ）、および「インターネット接
続」（71ページ）の手順に従って、本機を
インターネットに接続する。

2	デバイスのブラウザーを起動し、
「http://192.168.1.1:8080/index.html」に
アクセスする。
ユーザー名「User name」とパスワード
「Password」を入力する画面が表示されま
す。

3	ユーザー名とパスワードを入力して、「OK」
を選択する。
アクセス認証のユーザー名およびパスワー
ドについては、メニューのMaintenance 
>Basic Authentication（124ページ）でご
確認ください。

設定メニュー

デバイスでブラウザーを起動し、「http://本機
のIPアドレス（Maintenance >Network >IP 
Address）:8080」にアクセスすると、本機の

Media InfoのSD Card画面が表示されます。
Webメニュー画面左上の  をタップすると設
定メニューが表示されます。設定したい項目を
タップします。
項目にはSettings、Media Info、Job List、
Cam Remote Controlがあります。

Settings
本機の設定を行います。本画面の項目は次のと
おりです。

項目 内容 参照先
Wireless 
Module 
>Streaming 
Format

ストリーミン
グフォーマッ
ト設定

ストリーミング
フォーマット設
定「Streaming 
Format」
（84ページ）

Wireless 
Module 
>Proxy 
Format

プロキシ
フォーマット
設定

プロキシフォー
マット設定
「Proxy Format」
（85ページ）

Wireless 
Module 
>System 
Settings

Network 
Client Mode 
Settingsの証
明書のロー
ド（Load 
Certification
のLoadボタ
ンで実行）

「システム設
定「System 
Settings」」
（86ページ）

Wireless LAN 
>Station 
Settings

ワイヤレス
LAN設定

ワイヤレスLAN 
設定「Station 
Settings」
（86ページ）

Wireless LAN 
>Status

ワイヤレス
LAN設定状態
の確認

ワイヤレスLAN
設定の確認
（86ページ）

Wired LAN 
>Wired LAN 
Settings

有線LAN設定 有線LAN設定
「Wired LAN 
Settings」
（87ページ）

項目 内容 参照先
Wired LAN 
>Status

有線LAN設定
状態の確認

有線LAN
設定の確認
（87ページ）

Upload 
Settings

転送設定 転送設定
「Upload 
Settings」
（87ページ）

Media Info
メディアの情報を表示したりメディアから転送
するファイルを選択する画面を表示します。

ˎˎ SD Card：本機のPROXY SDカードスロット
に挿入されているメディア 
再生したいファイルをダブルタップすると、
選択したファイルが再生されます。

 ［ご注意］
お使いの端末機器のOS、ブラウザーのバージョンに
よっては再生できない場合があります。この場合は
「Content Browser Mobile」を使用してください。

ˎˎ Slot A：本機のカードスロットAに挿入され
ているメディア

ˎˎ Slot B：本機のカードスロットBに挿入されて
いるメディア

Job List
転送中のファイルを管理するJob List画面を表
示します（88ページ）。

Cam Remote Control

Wi-Fiリモコンを表示します（82ページ）。

OSS Information
著作権情報を表示します。

ストリーミングフォー
マット設定「Streaming 
Format」

デバイスでモニタリングされるストリームや、
インターネットまたはローカルネットを通じて
ストリーミング伝送するストリームのフォー
マットや伝送先の設定を行います。

映像

ˎˎ AVC/H.264 Main Profile、4 : 2 : 0 Long 
GOP
ˎˎ サイズは以下の設定で選択

音声

ˎˎ AAC-LC圧縮
ˎˎ サンプリング周波数：48 kHz
ˎˎ ビットレート：128 kbps for Stereo

モニタリング設定

デバイスでモニタリングされるときのフォー
マットを設定します。
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項目 内容 設定値
Monitoring 
Size

モニタリング用の
映像のサイズと
ビットレートを設
定する。

480x270(1Mbps)/ 
480x270(0.5Mbps)

Monitoring 
Frame Rate

モニタリング用の
映像のフレーム
レートを表示する。

23.98fps/25fps/
29.97fps/50fps/
59.94fps

Monitoring 
Bit Rate

モニタリング用の
映像のビットレー
トを表示する。

1Mbps(VBR)/ 
0.5Mbps(VBR)

［ご注意］

ˎˎ ビットレートは平均値であり、設定値を超える場合が
あります。
ˎˎ 映像のフレームレートは24fps に対応していません。
ˎˎ Monitoring sizeで640 × 360：3Mbps（VBR）には対
応していません。

ストリーミング設定

ストリーミング伝送時のフォーマットや伝送先
を設定します。設定はプリセットとして3つま
で保持できます。

項目 内容 設定値
On/Off ストリーミング伝

送のオン／オフを
切り換える。

On/Off

Preset プリセットを
Preset1～ 3から
選択する。Preset
はEditをタップす
ると編集できます。

Preset1/
Preset2/
Preset3

Type ストリーミング用
の映像の種類を選
択する。

MPEG-2 TS/
UDP/ 
MPEG-2 TS/ 
RTP

項目 内容 設定値
Size ストリーミング用

の映像のサイズを
設定する。
HD Autoを選択
した場合、SxSに
記録される記録
フォーマットの設
定や再生するク
リップのフォー
マットに基づい
て、1920x1080か
1280x720に設定
される。

HD Auto/ 
1280x720/ 
640x360/ 
480x270/ 
320x180

Bit Rate ストリーミング用
の映像のビット
レートを設定する。
選択できるビット
レートは、Sizeの
設定により異なる。

9Mbps/6Mbps/ 
3Mbps/2Mbps/ 
1Mbps/0.5Mbps/ 
0.3Mbps(Mono L)/
0.3Mbps(Mono R)/
0.2Mbps(Mono L)/
0.2Mbps(Mono R)

Destination 
Address

ストリーミング
データの伝送先
サーバーのアドレ
スを入力する。

ホスト名または
IPアドレス

Destination 
Port

伝送先サーバーの
ストリーミングに
使用するポート番
号を入力する。

1～ 65535

Audio 
Channel 
Select

ストリーミング出
力に乗せるAudio 
Channelを選択す
る。

Ch-1 & Ch-2/ 
Ch-3 & Ch-4

［ご注意］

ˎˎ StreamingをOnに設定した場合、モニタリング機能が
使用できません。
ˎˎ インターネット経由で映像／音声データをそのまま送
信します。 
そのためデータが漏えいする可能性があります。 
送信先がストリーミングデータを受信できていること
を確認してください。 
アドレスの設定ミスなどにより意図しない相手にデー

タを送信してしまう可能性があります。
ˎˎ ネットワークの状況により、すべてのフレームを再生
できない場合があります。
ˎˎ 動きの激しいシーンの場合には、画質が悪くなります。
ˎˎ ストリーミングを大きなサイズで小さいビットレート
に設定した場合、すべてのフレームが再生できない場
合があります。 
この現象を軽減させるためにはSizeでより小さいサイズ
を選んでください。
ˎˎ 500kbps以下のネットワークの帯域をご使用の場合、

SizeとBit Rateは以下のどちらかに設定してください。
 – Sizeが480x270のときは、Bit Rateの0.3Mbps(Mono 

L)、0.3Mbps(Mono R)、0.2Mbps(Mono L)、
0.2Mbps(Mono R)のいずれかを設定する。

 – Sizeが320x180のときは、0.2Mbps(Mono L)、
0.2Mbps(Mono R)のどちらかを設定する。

このときのビデオのフレームレートは10fps、オーディ
オのサンプリング周波数は48kHz、ビットレートは
56kbps Monoに設定されます。
ˎˎ Bit rateが0.3Mbps(Mono L)、または0.2Mbps(Mono 

L)の場合、Audio Channel Selectは、Ch-1 & Ch-2の
Ch-1、またはCh-3 & Ch-4のCh-3に設定されます。 
Bit rateが0.3Mbps(Mono R)、または0.2Mbps(Mono 
R)の場合、Audio Channel Selectは、Ch-1 & Ch-2の
Ch-2、またはCh-3 & Ch-4のCh-4に設定されます。

プロキシフォーマット設定
「Proxy Format」

本機のSDカードに記録されるプロキシファイル
のフォーマット設定を行います。

映像

ˎˎ XAVC Proxy （AVC/H.264 Main Profile、
4 :2 :0 Long GOP）
ˎˎ サイズは以下の設定で選択

音声

ˎˎ AAC-LC圧縮

ˎˎ サンプリング周波数：48 kHz
ˎˎ ビットレート：128 kbps for Stereo

項目 内容 設定値
Proxy File 
recording 
Size

プロキシファイル
用映像のサイズと
ビットレートを設
定する。

HD Auto(9Mbps)/
HD Auto(6Mbps)/ 
1280x720(9Mbps)/ 
1280x720(6Mbps)/ 
640x360(3Mbps)/ 
480x270(1Mbps)/ 
480x270(0.5Mbps)

Proxy File 
recording 
Frame 
Rate

プロキシファイル
用映像のフレーム
レートを表示する。

23.98fps/ 
25fps/ 
29.97fps/ 
50fps/ 
59.94fps

Proxy File 
recording
のBit Rate

プロキシファイル
用映像のビット
レートを表示する。

9Mbps(VBR)/ 
6Mbps(VBR)/ 
3Mbps(VBR)/ 
1Mbps(VBR)/ 
0.5Mbps(VBR)

Proxy File 
recording
のAudio 
Channel 
Select

プロキシファイル
に記録するオー
ディオチャンネル
を設定する。

Ch-1 & Ch-2/ 
Ch-3 & Ch-4

［ご注意］

ˎˎ ビットレートは平均値であり、設定値を超える場合が
あります。
ˎˎ 24fps には対応していません。
ˎˎ プロキシフォーマット設定のSizeにHD Autoを選択し
た場合、SxSメモリーカードへの記録フォーマットの設
定や再生するクリップのフォーマットに基づいて、プ
ロキシフォーマットが設定されます。
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ˎˎ プロキシフォーマット設定のSize をHD Autoに設定し
て記録したプロキシファイルは、ブラウザーやContent 
Browser Mobileで再生できない場合があります。プロ
キシファイルを記録したSDカードをコンピューターに
直接挿入して再生してください。

システム設定「System 
Settings」

Network Client Mode Settingsの証明書を
ロードします。

ネットワーククライアン
トモード設定「Network 
Client Mode Settings」

ˎˎ Load Certification：Loadボタン 
ロードするCCMの証明書「CCM_

certification.pem」は、あらかじめSDカード
のルートに書き込んでください。CCMの証明
書については、ソニー法人営業窓口にお問い
合わせください。

ワイヤレスLAN 設定
「Station Settings」

本機をワイヤレスLAN に接続するための設定を
行います。

項目 内容
Host Name 本機のデバイス名（変更不可）。

SSID Access Pointで選んだSSIDを
表示する。

Key アクセスポイントのパスワー
ドを入力する。

Show Key Onで、入力中の文字を表示す
る。

DHCP DHCP設定する。
Onにすると、自動的に本機に
IP アドレスを割り当てる。
手動で本機のIP アドレスを入
力する場合は、Offにする。

IP Address 本機のIP アドレスを入力する。
DHCPがOffのときに有効

Subnet mask 本機のサブネットマスクを入
力する。
DHCPがOffのときに有効

項目 内容
Gateway アクセスポイントのゲート

ウェイを入力する。
DHCPがOffのときに有効

DNS Auto DNS自動取得設定する。
Onにすると、自動的にDNS
サーバーのアドレスを取得す
る。

Primary DNS 
Server

アクセスポイントのプライマ
リーDNSサーバーを入力する。
DNS AutoがOffのときに有効

Secondary DNS 
Server

アクセスポイントのセカンダ
リー DNS サーバーを入力す
る。
DNS AutoがOffのときに有効

Submit ワイヤレスLAN 設定を確定す
る。

WPS機能を使用しないステーション
モードでアクセスポイントに接続す
る

1	アクセスポイントモードで本機とデバイス
を接続する（68ページ）。

2	 Station Settings画面の項目を設定する。
接続するアクセスポイントの設定に合わせ
て設定を行います。

 ˜ アクセスポイントの設定については、アクセスポ
イントの取扱説明書をご覧ください。

3	 Submitをタップする。
設定した項目が確定します。

4	メニューのMaintenance >Network > 
Wi-Fi Modeを選択する。

5	 MENUつまみを回してWi-Fi Stationを選択
し、つまみを押す。
この操作では、本機はステーションモード
でアクセスポイントに接続するため、「WPS
機能を使ってアクセスポイントに接続する」
（70ページ）の手順9以降を行って、デバ
イスから本機にアクセスします。

ワイヤレスLAN設定の確認

Wireless LANのStatusでワイヤレスLAN設定の
確認画面を表示します。
本機のワイヤレスLANモードによって、表示さ
れる内容が変わります。

アクセスポイントモード

ステーションモード
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有線LAN設定「Wired LAN 
Settings」

本機を有線LANに接続するための設定を行いま
す。

項目 内容
DHCP DHCP設定する。

Onにすると、自動的に本機に
IP アドレスを割り当てる。
手動で本機のIP アドレスを入
力する場合は、Offにする。

IP Address 本機のIP アドレスを入力する。
DHCPがOffのときに有効にな
る。

Subnet mask 本機のサブネットマスクを入
力する。DHCPがOffのときに
有効になる。

Gateway アクセスポイントのゲート
ウェイを入力する。
DHCPがOffのときに有効にな
る。

DNS Auto DNS自動取得設定する。
Onにすると、自動的にDNS
サーバーのアドレスを取得す
る。

Primary DNS 
Server

ルーターのプライマリー DNS 
サーバーを入力する。
DNS AutoがOffのときに有効
になる。

項目 内容
Secondary DNS 
Server

ルーターのセカンダリー DNS 
サーバーを入力する。
DNS AutoがOffのときに有効
になる。

Web/Cam 
Remote

本機Web メニューやWi-Fi リ
モコンへのアクセスの許可／
不許可の設定する。
Onにするとアクセスを許可す
る。

Submit 有線LAN 設定を確定する。

［ご注意］
インターネットからの不正アクセスを防ぐため、Web/
Cam RemoteをOnにする場合は有線LANネットワークが
インターネットに接続していないときを推奨します。イン
ターネットに接続する場合は、接続先がセキュアなネット
ワークであることをご確認の上ご使用ください。

有線LAN設定の確認

Wired LANのStatusで有線LAN 設定の確認画面
を表示します。

転送設定「Upload 
Settings」

本機に記録したプロキシファイルやオリジナル
ファイルを転送するサーバーを登録したり、設
定を変更します。

自動転送のON/OFF

Auto uploadがOnでインターネット接続状態
の場合、記録を終了するとUpload Settingでデ
フォルト設定されたサーバーに対して、自動的
にプロキシファイルを送信します。
転送先サーバーには、「Sony Ci」、「NCM：
RX Server」、「Server Settings1」、「Server 
Settings2」および「Server Settings3」が登録さ
れています。初期値は「Sony Ci」です。
「Sony Ci」とは、Sony が提供するMedia 
Cloud Servicesです。ソニーのクラウドサービ
ス「Sony Ci」へ転送することができます。

［ご注意］

ˎˎ 一部対応していない地域があります。
ˎˎ「Sony Ci」をお使いになる場合は、別途契約が必要です。
詳細は、www.SonyMCS.com/wirelessをご覧くださ
い。 
また、Sony Ciのプライバシーポリシーについては、以
下のサイトを参照してください。

 – 利用規約 
https://www.sonymcs.com/terms/

 – 使用ポリシー 
https://www.sonymcs.com/use/

 – プライバシーポリシー 
https://www.sonymcs.com/privacy/

ˎˎ 転送先のフォルダー名称は、「Destination Directory」
で設定したフォルダーになります。未設定の場合には、
当日の日付のフォルダーとなります。変更するには「登
録済みのサーバーの設定を変更するには」（88ページ）
で設定してください。

Sony Ciの登録方法は次のとおりです。
登録方法の詳細は、www.SonyMCS.com/
wirelessをご覧ください。

1	 Upload Settings画面で「Sony Ci」が表示さ
れていることを確認し、Editをタップする。
「Sony Ci」設定用の画面が表示されます。

2	「User」にユーザー名、「Password」にパス
ワードを入力する。
Show PasswordをOnにすると、入力中の
文字を表示できます。

Load Certification：Loadボタン
ロードするCiの証明書「Ci_certification.
pem」は、あらかじめSDカードのルートに
書き込んでください。Ciの証明書について
は、ソニー法人営業窓口にお問い合わせく
ださい。

3	 Linkをタップする。
しばらくすると完了のメッセージが表示さ
れます。
「Link」はユーザーと本機を関連付ける操作
となります。「Link」を実行するにはインター
ネットの接続が必要です。

4	 OKをタップする。
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「Sony Ci」登録後は、設定画面に「Unlink」
が表されます。タップするとユーザーアカ
ウントを解除し、他のユーザーアカウント
でリンクすることもできます。

転送先のサーバーを登録するには

登録先サーバーをUpload Serverの「Server 
Settings1」、「Server Settings2」、「Server 
Settings3」のいずれかから選択します。
選択後、Editをタップして表示される以下の画
面でサーバー情報を設定します。

設定後にOKをタップすると設定を反映し、
Cancelをタップすると、設定を中止します。

項目 内容
Default Server Onにすると、ファイルの転

送先をデフォルト設定する。
（ファイル転送時の転送先リ
ストに優先的に表示される。）

Display Name リストに表示されるサーバー
名を入力する。

Service サーバーの種類を表示する。
「FTP」：FTP サーバー

項目 内容
Host Name サーバーのアドレスを入力す

る。

［ご注意］
デフォルトのポート番号「21」以
外を使用する場合は、アドレス
の後に「:とポート番号」を付加し
てください。
例）:123

User ユーザー名を入力する。
Password パスワードを入力する。
Show Password Onにすると、入力中の文字

が表示される。
PASV Mode PASV モードのON/OFFを行

う。
Destination 
Directory

転送先のディレクトリーを指
定する。

［ご注意］
ディレクトリー名として不正な
文字が入力された場合は、ディレ
クトリーを生成せず、転送先ディ
レクトリー直下に転送します。

Using Secure 
Protocol

セキュアなFTP転送を行うか
どうかを設定する。

Load 
Certification

中間CA証明書を読み込みま
す。
Using Secure Protocolを
Onにすると、表示されます。

［ご注意］

ˎˎ FTPによる通信は暗号化され
ません。FTPSの使用をお勧め
します。
ˎˎ ルート証明書を含んだ中間CA
証明書が必要です。
ˎˎ 読み込む証明書はPEM 形式
で、SD カードのルートディレ
クトリーにcertification.pem
のファイル名であらかじめ書
き込んでおいてください。

［ご注意］
FTPによる通信は暗号化されません。FTPSの使用をおすす
めします。

登録済みのサーバーの設定を変更す
るには

Upload Settings画面で設定を変更したいサー
バー名を選んでEditをタップします。設定変更
画面が表示されたら、必要に応じて設定を変更
します。
設定項目、内容については「転送先のサーバー
を登録するには」をご覧ください。

ファイル転送の確認をする
「Job List」

転送中のファイルや転送ファイルのリストの確
認をしたり、転送するファイルの中止、再開、
削除などを行うことができます。
本機はFTPレジューム機能（転送途中からのファ
イルの再転送機能）に対応しています。

項目 内容
Total 転送する全ファイルの進捗状

況
Status 転送中のファイルの進捗状況
Remain time 予想残り転送時間表示

項目 内容
Transfer data rate 転送レート表示

ファイルの転送中止、再開、転送リ
ストからファイルを削除するには

1	ファイルを選ぶ。

2	画面右上の  をタップする。
以下の項目を選びます。

ˎˎ Abort selected：転送を中止します。
ˎˎ Delete from list：転送リストからファイ
ルを削除します。

ˎˎ Start selected：ファイルの転送を開始し
ます。

ˎˎ Select All : リストを全選択します。
ˎˎ Clear completed：転送済みファイルリ
ストを全削除します。

証明書ロード時のトラブル
と対応

現象 対応
「Invalid 
certification file.」
が表示される。

ロードする証明書が不正。
証明書を確認する。

「Certification file 
not found.」が表
示される。

証明書のファイル名が正し
いか、確認する。
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ネットワーク機能の対応状況／動作制限について
ネットワーク機能とネットワーク接続設定の対応状況

ネットワーク機能とネットワーク接続設定（メニューのMaintenance >Network >Wi-Fi Mode、
ModemおよびWired LANの設定）の対応状況は以下のとおりです。
ネットワーク機能を有効にするには、メニューのMaintenance >Network >SettingをOnにしてく
ださい。

ネットワーク 
機能

メニューのMaintenance 
>Network>Wi-Fi Mode

メニューの
Maintenance 
>Network >Modem

メニューのMaintenance 
>Network >Wired LAN

Wi-Fi Access 
Point 

Wi-Fi 
Station

Off On Off Enable Disable

プロキシ記録1)

（60ページ）
可 可 可 可 可 可 可

プロキシ再生
（84ページ）

可2) 可2) 不可 不可 不可 可2) 不可

ファイル転送
（75ページ）

不可 可2) 不可 可2) 不可 可2) 不可

ストリーミング 
伝送
（79ページ）

不可 可 不可 可 不可 可 不可

モニタリング
（84ページ）

可2) 可2) 不可 不可 不可 可2) 不可

ネットワーク 
クライアント
モード
（80ページ）

不可 可 不可 可 不可 可 不可

本機のリモート
操作
（82ページ）

可2) 可2) 不可 不可 不可 可2) 不可

1) プロキシ記録は、メニューのOperation >XAVC Proxy Rec Mode >SettingがOnで有効になります。
2) 本機とネットワーク接続したデバイスの機能に対応します。

ネットワーク機能同時使用時の動作制限

ネットワーク機能を同時に使用した場合の動作制限は以下のとおりです。

ワイヤレスLAN接続 有線LAN接続 動作仕様
なし 無効 ネットワーク機能動作停止
USBワイヤレスLANモジュール 無効 USBワイヤレスLANモジュールが動作
3G/4G/LTEUSBモデム 無効 3G/4G/LTEUSBモデムが動作
なし 有効 有線LANが動作
USBワイヤレLANモジュール 有効 USBワイヤレスLANモジュールと有線LANが動作1)

1) ストリーミング、ファイル転送は有線LANで動作します。USBワイヤレスLANモジュール側の操作はWi-Fiリモコンで
の操作が前提です。

［ご注意］
CBK-NA1（別売）に同梱のEthernet変換アダプター CBK-NA1RのUSB延長アダプターをUSBワイヤレスLANモジュールに
装着して、有線LANに接続することはできません。
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サムネイル画面でのクリップ操作について
サムネイル画面について

OK S

1 2 3 4

9 10 11 12 13

65 7 8

Sub

カーソル
（黄色）

E-E／再生モード時にTHUMBNAILボタンを押
すと、「サムネイル画面」が表示され、SxSメモ
リーカードに収録されているクリップの代表画
がサムネイル（縮小画）として一覧表示されます。
サムネイル画面では、任意のクリップを選択し
（91ページ）、そのクリップから再生を開始す
る（91ページ）ことができます。
またサムネイル画面で任意のクリップにクリッ
プフラグを付けることにより、フラグによるク
リップの絞り込みを行うことができます。また
サムネイル画面をエッセンスマークサムネイル
画面に切り換えて、クリップの任意のフレーム

にエッセンスマーク（ショットマークなど）を付
けることもできます。

サムネイル画面を消すには、THUMBNAILボタ
ンを押します。

1. サムネイル（縮小画）
記録時にはクリップの先頭フレームが自動的に
クリップの代表画として表示されます。代表画
は変更することができます（95ページ）。

2. 選択されているメディアのアイコン／メ
ディアの状態

メディアがプロテクトされていると が表示さ
れます。
SxSメモリーカードが2枚装着されている場合、
SLOT SELECTボタンを押して切り換えると、メ
ディアのアイコンも切り替わります。

3. クリップ番号／クリップ総数

4. バッテリー／電圧状態

5. 再生不可状態

6. クリップ状態
クリップの状態をアイコンで表示します。

アイコン 意味
S、OK、NG、
KPアイコン

クリップに付けられたエッセンス
マークまたはクリップフラグ

Subアイコン 1スロット同時記録によって生成
されたサブクリップが存在

錠アイコン クリップブロック（保護）中
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7. クリップ選択チェックボックス
クリップ（サムネイル）選択時にチェックが付き
ます。

8. サムネイル情報
サムネイルの情報が表示されます。表示内容
はCustomize Viewの設定により異なります
（96ページ）。

9. クリップ名／タイトル
選択されているクリップのクリップ名またはタ
イトルが表示されます。

10. 記録時のビデオフォーマット

11. 特殊記録撮影情報
特殊記録モード（スロー＆クイックモーション）
で記録されたクリップの場合は、そのモードが
表示されます。
スロー＆クイックモーション記録されたクリッ
プの場合は、右に［撮影フレームレート／再生
フレームレート］が表示されます。

12. クリップの収録時間（Duration）

13. 作成日時

クリップを選択する

クリップのサムネイルを選択するには、以下の
いずれかの操作により、選択したいサムネイル
に黄色いカーソルを合わせます。

ˎˎ 、、、ボタンを押す。

ˎˎ MENUつまみを回す。
ˎˎ PREVまたはNEXTボタンを押す。

先頭のサムネイルを選択す
る

F REVボタンを押したままPREVボタンを押しま
す。

最終のサムネイルを選択す
る

F FWDボタンを押したままNEXTボタンを押し
ます。

選択したクリップ以降のク
リップを連続再生する

1	再生を開始したいクリップのサムネイルを
選択する。

2	 PLAY/PAUSEボタンを押す。
選択したクリップの先頭から再生が始まり
ます。

選択したクリップ以降のすべてのクリップを連
続再生します。
最後のクリップの再生が終わると、カメラ撮像
画面または外部入力状態になります。
THUMBNAILボタンを押すと、サムネイル画面
に戻ります。

［ご注意］

ˎˎ 記録フォーマットが異なるクリップが混在記録されて
いるSxSメモリーカードでは、すべてのクリップを連続
して再生できない場合があります。
ˎˎ サムネイル画面で再生不可状態表示（90ページ）のク
リップは再生されません。該当クリップをスキップし
て連続再生されます。
ˎˎ クリップとクリップの境界では、一時的に画像が乱れ
たり、静止画になる場合があります。またこの間は、
再生コントロールボタンやTHUMBNAILボタンは操作
できません。
ˎˎ サムネイル画面でクリップを選択して再生を開始する
と、クリップの先頭部分の再生映像が乱れる場合があり
ます。クリップの先頭から乱れのない映像で再生する
には、一度再生モードにした後で一時停止にし、PREV
ボタンを押してクリップの先頭に戻して再生を行って
ください。

再生を一時停止する

PLAY/PAUSEボタンを押します。
一時停止中はPLAY/PAUSEインジケーターが点
滅します。
もう一度押すと再生モードに戻ります。

高速再生する

F FWDボタン（8ページ）またはF REVボタ
ン（8ページ）を押します。
標準再生に戻るには、PLAY/PAUSEボタンを押
します。

現在のクリップの先頭に戻
る

PREVボタンを押します。
ˎˎ 再生中に押すと、現在のクリップの先頭にジャ
ンプして再生を開始します。

ˎˎ F FWD中に押すと、現在のクリップの先頭に
ジャンプして一時停止します。

ˎˎ F REV中または一時停止中に押すと、現在の
クリップの先頭にジャンプして静止画を表示
します。

ˎˎ 続けて押すと、押すたびに1つずつ前のクリッ
プに移動します。

最初のクリップの先頭から
再生する

PREVボタンとF REVボタンを同時に押すと、
SxSメモリーカードの最初に記録されたクリッ
プの先頭にジャンプします。

後ろのクリップの先頭に
ジャンプする

NEXTボタンを押します。
ˎˎ 再生中に押すと、次のクリップの先頭にジャ
ンプして再生を開始します。

ˎˎ F FWD中に押すと、次のクリップの先頭に
ジャンプして一時停止します。最終クリップ
の操作中は、クリップの最終にジャンプして
一時停止します。
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ˎˎ F REV中または一時停止中に押すと、次のク
リップの先頭にジャンプして静止画を表示し
ます。

ˎˎ 続けて押すと、押すたびに1つずつ後ろのク
リップに移動します。

最後のクリップにジャンプ
する

F FWDボタンとNEXTボタンを同時に押すと、
SxSメモリーカードの最後に記録されたクリッ
プの最終画にジャンプします。

再生中にショットマークを
追加する

記録時と同じ操作で（54ページ）、再生中のクリッ
プにショットマークを追加することができます。

［ご注意］
SxSメモリーカードがプロテクトされている場合には
ショットマークは記録できません。

再生を終了する

STOPボタンを押す：再生が停止し本機は E-E
モードになります。

THUMBNAILボタンを押す：再生が停止し、ビ
ューファインダー画面にサムネイル画面
（90ページ）が表示されます。

再生中にメモリーカードを取り出した場合も、
再生が停止し、ビューファインダー画面にカメ
ラ画が表示されます。

Thumbnailメニューの基
本操作

クリップの保護／削除、詳細情報の確認、クリッ
プへのクリップフラグやクリップのフレームへ
のエッセンスマークの付加／削除などの操作に
はThumbnailメニューを使用します。

1	 THUMBNAILボタンを押す。
サムネイル画面が表示されます。

2	 MENU ON/OFFスイッチをONにするか
MENUボタンを押す。
メニュー画面が表示されます。

3	 MENUつまみを回してThumbnailを選択
し、MENUつまみを押す。
、ボタンを押してThumbnailを選択し、
SETボタンを押して表示することもできま
す。

Thumbnailメニューを消すときは、もう一度
MENUボタンを押します。

メニュー項目／細目を選択するには、次のいず
れかの操作を行います。

ˎˎ MENUつまみを回して項目／細目を選択し、
つまみを押す。

ˎˎ 矢印（、、、）ボタンを押して項目／
細目を選択し、SETボタンを押す。
選択したメニュー項目／細目に応じて、選択リ
ストまたはクリップの詳細情報画面（94ペー
ジ）が表示されます。
MENU CANCEL/PRST/ESCAPEスイッチを
ESCAPE側に押し下げると、1つ上の階層に戻り
ます。

［ご注意］

ˎˎ SxSメモリーカードがプロテクトされているときは、ク
リップのコピー・削除、代表画の変更、クリップフラグ・
ショットマークの付加／削除はできません。
ˎˎ メニューを表示させたときの状態によって選択できな
い項目があります。

Thumbnailメニュー構成は「Thumbnailメ
ニュー」（96ページ）をご覧ください。

クリップを保護する

特定のクリップまたはすべてのクリップを保護
して、クリップを削除できない状態にすること
ができます。

保護されたクリップのサムネイルには が付き
ます。
クリップの保護操作は、サムネイル画面または
フィルタードクリップサムネイル画面（95
ページ）で行います。

［ご注意］

ˎˎ ファイルシステムがFATに設定されているとき、この機
能は使用できません。

ˎˎ 1スロット同時記録で作成したクリップはサブクリップ
も保護されます。

特定クリップの保護

1	メニューのThumbnail >Lock/Unlock Clip 
>Select Clipを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
クリップの選択画面が表示されます。

3	 MENUつまみを回して保護するクリップを
選択し、つまみを押す。
選択したクリップにチェックマークが付き
ます。

4	 SHIFTボタンを押しながらSETボタンを押
す。
確認画面が表示されます。

5	 MENUつまみを回してExecuteを選択し、
つまみを押す。
クリップが保護され、完了メッセージが表
示されます。

6	 MENUつまみを押してメッセージを消す。

すべてのクリップの保護

1	メニューのThumbnail >Lock/Unlock Clip 
>Lock All Clipsを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
確認画面が表示されます。



000 6章　クリップ操作：サムネイル画面でのクリップ操作について93

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
すべてのクリップが保護され、完了メッセー
ジが表示されます。

4	 MENUつまみを押してメッセージを消す。

すべてのクリップの保護の解除

1	メニューのThumbnail >Lock/Unlock Clip 
>Unlock All Clipsを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
すべてのクリップの保護が解除され、完了
メッセージが表示されます。

4	 MENUつまみを押してメッセージを消す。

クリップをコピーする

クリップを別のSxSメモリーカードにコピーす
ることができます。
コピー先のSxSメモリーカードには同じクリッ
プ名でコピーされます。

［ご注意］

ˎˎ コピー先のSxSメモリーカードに同名のクリップが存在
している場合は、オリジナルのクリップ名に1桁の括弧
数字を付加したクリップ名でコピーされます。 
括弧数字は、コピー先に存在しない最小値になります。 
例: 
ABCD0002ABCD0002(1) 
ABCD0002(1)ABCD0002(2) 
ABCD0005(3)ABCD0005(4)
ˎˎ コピー回数が1000回を超えた場合など、括弧数字(1)～

(999)がすでに存在するカードには、それ以上コピーで
きません。
ˎˎ コピー先のSxSメモリーカードの残量が不足していると
きはメッセージが表示されますので、コピー先のSxSメ
モリーカードを交換してください。
ˎˎ コピー元のSxSメモリーカードに複数のクリップが記録
されている場合は、コピー先のSxSメモリーカードが同
じ容量であっても、使用条件やメモリーの特性などに
より、すべてのクリップを最後までコピーできない場
合があります。
ˎˎ 1スロット同時記録で作成したクリップをコピーした場
合、メイン/サブクリップともにコピーされます。

特定クリップのコピー

1	メニューのThumbnail >Copy Clip >Select 
Clipを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
クリップの選択画面が表示されます。

3	 MENUつまみを回してコピーするクリップ
を選択し、つまみを押す。
選択したクリップにチェックマークが付き
ます。

4	 SHIFTボタンを押しながらSETボタンを押
す。
確認画面が表示されます。

5	 MENUつまみを回してExecuteを選択し、
つまみを押す。
クリップがコピーされ、完了メッセージが
表示されます。

6	 MENUつまみを押してメッセージを消す。

クリップの一括コピー

同じSxSメモリーカードに記録されているク
リップを、別のSxSメモリーカードにまとめて
コピーすることができます。

1	メニューのThumbnail >Copy Clip >All 
Clipsを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
すべてのクリップがコピーされ、完了メッ
セージが表示されます。

4	 MENUつまみを押してメッセージを消す。

クリップを削除する

SxSメモリーカードからクリップを削除するこ
とができます。クリップの削除操作は、サムネ
イル画面またはフィルタードクリップサムネイ
ル画面（95ページ）で行います。

［ご注意］
1スロット同時記録で作成したクリップを削除した場合、
メイン/サブクリップともに削除されます。

1	メニューのThumbnail >Delete Clip 
>Select Clipを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
クリップの選択画面が表示されます。

3	 MENUつまみを回して削除するクリップを
選択し、つまみを押す。
選択したクリップにチェックマークが付き
ます。

4	 SHIFTボタンを押しながらSETボタンを押
す。
確認画面が表示されます。

5	 MENUつまみを回してExecuteを選択し、
つまみを押す。
クリップが削除され、完了メッセージが表
示されます。

6	 MENUつまみを押してメッセージを消す。

サムネイル画面では、削除したクリップの次以
降が1つずつ繰り上がります。

クリップの一括削除

同じSxSメモリーカードに記録されているク
リップをまとめて削除することができます。

［ご注意］

ˎˎ 削除したクリップを復元することはできません。
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ˎˎ メディアやクリップが保護されている場合は、この機
能を使用することはできません。

1	メニューのThumbnail >Delete Clip >All 
Clipsを選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
すべてのクリップが削除され、完了メッセー
ジが表示されます。

4	 MENUつまみを押してメッセージを消す。

クリップを転送する

メニューのThumbnail >Transfer Clip、または
Transfer Clip(Proxy)でSxSメモリーカードのク
リップ（オリジナルファイル）やSDカードに記
録したプロキシファイルを任意のサーバーへ転
送できます。
Thumbnail >Transfer Clipの操作手順は、「本
機のサムネイル画面でオリジナルファイルを転
送する」（76ページ）をご覧ください。
Thumbnail >Transfer Clip(Proxy)の操作手順
は、「本機のサムネイル画面でプロキシファイル
を転送する」（75ページ）を参照ください。

［ご注意］
1スロット同時記録で作成したクリップをメニューの
Thumbnail >Transfer Clipで転送した場合、メインクリッ
プのみが転送されます。

クリップの詳細情報を表示する

メニューのThumbnail >Display Clip Propertiesを選択すると、選択しているクリップの詳細情報
画面が表示されます。

1

2

3

4

5

6
7

OK S Sub

1. 現在のクリップ画像
選択しているクリップの代表画とクリップの状
態が表示されます。

2. タイムコード表示
TC Index：表示されている画像のタイムコード
Start：記録開始点のタイムコード
End：記録終了点のタイムコード
Duration：収録時間

3. 収録日時と変更日時

4. クリップ名

5. 記録フォーマット
Video Codec：ビデオコーデック
Size：画サイズ
FPS：フレームレート
Audio Codec：音声コーデック
Ch/Bit：音声記録チャンネル／音声記録ビット数

6. 特殊記録撮影情報

7. 収録機器名

クリップの詳細情報画面を消すには、次のいず
れかの操作を行います。
RESET/RETURNボタンを押す：Thumbnailメ
ニュー画面に戻ります。

THUMBNAILボタンを押す：本機は E-Eモード
になり、カメラ画が表示されます。

PLAY/PAUSEボタンを押す：選択されているク
リップから再生が始まります。

クリップにクリップフラグ
を付ける

クリップにクリップフラグ（OK、NG、KPマーク）
を付けると、クリップフラグを基準にクリップ

を絞り込んで表示することができます。この操
作は、サムネイル画面またはフィルタードクリッ
プサムネイル画面（95ページ）で行います。

［ご注意］
ファイルシステムがFATに設定されているとき、この機能
は使用できません。

1	クリップフラグを付けたいクリップのサム
ネイルを選択し、メニューのThumbnail 
>Set Clip Flagを選択する。

2	 MENUつまみを回してクリップフラグを選
択し、つまみを押す。

設定値 付加されるクリップフラグ
Add OK OK
Add NG NG
Add KEEP KP

選択したクリップのサムネイルにクリップ
フラグが付けられます。

クリップフラグ機能を割り当てたアサイナブル
スイッチ使用してクリップフラグを付けること
もできます（131ページ）。

クリップフラグを削除する

1	クリップフラグを削除したいクリップのサ
ムネイルを選択し、メニューのThumbnail 
>Set Clip Flag >Delete Clip Flagを選択す
る。
クリップフラグが削除されます。
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フィルタードクリップ画面
で表示するクリップを絞り
込む

［ご注意］
ファイルシステムがFATに設定されているとき、この機能
は使用できません。

1	メニューのThumbnail >Filter Clipsを選択
する。

2	 MENUつまみを回して絞り込み対象のク
リップフラグを選択し、つまみを押す。

設定値 絞り込み対象のクリップフラグ
OK OK
NG NG
KEEP KP
None なし（絞り込まない）

選択したクリップフラグで絞り込まれたク
リップ画面が表示されます。この画面をフィ
ルタードクリップ画面と呼びます。

絞り込みを解除するには、次のいずれかの操作
を行います。

ˎˎ RESET/RETURNボタンを押す。
ˎˎ メニューのThumbnail >Thumbnail View 
>Allを選択する。

クリップにエッセンスマー
クを付ける／削除する

クリップの任意の位置のフレームにエッセンス

マーク（ショットマーク、レックスタートマーク）
を付加／削除することができます。エッセンス
マークの付加／削除は、エッセンスマークサム
ネイル画面で行います。

［ご注意］
ファイルシステムがFATに設定されているとき、この機能
は使用できません。

ショットマークの付加

1	メニューのThumbnail > Thumbnail View 
> Essence Mark Thumbnailを選択する。

2	 MENUつまみを回してAllを選択し、つまみ
を押す。

3	エッセンスマークサムネイル画面でショッ
トマークを付けるフレームのサムネイルを
選択し、メニューのThumbnail >Set Shot 
Markを選択する。

4	 MENUつまみを回して次のいずれかを選択
し、つまみを押す。

設定値 動作

Add Shot Mark1 Shot Mark1を付ける
Add Shot Mark2 Shot Mark2を付ける

選択したフレームにショットマークが付け
られます。

ショットマークの削除

1	メニューのThumbnail > Thumbnail View 
> Essence Mark Thumbnailを選択する。

2	削除するショットマークの種類を選択する。

3	エッセンスマークサムネイル画面でショッ
トマークを削除するフレームのサムネイ
ルを選択し、メニューのThumbnail >Set 
Shot Markを選択する。

4	 MENUつまみを回して次のいずれかを選択
し、つまみを押す。

設定値 動作

Delete Shot Mark1 Shot Mark1を削除する
Delete Shot Mark2 Shot Mark2を削除する

選択したフレームのショットマークが削除
されます。

エッセンスマークサムネイ
ル画面でクリップ（フレー
ム）を絞り込む

エッセンスマークサムネイル画面は、クリップ
に1つ以上のエッセンスマークが記録されてい
る場合に、エッセンスマークの付加されている
フレームだけをサムネイル形式で表示します。
サムネイル画面を表示して、ESSENCE MARKボ
タン（10ページ）を押すか、次の手順で表示
することができます。

［ご注意］
ファイルシステムがFATに設定されているとき、この機能
は使用できません。

1	メニューのThumbnail >Thumbnail View 
>Essence Mark Thumbnailを選択する。

2	 MENUつまみを回して絞り込み対象のエッ
センスマークを選択し、つまみを回す。

設定値 内容

All エッセンスマークが付いた
すべてのフレームが対象

Rec Start レックスタートマークがつ
いているフレームおよび先
頭フレームにレックスター
トマークが付いていないク
リップの先頭フレームが対
象

Shot Mark0～
Shot Mark9

各ショットマークが付いた
フレームが対象

選択したエッセンスマークで絞り込まれた
エッセンスマークサムネイル画面が表示さ
れます。

ショットマーク0～ショットマーク9の名前を
定義したプランニングメタデータを使用してク
リップを記録した場合は、リストの選択項目が
定義した名前になります。

クリップの代表画を変更す
る

エッセンスマークサムネイル画面で選択したフ
レームをクリップの代表画にすることができま
す。
代表画にしたいフレームのサムネイルを選択し、
メニューのThumbnail >Set Index Pictureで選
択したフレームがクリップの代表画に設定され
ます。
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Thumbnailメニュー
太字とアンダーラインで表示されている設定値は、出荷時の設定です。

項目 細目と設定値 内容
Display Clip 
Properties

― クリップの詳細情報を表示する（94ペー
ジ）。

Set Index Picture ― クリップの代表画フレームを設定・変更する
（95ページ）。

Thumbnail View
表示するサムネイル画面
を変更します。

Essence Mark Thumbnail
All/Rec Start/Shot Mark1/
Shot Mark2/Shot Mark3/
Shot Mark4/Shot Mark5/
Shot Mark6/Shot Mark7/
Shot Mark8/Shot Mark9/
Shot Mark0

エッセンスマークでクリップを絞り込んだ
エッセンスマークサムネイル画面を表示する
（95ページ）。

Clip Thumbnail サムネイル画面（クリップサムネイル画面）を
表示する（90ページ）。

Set Shot Mark
ショットマークの付加／
削除を行います。

Add Shot Mark1 フレームにショットマーク1を付ける（95
ページ）。

Delete Shot Mark1 ショットマーク1を削除する（95ページ）。

Add Shot Mark2 フレームにショットマーク2を付ける（95
ページ）。

Delete Shot Mark2 ショットマーク2を削除する（95ページ）。

Set Clip Flag
クリップフラグの付加／
削除を行います。

Add OK クリップにOKフラグを付ける（94ページ）。

Add NG クリップにNGフラグを付ける（94ページ）。

Add KEEP クリップにKP（KEEP）フラグを付ける（94
ページ）。

Delete Clip Flag クリップフラグを削除する（94ページ）。
Lock/Unlock Clip
クリップの保護／保護解
除を行います。

Select Clip 設定対象のクリップを選択する（92ペー
ジ）。

Lock All Clips メディアのすべてのクリップを保護する
（92ページ）。

Unlock All Clips メディアのすべてのクリップの保護を解除す
る（93ページ）。

Copy Clip
クリップのコピーを行い
ます。

Select Clip コピー対象のクリップを選択する（93ペー
ジ）。

All Clips メディアのすべてのクリップをコピーする
（93ページ）。

項目 細目と設定値 内容
Copy Sub Clip 
サブクリップを別のメ
ディアにメインクリップ
としてコピー保存しま
す。

All Clips コピー対象のすべてのサブクリップを選択す
る（59ページ）。

Delete Clip
クリップの削除を行いま
す。

Select Clip 削除対象のクリップを選択する（93ペー
ジ）。

All Clips メディアのすべてのクリップを削除する
（93ページ）。

Transfer Clip
転送するオリジナルファ
イルをジョブリストに登
録します。

Select Clip オリジナルファイルをファイル転送対象とし
て選択する（76ページ）。

All Clips メディアのすべてのオリジナルファイルを
ファイル転送対象として選択する（76ペー
ジ）。

Transfer Clip(Proxy)
転送するプロキシファイ
ルをジョブリストに登録
します。

Select Clip オリジナルファイルに対応しているプロキシ
ファイルをファイル転送対象として選択する
（75ページ）。

All Clips オリジナルファイルに対応しているメディア
のすべてのプロキシファイルをファイル転送
対象として選択する（75ページ）。

Filter Clips
クリップフラグでクリッ
プ表示を絞り込みます。

OK OKフラグでクリップ表示を絞り込む（95
ページ）。

NG NGフラグでクリップ表示を絞り込む（95
ページ）。

KEEP KP（KEEP）フラグでクリップ表示を絞り込む
（95ページ）。

None 絞り込みを行わない（95ページ）。
Customize View Thumbnail Caption

Date Time/Time Code/
Duration/Sequential 
Number

サムネイルのクリップ直下の情報表示選択す
る。
Date Time：日時時刻を表示する。
Time Code：タイムコードを表示する。
Duration：クリップの収録時間を表示する。
Sequential Number：クリップの通し番号を
表示する。
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セットアップメニューの構成
本機では、ビューファインダー画面に表示され
るセットアップメニューを使用して、撮影や再
生に必要な各種の設定を行います。
セットアップメニューは、外部ビデオモニター
に表示する（145ページ）こともできます。

メニュー構成

Userメニュー
ユーザーがセットアップメニューを任意の
順番で配置するときに使用するメニューで
す。（101ページ）

Operationメニュー
撮影に関する設定（画質関連以外）をすると
きに使用するメニューです。

Paintメニュー
画質に関する設定をするときに使用するメ
ニューです。

Thumbnailメニュー
クリップのサムネイルに関する設定をする
ときに使用するメニューです。（96ペー
ジ）

 ［ご注意］
Thumbnailメニューは、サムネイル画面（90ペー
ジ）を表示しているときのみ使用できます。サムネイ
ル画面を表示していないときは無効です。

Maintenanceメニュー
本機のメンテナンスやシステム管理関連の
設定をするときに使用するメニューです。

Fileメニュー
各種ファイル操作をするときに使用するメ
ニューです。

各メニュー項目について

Operationメニュー

項目 概要 参照先

Format システム設定 104
Base Setting ダイナミックレンジ

モードの設定
104

HDR Setting HDR設定 104
Format Media メディアフォーマット 105

Input/Output 入出力信号設定 105
Super Impose スーパーインポーズ設

定
106

LCD LCDモニター設定 106
Rec Function 特殊記録モード設定 106
XAVC Proxy 
Rec Mode

プロキシデータ設定 107

Assignable 
Switch

アサイナブルスイッチ
への機能割り当て

107

VF Setting ビューファインダー設
定

107

Marker マーカー表示 108
Gain Switch ゲイン値設定 108
Auto Iris オートアイリス設定 108
Zebra ゼブラ設定 109
Display On/
Off

ビューファインダー表
示項目設定

109

"!"LED ビューファインダー
"!"設定

110

White Setting ホワイトバランス設定 110

Offset White オフホワイト設定 111
Shutter シャッター設定 111
Slow Shutter スローシャッター設定 111

Time Zone 時差設定 111
Clip クリップ設定 111

項目 概要 参照先

Update Media メディア管理情報アッ
プデート

111

GPS 測位情報（GPS）設定 112

Planning 
Metadata

プランニングメタデー
タ設定

112

USB USBメディアへのコ
ピー設定 

112

Flash Band 
Reduce

フラッシュバンド現象
補正設定

112

Paintメニュー

項目 概要 参照先

Switch Status 補正機能、テスト信号
ON/OFF設定

113

HDR Paint 
Setting

HDR設定 113

White 色温度設定 113
Black ブラックレベル設定 113
Flare フレア補正設定 113
Gamma(HDR) HDRガンマ設定 114
Gamma ガンマ補正設定 114
Black Gamma ブラックガンマ補正設

定
114

Knee ニー補正設定 115
White Clip ホワイトクリップ設定 115

Detail（QFHD) QFHDディテール設定 115
Detail（HD) HDディテール設定 115
Detail（SD) SDディテール設定 115
Aperture アパーチャー補正設定 116

Skin Detail スキンディテール補正
設定

116

Matrix マトリクス補正設定 116
Multi Matrix マルチマトリクス補正

設定
116
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項目 概要 参照先

V Modulation Vモジュレーション
シェーディング補正設
定

117

Low Key 
Saturation

ローキーサチュレー
ション補正設定

117

Saturation 
Mode

サチュレーション補正
設定

117

Noise 
Suppression

ノイズサプレス設定 117

Maintenanceメニュー

項目 概要 参照先

White 
Shading

ホワイトシェーディン
グ補正設定

119

Black Shading ブラックシェーディン
グ補正設定

119

Battery バッテリー設定 119
DC Voltage 
Alarm

外部DC電源電圧ア
ラーム設定

119

Audio オーディオ設定 119
WRR Setting ワイヤレスチューナー

設定
121

Time Code タイムコード設定 122
Essence Mark エッセンスマーク設定 122

Camera 
Config

カムコーダー動作設定 122

Preset White プリセットホワイト設
定

123

White Filter フィルター設定 123
DCC Adjust DCC設定 123
Flicker 
Reduce

フリッカー補正設定 124

Genlock ゲンロック設定 124
Auto Shading オートブラックシェー

ディング補正設定
124

APR APR設定 124

項目 概要 参照先

Basic 
Authentication

Basic認証設定 124

Network ネットワーク接続設定 124

Network 
Client Mode

ネットワーククライア
ントモード設定

126

File Transfer Wi-Fi転送設定 126
Streaming ストリーミング設定 127
Clock Set 内蔵時計設定 127
Language メッセージ表示言語設

定
127

Hours Meter デジタル時計設定 127
Network 
Reset

ネットワークリセット 127

Fan Control ファン制御設定 128
VF Display 
Setting

ビューファインダー表
示設定

128

Option ソフトウェアオプショ
ン設定

128

Version バージョン設定 128

Fileメニュー

項目 概要 参照先

User File ユーザーファイル設定 129

All File ALLファイル設定 129
Scene File シーンファイル設定 129
Reference File リファレンスファイル

設定
129

Lens File レンズファイル設定 130
User Gamma ガンマファイル設定 130
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セットアップメニューを表
示する

MENU ON/OFFスイッチをONにするかMENU
ボタンを押します。
本機がメニューモードになり、画面にメニュー
リストが表示されます。

以下は、Operationメニューにカーソルがある
場合の画面例です。

メニューリスト

メニュー項目項目選択エリア

［ご注意］
拡大フォーカス（Focus Mag）モードになっていると、セッ
トアップメニューは操作できません。Focus Magが割り
当てられているアサイナブルスイッチで拡大フォーカス
モードを解除してください。

メニューを設定する

1	 MENUつまみを回すか、、ボタンを押し
て、設定したいメニューにカーソルを合わ
せる。
メニューリスト右のメニュー項目選択エリ
アに、選択できるメニュー項目が表示され
ます。

2	 MENUつまみまたはSETボタンを押す。
メニュー項目選択画面が表示されます。 
ボタンを押してメニュー項目選択画面を
表示することもできます。

ˎˎ メニュー項目選択エリアは最大7行表示で
す。選択できる項目が一度に表示できな
い場合は、カーソルを上下に移動すると
表示がスクロールします。

メニュー表示選択エリア
ˎˎ 選択した項目に細目がある場合は、
右に細目が表示されます。
ˎˎ 細目がない場合は、右に現在の設
定値が表示されます。
ˎˎ Backを選択すると1つ上の階層に
戻ります。

メニュー項目がまだ下にある
ときに表示されます。

3	 MENUつまみを回すか、、ボタンを押し
て、設定したいメニュー項目にカーソルを
合わせ、MENUつまみまたはSETボタンを押
して決定する。
メニュー項目選択エリアの右に設定エリア
が表示され、カーソルが先頭の細目に移動
します。

設定エリア
ˎˎ 細目と現在の設定値が表示されます。
ˎˎ Backを選ぶかボタンを押す、また
はMENU CANCEL/PRST/ESCAPEス
イッチをESCAPE側に押し下げると1
つ上の階層に戻ります。

4	 MENUつまみを回すか、、ボタンを押
して、設定したい細目にカーソルを合わせ、
MENUつまみまたはSETボタンを押して決定
する。
選択した細目の選択肢が表示され、現在選
択されている値にカーソルが移動します。

選択肢エリア

ˎˎ 選択肢エリアは最大9行表示です。選択肢
が一度に表示できない場合は、カーソル
を上下に移動すると表示がスクロールし
ます。

ˎˎ 選択肢の範囲が大きい項目の場合（例：
–99～ +99）は、選択肢エリアは表示さ
れません。文字がハイライト表示になり
設定変更が可能な状態であることを示し
ます。

5	 MENUつまみを回すか、、ボタンを押し
て、設定したい値を選び、MENUつまみま
たはSETボタンを押して決定する。
設定が変更され、変更後の状態が表示され
ます。
実行項目でExecuteを選択した場合は、対応
する機能が実行されます。

実行前に確認が必要な項目の場合、手順3で、
実行前に確認が必要な項目を選択すると、いっ
たんメニューが消え、確認メッセージが表示さ
れます。メッセージに従って、実行するかキャ
ンセルするかを選択してください。

文字列を入力する

ファイル名など、文字列を設定する項目を選択
した場合は、文字列の入力画面が表示されます。

1

2 3

1	 MENUつまみを回して入力したい文字タイ
プを選択して、MENUつまみまたはSETボタ
ンを押す。
ABC：英大文字
abc：英小文字
123：数字
!#$：特殊文字

セットアップメニューの基本操作
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2	選択した文字タイプから文字を選択し、決
定する。
カーソルが次の欄に移動します。
Space：カーソルの位置にスペースを入力
します。

/：カーソル位置を移動します。
BS：カーソルの左の文字を削除します。

3	入力が終わったら、Doneを選択し、決定す
る。
文字列が確定され、入力画面が消えます。

設定変更を取り消す

1	 MENU CANCEL/PRST/ESCAPEスイッチを
ESCAPE側に押し下げる。

メニュー操作を終了する

1	 MENU ON/OFFスイッチをOFFにするか
MENUボタンを押す。
通常のカメラ画に戻ります。

メニューをロック／解除す
る

セットアップメニューの表示をロックして、
Userメニューだけを表示させることができま
す。

メニューをロックする

1	 MENUつまみを押しながら、MENU ON/
OFFスイッチを押し下げて、セットアップ
メニューを表示する。

2	メニューのMaintenance >Camera Config 
>User Menu with Lockを表示する。

 ［ご注意］

ˎˎ MENUつまみを押しながら、MENU ON/OFFス
イッチを押し下げると、Camera Config >User 
Menu OnlyがUser Menu with Lockに切り換わり
ます。
ˎˎ MENUつまみを押さずにMENU ON/OFFスイッ
チを押し下げる、またはMENUボタンを押してメ
ニュー表示した場合は、Camera Config>User 
Menu with Lockは表示されません。

3	 Onを選択してMENUつまみを押す。
ビューファインダー画面表示が、暗証番号
入力画面に切り換わります。

4	任意の暗証番号を入力する。
入力できる数値は4桁の0000～ 9999にな
ります。初期値は0000です。
数値を入力してMENUつまみを押すと、カー
ソルが次の桁に移動します。
すべての桁を入力したら、Setにカーソルが
移動します。

5	 Setにカーソルがある状態で、MENUつまみ
を押す。
入力が確定します。
設定が完了したメッセージが表示され、
Userメニューだけのメニュー表示に切り換
わります。

[ご注意]

ˎˎ 下表に示すセットアップメニューをUserメニューに登
録しないでロックすると、そのセットアップメニュー
と同じ機能をアサイナブルスイッチに割り当てできな
くなります。
ˎˎ 下表に示す機能をアサイナブルスイッチに割り当てて
いる状態で、その機能と同じセットアップメニューを
ロックすると、アサイナブルスイッチに割り当てた機
能の設定は強制的にOffになります。

セットアップメニュー アサイナブルス
イッチへの割り当
て可能機能

Operation>Rec Function 
>Picture Cache Rec

Picture Cache Rec

Operation >Rec Function 
>Clip Continuous Rec

Clip Continuous 
Rec

Operation >Rec Function 
>Slow & Quick Motion

Slow & Quick 
Motion

Operation >VF Setting 
>Color Mode

VF Mode

Operation >Display On/
Off >Video Signal Monitor

Video Signal 
Monitor

Operation >Display On/
Off >Lens Info

Lens Info

Operation >Auto Iris 
>Mode

Spotlight
Backlight

Operation >Marker 
>Setting

Marker

Maintenance >Audio 
>Front MIC Select

Front MIC

Maintenance >Network 
Client Mode >Setting

Network Client 
Mode

Maintenance >File 
Transfer >Auto 
Upload(Proxy)

Auto 
Upload(Proxy)

メニューのロックを解除する

1	 MENUつまみを押しながら、MENU ON/
OFFスイッチを押し下げて、セットアップ
メニューを表示する。

2	メニューのUser >Camera Config >User 
Menu with Lockを表示する。

 ［ご注意］

ˎˎ MENUつまみを押しながら、MENU ON/OFFス
イッチを押し下げると、Camera Config >User 
Menu OnlyがUser Menu with Lockに切り換わり
ます。
ˎˎ MENUつまみを押さずにMENU ON/OFFスイッ
チを押し下げる、またはMENUボタンを押してメ
ニュー表示した場合は、Camera Config >User 
Menu with Lockは表示されません。

3	 Offを選択してMENUつまみを押す。
ビューファインダー画面表示が、暗証番号
入力画面に切り換わります。

4	メニューをロックしたときの暗証番号を入
力する。
入力できる数値は4桁の0000～ 9999です。
数値を入力してMENUつまみを押すと、カー
ソルが次の桁に移動します。
すべての桁を入力したら、Setにカーソルが
移動します。

5	 Setにカーソルがある状態で、MENUつまみ
を押す。
入力が確定します。
メニューをロックしたときの暗証番号と入
力した番号が一致した場合、ロックが解除
できたことのメッセージが表示され、全メ
ニュー表示に切り換わります。

 ［ご注意］

ˎˎ メニューをロックしたときの暗証番号と入力した
番号が不一致の場合は、ロックを解除できません。
ˎˎ 暗証番号は、忘れたときのために、手元に記録を
残すことをおすすめします。忘れたときは、サー
ビス窓口にお問い合わせください。
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UserメニューのEdit User Menuで項目の追加
や削除、順番の入れ換えなどを行い、Userメ
ニューをより使いやすく編集することができま
す。
Operationメニュー、Paintメニュー、
Maintenanceメニューの任意の項目、および
一部のFileメニューの項目を選択して、Userメ
ニューに追加することができます。
Userメニューには項目を20個まで登録できま
す。工場出荷時には6項目登録されていますが、
そのうちの1項目は削除できないため、新規に
19個まで項目を追加できます。

［ご注意］
メニューロック中は編集できません。

Edit User Menu画面を表
示する

Userメニューの編集はEdit User Menu画面で
行います。

1	 MENUつまみを回してメニューのUser 
>Edit User Menuを選択し、つまみを押す。

Edit User Menu画面が表示されます。

項目／細目を追加する

1	 MENUつまみを回してEdit User Menu 
>Add Itemを選択し、つまみを押す。
追加が可能な項目が表示されます。

2	 MENUつまみを回して追加する項目を選択
し、つまみを押す。
追加する細目を選択する画面が表示されま
す。

3	 MENUつまみを回して追加する細目を選択
し、つまみを押す。
すべての細目を追加する場合はAllにチェッ
クを付けます。
追加する細目を指定する場合は、追加する
細目にチェックを付けます。

4	 MENUつまみを回してOKを選択し、つまみ
を押す。
項目／細目の追加が完了します。

［ご注意］
同じ項目／細目を2回登録することはできません。また追
加した項目／細目の名称を変更することはできません。

項目の細目を編集する

表示する項目を任意に設定することができます。

1	 Edit User Menuを表示する。

2	 MENUつまみを回して編集する項目を選択
し、つまみを押す。
編集機能リストが表示されます。

3	 MENUつまみを回して編集機能リストの
Edit Sub Itemを選択し、つまみを押す。

Edit Sub Item画面が表示されます。

最初に開いたときは、すべての細目にチェッ
クが付いています（すべての細目が表示され
る状態）。
細目のチェックを外すとUserメニューに表
示されなくなります。

4	 MENUつまみを回してOKを選択し、つまみ
を押す。
編集が完了します。

項目を削除する

1	 Edit User Menuを表示する。

2	 MENUつまみを回して編集する項目を選択
し、つまみを押す。
編集機能リストが表示されます。

3	 MENUつまみを回して編集機能リストの
Deleteを選択し、つまみを押す。

項目が削除されます。

項目を移動する

1	 Edit User Menuを表示する。

2	 MENUつまみを回して移動する項目を選択
し、つまみを押す。
編集機能リストが表示されます。

Userメニューの編集
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3	 MENUつまみを回して編集機能リストの
Moveを選択し、つまみを押す。

移動する項目がハイライトされ、移動先を
示す三角マークと線が表示されます。

移動先を示す三角マークと線

4	 MENUつまみを回して三角マークと線を移
動先に合わせ、つまみを押す。
項目が移動します。

Userメニューを工場出荷
時の状態に戻す

1	 MENUつまみを回してEdit User Menu 
>Customize Resetを選択し、つまみを押す。
Customize Reset画面が表示されます。

2	 MENUつまみを回してResetを選択し、つま
みを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。
Userメニューが工場出荷時の状態に戻りま
す。
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工場出荷時のUserメニューには以下の項目が含まれています。
ˎˎ Format Media（105ページ）
ˎˎ Rec Function（106ページ）
ˎˎ Input/Output（105ページ）
ˎˎ Clip（111ページ）
ˎˎ Assignable Switch1)（107ページ）
ˎˎ Camera Config2)（122ページ）

1) 細目<0>を除く
2) 細目はUser Menu Onlyのみ

Userメニューの編集については、「Userメニューの編集」（101ページ）をご覧ください。

Userメニュー（工場出荷時の構成）
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Operationメニュー
太字とアンダーラインで表示されている設定値は、出荷時の設定です。

Operation >Format
使用するシステム周波数、ファイルシステム、記録フォーマット、記録アスペクトを設定します。

項目 設定値 内容
Frequency 59.94/50/29.97/25/23.98 システム周波数を選択する（Executeで実行）。

［ご注意］
システム周波数の変更に連動して、そのシステム周波
数で以前設定していたRec Formatに切り換わります。

File System exFAT/UDF/FAT ファイルシステムを切り換える（Executeで実
行）。

Rec Format システム周波数の設定に応じて
変わる。

記録フォーマットを選択する（Executeで実
行）。

XAVC-I 3840×2160P
XAVC-I 1920×1080P
XAVC-I 1920×1080i
XAVC-I 1280×720P
XAVC-L 3840×2160P
XAVC-L 50 1920×1080P
XAVC-L 50 1920×1080i
XAVC-L 50 1280×720P
XAVC-L 35 1080P
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HD422 50 720P
HQ 1920×1080i
HQ 1440×1080i
HQ 1280×720P
MPEG IMX 50
DVCAM

ファイルシステムがexFAT、システム周波数が
59.94または50のとき

XAVC-I 3840×2160P
XAVC-I 1920×1080P
XAVC-L 3840×2160P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HD422 50 720P
HQ 1920×1080P

ファイルシステムがexFAT、システム周波数が
29.97、25または23.98のとき

Operation >Format
使用するシステム周波数、ファイルシステム、記録フォーマット、記録アスペクトを設定します。

項目 設定値 内容
Rec Format HD422 50 1080i

HD422 50 720P
HQ 1920×1080i
HQ 1440×1080i
HQ 1280×720P
MPEG IMX 50
DVCAM

ファイルシステムがUDF、システム周波数が
59.94または50のとき

HD422 50 1080P
HD422 50 720P
HQ 1920×1080P

ファイルシステムがUDF、システム周波数が
29.97、25または23.98のとき

HQ 1920×1080i
HQ 1440×1080i 
HQ 1280×720P 
SP 1440×1080i

ファイルシステムがFAT、システム周波数が
59.94または50のとき

HQ 1920×1080P ファイルシステムがFAT、システム周波数が
29.97、25または23.98のとき

Aspect Ratio (SD) 16:9/4:3 SDモードのアスペクト比を選択する。

Audio Length 24bit/16bit IMXフォーマット時のオーディオ記録のビット
数を選択する。

Operation >Base Setting
撮像に使用するダイナミックレンジを設定します。

項目 設定値 内容
Shooting Mode SDR/HDR SDR：従来の標準的なダイナミックレンジの撮

像モードに設定する。
HDR：ダイナミックレンジを拡大した撮像モー
ドに設定する。

Operation >HDR Setting
HDR運用時の4K(QFHD)側とHD側それぞれの記録と出力系統を設定します。色域はHDR(HLG)時は
ITU-R BT.2020、HDR(S-Log3)時はITU-R BT.2020またはS-Gamut3/S-Gamut3.Cineから選択します。

項目 設定値 内容
4K(QFHD) Rec/Out HDR(HLG)/HDR(S-Log3) HDR(HLG)：4K(QFHD)側の記録と出力をHLG

に設定する。
HDR(S-Log3)：4K(QFHD)側の記録と出力を

S-Log3に設定する。
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Operation >HDR Setting
HDR運用時の4K(QFHD)側とHD側それぞれの記録と出力系統を設定します。色域はHDR(HLG)時は
ITU-R BT.2020、HDR(S-Log3)時はITU-R BT.2020またはS-Gamut3/S-Gamut3.Cineから選択します。

項目 設定値 内容
HD Rec/Out HDR(HLG)/SDR 4K(QFHD) Rec/Out設定がHDR(HLG)のときに

有効。
HDR(HLG)：HD側の記録と出力をHLG設定に
設定する。

SDR ：HD側の記録と出力をSDR設定に設定す
る。

［ご注意］
4K(QFHD) Rec/Out設定がHDR(S-Log3)のときは
SDR固定となります。

SDR Gain 0dB～－6dB～－15dB HD Rec/OutがSDRのとき、HDRに対するSDR
側のゲインを調整する。

S-Log Color Space BT.2020/ 
S-Gamut3(3200K)/ 
S-Gamut3(4300K)/ 
S-Gamut3(5500K)/ 
S-Gamut3.Cine(3200K)/ 
S-Gamut3.Cine(4300K)/ 
S-Gamut3.Cine(5500K)

S-Gamut3：ソニー独自のITU-R BT.2020を 
カバーする広い色域

S-Gamut3.Cine：デジタルシネマの色域
（DCI-P3）への調整がしやすい色域

ホワイトバランスの色温度を目安とした場合の
設定値は以下のとおりです。
3700Kより低い場合：S-Gamut3(3200K)か

S-Gamut3.Cine(3200K)、
3700K～ 4800K：S-Gamut3(4300K)か

S-Gamut3.Cine(4700K)
4700Kより高い場合：S-Gamut3(5500K)か

S-Gamut3.Cine(5500K)

［ご注意］
S-Gamut3またはS-Gamut3.Cine選択時は、そのとき
のホワイトバランスに近い色温度を選択してください。
また、マトリックス機能をメニューのPaint >Matrix 
>Settingでオフにしてください。 

Operation >Format Media
メディアをフォーマットします。

項目 設定値 内容
Media(A) Execute/Cancel スロットAのSxSメモリーカードを初期化する

（Executeで実行）。
Media(B) Execute/Cancel スロットBのSxSメモリーカードを初期化する

（Executeで実行）。

Operation >Format Media
メディアをフォーマットします。

項目 設定値 内容
SD Card(Utility) Execute/Cancel UTILITY SDカードスロットのSDカードを初期

化する（Executeで実行）。
SD Card(Proxy) Execute/Cancel PROXY SDカードスロットのSDカードを初期

化する（Executeで実行）。

Operation >Input/Output
入／出力信号を設定します。

項目 設定値 内容
Output Format システム周波数の設定に応じて

変わる。
出力フォーマットを選択する（Executeで実行）。
記録フォーマットにより設定値が異なる（38
ページ）。

Source Select Camera/External ビデオ入力ソースをカメラ画（Camera）にするか
SDI IN端子からの入力信号にするかを選択する。

SDI Out1/3 Output On/Off SDI OUT1/3端子からの出力信号をオン／オフ
する。

SDI Out2/4 Output On/Off SDI OUT2/4端子からの出力信号をオン／オフ
する。

［ご注意］
Output Formatが3840×2160PのときはSDI Out1/3 
Outputと連動します。

HDMI Output On/Off HDMI端子からの出力信号をオン／オフする。
4K(QFHD) SDI Out 
Super

Off/On 4K(QFHD)出力時のSDI OUT端子、および
HDMI端子からの文字情報（スーパーインポー
ズ）出力をオン／オフする。

SDI Out2/4 /HDMI 
Super

Off/On SDI OUT2/4端子、およびHDMI端子からの文
字情報（スーパーインポーズ）出力をオン／オフ
する。

Video Out Super Off/On VIDEO OUT端子からの文字情報（スーパーイン
ポーズ）出力をオン／オフする。

Down Converter Edge Crop/Letter Box/
Squeeze

SD信号を出力するときの信号変換モードを選
択する。
Edge Crop：16:9画像の両端をカットして4:3
画像として出力する。

Letter Box：4:3画像の上下をマスクして、画
面中央に16:9映像を表示する。

Squeeze：16:9画像を左右方向に縮小して4:3
画像として出力する。
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Operation >Input/Output
入／出力信号を設定します。

項目 設定値 内容
Wide ID Through/Auto SD出力信号にワイド識別信号を付加するかど

うかを選択する。
Through：ワイド識別信号を付加せずにそのま
ま出力する。

Auto：ワイド識別信号がSqueezeのとき、ビデ
オ信号にワイド識別信号を付加して出力する。

Wide Mode(Ext.) Auto/16:9 入力信号がSDのとき、ワイド画面情報の判定
方法を設定する。
Auto：入力信号のワイド画面情報がSqueeze
のとき、アスペクト比を16:9として記録す
る。それ以外は、4:3として記録する。

16:9：常にアスペクト比を16:9として記録する。

Operation >Super Impose
スーパーインポーズされる文字情報／マーカーを設定します。

項目 設定値 内容
Super(VF Display) On/Off Input/Output >SDI Out2/4/HDMI Superま

たはInput/Output >Video Out SuperがOnの
ときに、SDI OUT端子またはVIDEO OUT端子
からの出力にスーパーインポーズされる文字情
報を項目ごとにオン／オフする。

Super(Menu) On/Off

Super(Marker) On/Off Input/Output >Video Out SuperがOnのと
きにVIDEO OUT端子からの出力に、Input/
Output >SDI Out2/4/HDMI SuperがOnのと
きにSDI OUT端子からの出力にスーパーイン
ポーズされるマーカー表示をオン／オフする。

Operation >LCD
LCDモニターを設定します。

項目 設定値 内容
LCD Color －99～±0～ +99 LCDモニター画面の色の濃さを調整する。
LCD Marker&Zebra On/Off LCDモニターのマーカー表示とゼブラ表示をオ

ン／オフする。

Operation >Rec Function
特殊記録モードを設定します。

項目 設定値 内容
Slow & Quick 
Motion

On/Off スロー＆クイックモーションモードをオン／オ
フする。（この設定をOnにすると、他の特殊記
録モードの設定がOffになる。）

Operation >Rec Function
特殊記録モードを設定します。

項目 設定値 内容
Frame Rate 記録フォーマットの設定に応じ

て変わる。
Slow & Quick Motion設定がOnの場合に、ス
ロー＆クイックモーション撮影時のフレーム
レートを選択する。

1～ 60 ファイルシステムがexFAT、記録フォーマット
がXAVC Intra、XAVC Longのとき

1～ 50 ファイルシステムがUDF、記録フォーマットが
MPEG HD 422 50M（1280×720）、50P/25P
のとき

1～ 30 ファイルシステムがexFATまたはUDF、記録
フォーマットがMPEG HD 422 50M（1920×
1080）、29.97P/23.98Pのとき

1～ 25 ファイルシステムがexFATまたはUDF、記録
フォーマットがMPEG HD 422 50M（1920×
1080）、25Pのとき

Clip Continuous Rec On/Off クリップコンティニュアスレックモードをオン
／オフする。（この設定をOnにすると、他の特
殊記録モードの設定がOffになる。）

Picture Cache Rec On/Off ピクチャーキャッシュレックモードをオン／オ
フする。（この設定をOnにすると、他の特殊記
録モードの設定がOffになる。）

Cache Rec Time 設定値は記録フォーマットの設
定により変わる。

ピクチャーキャッシュメモリーに画像を蓄積す
る時間（キャッシュレック開始時にさかのぼる
時間）を設定する。

 ˜ 詳しくは付録の「ピクチャーキャッシュレックモー
ド設定」（174ページ）をご覧ください。

Interval Rec On/Off インターバルレックモードをオン／オフする。
（この設定をOnにすると、他の特殊記録モード
の設定がOffになる。）

Number of Frames Format >Frequencyの設定に
応じて変わる。

Interval Recの設定がOnの場合に、インターバ
ル撮影時の1回の記録フレーム数を設定する。

2frames/6frames/12frames 記録フォーマットのフレームレートが50P、
59.94Pのとき

1frame/3frames/6frames/ 
9frames

記録フォーマットのフレームレートが23.98P、
25P、29.97P、50i、59.94iのとき
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Operation >Rec Function
特殊記録モードを設定します。

項目 設定値 内容
Interval Time 1/2/3/4/5/6/7/8/9/10/15/ 

20/30/40/50 (sec) 
1/2/3/4/5/6/7/8/9/10/15/ 
20/30/40/50/ (min) 
1/2/3/4/6/12/24 (hour)

Interval Recの設定がOnの場合に、インターバ
ル撮影時の録画間隔（インターバル）を設定す
る。

Pre-Lighting Off/2sec/5sec/10sec インターバルレック撮影開始時にビデオライト
を点灯させる場合は何秒前に点灯させるかを選
択、点灯させない場合はOffを選択する。

Simul Rec On/Off Aスロット＆Bスロットへの2スロット同時記録
機能をオン／オフする。

4K & HD (Sub) Rec On/Off 1スロット同時記録をオン／オフする。
HD (Sub) Playback 
Mode

On/Off 1スロット同時記録されたクリップのHD(Sub)
の再生機能をオン/オフする。

Operation >XAVC Proxy Rec Mode
プロキシ記録を設定します。

項目 設定値 内容
Setting On/Off プロキシ記録をオン／オフする。
Size HD Auto(9Mbps)/

HD Auto(6Mbps)/
1280x720(9Mbps)/ 
1280x720(6Mbps)/ 
640x360(3Mbps)/ 
480x270(1Mbps)/ 
480x270(0.5Mbps)

プロキシ記録フォーマットのサイズを選択す
る。

Frame Rate 23.98fps/25fps/29.97fps/50f
ps/59.94fps

プロキシ記録フォーマットのフレームレートを
表示する。

Bit Rate 9Mbps/6Mbps/3Mbps/ 
1Mbps/0.5Mbps

プロキシ記録フォーマットのビットレートを表
示する。

Audio Channel CH1/CH2/CH3/CH4 プロキシデータに記録するオーディオチャンネ
ルを選択する。

Operation >Assignable Switch
アサイナブルスイッチに機能を割り当てます。

 ˜ 機能の割り当てについて詳しくは、「アサイナブルスイッチに機能を割り当てる」（131ページ）をご覧ください。

項目 設定値 内容
<0> 131ページ ASSIGN. 0スイッチに機能を割り当てる。
<1> 132ページ ASSIGN. 1スイッチに機能を割り当てる。

Operation >Assignable Switch
アサイナブルスイッチに機能を割り当てます。

 ˜ 機能の割り当てについて詳しくは、「アサイナブルスイッチに機能を割り当てる」（131ページ）をご覧ください。

項目 設定値 内容
<2> 131ページ ASSIGN. 2スイッチに機能を割り当てる。
<3> 132ページ ASSIGN. 3スイッチに機能を割り当てる。
<4> 132ページ ASSIGNABLE 4スイッチに機能を割り当てる。
<5> 132ページ ASSIGNABLE 5スイッチに機能を割り当てる。
Lens RET 133ページ レンズのRETボタンに機能を割り当てる。
Online 132ページ ONLINEボタンに機能を割り当てる。
Zoom Speed 0～ 20～ 99 ASSIGNABLE 4または5スイッチにZoomを割

り当てた場合の動作速度を設定する。

Operation >VF Setting
ビューファインダー画面を設定します。

項目 設定値 内容
Color －99～±0～＋99 ビューファインダー映像の色の濃さを調整する。
Color Mode Color/B&W ビューファインダーの表示モードを選択する

（CBK-VF02使用時）。
Color：カラー
B&W：白黒

Peaking Type Normal/Color ピーキングの種類を選択する（CBK-VF02使用
時）。
Normal：通常のピーキング
Color：カラーピーキング

Peaking Frequency Normal/High Peaking Typeの設定がNormalの場合に、ピー
キング周波数を標準（Normal）にするか高く
（High）するかを選択する（CBK-VF02使用時）。

Peaking Color B&W/Red/Yellow/Blue Peaking Typeの設定がColorの場合に、ピーキ
ングの色を選択する（CBK-VF02使用時）。
B&W：白黒
Red：赤
Yellow：黄
Blue：青

VF Detail Level －99～±0～ +99 カムコーダー側で付けるビューファインダーの
ディテールレベルを設定する（HDVF-20A使用
時）。
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Operation >Marker
ビューファインダー画面のマーカー表示を設定します。

項目 設定値 内容
Setting On/Off すべてのマーカー表示をオン／オフする。

［ご注意］
ASSIGN. 2にMarkerを割り当てている場合、この設定
は無効です。

Color White/Yellow/Cyan/Green/
Magenta/Red/Blue

マーカーの表示色を選択する。

Center Marker 1/2/3/4/Off センターマーカーを表示する場合はその種類を
選択、表示しない場合はOffを選択する。

Safety Zone On/Off セーフティーゾーンの表示をオン／オフする。
Safety Area 80%/90%/92.5%/95% セーフティーゾーンの範囲を選択する。
Aspect Marker Line/Mask/Off アスペクトマーカーを表示する場合は表示方法

を選択、表示しない場合はOffを選択する。
Line：白線で表示する。
Mask：マーカー範囲外のビデオ信号レベルを
下げて表示する。

Aspect Select 15:9/14:9/13:9/4:3/1.66:1/ 
1.85:1/2.35:1/2.4:1

マーカーのアスペクト比を選択する。

Aspect Mask 0%～ 12%～ 15% Aspect MarkerがMaskの場合に、マーカー範
囲内のビデオ信号レベルに対するマーカー範囲
外のビデオ信号レベルを設定する。

Aspect Safety Zone On/Off アスペクトセーフティーゾーンマーカーをオン
／オフする。

Aspect Safety Area 80%/90%/92.5%/95% アスペクトセーフティーゾーンマーカーの大き
さ(画面全体に対する比率)を選択する。

100% Marker On/Off 100%のセーフティーゾーンマーカーの表示を
オン／オフする。

User Box On/Off ボックスカーソルの表示をオン／オフする。
User Box Width 40～ 500～ 999 ボックスカーソルの幅（中心から左右端までの

距離）を設定する。
User Box Height 70～ 500～ 999 ボックスカーソルの高さ（中心から上下端まで

の距離）を設定する。
User Box H Position －479～ 0～ 479 ボックスカーソルの中心の水平位置を設定す

る。
User Box V Position －464～ 0～ 464 ボックスカーソルの中心の垂直位置を設定す

る。

Operation >Gain Switch
ゲイン値の切り換え設定をします。

項目 設定値 内容
Gain<L> －9dB/－6dB/－3dB/0dB/ 

3dB/6dB/9dB/12dB/18dB/ 
24dB/30dB/36dB/42dB

GAINスイッチの設定がLの場合のゲイン値を選
択する。

Gain<M> －9dB/－6dB/－3dB/0dB/ 
3dB/6dB/9dB/12dB/18dB/ 
24dB/30dB/36dB/42dB

GAINスイッチの設定がMの場合のゲイン値を
選択する。

Gain<H> －9dB/－6dB/－3dB/0dB/ 
3dB/6dB/9dB/12dB/18dB/ 
24dB/30dB/36dB/42dB

GAINスイッチの設定がHの場合のゲイン値を
選択する。

Gain <Turbo> －9dB/－6dB/－3dB/0dB/ 
3dB/6dB/9dB/12dB/18dB/ 
24dB/30dB/36dB/42dB

Turbo Gain機能を割り当てたアサイナブルス
イッチをオンにしたときのゲイン値を選択す
る。

Shockless Gain On/Off ショックレスゲイン（ゲイン切り換え時にス
ムーズに値が切り替わる機能）をオン／オフす
る。

Operation >Auto Iris
オートアイリスを設定します。

項目 設定値 内容
Iris Override On/Off 絞りを開きぎみまたは閉じぎみにする設定をオ

ン／オフする。
Mode Backlight/Standard/

Spotlight
オートアイリスの制御モードを選択する。
Backlight： バックライトモード（中心となる被
写体が逆光のとき、黒沈みを軽減するモード）

Standard： 標準モード（オプションのリモコン
接続時は選択できません。）

Spotlight： スポットライトモード（中心となる
被写体にスポットライトがあたっていると
き、白潰れを軽減するモード）

Level －99～±0～＋99 収束目標レベルを設定する（値が大きいほど明
るめになる）。

Speed －99～±0～＋99 制御スピード（映像の変化に対する反応速度）を
設定する（値が大きいほど反応は速くなる）。

Clip High light On/Off 高輝度部の検出を無視して、高輝度に対する反
応を鈍くさせる機能をオン／オフする。

Detect Window 1/2/3/4/5/6/Var オートアイリス検出ウィンドウの種類を選択す
る。
Var：可変
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Operation >Auto Iris
オートアイリスを設定します。

項目 設定値 内容
Detect Window 
Indication

On/Off オートアイリス検出ウィンドウの枠をマーカー
で表示する機能をオン／オフする。

Iris APL Ratio －99～±0～＋99 Auto IrisのModeがStandard の場合に、オー
トアイリス検出値のピークと平均値の混合比を
設定する。

Iris Var Width 40～ 500～ 999 Iris WindowがVarの場合に、ウィンドウの幅を
設定する。

Iris Var Height 70～ 500～ 999 Iris WindowがVarの場合に、ウィンドウの高さ
を設定する。

Iris Var H Position －479～ 0～ 479 Iris WindowがVarの場合に、ウィンドウの水平
方向の位置を設定する。

Iris Var V Position －464～ 0～ 464 Iris WindowがVarの場合に、ウィンドウの垂直
方向の位置を設定する。

Operation >Zebra
ビューファインダーに表示されている映像に対してゼブラ表示を設定します。

 ［ご注意］
HLG Display Assist効果は反映されません。

項目 設定値 内容
Zebra Select 1/2/Both ゼブラ表示の種類（ゼブラ1、ゼブラ2、または

両方）を選択する。
Zebra1 Level 0%～ 70%～ 107% ゼブラ1を表示するレベルを設定する。
Zebra1 Aperture 
Level

1%～ 10%～ 20% ゼブラ1のアパーチャーレベルを設定する。

Zebra2 Level 1%～ 100%～ 109% ゼブラ2を表示するレベルを設定する。

Operation >Display On/Off
ビューファインダー画面に表示する項目を設定します。

項目 設定値 内容
Video Level Warning On/Off 映像が明るすぎる場合または暗すぎる場合の警

告表示をオン／オフする。
Shutter Setting On/Off シャッターモードとシャッタースピードの表示

をオン／オフする。
ND Filter Position On/Off NDフィルター設定の表示をオン／オフする。
Gain Setting On/Off ゲイン設定表示をオン／オフする。
Rec /Play Status On/Off 記録、再生状態の表示をオン／オフする。
Color Temp. On/Off 色温度表示をオン／オフする。

Operation >Display On/Off
ビューファインダー画面に表示する項目を設定します。

項目 設定値 内容
Frame Rate/Interval On/Off 特殊記録モード表示をオン／オフする。
Battery Remain Auto/Voltage/Off バッテリー残量／入力電圧表示を設定する。

Auto：バッテリー種別に応じた残量を表示
Voltage：バッテリー種別に関わらず入力電圧
値を表示

Off：表示オフ
Timecode On/Off タイムデータ（タイムコード、ユーザービット、

デュレーション）表示をオン／オフする。
Audio Level Meter On/Off オーディオレベルメーターの表示をオン／オフ

する。
Media Status On/Off メディア状態の表示をオン／オフする。
SD Card(Utility) On/Off SDカード（Utility）状態表示をオン／オフする。
Focus Position Meter/Feet/Off レンズのフォーカスポジションを表示するかど

うかと表示単位を選択する。
Iris Position On/Off レンズのアイリスポジション表示をオン／オフ

する。
Zoom Position On/Off レンズのズームポジション表示をオン／オフす

る。
Extender On/Off レンズのエクステンダーの表示をオン／オフす

る。
ALAC On/Off 収差補正の表示をオン／オフする。
AE Mode On/Off AEのモードと現在のAEレベルの設定値の表示

をオン／オフする。
Focus Mode On/Off フォーカスモード表示をオン／オフする。
White Balance 
Mode

On/Off ホワイトバランスモード表示をオン／オフす
る。

CC5600K On/Off CC5600Kの表示をオン／オフする。
Rec Format On/Off 記録フォーマットの表示をオン／オフする。
Gamma On/Off 選択されているGammaの種類の表示をオン／

オフする。
Timecode Lock On/Off タイムコードの表示をオン／オフする。
Network Condition On/Off ネットワーク接続状態の表示をオン／オフす

る。
Proxy Status On/Off プロキシ状態の表示をオン／オフする。
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Operation >Display On/Off
ビューファインダー画面に表示する項目を設定します。

項目 設定値 内容
NW Client Mode 
Status

On/Off ネットワーククライアントモード表示をオン／
オフする。

Streaming Status On/Off ストリーミング状態の表示をオン／オフする。
GPS On/Off GPS受信状態の表示をオン／オフする。
Video Signal 
Monitor

Off/Waveform/Vector/
Histogram

出力映像信号の状態表示のオン／オフ、および
表示するビデオ信号の種類を選択する（20
ページ）。

［ご注意］
次の場合は表示されません。
メニューのOperation >Input/Output >SDI Out1/3 
SelectとSDI Out2/4 Selectが両方ともOffのとき。
メニューのOperation >Input/Output >Output 
Formatの設定が720x480Pまたは720x576Pのとき。

Clip Name On/Off クリップ名の表示をオン／オフする。
Focus Assist 
Indicator

On/Off フォーカスアシストの表示をオン／オフする。

Focus Area Marker On/Off フォーカスエリアマーカーの表示をオン／オフ
する。

Lens Info Meter/Feet/Off 写界深度を表示するかどうかと表示単位を選択
する。

WRR RF Level On/Off ワイヤレスレシーバーの受信状態の表示をオン
／オフする。

Clip Number On/Off クリップ情報の表示をオン／オフする。

Operation >"!"LED
ビューファインダーの"!"表示を設定します。（HDVF-20A使用時に有効な設定です。）

項目 設定値 内容
Gain <!> On/Off ゲインが0dB以外に設定されている場合に、！

ランプを点灯させる機能をオン／オフする。
Shutter <!> On/Off SHUTTERスイッチがONに設定されている場合

に、！ランプを点灯させる機能をオン／オフす
る。

White Preset <!> On/Off WHITE BALスイッチがPRSTに設定されている
場合に、！ランプを点灯させる機能をオン／オ
フする。

ATW Run <!> On/Off ATWが使用されている場合に、！ランプを点灯
させる機能をオン／オフする。

Operation >"!"LED
ビューファインダーの"!"表示を設定します。（HDVF-20A使用時に有効な設定です。）

項目 設定値 内容
Extender <!> On/Off レンズのエクステンダーが使用されている場合

に、！ランプを点灯させる機能をオン／オフす
る。

Filter <!> On/Off NDフィルターが1以外に設定されている場合
に、！ランプを点灯させるか機能をオン／オフ
する。

Iris Override <!> On/Off オートアイリスオーバーライドが標準値以外に
設定されている場合に、！ランプを点灯させる
機能をオン／オフする。

Operation >White Setting
ホワイトバランス調整に関する設定をします。

項目 設定値 内容
White Switch<B> Memory/ATW WHITE BALスイッチの設定がBの場合の動作

モードを設定する。
Memory：オートホワイトバランス
ATW：自動追尾ホワイトバランス

Shockless White Off/1/2/3 WHITE BALスイッチ切り換え時の切り替わり
遷移時間を選択する（1が最も速い）。

ATW Speed 1/2/3/4/5 ATW(自動追尾ホワイトバランス)の遷移スピー
ドを選択する（1が最も速い）。

ATW Mode Natural/Pure ATW（自動追尾ホワイトバランス）の動作を設
定する。
Natural： シーンの明るさに応じて、自然な雰
囲気になるようにATWを自動調整する。

Pure： 青みや赤みの色を残さずに、より原色に
近づけるようにATWを自動調整する。

AWB Fixed Area On/Off 画面中央部でAWB（オートホワイトバランス）
を実行する。

Filter White Memory On/Off White BalanceがPresetまたはATWのときに、
FILTERつまみのポジション番号ごとにホワイト
バランスのメモリー領域を設定する。

 ˎ AssignボタンにElectrical CC を割り当てて
いるときは、Electrical CCのA、B、C、Dに
それぞれ独立のホワイトのメモリー領域を設
定する。

 ˎ AssignボタンにElectrical CC を割り当てて
いないときは、FILTERつまみのポジション番
号ごとにホワイトバランスのメモリー領域を
設定する。
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Operation >Offset White
ホワイトバランスオフセット値に関する設定を行います。

項目 設定値 内容
Offset White<A> On/Off メモリー Aのホワイトバランスにオフセット値

を付加する（On）か付加しないか（Off）を選択
する。

Warm Cool <A> 目安の色温度を表示
（約1600K～ 3200K～
16000K程度）

Offset White<A>がOnの場合に、メモリー Aの
ホワイトバランスに付加するオフセットを色温
度で設定する（オフセットの色温度が高いと誤差
が大きくなるため実際の映像を見ながら調整）。

Warm Cool 
Balance<A>

－99～±0～＋99 Warm Cool <A>の設定で希望の映像が得られ
なかった場合に、さらに細かく色温度を設定す
る。

Offset White <B> On/Off Onにするとここで調整したオフセットがBチャ
ンネルのホワイトバランスに付加される。

Warm Cool <B> 目安の色温度を表示
（約1600K～ 3200K～
16000K程度）

Offset White<B>がOnの場合に、メモリー Aの
ホワイトバランスに付加するオフセットを色温
度で設定する（オフセットの色温度が高いと誤差
が大きくなるため実際の映像を見ながら調整）。

Warm Cool 
Balance<B>

－99～±0～＋99 Warm Cool <B>の設定で希望の映像が得られ
なかった場合に、さらに細かく色温度を設定す
る。

Operation >Shutter
シャッターの動作モードを設定します。

項目 設定値 内容
Mode Speed/Angle 電子シャッターの動作モードを選択する。

Speed：シャッタースピードを時間（秒単位）
で設定する。

Angle：シャッタースピードを角度（度単位）で
設定する。

Operation >Slow Shutter
スローシャッターを設定します。

項目 設定値 内容
Setting On/Off スローシャッター機能をオン／オフする。
Number of Frames 2/3/4/5/6/7/8/16 スローシャッター機能の蓄積フレーム数を設定

する。

Operation >Time Zone
時差を設定します。

項目 設定値 内容
Time Zone UTC +14:00～ UTC 

Greenwich～ UTC -12:00  
（30分単位）

UTC（グリニッジ標準時）からの時差を30分単
位で選択する。

Operation >Clip
クリップの名称や管理に関する設定をします。

 ［ご注意］
クリップ名の最初の文字を「.」の記号にしないでください。クリップ名の最初の文字が「.」になっているクリップは、
コンピューター上のアプリケーションソフトウェアで閲覧できません。

項目 設定値 内容
Clip Naming Title/Plan クリップ名の設定方法を選択する。

Title：Title Prefixで任意に設定する。
Plan：プランニングメタデータで設定した名称
にする（プランニングメタデータで設定し
た名称がない場合は、Title Prefixで設定し
た名称にする）。

Title Prefix 文字入力 文字列の入力画面でクリップ名のタイトル部分
（4～ 46文字の英数字）を設定する（99ペー
ジ）。

Number Set Clip Namingの選択により変わ
る（「内容」欄参照）

クリップ名の番号部分を設定する。
Clip Namingの設定がTitleのとき： 

0001～ 9999
Clip Namingの設定がPlanでプランニングメタ
データがロードされているとき： 
00001～ 99999

Operation >Update Media
メディア内管理ファイルを更新します。

 ［ご注意］
ファイルシステムがFATに設定されているとき、この機能は使用できません。

項目 設定値 内容
Media(A) Execute/Cancel スロットAのSxSメモリーカードの管理情報を

更新する（Executeで実行）。
Media(B) Execute/Cancel スロットBのSxSメモリーカードの管理情報を

更新する（Executeで実行）。
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Operation >GPS
測位情報（GPS）をオン／オフします。

項目 設定値 内容
GPS On/Off GPS機能をオン／オフする。

Operation >Planning Metadata
プランニングメタデータの操作に関する設定をします。

項目 設定値 内容
Load Media(A) Execute/Cancel Slot(A)のSxSメモリーカードからプランニング

メタデータをロードする。
Executeを選択するとSlot(A)のSxSメモリー
カードに保存されているプランニングメタデー
タのファイルが一覧表示される。ファイルを選
択すると、詳細画面が表示される。

［ご注意］
ファイルシステムがFATに設定されているとき、この
項目は表示されません。

Load Media(B) Execute/Cancel Slot(B)のSxSメモリーカードからプランニング
メタデータをロードする。
Executeを選択するとSlot(B)のSxSメモリー
カードに保存されているプランニングメタデー
タのファイルが一覧表示される。ファイルを選
択すると、詳細画面が表示される。

［ご注意］
ファイルシステムがFATに設定されているとき、この
項目は表示されません。

Properties Execute/Cancel 本機にロードされているプランニングメタデー
タの内容を表示する（Executeで実行）。

Clear Memory Execute/Cancel 本機にロードされているプランニングメタデー
タを消去する（Executeで実行）。

Clip Name Disp Title1(ASCII)/Title2(UTF-8) プランニングメタデータでクリップ名を設定す
る場合の表示形式を選択する（62ページ）。

Operation >USB
SxSカードスロットに挿入された記録メディア内のクリップをUSBメディアにコピーするときの操作
に関する設定をします。

項目 設定値 内容
Select Folder USBメディア内のフォルダーを選択する。

USBメディア内に新しいフォルダーを作成す
る。

View Clip List USBメディア内のクリップ一覧を表示する。

Operation >USB
SxSカードスロットに挿入された記録メディア内のクリップをUSBメディアにコピーするときの操作
に関する設定をします。

項目 設定値 内容
Rename Folder USBメディア内のフォルダー名を編集する。
Error Check On/Off SxSカードスロットに挿入された記録メディア

内のクリップをUSBメディアへコピーするとき
に、エラーチェックを行うかどうかを選択する。

Format USB Execute/Cancel USBメディアを初期化する（Executeで実行）。
Copy to USB Media(A) to USB/ 

Media(B) to USB/ 
Media(A)(B) to USB

SxSカードスロット内のすべてのクリップを一
括コピーするとき、対象のスロットを選択する。
Media(A) to USB：スロットAに挿入されてい
る記録メディアのすべてのクリップをUSB
メディアにコピーする。

Media(B) to USB：スロットBに挿入されてい
る記録メディアのすべてのクリップをUSB
メディアにコピーする。

Media(A)(B) to USB：スロットA、およびスロッ
トBに挿入されている記録メディアのすべ
てのクリップをUSBメディアにコピーする。

Media Remain （空き容量：数値表示）
（バー表示）

USBメディアの空き容量を表示する。

Operation >Flash Band Reduce
フラッシュバンド現象を補正します。

［ご注意］
記録中およびSlow &QuickがOnのとき、この項目は無効（グレー表示）になります。

項目 設定値 内容
Setting On/Off Flash Band軽減機能をオン／オフする。

［ご注意］

ˎˎ Flash Band Reduceのオン／オフ切り換え時は、
映像や音声が不連続になったり、一瞬ノイズが入り
ます。
ˎˎ Flash Band Reduceがオンでも、シャッタースイッ
チがオンの場合は機能しません。
ˎˎ 電源を切ると設定は出荷時設定に戻ります。
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Paintメニュー
太字とアンダーラインで表示されている設定値は、出荷時の初期設定値です。

Paint >Switch Status
各種補正機能とテスト信号をオン／オフします。

項目 設定値 内容
Gamma On/Off ガンマ機能をオン／オフする。
Black Gamma On/Off ブラックガンマ機能をオン／オフする。
Matrix On/Off マトリクス機能をオン／オフする。
Knee On/Off ニー機能をオン／オフする。
White Clip On/Off ホワイトクリップ機能をオン／オフする。

［ご注意］
Offに設定しても、電源再投入後はOnに戻ります。

Detail（QFHD) On/Off QFHDディテール機能をオン／オフする。
Detail（HD) On/Off HDディテール機能をオン／オフする。
Aperture On/Off アパーチャー機能をオン／オフする。
Flare On/Off フレア補正機能をオン／オフする。
Test Saw On/Off テスト信号をオン／オフする。

Paint >HDR Paint Setting
Shooting ModeがHDRのときのHDR設定を行います。

項目 設定値 内容
HLG Look Natural/Live HDRモード時のHLG種類を設定する。

Natural：ITU-R BT.2100(HLG)に準拠した特性
Live：ITU-R BT.2100(HLG)に準拠し、より

HDRの効果を引き出す特性
HDR Black Offset －95～±0～ +103 HDRモード時のSDR設定(Master Black)に対す

るHDRのBlackのオフセット値を設定する。
HDR Knee On/Off HDRモード時のHDR信号に対するニー補正機

能オン／オフする。
HDR Knee Point －99～±0～ +99 HDR KneeがOnのときにHDR信号にかける

ニーポイントを設定する。
HDR Knee Slope －99～±0～ +99 HDR KneeがOnのときにHDR信号にかける

ニースロープを設定する。

Paint >White
色温度を設定して、手動でホワイトバランス調整を行います。

項目 設定値 内容
Color Temp <A> 1500K～ 3200K～ 50000K メモリー Aに保存されたホワイトバランスの色

温度を表示する。

Paint >White
色温度を設定して、手動でホワイトバランス調整を行います。

項目 設定値 内容
Color Temp Balance 
<A>

－99～±0～＋99 メモリー Aに保存されたホワイトバランスのゲ
イン値（Rゲイン、Bゲイン連動）を設定する。

R Gain <A> －99～±0～＋99 メモリー Aに保存されたホワイトバランスのR
ゲイン値を設定する。

B Gain <A> －99～±0～＋99 メモリー Aに保存されたホワイトバランスのB
ゲイン値を設定する。

Color Temp <B> 1500K～ 3200K～ 50000K メモリー Bに保存されたホワイトバランスの色
温度を表示する。

Color Temp Balance 
<B>

－99～±0～＋99 メモリー Bに保存されたホワイトバランスのゲ
イン値（Rゲイン、Gゲイン連動）を設定する。

R Gain <B> －99～±0～＋99 メモリー Bに保存されたホワイトバランスのR
ゲイン値を設定する。

B Gain <B> －99～±0～＋99 メモリー Bに保存されたホワイトバランスのB
ゲイン値を設定する。

Paint >Black
ブラックレベル（光があたっていないときの映像のレベル）を設定します。
ブラックレベルを調整して、黒を浮かせる、黒を沈めるといった絵作りが可能です。

項目 設定値 内容
Master Black －99～±0～＋99 マスターブラックレベルを設定する。
R Black －99～±0～＋99 Rブラックレベルを設定する。
B Black －99～±0～＋99 Bブラックレベルを設定する。

Paint >Flare
フレア補正に関する設定を行います。
フレアは、画面上の明るい部分の影響を受けて映像のレベル全体が上がってしまい、黒い部分が明る
くなる現象で、レンズ内部での光の乱反射により発生します。

項目 設定値 内容
Setting On/Off フレア補正機能をオン／オフする。
Master Flare －99～±0～＋99 マスターフレア補正レベルを設定する。
R Flare －99～±0～＋99 Rフレア補正レベルを設定する。
G Flare －99～±0～＋99 Gフレア補正レベルを設定する。
B Flare －99～±0～＋99 Bフレア補正レベルを設定する。
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Paint >Gamma(HDR)
HDRのガンマ設定値を表示します。

項目 設定値 内容
Gamma Select S-Log3

HLG(Natural)
HLG(Live)
---

HDRのガンマ設定値（表示のみ）

Paint >Gamma
ガンマ補正に関する設定を行います。
ガンマ補正により、画面のコントラストを調整して、映像の印象を大きく変えることができます。

項目 設定値 内容
Setting On/Off ガンマ補正機能をオン／オフする。
Step Gamma 0.35～ 0.45～ 0.90

（0.05ステップ）
ガンマ補正値を0.05ステップで設定する。

Master Gamma －99～±0～＋99 マスターガンマレベルを設定する。
R Gamma －99～±0～＋99 Rガンマレベルを設定する。
G Gamma －99～±0～＋99 Gガンマレベルを設定する。
B Gamma －99～±0～＋99 Bガンマレベルを設定する。
Gamma Category STD/HG/User/--- ガンマカテゴリーを選択する。

STD：ビデオ信号用の通常のガンマカーブ
HG：フィルムで撮影したような階調や色再現
に似せたガンマカーブ

User：ユーザーがCvpFileEditorTM V4.2で作
成したガンマカーブ

---：SDR出力がない場合

Paint >Gamma
ガンマ補正に関する設定を行います。
ガンマ補正により、画面のコントラストを調整して、映像の印象を大きく変えることができます。

項目 設定値 内容
Gamma Select Gamma Categoryの選択によ

り変わる（以下を参照）
ガンマ補正に使用するガンマテーブルを選択す
る。

Gamma CategoryがSTDの場合
STD1 DVW：DVWカムコーダー相当
STD2 x4.5：×4.5ゲイン
STD3 x3.5：×3.5ゲイン
STD4 240M：SMPTE-240M相当
STD5 R709：ITU-R709相当
STD6 x5.0：×5.0ゲイン

Gamma CategoryがHGの場合
HG1 3250G36：325%のビデオ入力を100%のビデオ出力に圧縮する
HG2 4600G30：460%のビデオ入力を100%のビデオ出力に圧縮する
HG3 3259G40：325%のビデオ入力を109%のビデオ出力に圧縮する
HG4 4609G33：460%のビデオ入力を109%のビデオ出力に圧縮する

Gamma CategoryがUserの場合
User 1：User1に登録されたガンマテーブル
User 2：User2に登録されたガンマテーブル
User 3：User3に登録されたガンマテーブル
User 4：User4に登録されたガンマテーブル
User 5：User5に登録されたガンマテーブル

SDR出力がない場合
---

Paint >Black Gamma
ブラックガンマ補正に関する設定を行います。
ブラックガンマ補正により、映像の黒または黒に近い（暗い）部分の階調や色合いが再現することが
できます。

項目 設定値 内容
Setting On/Off ブラックガンマ補正機能をオン／オフする。

［ご注意］
ブラックガンマ機能を有効にするにはSaturation 
ModeをLow Keyに設定してください。
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Paint >Black Gamma
ブラックガンマ補正に関する設定を行います。
ブラックガンマ補正により、映像の黒または黒に近い（暗い）部分の階調や色合いが再現することが
できます。

項目 設定値 内容
Range Low/L.Mid/H.Mid ブラックガンマ補正の有効範囲を選択する。

Low：0～ 3.6 %
L.Mid：0～ 7.2%
H.Mid：0～ 14.4 %

Master Black 
Gamma

－99～±0～＋99 マスターブラックガンマレベルを設定する。

Paint >Knee
ニー補正に関する設定を行います。
ニー補正は、映像の明るい部分を記録／出力する映像のダイナミックレンジの上限に応じて圧縮し、
白つぶれを防ぐ処理です。ニーをかけ始める信号レベルを「ニーポイント」、ニーによる圧縮の傾き
を「ニースロープ」と呼びます。

項目 設定値 内容
Setting On/Off ニー補正機能をオン／オフする。
Point 75%～ 95%～ 109% DCC機能がオフのとき、ニーポイントを設定す

る。
Slope －99～±0～＋99 DCC機能がオフのとき、ニースロープを設定す

る。
Knee Saturation On/Off ニーサチュレーション機能をオン／オフする。

［ご注意］
ニーサチュレーション機能を有効にするには
Saturation ModeをKneeに設定してください。

Knee Saturation 
Level

－99～±0～＋99 ニーサチュレーションレベルを設定する。

Paint >White Clip
ホワイトクリップ調整に関する設定を行います。
ホワイトクリップは、ビデオ出力信号の最大レベルに制限をかける処理です。ビデオ出力信号の最大
値を「ホワイトクリップレベル」と呼びます。

項目 設定値 内容
Setting On/Off ホワイトクリップ調整機能をオン／オフする。
Level 90.0%～ 108.0%～ 109.0% ホワイトクリップレベルを設定する。

初期設定は、システム周波数が59.94、29.97、
24、23.98のときは108.0%、50.25のときは
105.0%

Paint >Detail(QFHD)/Detail(HD)/Detail(SD)
4K/HDモード時またはSDモード時のディテール調整に関する設定を個別に行います。
ディテール調整は、被写体の輪郭部分にディテール信号を加えて輪郭を強調し、クリアな映像を作成
する処理です。

項目 設定値 内容
Setting On/Off ディテール調整機能をオン／オフする。
Level －99～±0～＋99 ディテールレベルを設定する。
H/V Ratio －99～±0～＋99 HディテールレベルとVディテールレベルの

ミックス比を設定する。
Crispening －99～±0～＋99 クリスプニングレベルを設定する。
Level Depend On/Off レベルディペンド調整機能をオン／オフする。
Level Depend Level －99～±0～＋99 レベルディペンドレベルを設定する。
Frequency －99～±0～＋99 Hディテール信号の中心周波数を設定する（値

を大きくするほどディテールは細くなる）。
Knee Aperture On/Off ニーアパーチャー補正機能をオン／オフする。
Knee Aperture Level －99～±0～＋99 ニーアパーチャーレベルを設定する。
Limit －99～±0～＋99 白側、黒側両方向のディテールリミッターを設

定する。
White Limit －99～±0～＋99 白側のディテールリミッターを設定する。
Black Limit －99～±0～＋99 黒側のディテールリミッターを設定する。
V Black Limit －99～±0～＋99 黒側のVディテールリミッターを設定する。
V Detail Creation NAM/Y/G/G+R Vディテール信号を生成するためのソース信号

を選択する。
NAM：R信号から作られたVディテール信号と

G信号から作られたVディテール信号とB信
号から作られたVディテール信号のうち最
もレベルの高い信号

Y：Y信号
G：G信号
G＋R：G信号とR信号を1：1で合成した信号

Cross Color 
Suppress 
（SDモード時）

－99～±0～＋99 ディテールのクロスカラー抑圧レベルを設定す
る。

［ご注意］
ディテール調整機能Offの場合や、メニューの
Operation >Format >Frequencyが50または25の場
合、この設定は無効です。



000 7章　メニュー表示と詳細設定：Paintメニュー116

Paint >Aperture
アパーチャー補正に関する設定を行います。
アパーチャー補正は、ビデオ信号に、高周波数のアパーチャー信号を加えて周波数特性による劣化を
補正し、解像度を高める処理です。

項目 設定値 内容
Setting On/Off アパーチャー補正機能をオン／オフする。
Level －99～±0～＋99 アパーチャーレベルを設定する。

Paint >Skin Detail
スキンディテール補正に関する設定を行います。
スキンディテール補正は、人物の肌をきれいに見せるなどの目的で、特定の色の範囲を選んでディテー
ルレベルを増減させる処理です。

項目 設定値 内容
Setting On/Off スキンディテール補正機能をオン／オフする。
Area Detection Execute/Cancel スキンディテール補正の対象となる色を検出す

る色検出画面が表示される（Executeで実行）。
Area Indication On/Off スキンディテール補正の対象となる色のエリア

にゼブラを表示する機能をオン／オフする。
Level －99～±0～＋99 スキンディテールレベルを設定する。
Saturation －99～±0～＋99 スキンディテール補正の対象となる色の飽和度

（サチュレーション）を設定する。
Hue 0～ 359 スキンディテール補正の対象となる色の色相

（ヒュー）を設定する。
Width 0～ 40～ 90 スキンディテール補正の対象となる色の色相の

範囲を設定する。

Paint >Matrix
マトリクス補正に関する設定を行います。
マトリクス補正により、映像の色味、鮮やかさを調整することができます。
「プリセットマトリクス」としてあらかじめ用意されたパラメーターセットから目的に合うマトリク
スを選択できます。また自分でパラメーターを任意に設定して「ユーザーマトリクス」を作成するこ
ともできます。「アダプティブマトリクス」はマトリクスの効き具合を抑制する機能です。

項目 設定値 内容
Setting On/Off マトリクス補正機能をオン／オフする。
Adaptive Matrix On/Off アダプティブマトリクス機能をオン／オフす

る。
Tracing Matrix Type A/Type B ホワイトバランスの変化によって生じる色再現

の補正方法を選択します。Type BはType Aに
比べてより補正を強めます。

Preset Matrix On/Off プリセットマトリクス機能をオン／オフする。

Paint >Matrix
マトリクス補正に関する設定を行います。
マトリクス補正により、映像の色味、鮮やかさを調整することができます。
「プリセットマトリクス」としてあらかじめ用意されたパラメーターセットから目的に合うマトリク
スを選択できます。また自分でパラメーターを任意に設定して「ユーザーマトリクス」を作成するこ
ともできます。「アダプティブマトリクス」はマトリクスの効き具合を抑制する機能です。

項目 設定値 内容
Preset Select 1：SMPTE240M

2：ITU-709
3：SMPTE Wide
4：NTSC
5：EBU
6：PAL

プリセットマトリクスを選択する。
1：SMPTE240M：SMPTE-240M相当
2：ITU-709：ITU-709相当
3：SMPTE Wide：SMPTE WIDE相当
4：NTSC：NTSC相当
5：EBU：EBU相当
6：PAL：PAL相当

User Matrix On/Off ユーザーマトリクス補正機能をオン／オフす
る。

Level －99～±0～＋99 映像全域の色の濃さ（Saturation）を設定する。
Phase －99～±0～＋99 映像全域の色合い(Phase)を設定する。
User Matrix　R-G －99～±0～＋99 R-Gのユーザーマトリクスを任意に設定する。
User Matrix　R-B －99～±0～＋99 R-Bのユーザーマトリクスを任意に設定する。
User Matrix　G-R －99～±0～＋99 G-Rのユーザーマトリクスを任意に設定する。
User Matrix　G-B －99～±0～＋99 G-Bのユーザーマトリクスを任意に設定する。
User Matrix　B-R －99～±0～＋99 B-Rのユーザーマトリクスを任意に設定する。
User Matrix　B-G －99～±0～＋99 B-Gのユーザーマトリクスを任意に設定する。

Paint >Multi Matrix
マルチマトリクス補正に関する設定を行います。
マルチマトリクス補正は、16軸の色相（Hue）空間で飽和度（Saturation）を設定します。

項目 設定値 内容
Setting On/Off マルチマトリクス補正機能をオン／オフする。
Area Indication On/Off マルチマトリクス補正の対象となる色のエリア

にゼブラを表示する機能をオン／オフする。
Color Detection Execute/Cancel マルチマトリクス補正の対象となる色を検出す

る色検出画面が表示される（Executeで実行）。
Reset Execute/Cancel 各軸の[Hue]と[Saturation]をすべて初期値に

する（Executeで実行）。
Axis B/B+/MG－/MG/MG+/R/R+/

YL－/YL/YL+/G－/G/G+/CY/
CY+/B－

マルチマトリクス補正の対象となる色（16軸
モード）を設定する。
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Paint >Multi Matrix
マルチマトリクス補正に関する設定を行います。
マルチマトリクス補正は、16軸の色相（Hue）空間で飽和度（Saturation）を設定します。

項目 設定値 内容
Hue －99～±0～＋99 マルチマトリクス補正の対象となる色の色相

（ヒュー）を16軸モードごとに設定する。
Saturation －99～±0～＋99 マルチマトリクス補正の対象となる色の飽和度

（サチュレーション）を16軸モードごとに設定
する。

Paint >V Modulation
Vモジュレーションシェーディング補正に関する設定を行います。
レンズとプリズムの関係で発生する垂直方向の感度の傾きを補正します。

項目 設定値 内容
Setting On/Off Vモジュレーションシェーディング補正機能を

オン／オフする。
Master V 
Modulation

－99～±0～＋99 マスターVモジュレーションレベルを設定する。

R V Modulation －99～±0～＋99 R信号のVモジュレーションレベルを設定する。
G V Modulation －99～±0～＋99 G信号のVモジュレーションレベルを設定する。
B V Modulation －99～±0～＋99 B信号のVモジュレーションレベルを設定する。

Paint >Low Key Saturation
ローキーサチュレーション補正に関する設定を行います。
映像の暗い部分の色の濃さだけを補正できます。

項目 設定値 内容
Setting On/Off ローキーサチュレーション補正機能をオン／オ

フする。

［ご注意］
ローキーサチュレーション機能を有効にするには
Saturation ModeをLow Keyに設定してください。

Level －99～±0～＋99 低輝度エリアの色の飽和度（サチュレーション）
を設定する。

Range Low/L.Mid/H.Mid ローキーサチュレーション補正を有効にする輝
度レベルを選択する。

Paint >Saturation Mode
サチュレーション補正に関する設定を行います。

項目 設定値 内容
Saturation Mode Knee/Low Key サチュレーション機能をレベルが高いところ

（Knee）で働かせるか低いところ（Low Key）で
働かせるかを選択する。

Knee Saturation On/Off ニーサチュレーション機能をオン／オフする。
Black Gamma On/Off ブラックガンマ補正機能をオン／オフする。
Low Key Saturation On/Off ローキーサチュレーション機能をオン／オフす

る。

Paint >Noise Suppression
ノイズサプレス（ノイズ圧縮）機能に関する設定を行います。
被写体の細かなエッジ成分を残しつつ、ノイズ成分を効果的に抑制することができます。

項目 設定値 内容
Setting On/Off ノイズサプレス機能をオン／オフする。
Level Low/Mid/High/Super ノイズサプレスのレベルを選択する。
Gain Link On/Off ノイズサプレスのレベルをゲインに連動する／

しないを設定する。
－9dB Low/Mid/High/Super Gain LinkがOnのとき、－9 dBのノイズサプレ

スのレベルを設定する。
－6dB Low/Mid/High/Super Gain LinkがOnのとき、－6 dBのノイズサプレ

スのレベルを設定する。
－3dB Low/Mid/High/Super Gain LinkがOnのとき、－3 dBのノイズサプレ

スのレベルを設定する。
0dB Low/Mid/High/Super Gain LinkがOnのとき、0 dBのノイズサプレス

のレベルを設定する。
3dB Low/Mid/High/Super Gain LinkがOnのとき、3 dBのノイズサプレス

のレベルを設定する。
6dB Low/Mid/High/Super Gain LinkがOnのとき、6 dBのノイズサプレス

のレベルを設定する。
9dB Low/Mid/High/Super Gain LinkがOnのとき、9 dBのノイズサプレス

のレベルを設定する。
12dB Low/Mid/High/Super Gain LinkがOnのとき、12 dBのノイズサプレ

スのレベルを設定する。
18dB Low/Mid/High/Super Gain LinkがOnのとき、18 dBのノイズサプレ

スのレベルを設定する。
24dB Low/Mid/High/Super Gain LinkがOnのとき、24 dBのノイズサプレ

スのレベルを設定する。
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Paint >Noise Suppression
ノイズサプレス（ノイズ圧縮）機能に関する設定を行います。
被写体の細かなエッジ成分を残しつつ、ノイズ成分を効果的に抑制することができます。

項目 設定値 内容
30dB Low/Mid/High/Super Gain LinkがOnのとき、30 dBのノイズサプレ

スのレベルを設定する。
36dB Low/Mid/High/Super Gain LinkがOnのとき、36 dBのノイズサプレ

スのレベルを設定する。
42dB Low/Mid/High/Super Gain LinkがOnのとき、42 dBのノイズサプレ

スのレベルを設定する。
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Maintenanceメニュー
太字とアンダーラインで表示されている設定値は、出荷時の初期設定値です。

Maintenance >White Shading
ホワイトシェーディング補正に関する設定を行います。
ホワイトシェーディングはレンズの特性により発生する明るい部分の輝度ムラや色ムラで、レンズご
とに補正が必要です。

項目 設定値 内容
Channel Select Red/Green/Blue ホワイトシェーディング補正の対象を選択す

る。
White H Saw －99～±0～＋99 水平方向のSAWホワイトシェーディング補正値

を設定する。
White H Para －99～±0～＋99 水平方向のパラボラホワイトシェーディング補

正値を設定する。
White V Saw －99～±0～＋99 垂直方向のSAWホワイトシェーディング補正値

を設定する。
White V Para －99～±0～＋99 垂直方向のパラボラホワイトシェーディング補

正値を設定する。
White Saw/ Para On/Off ホワイトシェーディングのSAW／パラボラ補

正機能をオン／オフする。

Maintenance >Black Shading
ブラックシェーディング補正に関する設定を行います。

項目 設定値 内容
Channel Select Red/Green/Blue ブラックシェーディング補正の対象を選択す

る。
Black H Saw －99～±0～＋99 水平方向のSAWブラックシェーディング補正値

を設定する。
Black H Para －99～±0～＋99 水平方向のパラボラブラックシェーディング補

正値を設定する。
Black V Saw －99～±0～＋99 垂直方向のSAWブラックシェーディング補正値

を設定する。
Black V Para －99～±0～＋99 垂直方向のパラボラブラックシェーディング補

正値を設定する。
Black Saw/Para On/Off ブラックシェーディングのSAW／パラボラ補

正機能をオン／オフする。
Master Black －99～±0～＋99 マスターのブラックレベルを設定する。
Master Gain (TMP) －9dB/－6dB/－3dB/0dB/ 

3dB/6dB/9dB/12dB/18dB/ 
24dB/30dB/36dB/42dB

一時的にマスターゲインの値を設定する。

Maintenance >Battery
バッテリーに関する設定を行います。

項目 設定値 内容
Near End:Info 
Battery

5%/10%/15%...95%/100% バッテリーパックBP-FLX75/GL65A/GL95A使
用時に「Battery Near End」を表示するしきい
値を設定する。

End:Info Battery 0%/1%/2%/3%/4%/5% バッテリーパックBP-FLX75/GL65A/GL95A使
用時に「Battery End」を表示するしきい値を設
定する。

Near End:Sony 
Battery

11.5V～ 17V 
（0.1Vステップ）

バッテリーパックBP-L60S/L80S使用時に
「Battery Near End」を表示するしきい値を設
定する。

End:Sony Battery 11.0V～ 12.5V 
（0.1Vステップ）

バッテリーパックBP-L60S/L80S使用時に
「Battery End」を表示するしきい値を設定する。

Near End:Other 
Battery

11.5V～ 11.8V～ 17.0V 
（0.1Vステップ）

ソニー製以外のバッテリーパック使用時に
「Battery Near End」を表示するしきい値を設
定する。

End:Other Battery 11.0V～ 14.0V 
（0.1Vステップ）

ソニー製以外のバッテリーパック使用時に
「Battery End」を表示するしきい値を設定する。

Detected Battery Sony Info Battery/ 
Sony Battery/Other Battery/
DC IN

バッテリーの種類を自動判別した結果を表示す
る。

Maintenance >DC Voltage Alarm
外部DC電源電圧に関するアラームを設定します。

項目 設定値 内容
DC Low Voltage1 11.5V～ 17V 

（0.1Vステップ）
DC IN端子に外部電源を接続している場合に
「Battery Near End」を表示するしきい値を設
定する。

DC Low Voltage2 11.0V～ 14.0V 
（0.1Vステップ）

DC IN端子に外部電源を接続している場合に
「Battery End」を表示するしきい値を設定す
る。」

Maintenance >Audio
オーディオに関する設定を行います。

項目 設定値 内容
Front MIC Select Mono/Stereo フロントマイクをモノラル（Mono）にするか、

ステレオ（Stereo）にするかを選択する。
Rear XLR Auto On/Off 後面のAUDIO IN CH-1/CH-2端子にケーブルが

接続されているかどうかを自動的に検出する機
能をオン／オフする。
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Maintenance >Audio
オーディオに関する設定を行います。

項目 設定値 内容
Front MIC CH1 Ref －70dB/－60dB/－50dB/ 

－40dB/－30dB
フロントマイクのチャンネル1の基準入力レベ
ルを選択する。

Front MIC CH2 Ref －70dB/－60dB/－50dB/ 
－40dB/－30dB

フロントマイクのチャンネル2の基準入力レベ
ルを選択する。

Rear MIC CH1 Ref －70dB/－60dB/－50dB/ 
－40dB/－30dB

AUDIO IN CH1スイッチの設定がMICの場合の
基準入力レベルを選択する。

Rear MIC CH2 Ref －70dB/－60dB/－50dB/ 
－40dB/－30dB

AUDIO IN CH2スイッチの設定がMICの場合の
基準入力レベルを選択する。

Line Input Ref ＋4dB/0dB/－3dB/EBUL AUDIO IN CH1/CH2スイッチの設定がLINEの
場合の基準入力レベルを選択する。

Min Alarm Volume Off/Set ALARMつまみを絞りきったときの音量を選択
する。
Off：ほぼ聞こえない
Set：ある程度は聞こえる

Speaker Attenuate Off/3dB/6dB/9dB/12dB モニタースピーカーからの音量を選択する（イ
ヤホンの音量には影響しない）。

Headphone Out Mono/Stereo イヤホンをモノラル（Mono）にするか、ステレ
オ（Stereo）にするかを選択する。

Reference Level －20dB/－18dB/－16dB/ 
－12dB/EBUL

基準入力レベルを設定する。合わせて、1 kHz
テスト信号の出力レベルを設定する。

Reference Out ＋4dB/0dB/－3dB/EBUL 基準入力レベルに対する出力レベルを設定す
る。

CH1&2 AGC Mode Mono/Stereo チャンネル1、2に記録するアナログオーディオ
信号の入力レベルの自動調整を、各チャンネル
で独立して行うか（Mono）、ステレオモードで
行うか（Stereo）を選択する。

CH3&4 AGC Mode Mono/Stereo チャンネル3、4に記録するアナログオーディオ
信号の入力レベルの自動調整を、各チャンネル
で独立して行うか（Mono）、ステレオモードで
行うか（Stereo）を選択する。

AGC Spec －6dB/－9dB/－12dB/ 
－15dB/－17dB

AGCの特性（飽和レベル）を選択する。

Limiter Mode Off/－6dB/－9dB/－12dB/ 
－15dB/－17dB

オーディオ入力レベルの手動調整時、大きな入
力信号に対するリミッター特性（飽和レベル）を
選択する。リミッターを使用しない場合はOff
を選択する。

Output　Limiter On/Off オーディオ出力リミッターをオン／オフする。

Maintenance >Audio
オーディオに関する設定を行います。

項目 設定値 内容
CH1 Wind Filter On/Off チャンネル1の風音低減フィルターをオン／オ

フする。
CH2 Wind Filter On/Off チャンネル2の風音低減フィルターをオン／オ

フする。
CH2 Wind Filter On/Off チャンネル3の風音低減フィルターをオン／オ

フする。
CH4 Wind Filter On/Off チャンネル4の風音低減フィルターをオン／オ

フする。
1kHz Tone on Color 
Bars

On/Off/Auto カラーバーモード時に1kHzのテスト信号を出
力するか（On）出力しないか（Off）を設定する。
Auto：AUDIO SELECT CH1スイッチの設定が

AUTOの場合のみテスト信号を出力する。
MIC CH1 Level Side1/Front/Front+Side1 フロントマイクの入力音声をチャンネル1に記

録する場合に、どのつまみで音声レベルを調節
するかを選択する。
Side1：サイドパネルのLEVELつまみ（左）
Front：フロントパネルのMICLEVELつまみ
Front+Side1：LEVELつまみ（左）とMIC LEVEL
つまみを連動させる

MIC CH2 Level Side2/Front/Front+Side2 フロントマイクの入力音声をチャンネル2に記
録する場合に、どのつまみで音声レベルを調節
するかを選択する。
Side2：サイドパネルのLEVELつまみ（右）
Front：フロントパネルのMIC LEVELつまみ
Front+Side2：LEVELつまみ（右）とMIC LEVEL
つまみを連動させる

Rear1/WRR Level Side1/Front/Front+Side1 ワイヤレスマイクとリアパネルのAUDIO IN 
CH-1端子に接続した機器をどのつまみで音声
レベルを調節するかを選択する。
Side1：サイドパネルのLEVELつまみ（左）
Front：フロントパネルのMIC LEVELつまみ
Front+Side1：LEVELつまみ（左）とMIC LEVEL
つまみを連動させる
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Maintenance >Audio
オーディオに関する設定を行います。

項目 設定値 内容
Rear2/WRR Level Side2/Front/Front+Side2 ワイヤレスマイクとリアパネルのAUDIO IN 

CH-2端子に接続した機器をどのつまみで音声
レベルを調節するかを選択する。
Side2：サイドパネルのLEVELつまみ（右）
Front：フロントパネルのMICLEVELつまみ
Front+Side2：LEVELつまみ（右）とMIC LEVEL
つまみを連動させる

Audio CH3 Level Side3/Front/Front+Side3 チャンネル3に記録される音声レベルをどのつ
まみで調節するかを選択する。
Side3：サイドパネルのLEVELつまみ
Front：フロントパネルのMIC LEVELつまみ
Front+Side3：LEVELつまみとMIC LEVELつま
みを連動させる

Audio CH4 Level Side4/Front/Front+Side4 チャンネル4に記録される音声レベルをどのつ
まみで調節するかを選択する。
Side4：サイドパネルのLEVELつまみ
Front：フロントパネルのMIC LEVELつまみ
Front+Side4：LEVELつまみとMIC LEVELつま
みを連動させる

Maintenance >WRR Setting
ワイヤレスチューナーに関する設定を行います。

項目 設定値 内容
WRR Valid CH Sel All/CH1 ワイヤレスレシーバーのチャンネル1、2とも有

効にするか（All）、チャンネル1のみを有効にす
るか（CH1）を選択する。

WRR CH Select TX1/TX2 内容をメニューに表示する受信チャンネルを選
択する。
TX1：チャンネル1の内容を表示する。
TX2：チャンネル2の内容を表示する。

WRR Delay Comp On/Off ワイヤレス入力音声の遅延補正機能を有効にす
るか（On）無効にするか（Off）を選択する（On
を選択するとすべてのE-E出力の音声が約8ms
遅延する）。

TX --- WRR CH Selectで選択したチャンネルで受信し
ている送信機の名前を表示する。

TX Audio Peak ---/Peak WRR CH Selectで選択したチャンネルで受信し
ている送信機のAFレベルがピークオーバーか
どうかを表示する。

Maintenance >WRR Setting
ワイヤレスチューナーに関する設定を行います。

項目 設定値 内容
TX Input Level ---/Mic/Line WRR CH Selectで選択したチャンネルで受信し

ている送信機の入力レベルがマイク（Mic）とラ
イン（Line）のどちらに設定されているかを表
示する。

TX ATT Level --- WRR CH Selectで選択したチャンネルで受信し
ている送信機のATTレベルを設定する(設定値の
可変範囲は、受信している送信機によって異な
る場合がある)。

TX LCF Frequency --- WRR CH Selectで選択したチャンネルで受信し
ている送信機のローカットフィルター周波数を
設定する（設定値の可変範囲は、受信している
送信機によって異なる場合がある）。

TX System Delay Auto/0.0ms～ 8.0ms 音声の遅延量を設定する。
Auto：ワイヤレスレシーバーから送られてく
る音声の遅延量が0になるように自動的に
遅延量を補正する。

0.0ms～ 8.0ms：オーディオミキサーなどを介
して複数のワイヤレスシステムを使用して
いる場合に、予測されるワイヤレスシステ
ムの遅延量を設定する。

TX RF Power High（Power値）mW/Mid
（Power値）mW/Low（Power
値）mW

WRR CH Selectで選択されたチャンネルで通信
している送信機のRF Power Levelを設定する
（設定値の可変範囲は、受信している送信機に
よって異なる場合がある）。

TX Power Save Active/Sleep WRR CH Selectで選択されたチャンネルで受信
している送信機のパワーセーブモードを設定す
る。
Active：送信機を起動モードにする。
Sleep：送信機をパワーセーブモードにする。

TX-Cam Power Sync Off/On 送信機のパワーセーブ状態を本機のPOWERス
イッチと同期して切り替えるかどうかを設定す
る。
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Maintenance >Time Code
タイムコードに関する設定を行います。

項目 設定値 内容
TC Out Auto/Generator タイムコード出力を選択する。

Auto：記録時はタイムコードジェネレーター
の値を出力し、再生時はタイムコードリー
ダーの値を出力する

Generator：記録時、再生時ともタイムコード
ジェネレーターの値を出力する

DF/NDF DF/NDF ドロップフレームモード（DF）またはノンド
ロップフレームモード（NDF）を選択する。

LTC UBIT Fix/Time LTCのユーザービットに記録するデータを設定
する。
Fix：ユーザーが設定したデータを記録する
Time：現在の時刻を記録する

Counter Display Counter/Duration ビューファインダーに表示されるカウンター値
のリセットの方法を選択する。
Counter：RESETボタンを押すまで積算される。
Duration：記録開始ごとにリセットされる。

Maintenance >Essence Mark
エッセンスマークに関する設定を行います。

項目 設定値 内容
Find Mode Clip/Rec Start NEXT/PREVボタンを押したときの動作を設定

する。
Rec Start：次または1つ前のレックスタート
マークに移動する。

Clip：NEXTボタンを押すと、次のクリップの
先頭へ移動する。PREVボタンを押すと、現
在のクリップの先頭に移動する（クリップ
の先頭でPREVボタンを押すと1つ前のク
リップの先頭に移動する）。

Maintenance >Camera Config
カムコーダーの各種動作に関する設定を行います。

項目 設定値 内容
HD SDI Remote I/F Off/Characters/

Green Tally/Red Tally
本機のSDI OUT 1/2端子（HD SDI出力）に接続
された外部機器に対する記録動作制御機能を使
用するかどうか設定する。使用する場合、外部
機器が記録状態であることの表示方法を選択す
る。
Off：記録動作制御機能を使用しない。
Chara：ビューファインダー画面上の状態表示
の外部機器制御表示で表示する。

G-Tally：ビューファインダー内のTALLY（グリー
ンタリー）ランプで表示する。

R-Tally：ビューファインダー内のREC（記録・
レッドタリー）ランプで表示する。

Color Bars Select ARIB/100%/75%/SMPTE カラーバーの種類を選択する。
User Menu Only On/Off メニューを表示したときに、Userメニューだけ

を表示するか（On）、メニューリストを表示す
るか（Off）を選択する。

User Menu with 
Lock

On/Off メニュー表示にロックをかけて、Userメニュー
だけの表示にするかどうかを選択する。
On：任意の暗証番号を入力し、メニュー表示
にロックをかける。（Userメニューだけの
表示になります。）

Off：Onしたときに入力した任意の暗証番号を
入力し、ロックを解除する。（解除すると、
通常のメニューリスト表示に切り換わりま
す。）

［ご注意］
通常のメニュー表示操作では、表示されません。
メニュー表示操作方法は、100ページをご覧くださ
い。

RM Common 
Memory

On/Off リモートコントロールユニット接続時とローカ
ル操作時で設定を共有するか（On）共有しない
か（Off）を選択する。

RM Rec Start RM/Camera/PARA リモートコントロールユニット接続時にどちら
の記録開始／停止ボタンを有効にするかを設定
する。
RM：リモートコントロールユニット
Camera：カムコーダー
PARA：両方
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Maintenance >Camera Config
カムコーダーの各種動作に関する設定を行います。

項目 設定値 内容
Detail Control(RM/
RCP)

HD/QFHD QFHD記録フォーマット時にRM/RCPでディ
テール操作ができる信号フォーマットをHD、
またはQFHDから選択する。

SET Key on 
Thumbnail

Pause/Play 1つのサムネイルを選択した状態でMENUつま
みを押したときの動作を選択する。

ALAC Auto/Off ALAC（倍率色収差補正）を自動的に実行するか
どうかを設定する。
Auto：ALACに対応しているレンズが取り付け
られ、ALACが有効になっていると、自動
的にALACを実行する。

Off：実行しない。

［ご注意］
収差補正対応レンズによっては、本項目がAutoに設
定されていても電源投入直後に収差補正機能が動作し
ない（ビューファインダー画面上に「ALAC」と表示さ
れない）ことがあります。このようなときは、レンズ
のズームリングとフォーカスリングをいったん端まで
動かして、ビューファインダー画面上に「ALAC」の表
示が出ることを確認してから使用してください。

 ˜ 収差補正対応レンズについては、ソニーのサービ
ス担当者または営業担当者にお問い合わせくださ
い。

Maintenance >Preset White
ホワイトバランスのプリセット値に関する設定を行います。

項目 設定値 内容
Color Temp <P> 1500K～ 3200K～ 50000K ホワイトバランスのプリセット値を設定する。
Color Temp Balance 
<P>

－99～±0～＋99 Color Temp <P>で希望の映像が得られなかっ
た場合に、さらに細かく色温度を設定する。

R Gain <P> －99～±0～＋99 Rゲインのプリセット値を設定する。
B Gain <P> －99～±0～＋99 Bゲインのプリセット値を設定する。
AWB Enable <P> On/Off WHITE BALスイッチがPRSTのとき、AWB（オー

トホワイトバランス）を実行する機能をオン／
オフする。

Maintenance >White Filter
フィルターに関する設定を行います。

項目 設定値 内容
ND Filter C.Temp On/Off 電気的CCフィルターをNDフィルターに割り当

てる機能をオン／オフする。
ND FLT C.Temp<1> 3200K/4300K/5600K/6300K 電気的CCフィルターをNDフィルターに割り当

てるときの色温度を選択する（フィルター1用）。
ND FLT 
C.Temp<2-4>

3200K/4300K/5600K/6300K 電気的CCフィルターをNDフィルターに割り当
てるときの色温度を選択する（フィルター 2～
4用）。

Electrical CC<A> 3200K/4300K/5600K/6300K 電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てるときの色温度を選
択する。

Electrical CC<B> 3200K/4300K/5600K/6300K 電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てるときの色温度を選
択する。

Electrical CC<C> 3200K/4300K/5600K/6300K/ 
---

電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てるときの色温度を選
択する。Cを使わないときは----を選択する。

Electrical CC<D> 3200K/4300K/5600K/6300K/ 
---

電気的CCフィルターの切り換え機能をアサイ
ナブルスイッチに割り当てるときの色温度を選
択する。Dを使わないときは----を選択する。

Maintenance >DCC Adjust
DCC（ダイナミックコントラストコントロール）に関する設定を行います。

項目 設定値 内容
DCC Function 
Select

DCC/Fix OUTPUT/DCCスイッチをCAM、DCC：ONに
したときのニーポイントの設定方法を選択す
る。
DCC：ニーポイントを被写体の輝度に合わせて
自動調整する

Fix：ニーポイントを固定値にする
DCC D Range 400%/450%/500%/550%/ 

600%
OUTPUT/DCCスイッチをCAM、DCC：ONに
したときのダイナミックレンジを設定する。

DCC Point －99～±0～＋99 DCCの最小ニーポイントを設定する。
DCC Gain －99～±0～＋99 DCCの検出値に対するゲイン値を設定する。
DCC Delay Time －99～±0～＋99 DCCの制御スピード（映像の変化に対する反応

速度）を設定する。
DCC Peak Filter －99～±0～＋99 DCCの検出値のピークに対する応答感度を調整

する。
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Maintenance >Flicker Reduce
フリッカー補正機能に関する設定を行います。
蛍光灯など周期的に輝度が変化する照明下で被写体を撮影したとき、記録フレームレートとの関係で
発生するフリッカーを補正できます。

項目 設定値 内容
Mode Auto/On/Off フリッカー補正機能の動作を設定する。

On：常に動作させる。
Auto：フリッカーを検出すると動作する。
Off：動作させない。

Frequency 60Hz/50Hz フリッカーの原因となっている照明の電源周波
数に合わせる。
System Frequencyの設定が59.94、29.97、
23.98の場合の出荷時設定は60Hz
System Frequencyの設定が50, 25の場合の出
荷時設定は50Hz

Maintenance >Genlock
ゲンロックに関する設定を行います。

項目 設定値 内容
Genlock On/Off ゲンロック機能オン／オフする。
Reference Internal/External(HD)/

External(SD)/SDI IN/CA
本機が使用している基準信号の種類を表示す
る。

Maintenance >Auto Shading
オートブラックシェーディング補正を実行します。

項目 設定値 内容
Auto Black Shading Execute/Cancel オートブラックシェーディング補正を実行する

（Executeで実行する）。
Reset Black Shading Execute/Cancel ブラックシェーディング補正値をクリアする

（Executeで実行する）。
Master Gain (TMP) －9dB/－6dB/－3dB/0dB/ 

3dB/6dB/9dB/12dB/18dB/ 
24dB/30dB/36dB/42dB

一時的にマスターゲインの値を設定する（GAIN
スイッチの設定値と同じ値になる）。

Maintenance >APR
自動ピクセルノイズリダクション補正に関する設定を行います。

項目 設定値 内容
APR Execute/Cancel 自動欠陥補正（自動ピクセルノイズリダクショ

ン）機能を実行し、SLSモード時の白点を軽減
する（Executeで実行する）。

Reset Execute/Cancel APRおよびブラックバランスの自動調整の実行
によって、追加登録された白点データを削除す
る（Executeで実行する）。

Maintenance >Basic Authentication
Basic認証に関する設定を行います。

項目 設定値 内容
User Name (現在のユーザー名を表示) 任意のユーザー名を設定する（Basic認証用）。

出荷時はadminに設定されています。
Password ******* Basic認証に使用するパスワードを設定する。

パスワードには、8文字以上の英数字をそれぞ
れ1文字以上使用する。
入力したパスワードは*で表示されるが、SHIFT
キーを押している間は、入力した文字が表示さ
れる。

［ご注意］
本機のファームウェアを5.0未満から5.0以降にバー
ジョンアップすると、パスワード設定はリセットされ
ます。この場合はパスワードを再設定してください。

Maintenance >Network
ネットワーク接続に関する設定と表示を行います。

項目 設定値 内容
Setting On/Off ネットワーク機能をオン／オフする。
Wi-Fi Mode Wi-Fi Access Point/ 

Wi-Fi Station/Off
ワイヤレスLAN接続の動作モードを設定する。

NFC Execute/Cancel NFCによる簡単接続を開始する（Executeで実
行する）。

WPS Execute/Cancel Wi-Fi Protected Setup（=WPS）を開始する
（Executeで実行する）。

Channel Auto(5GHz)/Auto/CH1/CH2/
CH3/CH4/CH5/CH6/CH7/
CH8/CH9/CH10/CH11

ワイヤレスLANのチャンネルを設定する。

［ご注意］
Auto(5GHz)は、ご使用のワイヤレスLANモジュール
によっては、表示されない場合があります。

SSID & Password （SSID表示）
（Password表示）

SSIDとパスワードを表示する。

SSID （SSID表示） Wi-Fi Station Modeでの接続先アクセスポイン
トのSSIDを表示する。
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Maintenance >Network
ネットワーク接続に関する設定と表示を行います。

項目 設定値 内容
Wi-Fi Station Detail 
Settings

Scan Networks（Execute/
Cancel）

接続先ネットワーク自動検出を開始する
（Executeで実行する）。

SSID（アクセスポイントの
SSID）

Wi-Fi Station Modeでの接続先アクセスポイン
トのSSIDを入力する。
入力できる文字は以下のとおり。
アルファベット大文字： A ～ Z
アルファベット小文字： a ～ z
数字： 0 ～ 9
記号： !"#$%&'*+,/:;<=>?[\]^`{|}~

Password（アクセスポイント
のパスワード）

Wi-Fi Station Modeでの接続先アクセスポイン
トのパスワードを入力する。
入力したパスワードは*で表示されるが、SHIFT
キーを押している間は、入力した文字が表示さ
れる。
入力できる文字は以下のとおり。
アルファベット大文字： A ～ Z
アルファベット小文字： a ～ z
数字： 0 ～ 9
記号： !"#$%&'*+,/:;<=>?[\]^`{|}~

DHCP（On/Off） Wi-Fi Station ModeでのDHCPを設定する。
Onにすると、自動的に本機にIPアドレスを割
り当てる。手動で本機のIPアドレスを入力する
場合は、Offにする。

IP Address（DHCP/On：
自動取得 DHCP/Off：
192.168.1.50）

本機のIPアドレスを入力する。
DHCPがOffのときに有効。

Subnet Mask（DHCP/
On：自動取得 DHCP/Off：
255.255.255.0）

本機のサブネットマスクを入力する。
DHCPがOffのときに有効。

Gateway（DHCP/On：自動取
得 DHCP/Off：0.0.0.0）

アクセスポイントのゲートウェイを入力する。
DHCPがOffのときに有効。

DNS Auto（On/Off） DNS自動取得を設定する。
Onにすると、自動的にDNSサーバーのアドレ
スを取得する。

Primary DNS Server（DNS 
Auto/On：自動取得 DNS 
Auto/Off：0.0.0.0）

ルーターのプライマリー DNSサーバーを入力
する。
DNS AutoがOffのときに有効。

Maintenance >Network
ネットワーク接続に関する設定と表示を行います。

項目 設定値 内容
Wi-Fi Station Detail 
Settings

Secondary DNS Server（DNS 
Auto/On：自動取得 DNS 
Auto/Off：0.0.0.0）

ルーターのセカンダリー DNSサーバーを入力
する。
DNS AutoがOffのときに有効。

Device Name (Wi-Fi) USBワイヤレスLANモジュール用端子に装着さ
れているネットワーク機器の名称を表示する。

IP Address (Wi-Fi) ワイヤレスLAN接続時の本機のIPアドレスを表
示する。

Subnet Mask (Wi-Fi) ワイヤレスLAN接続時のサブネットマスクを表
示する。

MAC Address (Wi-Fi) 本機に搭載されているUSB Wireless LAN 
ModuleのMacアドレスを表示する。

Regenerate 
Password

Execute/Cancel パスワードを再生成する（Executeで実行す
る）。

Modem On/Off 3G/4Gモデムによるネットワーク接続の有効／
無効を設定する。

Wired LAN Enable/Disable 有線LAN接続有効／無効を設定する。
Wired LAN Remote On/Off LANケーブルでネットワーク接続したときに、

Wi-Fiリモコン、Webメニュー、「Content 
Browser Mobile」アプリケーションからの操作
の有効／無効を設定する。

Wired LAN Detail 
Settings

DHCP（On/Off） DHCPを設定する。
Onにすると、自動的に本機にIPアドレスを割
り当てる。
手動で本機のIPアドレスを入力する場合は、
Offにする。

IP Address（DHCP/On：
自動取得 DHCP/Off：
192.168.2.50）

本機のIPアドレスを入力する。
DHCPがOffのときに有効。

Subnet Mask（DHCP/
On：自動取得 DHCP/Off：
255.255.255.0）

本機のサブネットマスクを入力する。
DHCPがOffのときに有効。

Gateway（DHCP/On：自動取
得 DHCP/Off：0.0.0.0）

アクセスポイントのゲートウェイを入力する。
DHCPがOffのときに有効。

DNS Auto（On/Off） DNS自動取得を設定する。
Onにすると、自動的にDNSサーバーのアドレ
スを取得する。
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Maintenance >Network
ネットワーク接続に関する設定と表示を行います。

項目 設定値 内容
Wired LAN Detail 
Settings

Primary DNS Server（DNS 
Auto/On：自動取得 DNS 
Auto/Off：0.0.0.0）

ルーターのプライマリー DNSサーバーを入力
する。
DNS AutoがOffのときに有効。

Secondary DNS Server（DNS 
Auto/On：自動取得 DNS 
Auto/Off：0.0.0.0）

ルーターのセカンダリー DNSサーバーを入力
する。
DNS AutoがOffのときに有効。

Maintenance >Network Client Mode
XDCAM airやソニー製ネットワークRXステーションと接続するためのネットワーククライアント
モードに関する設定を行います。

 ［ご注意］
すべての項目に値が入力されないと、ネットワーククライアントモードを設定できません。

項目 設定値 内容
Setting On/Off ネットワーククライアントモードをオン／オフ

する。

［ご注意］
Onにすると、ファームウェアのバージョンアップは
できません。

Preset Select Preset 1/Preset 2/Preset 3 ネットワーククライアントモードの接続設定を
あらかじめ設定したプリセット設定（Preset 1/
Preset 2/Preset 3）から選択する。

Preset 1 （プリセット名の表示） プリセット名を入力する。
CCM Address 接続先CCMのアドレスを設定する。

ホスト名またはIPアドレス
CCM Port（1～ 65535（8443）) 接続先CCMのポート番号を設定する。
User Name 接続先CCMの認証用ユーザー名を設定する。
Password 接続先CCMのパスワードを設定する。

入力したパスワードは*で表示されるが、SHIFT
キーを押している間は、入力した文字が表示さ
れる。

NCM with Proxy（Enable/
Disable）

Enable：CCM接続時のプロキシ記録を有効に
する。

Disable：CCM接続時のプロキシ記録を無効に
する。

Camera Control（Enable/
Disable）

CCM接続時のカメラコントロール操作の許可
／不許可を設定する。

Maintenance >Network Client Mode
XDCAM airやソニー製ネットワークRXステーションと接続するためのネットワーククライアント
モードに関する設定を行います。

 ［ご注意］
すべての項目に値が入力されないと、ネットワーククライアントモードを設定できません。

項目 設定値 内容
Preset 1 Camera Setting (Always/

Onetime/Off)
CCM接続時のALLファイル操作の許可／不許可
を設定する。
Always：常にALLファイルの操作を許可する
Onetime：1回だけALLファイルの操作を許可
する

Off：ALLファイルの操作を許可しない
Preset 2 Preset 1と同じ Preset 1と同じ
Preset 3 Preset 1と同じ Preset 1と同じ

Maintenance >File Transfer
ファイルのネットワーク転送に関する設定を行います。

項目 設定値 内容
File Transfer Execute/Cancel 転送モードへ移行する（Executeで実行する）。
Remote File Transfer Enable/Disable 本機で記録したオリジナルファイル転送時、転

送モードへの移行をネットワークからのリモー
ト操作で許可する／許可しないを設定する。
Enable：ネットワークからのリモート操作で、
転送モードへの移行を許可する。 
Maintenance >File Transferで転送を実行
する必要はありません。

Disable：ネットワークからのリモート操作で、
転送モードへの移行を許可しない。 
Maintenance >File Transferで転送を実行
する必要があります。

Auto Upload (Proxy) Off/On プロキシファイルの自動転送をオン／オフす
る。

Default Upload 
Server

Sony Ci/NCM RX Server/
Server Settings1/Server 
Settings2/Server Settings3

オリジナルファイルやプロキシファイルの転送
先サーバーを選択する。
Server Settings1～ 3は、Webメニューの
「Upload Settings」のDisplay Nameに入力し
たサーバー名が表示されます。詳しくは「転送
先のサーバーを登録するには」（88ページ）
をご覧ください。

Clear Completed 
Jobs

Execute/Cancel 転送完了済みのジョブをジョブリストからクリ
アする。



000 7章　メニュー表示と詳細設定：Maintenanceメニュー127

Maintenance >File Transfer
ファイルのネットワーク転送に関する設定を行います。

項目 設定値 内容
Clear All Jobs Execute/Cancel ジョブリストに登録したすべてのジョブをクリ

アする。
View Job List 転送ジョブ一覧を表示する。

Maintenance >Streaming
ストリーミングに関する設定を行います。

項目 設定値 内容
Setting On/Off ストリーミング伝送をオン／オフする。

［ご注意］

ˎˎ この設定は、本機の電源を入れ直したときにOffに
リセットされます。
ˎˎ Onにすると、「Content Browser Mobile」アプリ
ケーションでのモニタリング機能は使えません。

Preset Select Preset 1/Preset 2/Preset 3 ストリーミングのプリセット項目を選択する。
設定項目はPreset 1/Preset 2/Preset 3で共通
です。各設定項目については、以下を参照して
ください。

Size HD Auto/ 
1280x720/ 
640x360/ 
480x270/ 
320x180

ストリーミング用の映像のサイズを設定する。
HD Autoを選択した場合、SxSに記録される記
録フォーマットの設定や、再生するクリップ
のフォーマットに基づいて、サイズが1920×
1080か1280×720に設定されます。

Bit Rate 9Mbps/ 
6Mbps/ 
3Mbps/ 
2Mbps/ 
1Mbps/ 
0.5Mbps/ 
0.3Mbps(Mono L)/ 
0.3Mbps(Mono R)/ 
0.2Mbps(Mono L)/ 
0.2Mbps(Mono R)

ストリーミング用の映像のビットレートを設定
する。
選択できるビットレートはSizeの設定値により
異なります。

［ご注意］

ˎˎ インターネット経由で映像／音声データをそのまま
送信します。そのためデータが漏えいする可能性が
あります。送信先がストリーミングデータを受信で
きていることを確認してください。
ˎˎ アドレスの設定ミスなどにより意図しない相手に
データを送信してしまう可能性があります。
ˎˎ ネットワークの状況により、すべてのフレームを再
生できない場合があります。
ˎˎ 動きの激しいシーンでは、画質が悪くなります。
ˎˎ ストリーミングを大きなサイズで小さいビットレー
トに設定した場合、すべてのフレームが再生できな
い場合があります。この現象を軽減させるためには
Sizeでより小さいサイズを選んでください。

Maintenance >Streaming
ストリーミングに関する設定を行います。

項目 設定値 内容
Type MPEG-2 TS/UDP/ 

MPEG-2 TS/RTP
ストリーミング用の映像の種類を選択する。

Destination Address 文字列(0.0.0.0） ストリーミングデータの伝送先サーバーのアド
レスを入力する。

Destination Port 1～ 65545(1234） 伝送先サーバーの、ストリーミングに使用する
ポート番号を入力する。

Audio Channel CH1/CH2/CH3/CH4 ストリーミング出力に乗せるAudio Channelを
選択する。

Maintenance >Clock Set
内蔵時計を設定します。

項目 設定値 内容
Date Mode YYMMDD/MMDDYY/

DDMMYY
年月日の表示方式を選択する。

12H/24H 12H/24H 時刻の表示形式を選択する。
Date 日付設定画面を表示する。
Time 時刻設定画面を表示する。

Maintenance >Language
メッセージの表示言語を選択します。

項目 設定値 内容
Select English/中文(简)/日本語/

Espanol/Русский 
メッセージの表示言語を選択する。

Maintenance >Hours Meter
デジタル時間計に関する設定を行います。

項目 設定値 内容
Hours (System) xxxxH

（xxxxは時間）
積算使用時間（リセット不可）を表示する。

Hours (Reset) xxxxH
（xxxxは時間）

積算使用時間（リセット可）を表示する。

Reset Execute/Cancel Hours（Reset）表示を0にリセットする
（Executeで実行する）。

Maintenance >Network Reset
ネットワーク関連設定を工場出荷状態に戻します。

項目 設定値 内容
Reset Execute/Cancel ネットワーク関連の設定を初期化する

（Executeで実行する）。
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Maintenance >Fan Control
ファンの制御モードを設定します。

項目 設定値 内容
Setting Auto/Minimum/Off in Rec ファンの制御モードを選択する。

Maintenance >VF Display Setting
ビューファインダーの表示に関する設定を行います。

項目 設定値 内容
Chara/Marker 
Brightness

5/4/3/2/1 ビューファインダーの映像に重畳するキャラク
ター、アイコン、マーカーの明るさを設定する。

Maintenance >Option
ソフトウェアオプションの確認や操作を行います。

項目 設定値 内容
Type 1 （オプションのモデル名） インストールされている1つ目のオプションの

モデル名が表示されます。
Type 2 （オプションのモデル名） インストールされている2つ目のオプションの

モデル名が表示されます。
Type 3 （オプションのモデル名） インストールされている3つ目のオプションの

モデル名が表示されます。
Install Option Execute/Cancel オプションのインストール画面を表示する

（Executeで実行する）。
Remove Option ソフトウェアオプションのリムーブ画面を表示

する。

Maintenance >Version
本機のバージョン表示およびバージョンアップを実行します。

項目 設定値 内容
Number 本機のソフトウェアバージョンを表示する（Vx.

xx）。
Version Up Execute/Cancel UTILITY SDカードスロットを使用し、本機のソ

フトウェアをバージョンアップする（Execute
で実行する）。
以下のSDカードが使用できます。

 ˎ SDHCメモリーカード（Speed Class：4以上/
UHS非対応／容量：4～ 32 GB）

［ご注意］
バージョンアップデータのSDカードが挿入されてい
ないとき、またはMaintenanceメニューのNetwork 
Client Mode >SettingがOnのときは選択できませ
ん。

Maintenance >Version
本機のバージョン表示およびバージョンアップを実行します。

項目 設定値 内容
Net-Func Version 
Number

本機のワイヤレスLAN接続機能のバージョンを
表示する（Vx.xx）。

［ご注意］
OperationメニューのXAVC Proxy Rec Mode 
>SettingがOff、かつMaintenanceメニューの
Network >SettingがOffのときは表示されません。

Net-Func Ver.Up Execute/Cancel PROXY SDカードスロットを使用し、本機のワ
イヤレスLAN接続機能のソフトウェアをバー
ジョンアップする（Executeで実行する）。
以下のSDカードが使用できます。

 ˎ SDHCメモリーカード（Speed Class：4以上/
UHS非対応／容量：4～ 32 GB）

 ˎ SDXCメモリーカード（Speed Class：4以上/
UHS非対応／容量：64～ 256 GB）

［ご注意］
MaintenanceメニューのNetwork Client Mode 
>SettingがOnのときは選択できません。
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Fileメニュー
太字とアンダーラインで表示されている設定値は、出荷時の初期設定値です。

File >User File
ユーザーファイルの操作に関する設定を行います。

項目 設定値 内容
Load SD Card ユーザーファイルの設定をSDカードから呼び

出す画面を表示する。
Save SD Card ユーザーファイルの設定をSDカードへ保存す

る画面を表示する。
File ID ユーザーファイルのFile ID表示と編集を行う画

面を表示する。
Recall User Preset Execute/Cancel Userメニューに登録されているメニュー項目の

値をプリセット値に戻す（Executeで実行）。
Store User Preset Execute/Cancel Userメニューに登録されているメニュー項目の

値をプリセット値として保存する（Executeで
実行）。

Clear User Preset Execute/Cancel Userメニューに登録されているメニュー項目の
現在の設定値およびプリセット値を工場出荷値
に戻す（Executeで実行）。

Load Customize 
Data

On/Off ［Load SD Card］の実行時にUserメニューの構
成カスタマイズ情報を読み込むかどうかを設定
する。

Load White Data On/Off ［Load SD Card］の実行時にホワイトバランス
情報を読み込むかどうかを設定する。

File >All File
ALLファイルの操作に関する設定を行います。

項目 設定値 内容
Load SD Card All Fileの設定をSDカードから呼び出す画面を

表示する。
Save SD Card All Fileの設定をSDカードへ保存する画面を表

示する。
File ID All FileのFile ID表示と編集を行う画面を表示す

る。
All Preset Execute/Cancel すべての項目をプリセット値に戻す（Execute

で実行する）。
Store All Preset Execute/Cancel すべての項目について現在の設定値をプリセッ

ト値として保存する（Executeで実行する）。
Clear All Preset Execute/Cancel All Fileの対象のメニュー項目の現在の設定

値およびプリセット値を工場出荷値に戻す
（Executeで実行する）。

File >All File
ALLファイルの操作に関する設定を行います。

項目 設定値 内容
3Sec Clear Preset On/Off MENU CANCEL/PRST/ESCAPEスイッチを

CANCEL/PRST側に3秒間押し上げたままにす
ると項目ごとに現在の設定値とプリセット値が
クリアされる機能をオン／オフする。

File >Scene File
シーンファイルの操作に関する設定を行います。

項目 設定値 内容
Recall Internal 
Memory

内蔵メモリーからシーンファイルを呼び出す画
面を表示する。

Store Internal 
Memory

内蔵メモリーにシーンファイルを保存する画面
を表示する。

Load SD Card SDカードからシーンファイルを呼び出す画面
を表示する。

Save SD Card SDカードにシーンファイルを保存する画面を
表示する。

File ID シーンファイルのFile ID表示と編集を行う画面
を表示する。

Scene White Data On/Off シーンファイルを呼び出す場合に、シーンファ
イルのホワイトバランスデータを反映させるか
どうかを設定する。

File >Reference File
リファレンスファイルの操作に関する設定を行います。

項目 設定値 内容
Store Reference Execute/Cancel リファレンスファイルの対象メニュー項目

の現在の設定値をプリセット値に保存する
（Executeで実行）。

Clear Reference Execute/Cancel リファレンスファイルの対象メニュー項目の現
在の設定値およびプリセット値を工場出荷値に
戻す（Executeで実行）。

Load Reference(SD 
Card)

Execute/Cancel SDカードからリファレンスファイル設定値を
呼び出し、プリセット値に設定する（Execute
で実行）。

Save Reference(SD 
Card)

Execute/Cancel リファレンスファイルの対象メニュー項目のプ
リセット値をSDカードに保存する（Executeで
実行）。

File ID リファレンスファイルのFile ID表示と編集を行
う画面を表示する。
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File >Lens File
レンズファイルの操作に関する設定を行います。

項目 設定値 内容
Display Mode Model Name/Lens ID 保存や呼び出し時に表示されるリストボックス

に表示する項目を選択する。
Recall Internal 
Memory

内蔵メモリーからレンズファイルを呼び出す画
面を表示する。

Store Internal 
Memory

内蔵メモリーにレンズファイルを保存する画面
を表示する。

Load SD Card SDカードからレンズファイルを呼び出す画面
を表示する。

Save SD Card SDカードにレンズファイルを保存する画面を
表示する。

File ID レンズファイルのFile ID表示と編集を行う画面
を表示する。

File Source 選択しているファイルの番号が表示される。
Clear Lens Offset Execute/Cancel レンズファイルをクリアする（Executeで実行

する）。
Lens Auto Recall Off/On(Lens Name)/

On(Serial Number)
シリアル通信対応レンズ装着時に、該当するレ
ンズファイルを自動的に呼び出すかどうかを設
定する。

Lens Serial Number 装着されたシリアル通信対応レンズのシリアル
ナンバーが表示される（対応レンズのみ）。

Lens Name 装着されたシリアル通信対応レンズの機種名が
表示される（対応レンズのみ）。

Lens Manufacturer 装着されたシリアル通信対応レンズのメーカー
名が表示される（対応レンズのみ）。

Master V 
Modulation

－99～±0～＋99 レンズファイルに垂直方向のSAWシェーディン
グ補正値を設定する。

Lens Center H －40～±0～ +40 レンズファイルにセンターマーカーの水平位置
を設定する。

Lens Center V －40～±0～ +40 レンズファイルにセンターマーカーの垂直位置
を設定する。

R Flare －99～±0～＋99 レンズファイルにRフレアレベルを設定する。
G Flare －99～±0～＋99 レンズファイルにGフレアレベルを設定する。
B Flare －99～±0～＋99 レンズファイルにBフレアレベルを設定する。
White Offset R －99～±0～＋99 レンズファイルにレンズによるホワイトバラン

スオフセットのRch補正値を設定する。

File >Lens File
レンズファイルの操作に関する設定を行います。

項目 設定値 内容
White Offset B －99～±0～＋99 レンズファイルにレンズによるホワイトバラン

スオフセットのBch補正値を設定する。
Shading Ch Select Red/Green/Blue ホワイトシェーディング補正の対象を選択す

る。
Shading H SAW －99～±0～＋99 レンズファイルに水平方向のSAWホワイト

シェーディング補正値を設定する。
Shading H PARA －99～±0～＋99 レンズファイルに水平方向のパラボラホワイト

シェーディング補正値を設定する。
Shading V SAW －99～±0～＋99 レンズファイルに垂直方向のSAWホワイト

シェーディング補正値を設定する。
Shading V PARA －99～±0～＋99 レンズファイルに垂直方向のパラボラホワイト

シェーディング補正値を設定する。

File >User Gamma
User Gammaに関する設定を行います。

項目 設定値 内容
Current Settings ユーザーガンマファイルの現在の設定（ファイ

ル名）リスト画面を表示する。
Load SD Card User Gammaの設定をSDカードから呼び出す

画面を表示する。
Reset 1/2/3/4/5/All 設定をリセットするユーザーガンマファイルを

選択し、Executeで実行する。
Allを選択するとすべてのユーザーガンマファイ
ルがリセットされる。
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アサイナブルスイッチに機能を割り当てる
OperationメニューのAssignable Switchで、ASSIGN. 0～ 3スイッチ、ASSIGNABLE 4/5スイッ
チとONLINEボタン、レンズのRETボタンに任意の機能を割り当てることができます。
工場出荷時には、それぞれ下表に示す機能が割り当てられています。

スイッチ／ボタン 機能 Assignable Switchの設定
ASSIGN. 0スイッチ 未設定 Off
ASSIGN. 1スイッチ 未設定 Off
ASSIGN. 2スイッチ 未設定 Off
ASSIGN. 3スイッチ 未設定 Off
ASSIGNABLE 4スイッチ 未設定 Off
ASSIGNABLE 5スイッチ 未設定 Off
RETボタン レックレビュー（再生可能な場合） Lens RET
ONLINEボタン Proxyクリップを自動転送する Network Client Mode

ASSIGN. 0スイッチに割り当て可能な機能

Assignable Switchの 
設定

機能 電源再投入時の状態

Off 未設定 －
Marker すべてのマーカー表示をオン／オフする 設定を保持する
ATW Hold ATW（自動追尾ホワイトバランス）によるホワ

イトバランス設定値を保持する
－

Picture Cache Rec ピクチャーキャッシュレックモードをオン／オ
フする

設定を保持する

Focus Magnifier 拡大フォーカス機能をオン／オフする 設定を保持しない
Zebra ゼブラ表示をオン／オフする 設定を保持しない
Shot Mark1 ショットマーク1を書き込む －
Shot Mark2 ショットマーク2を書き込む －
Clip Flag OK 記録または再生中のクリップに対してOKフラ

グを設定／解除する
設定を保持しない

Clip Flag NG 記録または再生中のクリップに対してNGフラ
グを設定／解除する

設定を保持しない

Clip Flag Keep 記録または再生中のクリップに対してKP
（Keep）フラグを設定／解除する

設定を保持しない

Flash Band Reduce1) フラッシュバンド現象補正機能をオン／オフする 設定を保持しない

1) Flash Band Reduceがオンでも、シャッタースイッチがオンの場合は機能しません。

ASSIGN. 2スイッチに割り当て可能な機能

［ご注意］
ASSIGN. 2スイッチに機能を割り当てた直後と記録フォーマットの切り換え直後は、その時点のスイッチの設定と本機の
状態が一致しないことがあります。機能の割り当て後にASSIGN. 2スイッチを切り換えるか、電源を再投入すると一致し
ます。

Assignable Switchの 
設定

機能

Off 未設定
Front Mic ステレオマイク接続時、ステレオ／モノラルを切り換える
Marker すべてのマーカー表示をオン／オフする
Picture Cache Rec 1) ピクチャーキャッシュレックモードをオン／オフする
Zebra ゼブラ表示をオン／オフする
Clip Continuous Rec クリップコンティニュアスレックモードをオン／オフする
Rec Source 記録する信号をカメラ画または外部入力に切り換える（記録／再生中に操作

すると、記録／再生が終了してから切り換えが実行される）
TX Power Save ワイヤレス送信機のパワーセーブモードを切り換える

1) Picture Cache Recを割り当てると、メニューのOperation >Rec Functionは無効（グレー表示）になり、設定できな
くなります。
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ASSIGN. 1/3スイッチ、ASSIGNABLE 4/5スイッチと
ONLINEボタンに割り当て可能な機能

Assignable Switchの 
設定

機能 電源再投入時の状態

Off 未設定 －
Front Mic ステレオマイク接続時、ステレオ（オン）／モ

ノラル（オフ）を切り換える
設定を保持する

Marker すべてのマーカー表示をオン／オフする 設定を保持する
Last Clip Delete 直前に記録したクリップを削除する －
ATW ATW（自動追尾ホワイトバランス）モードをオ

ン／オフする
設定を保持しない

ATW Hold ATWによるホワイトバランス設定値を保持す
る

－

Turbo Gain Operation >Gain Switch >Gain Turboの設定
に基づいてターボゲインを実行する

設定を保持しない

Rec Review レックレビューを実行する －
Rec 記録開始／停止を実行する －
NFC NFC機能を実行する －
Network Client Mode ネットワーククライアントモードをオン／オフ

する
設定を保持する

Streaming ストリーミング伝送をオン／オフする 設定を保持しない
Auto Upload(Proxy) プロキシファイルの自動転送のオン／オフを設

定する
設定を保持する

Picture Cache Rec ピクチャーキャッシュレックモードをオン／オ
フする

設定を保持する

Spotlight オートアイリスモードをスポットライトに設定
／解除する

設定を保持する

Backlight オートアイリスモードをバックライトに設定／
解除する

設定を保持する

VF Mode ビューファインダー画面の白黒（オン）／カラー
（オフ）を切り換える

設定を保持する

Video Signal Monitor ビデオ信号モニター表示機能を切り換える 設定を保持する
Lens Info 被写界深度表示のオフ、メーター表示、フィー

ト表示を切り換える
設定を保持する

Assignable Switchの 
設定

機能 電源再投入時の状態

Zoom Tele/Wide シリアル通信対応レンズ使用時に、
ASSIGNABLE 4にZoom Tele機能を、
ASSIGNABLE 5にZoom Wide機能をそれぞれ
割り当てる（<4>、<5>の設定時のみ表示する）

［ご注意］
プロキシ単独記録中に割り当て設定を変更しないでく
ださい。

－

Zoom Wide/Tele シリアル通信対応レンズ使用時に、
ASSIGNABLE 4にZoom Wide機能を、
ASSIGNABLE 5にZoom Tele機能をそれぞれ割
り当てる（<4>、<5>の設定時のみ表示する）

［ご注意］
プロキシ単独記録中に割り当て設定を変更しないでく
ださい。

－

Manual Focus Assist マニュアルフォーカスアシスト機能をオン／オ
フする

設定を保持する

Focus Magnifier 拡大フォーカス機能をオン／オフする 設定を保持しない
Zebra ゼブラ表示をオン／オフする 設定を保持しない
Lens RET レックレビュー（再生可能な場合） －
Shot Mark1 ショットマーク1を書き込む －
Shot Mark2 ショットマーク2を書き込む －
Clip Flag OK 記録または再生中のクリップに対してOKフラ

グを設定 ／解除する
設定を保持しない

Clip Flag NG 記録または再生中のクリップに対してNGフラ
グを設定 ／解除する

設定を保持しない

Clip Flag Keep 記録または再生中のクリップに対してKP
（Keep）フラグを設定／解除する

設定を保持しない

Color Temp SW 3200K ホワイトバランスを3200Kのプリセット値でホ
ワイトバランス調整を行う

設定を保持する

Color Temp SW 4300K ホワイトバランスを4300Kのプリセット値でホ
ワイトバランス調整を行う

設定を保持する

Color Temp SW 5600K ホワイトバランスを5600Kのプリセット値でホ
ワイトバランス調整を行う

設定を保持する

Color Temp SW 6300K ホワイトバランスを6300Kのプリセット値でホ
ワイトバランス調整を行う

設定を保持する
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Assignable Switchの 
設定

機能 電源再投入時の状態

Electrical CC ホワイトバランス調整値に対して
電気的CCフィルターを切り換える
（3200K/4300K/5600K/6300K）機能
スイッチ／ボタンを押すたびに
3200K4300K5600K6300Kと切り換わ
る
Menu設定で変更可能（Electrical 
CC<A><B><C><D>で設定）

［ご注意］
メニューのMaintenance >White Filter >ND Filter 
C.TempがOnの場合は設定できません。
機能を割り当てたあとでND Filter C.TempをOnする
と、そのアサイナブルスイッチは機能しなくなります。

設定を保持する

CC5600K ホワイトバランス調整値に対して5600Kの電気
的CCフィルターをかける

設定を保持する

Clip Continuous Rec クリップコンティニュアスレックモードをオン
／オフする

設定を保持しない

Slow & Quick Motion スロー＆クイックモーションをオン／オフする 設定を保持する
Slot Select スロットAとBの両方に記録メディアが装着さ

れているとき、使用する記録メディアを切り換
える

－

TX Power Save ワイヤレス送信機のパワーセーブモードを切り
換える

設定を保存しない

Flash Band Reduce フラッシュバンド現象補正機能をオン／オフする

［ご注意］
Flash Band Reduceがオンでも、シャッタースイッチ
がオンの場合は機能しません。

設定を保持しない

XAVC Proxy Rec Mode プロキシデータ記録機能をオン／オフする 設定を保持する
XAVC Proxy Rec Start プロキシ記録を開始／停止する 設定を保持しない
HLG Display Assist ビューファインダー上の映像にHLGのガンマ

カーブをかけて表示する

［ご注意］
SDRモード時、または再生時は使用できません。

設定を保持しない

HD (Sub) P/B 
Mode 

サブクリップ再生モードをオン／オフする 設定を保持する

レンズのRETボタンに割り当て可能な機能

Assignable Switchの設
定

機能 電源再投入時の状態

Off 未設定 －
Lens RET レックレビュー（再生可能な場合） －
Rec Review レックレビューを実行する －
Shot Mark1 ショットマーク1を書き込む －
Shot Mark2 ショットマーク2を書き込む －
Clip Flag OK 記録または再生中のクリップに対してOKフラ

グを設定／解除する
設定を保持しない

Clip Flag NG 記録または再生中のクリップに対してNGフラ
グを設定／解除する

設定を保持しない

Clip Flag Keep 記録または再生中のクリップに対してKP
（Keep）フラグを設定／解除する

設定を保持しない

Focus Magnifier 拡大フォーカス機能をオン／オフする 設定を保持しない
XAVC Proxy Rec Start プロキシ記録を開始／停止する 設定を保持しない
HLG Display Assist ビューファインダー上の映像にHLGのガンマ

カーブをかけて表示する

［ご注意］
SDRモード時、または再生時は使用できません。

設定を保持しない
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セットアップメニューの設定内容は、本機の内
蔵メモリーまたはSDカードに保存することがで
きます。このデータを使って、適切なセットアッ
プ状態をすばやく再現できます。
設定データをSDカードに保存する場合は、あら
かじめ、書き込み可能なSDカード（35ページ）
をUTILITY SDカードスロットに挿入しておきま
す。
各ファイルに保存される設定値について
は、「ユーザーデータに保存される項目」
（162ページ）をご覧ください。

設定データ保存用SDカードの挿入

1	スイッチカバーを開ける。

2	設定データ保存用SDカードをUTILITY SD
カードスロットに挿入する。

3	スイッチカバーを閉める。
設定データ保存用SDカードの取り出
し

1	スイッチカバーを開ける。

2	設定データ保存用SDカードを軽く 
1回押して取り出す。

［ご注意］

ˎˎ SDカードにアクセス中に本機の電源を切ったりSDカー
ドを抜いた場合、データは保証されません。カードに
記録されたすべてのデータが壊れる可能性があります。
電源を切ったり、カードを抜くときは、必ず使用する
SDカードのACCESSランプが消灯していることを確認
してから操作してください。
ˎˎ 出し入れ時にはSDカードの飛び出しにご注意ください。

使用できるユーザーデータは次のとおりです。

ユーザーファイル

カスタマイズしたUserメニューの設定項目と
設定データを保存します。SDカードに64個ま
で保存することができます。このファイルを本
機のメモリーに読み込むことにより、USERメ
ニューをカスタマイズした状態にセットアップ
することができます。

ALLファイル

全メニューの設定データを保存します。SDカー
ドに64個まで保存することができます。

［ご注意］
機器固有のデータ（機器ごとに調整が必要なシェーディン
グや出力レベルなど）は保存されません。

シーンファイル

撮影シーンに合わせて設定したペイント項目の
設定値を保存します。本機の内蔵メモリーに5
個、SDカードに64個まで保存することができ
ます。
次のデータをシーンファイルに保存できます。

ˎˎ Paintメニューを使用して設定した値
ˎˎ 標準モードおよびECSモードでのシャッター
スピードの設定

ˎˎ ホワイトバランスのデータ 
保存されるデータおよび呼び出されるデー

タは、メニューのFile >Scene File >Scene 
White Dataの設定によって異なります。

シーンファイルは本機の内蔵メモリーまたはSD
カードに保存することができます。
また保存したシーンファイルを呼び出すことも
できます。

リファレンスファイル

シーンファイルの基準設定（File IDがStandard）
の設定値を保存します。本機の内蔵メモリーと
SDカードに1個ずつ保存することができます。

レンズファイル

レンズ固有の特性を補正する以下のデータを設
定し、レンズファイルとして保存します。本機
の内蔵メモリーに32個、SDカードに64個まで
保存することができます。

設定データ 細目

Vモジュレーションシェー
ディング補正値

M V Modulation

センターマーカーの位置 Lens Center H
Lens Center V

フレアレベル R Flare
G Flare
B Flare

ホワイトバランス補正値 White Offset R
White Offset B

設定データ 細目

ホワイトシェーディング
補正値

Shading Ch Select
Shading H SAW
Shading H PARA
Shading V SAW
Shading V PARA

ガンマファイル

ユーザーが作成したガンマテーブルデータ
（User Gamma Data File）を本機の内部メモ
リーに5個まで保存することができます。

ユーザー設定データ
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ユーザーファイルを保存す
る

1	メニューのFile > User File >Save SD Card
を選択する。
ユーザーファイルの保存先画面が表示され
ます。

2	 MENUつまみを回して保存先を選択し、つ
まみを押す。
File IDがNo Fileの行にファイルを保存する
ことができます。File IDにFile IDが記載さ
れている行を選択すると、そのファイルに
上書きされます。
File IDは自動的に付けられますが、変更す
ることもできます。

3	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。

File IDを変更する

1	メニューのFile >User File >File IDを選択す
る。
File IDの編集画面が表示されます。

2	文字を選択してFile IDを入力する。

3	 MENUつまみを回してDoneを選択し、つま
みを押す。
File IDの変更が完了します。

ユーザーファイルを呼び出
す

1	メニューのFile >User File >Load SD Card
を選択する。
ユーザーファイル一覧画面が表示されます。

2	 MENUつまみを回して呼び出すファイルを
選択し、つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。

［ご注意］
設定データを呼び出すと、本機は自動的に再起動されます。

ユーザーファイル
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設定データをALLファイル
として保存する

1	メニューのFile >All File >Save SD Cardを
選択する。
ALLファイルの保存先画面が表示されます。

2	 MENUつまみを回して保存先を選択し、つ
まみを押す。
File IDがNo Fileの行にファイルを保存する
ことができます。File IDにFile IDが記載さ
れている行を選択すると、そのファイルに
上書きされます。
File IDは自動的に付けられますが、変更す
ることもできます。

3	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。

［ご注意］
ALLファイルには現在の設定値とプリセット値が保存され
ます。

ファイルの保存が実行されないとき
は

操作中または操作後に次のエラーメッセージが
表示されたときは、ファイルは保存されません。

エラーメッ
セージ

状況 対策

File Access 
NG

記録可能なメ
ディアが挿入さ
れていない

記録可能なメ
ディアを挿入す
る

File IDを変更する

1	メニューのFile >All File >File IDを選択す
る。
File IDの編集画面が表示されます。

2	文字を選択してFile IDを入力する。

3	 MENUつまみを回してDoneを選択し、つま
みを押す。
File IDの変更が完了します。

設定データを呼び出す

1	メニューのFile >All File >Load SD Cardを
選択する。
ALLファイル一覧画面が表示されます。

2	 MENUつまみを回して呼び出すファイルを
選択し、つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。

［ご注意］

ˎˎ SDカードからファイルを呼び出すと、本機内部に保存
されている現在の設定値とプリセット値は上書きされ
ます。
ˎˎ ファイルを保存した機器より古いバージョンの機器で
は呼び出しをしないでください。故障の原因となるこ
とがあります。
ˎˎ 設定データを呼び出すと、本機は自動的に再起動され
ます。

ファイルの呼び出しが実行されない
とき

操作中または操作後に次のエラーメッセージが
表示された場合は、ファイルの呼び出しは行わ
れません。

エラーメッ
セージ

状況 対策

File Access 
NG

読み出し可能な
メディアがない
メディアに該当
のファイルがな
い

ファイルを保存
したメディアを
挿入する

現在の設定値をすべてプリ
セット値に戻す

本書では、ユーザーが最初に設定／保存した
セットアップメニューの設定内容を「プリセッ
ト値」と表記します。
ファイルを呼び出して本機をセットアップし、
さらに設定変更を行った状態で元のファイルを
上書き保存した場合でも、プリセット値を復活
させることにより、ファイルの内容をリセット
することができます。

1	メニューのFile >All File >All Presetを選択
する。
確認画面が表示されます。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。

現在の設定値をすべてプリ
セット値として保存する

1	メニューのFile >All File >Store All Preset
を選択する。
確認画面が表示されます。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。

［ご注意］
実行後、本機は自動的に再起動されます。

現在のすべての設定値とプ
リセット値を工場出荷値に
戻す

1	メニューのFile >All File >Clear All Preset
を選択する。
確認画面が表示されます。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。

［ご注意］
実行後、本機は自動的に再起動されます。

ALLファイル
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シーンファイルを内蔵メモ
リーに保存する

1	メニューのFile >Scene File >Store 
Internal Memoryを選択する。
シーンファイル一覧画面が表示されます。
File IDがStandardの保存先にはあらかじめ
標準設定が保存されています。

2	 MENUつまみを回して保存先を選択し、つ
まみを押す。
選択した保存先にシーンファイルが上書き
保存されます。

3	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。

シーンファイルをSDカー
ドに保存する

1	メニューのFile >Scene File >Save SD 
Cardを選択する。
シーンファイル保存先画面が表示されます。

2	 MENUつまみを回して保存先を選択し、つ
まみを押す。
File IDがNo Fileの行にファイルを保存する
ことができます。File IDにFile IDが記載さ
れている行を選択すると、そのファイルに
上書きされます。
File IDは自動的に付けられますが、変更す
ることもできます。

3	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。

File IDを変更する

1	メニューのFile >Scene File >File IDを選択
する。
File IDの編集画面が表示されます。

2	文字を選択してFile IDを入力する。

3	 MENUつまみを回してDoneを選択し、つま
みを押す。
File IDの変更が完了します。

シーンファイルを内蔵メモ
リーから呼び出す

1	メニューのFile >Scene File >Recall 
Internal Memoryを選択する。
シーンファイル一覧画面が表示されます。

2	 MENUつまみを回して呼び出すファイルを
選択し、つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。

シーンファイルをSDカー
ドから呼び出す

1	メニューのFile >Scene File >Load SD 
Cardを選択する。
シーンファイル一覧画面が表示されます。

2	 MENUつまみを回して呼び出すファイルを
選択し、つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。

シーンファイル
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現在の設定値をプリセット
値として保存する

1	メニューのFile >Reference File >Store 
Referenceを選択する。
確認画面が表示されます。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。

現在の設定値をプリセット
値としてSDカードに保存
する

1	メニューのFile >Reference File >Save 
Reference(SD Card)を選択する。
確認画面が表示されます。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。

File IDを変更する

1	メニューのFile >Reference File >File IDを
選択する。
File IDの編集画面が表示されます。

2	文字を選択してFile IDを入力する。

3	 MENUつまみを回してDoneを選択し、つま
みを押す。
File IDの変更が完了します。

リファレンスファイルを
SDカードから呼び出す

1	メニューのFile >Reference File >Load 
Reference(SD Card)を選択する。
確認画面が表示されます。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。

現在のすべての設定値とプ
リセット値を工場出荷値に
戻す

1	メニューのFile >Reference File >Clear 
Referenceを選択する。
確認画面が表示されます。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。

リファレンスファイル
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レンズファイルを内蔵メモ
リーに保存する

1	メニューのFile >Lens File >Store Internal 
Memoryを選択する。
レンズファイル一覧画面が表示されます。

2	 MENUつまみを回して保存先を選択し、つ
まみを押す。
File IDがNo offsetの行にファイルを保存す
ることができます。File IDにFile IDが記載
されている行を選択すると、そのファイル
に上書きされます。
File IDは自動的に付けられますが、変更す
ることもできます。

3	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。

レンズファイルをSDカー
ドに保存する

1	メニューのFile >Lens File >Save SD Card
を選択する。
レンズファイル保存先画面が表示されます。

2	 MENUつまみを回して保存先を選択し、つ
まみを押す。
File IDがNo Fileの行にファイルを保存する
ことができます。File IDにFile IDが記載さ
れている行を選択すると、そのファイルに
上書きされます。

File IDは自動的に付けられますが、変更す
ることもできます。

3	 MENUつまみを回して確認画面のExecute
を選択し、つまみを押す。

File IDを変更する

1	メニューのFile >Lens File >File IDを選択す
る。
File IDの編集画面が表示されます。

2	文字を選択してFile IDを入力する。

3	 MENUつまみを回してDoneを選択し、つま
みを押す。
File IDの変更が完了します。

レンズファイルを内蔵メモ
リーから呼び出す

1	メニューのFile >Lens File >Recall Internal 
Memoryを選択する。
レンズファイル一覧画面が表示されます。

2	 MENUつまみを回して呼び出すファイルを
選択し、つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。

レンズファイルをSDカー
ドから呼び出す

1	メニューのFile >Lens File >Load SD Card
を選択する。
レンズファイル一覧画面が表示されます。

2	 MENUつまみを回して呼び出すファイルを
選択し、つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。

レンズファイルを自動で呼
び出す

シリアル通信対応レンズを使用しているときは、
レンズの設定に対応するレンズファイルを自動
的に呼び出して、本機をセットアップすること
ができます（Lens Auto Recall機能）。
Lens Auto Recall機能を使用するときは、File
メニューの >Lens File >Lens Auto Recallを以
下のいずれかに設定します。
Off：機能を使用しない
On(Lens Name)：レンズ機種名に対応するレ
ンズファイルを呼び出す

On(Serial Number)：レンズ機種名とシリアル
番号に対応するレンズファイルを呼び出す
（シリアル番号の通信が可能なレンズの場
合）

シリアル番号の通信に対応していないレンズを

使用している場合は、On(Serial Number)の設
定でも、レンズ機種名に対応するレンズファイ
ルを呼び出します。

レンズファイル
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ガンマファイルの現在の設
定（ファイル名）を確認す
る

メニューのFile >User Gamma >Current 
Settingsを選択すると、現在設定されているユー
ザーガンマファイル一覧画面が表示されます。

SDカードからユーザーガ
ンマファイルを呼び出す

1	メニューのFile >User Gamma >Load SD 
Cardを選択する。
ユーザーガンマファイル一覧画面が表示さ
れます。

2	 MENUつまみを回して呼び出すファイルを
選択し、つまみを押す。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。

CvpFile EditorTM V4.3で
作成したユーザーガンマ
ファイルを使用する

作成したユーザーガンマファイルはSDカード
の「PRIVATE/SONY/PRO/CAMERA/HD_CAM」
ディレクトリーに保存して、呼び出し操作を行っ
てください。

変更されたファイルの内容
を初期状態にリセットする

1	メニューのFile >User Gamma >Resetを選
択する。
リセットするガンマファイルの番号画面が
表示されます。

2	 MENUつまみを回してリセットするガンマ
ファイルの番号（1～ 5）を選択する。
すべてのガンマファイルをリセットする場
合はAllを選択します。
確認画面が表示されます。

3	 MENUつまみを回してExecuteを選択し、
つまみを押す。

ガンマファイル
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リモートコントロールユニットを接続する
リモートコントロールユニットRM-B170やリ
モートコントロールパネルRCP-1001/1501な
どのコントロールユニットを接続すると、それ
らの機器から本機の機能の一部をコントロール
することが可能です。
RM-B170のMONITOR端子に接続したモニター
画面で、メニューを操作したり、画像をモニター
することもできます。

リモートコントロールユ
ニットを接続する

リモートケーブルを使って、本機のREMOTE端
子（8ピン）と、コントロールユニットのカメラ
端子を接続します。
接続後に本機の電源を入れると、本機はリモー
トコントロールモードになり、本機のメニュー
操作や撮影操作が可能となります。

［ご注意］

ˎˎ 本機へのUSB接続が有効になっている状態では、リモー
トコントロールはできません。
ˎˎ リモートコントロール中に、本機へのUSB接続が有効に
なると、リモートコントロールモードが解除されます。
ˎˎ 本機の電源を入れたままコントロールユニットを接続
したり、接続を外さないでください。
ˎˎ リモートコントロールパネルRCP-1001/1501にはリ
モートケーブルは付属されていません。

コントロールユニットが接続されているときは、
本機の下記スイッチ類は無効になります。

ˎˎ GAINスイッチ
ˎˎ WHITE BALスイッチ
ˎˎ AUTO W/B BALスイッチ
ˎˎ SHUTTERスイッチ
ˎˎ OUTPUT/DCCスイッチ

ˎˎ Turbo GainまたはATW機能が割り当て
られている場合のASSIGN. 1/3スイッチ、
ASSIGNABLE 4/5スイッチおよびONLINEボ
タン

リモートコントロールモー
ドを解除する

本機の電源を切り、コントロールユニットを取
り外します。
本機のスイッチ類の設定が有効になります。

RM-B170にモニターを接
続する

RM-B170のMONITOR端子（BNC型）からは、
VIDEO OUT端子からの出力と同じ信号が出力さ
れます。
RM-B170のMONITOR端子とモニターを接続
する場合は、本機のVIDEO OUT端子の設定を
Composite信号にして、RM-B170に付属の黒
いケーブルを使用してください。

RM-B170接続時の画質調
整項目について

カメラの画質調整項目（ペイントデータ）につい
ては、前回RM-B170を接続したときに設定した
パラメーターが再現されます。

RM-B170接続時の記録開
始／停止ボタンの機能につ
いて

メニューのMaintenance >Camera Config 
>RM Rec Startで選択できます。

RM Rec Startの設定値に対するボタンの機能
は、以下のとおりです。

ボタン RM Rec Startの設定値
RM Camera PARA

本機のREC 
STARTボタン

無効 有効 有効

レンズのVTRボ
タン

無効 有効 有効

記録開始／停
止機能が割り
当てられて
いるASSIGN. 
1/3スイッチ、
ASSIGNABLE  
4/5スイッチ、お
よびONLINEボタ
ン

無効 有効 有効

RM-B170の
MEDIA STARTボ
タン

有効 無効 有効

カメラ画質調整データの
データ構造について

本機の持つカメラ画質調整データ（ペイントデー
タ）のデータ領域には、次図のように、リモー
トコントロールユニットを接続しないときに有
効となる「単独用データ領域」と、リモートコン
トロールユニットを接続したときに有効となる
「リモートコントロール用データ領域」がありま
す。RM-B170などのリモートコントロールユ
ニットの接続／非接続に応じて、「単独用データ
領域」と「リモートコントロール用データ領域」
が自動的に切り換えられて、カメラ部に出力さ
れます。

本機の設定メニュー

単独用データ領域 リモートコントロール用
データ領域

カメラ部のハードウェア

RM-B170接続時
RM-B170非接続時

RM-B170

本機の不揮発性メモリー

リモートコントロールユニットを接続すると、
ペイントデータのデータ領域は「リモートコン
トロール用データ領域」に切り替わり、以前に
リモートコントロールユニットを接続していた
ときの状態が再現されます。
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ただし、リモートコントロールユニット側で絶
対値ボリューム1） や絶対値スイッチ 2）などが設
定されているときは、絶対値ボリュームや絶対
値スイッチのポジションに合わせて状態が変更
されます。
また、リモートコントロールユニットを外すと、
「単独用データ領域」が有効となり、リモートコ
ントロールユニットを接続する前の状態に戻り
ます。
1) 絶対値ボリューム：ボリュームの回転角度（位置）に対
応したデータが出力される。これに対して、回転（変化）
量に応じたデータが出力されるものを相対値ボリュー
ムと呼ぶ。

2) 絶対値スイッチ：トグルスイッチや、スライドスイッ
チ（原則としてモーメンタリー型を除く）のように、ス
イッチのレバー（またはつまみ）の位置とそのスイッチ
の機能の状態とが一致している必要があるスイッチ

メニューのMaintenance >Camera Config 
>RM Common MemoryをOnに設定すると、
リモートコントロールユニットを接続しても「リ
モートコントロールユニット用データ領域」を
無効にしたまま「単独用データ領域」を使うこと
ができます。この場合、リモートコントロール
ユニットは「単独用データ領域」のデータを更新
することになり、外したときもリモートコント
ロールユニットで調整したままの画質が維持さ
れます。ただし、本機のスイッチのポジション
と状態が異なるときは、本機のスイッチが優先
されます。
また、リモートコントロールユニットを接続し
たときに、接続前と比べて画質が変化しないよ
うにすることができます。この場合は、リモー
トコントロールユニットのボリュームをすべて
相対値ボリュームに設定しておく必要がありま
す。

 ˜ 詳しくは、各リモートコントロールユニットに付属の
オペレーションマニュアルをご覧ください。

RM-B170からメニューを
操作する

1	 RM-B170のCHARACTERボタンを押して点
灯させてから、MENUボタンを押す。
RM-B170のMONITOR端子に接続したモニ
ター画面にメニューが表示されます。

2	調整つまみとCANCEL/ENTERボタンを使用
してメニューを選択・設定する。

3	設定が終わったら、MENUボタンをOFFに
してメニューを抜ける。

 ˜ RM-B170の操作について詳しくはRM-B170のオ
ペレーションマニュアルをご覧ください。
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RCP-1001/1501、RM-B170で操作できる主な機能

表の見かた
操作表示の記号の意味は次のとおりです。
○：操作できる
―：操作できない
項目 細目 選択肢 機能 RCP-1001 RCP-1501 RM-B170
Panel Active Panel Active On/Off パネル操作の有効をオン／オフする ○ ○ ○
Bars Bars On/Off カラーバー出力をオン／オフする ○ ○ ○
Call Call On/Off RCP/RMからカムコーダをコールする ○ ○ ○ 1)

Standard Standard On/Off 標準モードにする ○ ○ ○ 1)

ND Filter ND Filter 1/2/3/4 選択されているNDフィルターを表示する ○ ○ ○
CC Filter CC Filter A/B/C/D 選択されているCCフィルターを表示する ― ― ―
Gain Step Gain －9/－6/－3/0/3/6/9/12/18/ 

24/30/36/42dB
マスターゲインの設定 ○ ○ ○

White Balance AWB Start/Stop オートホワイトバランスを実行する
実行中に行った場合はストップする

○ ○ ○

White Memory A/B/PRESET ホワイトバランスのメモリーを切り替える ○ ○ ○
ATW On/Off ATWをオン／オフする ○ 1) ○ ○ 1)

5600K On/Off 電気色温度変換をオン／オフする ○ ○ ○ 1)

Black ABB Start/Stop ブラックバランス自動調整を実行する
実行中に行った場合はストップする

○ ○ ○

Knee Point 75% ～ 90% ～ 109% ニーポイントを設定する ― ○ ○ 1)

Detail Level －99～±0～ +99 QFHDまたはHDディテールレベルを設定する ○ 3) ○ 3) ○ 3)

Shutter Shutter Setting On/Off シャッターをオン／オフする ― ○ ○
Shutter Speed ― シャッター速度を設定する ― ○ ○
ECS Setting On/Off ECS モードをオン／オフする ― ○ ○
ECS Frequency ― ECS モードの周波数を設定する ― ○ ○
SLS Setting On/Off SLS モードをオン／オフする ― ○ ○
SLS Speed ― SLS モードのスピード（フレーム数）を設定する ― ○ ○

Iris Iris Mode Auto/Manual アイリスモードを設定する ○ ○ ○
Iris Level －99～±0～ +99 オートアイリスの目標値レベルを調整する ○ ○ ○
Close On/Off アイリス強制クローズをオン／オフする ○ ○ ―
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項目 細目 選択肢 機能 RCP-1001 RCP-1501 RM-B170
Switch Status Gamma On/Off ガンマ補正機能をオン／オフする ― ○ ○ 1)

Black Gamma On/Off ブラックガンマ補正機能をオン／オフする ○ 1) ○ ○ 1)

Matrix On/Off マトリクス機能をオン／オフする ― ○ ○ 2)

Knee On/Off ニー補正機能をオン／オフする ― ○ ○ 1)

White Clip On/Off ホワイトクリップ調整機能をオン／オフする ― ○ ○ 2)

Detail(QFHD) On/Off QFHDディテール調整機能をオン／オフする ― ○ ○
Detail(HD) On/Off HDディテール調整機能をオン／オフする ― ○ ○
Flare On/Off フレア補正機能をオン／オフする ― ○ ○ 1)

Test Saw On/Off テスト信号をオン／オフする ― ○ ○ 1)

White R Gain －99～±0～ +99 ホワイトバランスのRゲイン値を設定する ○ ○ ○
B Gain －99～±0～ +99 ホワイトバランスのBゲイン値を設定する ○ ○ ○

Black Master Black －99～±0～ +99 マスターブラックレベルを設定する ○ ○ ○
R Black －99～±0～ +99 Rチャンネルブラックレベルを設定する ○ ○ ○
B Black －99～±0～ +99 Bチャンネルブラックレベルを設定する ○ ○ ○

Camcorder Menu Menu On/Off 本機のメニューを操作する ― ― ○
Cancel/Preset Cancel/Preset ― ― ○
Select/Set Select(Up/Down)/Set ― ― ○

Media Rec Start/Stop 記録を開始／停止する ― ― ○
Play Play/Pause 再生を開始する ― ― ○
FREV ― 逆高速再生する ― ― ○
FFWD ― 高速再生する ― ― ○
STOP ― 再生を停止する ― ― ○
Rec Review ― レックレビューを開始する ― ― ○
PREV ― 現在のクリップの先頭にジャンプする ― ― ○
NEXT ― 次のクリップの先頭にジャンプする ― ― ○

Shot Mark Shot Mark1 ― ショットマーク1を設定する ― ― ○
Shot Mark2 ― ショットマーク2を設定する ― ― ○ 1)

ZOOM ― ― ズーム操作（対応レンズ） ― ― ○ 1)

FOCUS ― ― フォーカス操作（対応レンズ） ― ― ○ 1)

1) RCP/RM側のアサイナブルスイッチに機能が割り当てられている場合に操作可能
2) RM側から本機のメニューを操作可能
3) メニューのMaintenance >Camera Config >Detail Control(RM/RCP)の設定に従い、QFHDまたはHDのディテールを操作できます。
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本機の出力信号を選択し、接続するモニターに応じた接続ケーブルを使用してください。

BNCケーブル（別売）

BNCケーブル（別売）

4K信号／ HD信号／ SD信号を問わず、外部モ
ニターにビューファインダー画面と同様の各種
ステータス情報やメニューなどを表示させるこ
とができます。

［ご注意］
SD信号のダウンコンバート出力は、メニューの
Operation >Input/Output >Output Formatの設定が
720x486i 720x576iのときに行うことができます。

SDI OUT端子（BNC型）

SDI OUT端子には、SDI対応のモニター、スイッ
チャーやVTRなどの記録装置を接続することが
できます。
本端子からの出力信号は、メニュー
のOperation >Input/Output >SDI 
Out1/3 Output/SDI Out2/4 Output（105
ページ）でオン／オフすることができます。
接続には、別売のBNCケーブルを使用します。

VIDEO OUT端子

VIDEO OUT端子には、アナログコンポジット対
応のモニターやVTRなどの記録装置を接続する
ことができます。
出力信号は、メニューのOperation >Input/
Output >Output Formatの設定に連動して変
わります。
アナログコンポジット対応機器に信号を入力す
るには、必要に応じて、VIDEO OUT端子から
のアナログコンポジット信号の設定に合わせて、
アナログコンポジット対応機器側の入力信号設
定を変更します。
モニターやVTRなどの記録装置に音声を入力す
る場合は、AUDIO OUT端子からの音声出力と
モニターやVTR側のオーディオ入力を接続しま
す。
接続には、別売のBNCケーブルを使用します。

HDMI OUT端子（Type A
コネクター）

本端子からの出力信号は、メニューの
Operation >Input/Output >HDMI Outputで
オン／オフすることができます。
出力信号のフォーマットは、メニューの
Operation >Input/Output >Output Format
で設定します。
接続には、市販のHDMI接続ケーブルを使用し
ます。

外部モニターを接続する
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コンピューターでクリップを管理・編集する
本機でSxSメモリーカードに記録したクリップ
を、コンピューター上で管理したり、別売のノ
ンリニア編集ソフトで編集することができます。
また外部機器接続端子にポータブルストレージ
／ USBメディアを接続すれば、SxSメモリーカー
ド内のクリップをポータブルストレージ／ USB
メディアにコピーすることができます。

コンピューターとUSB接続
する

本機を別売のUSBケーブルを使ってコンピュー
ターに接続すると、スロットに装着されたメモ
リーカードがコンピューターの拡張ドライブと
して認識されます。
本機の場合、2枚のメモリーカードが挿入され
ているときは、コンピューターでは2つのドラ
イブとして認識されます。

USBケーブル
（別売）

［ご注意］

ˎˎ 本機の電源をオンにして、画面に映像や情報が表示さ
れてから、本機にUSBケーブルを接続してください。

ˎˎ コンピューターに接続するときは、USBコネクターの
形と向きに注意してください。
ˎˎ 本機はコンピューターからのバスパワーでは動作しま
せん。

USB接続を開始するには

PC接続端子とコンピューターを別売のUSBケー
ブルを使って接続したとき、USB接続を有効
にするか、無効にするかを確認する「Connect 
USB Now?」のメッセージが表示されます。
「Cancel」を選択したり、MENU CANCEL/
PRST/ESCAPEスイッチをESCAPE側に押し下げ
た場合、またはUSBケーブルを抜いた場合は、
「Connect USB Now?」のメッセージが消え、
元の画面に戻ります。
「Execute」を選択し、MENUつまみを押すと、
USB接続が有効になり、本機はコンピューター
の拡張ドライブとして認識されます。
記録／再生動作中にUSB接続を許可した場合は、
動作を停止し「USB Connecting（USB接続中）」
をビューファインダー画面に表示します。
このとき、VIDEO OUT端子、SDI OUT 1/2/3/4
端子からの出力信号は黒画となります。

［ご注意］

ˎˎ USB接続中は、本機で記録／再生などの操作はできま
せん。
ˎˎ コンピューターから本機の記録メディアにアクセス（読
み書き）しているときは以下の操作を行わないでくださ
い。

 – 本機の操作（電源のオン／オフ、モード切り換えなど）
 – アクセス中の記録メディアを抜き差し
 – USB接続ケーブルの抜き差し

USB接続の解除

USB接続の解除は、コンピューターのデバイス
取り外し手順に従って操作します。
USBを再接続するときは、一度USBケーブル

を抜いたあとに再度接続してください。再び
「Connect USB Now?」のメッセージが表示さ
れます。

SxSメモリーカードを取り外すには

Windowsの場合

1	コンピューターのタスクバーに表示されて
いる「ハードウェアの取り外しまたは取り出
し」アイコンをクリックする。

2	表示されたメニューから「SxS Memory 
Card －ドライブ（X:）を安全に取り外しま
す」を選択する。

3	安全に取り外すことができることを知らせ
るメッセージが表示されたら、カードを抜
く。

Macintoshの場合
デスクトップにあるSxSメモリーカードのアイ
コンを「ゴミ箱」（イジェクトアイコン）にドラッ
グします。
ファインダー上にSxSメモリーカードのアイコ
ンがある場合は、横のイジェクトアイコンをク
リックしてください。

アプリケーションソフトウェアを使
うには

コンピューターのローカルディスクにクリップ
をコピーする場合などは、専用のアプリケーショ
ンソフトウェアをダウンロードし、インストー
ルして使用します。ソフトウェアのダウンロー

ドについては、「ソフトウェアのダウンロードに
ついて」（181ページ）をご覧ください。
記録した素材は、情報が複数のファイル、複数
のフォルダーにまたがって置かれていますが、
専用アプリケーションソフトウェアでは、これ
らの情報やディレクトリー構造を、ユーザーが
意識することなく、容易に扱えるようになって
います。

［ご注意］
Explorer（Windows環境）やFinder（Mac環境）を使用し
て、SxSメモリーカード内のクリップのコピーなどを行う
と、クリップが持つ情報を保持できなくなることがありま
す。

ノンリニア編集システムを使うには

ノンリニア編集システムには、本機で記録した
フォーマットに対応した編集ソフトウェア（別
売）が必要です。
付属の専用アプリケーションソフトウェアを
使って、あらかじめコンピューターのHDDに編
集したいクリップを保存しておきます。
使用する編集ソフトによっては正しく動作しな
い場合があります。ご使用になる前に、必ず本
機で記録したフォーマットに対応することをご
確認ください。

ポータブルストレージ／
USBメディアを接続する

本機の外部機器接続端子にポータブルストレー
ジやUSBメディアを接続しているときは、SxS
カードスロットに挿入されている記録メディ
アのクリップをポータブルストレージやUSBメ
ディアにコピーすることができます。
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1	メニューのOperation >USB>Select 
Folderでクリップのコピー先フォルダーを
指定する。
画面のNewを選択して、新しいフォルダー
を任意に作成することもできます。

［ご注意］
フォルダーを指定しない場合は、コピーするクリップ
の先頭クリップの撮影日時をフォルダー名とするフォ
ルダーが自動的に作成され、クリップはそのフォル
ダーにコピーされます。

2	メニューのOperation >USB >Copy to 
USBを選択する。

3	画面からコピー対象の記録メディアが挿入
されているスロットを選択する。
Media(A) to USB：スロットAに挿入されて
いる記録メディアのすべてのクリップを
USBメディアにコピーする。

Media(B) to USB：スロットBに挿入されて
いる記録メディアのすべてのクリップを
USBメディアにコピーする。

Media(A)(B) to USB：スロットA、および
スロットBに挿入されている記録メディ
アのすべてのクリップをUSBメディアに
コピーする。

［ご注意］
手順1でコピー先フォルダーを指定して、Media(A)(B) 
to USBを選択した場合、スロットAのクリップは、指
定先のフォルダーにコピーされます。スロットBのク
リップは、クリップの先頭クリップの撮影日時をフォ
ルダー名として自動的に作成されるフォルダーにコ
ピーされます。

4	 MENUつまみを回してExecuteを選択し、
つまみを押す。

対象の記録メディアのクリップがすべて
USBメディアにコピーされます。

［ご注意］
コピーするクリップと同じファイル名のクリップがコ
ピー先フォルダーに既存の場合、そのクリップはコ
ピーされません。

ポータブルストレージ／ USBメディ
ア内のクリップの一覧表示

メニューのOperation >USB >View Clip List
でポータブルストレージ／ USBメディア内のク
リップを一覧表示することができます。

ポータブルストレージ／ USBメディ
ア内のフォルダー名の変更

メニューのOperation >USB >Rename Folder
でフォルダー名を変更することができます。

1	メニューのOperation >USB >Rename 
Folderを選択する。

2	変更するフォルダーを選択し、SETボタンを
押す。
ファイル名の入力画面が表示されます。

3	フォルダー名を入力し、画面のDoneを選択
する。
フォルダー名が変更されます。

コピーのリードチェックエラー

メニューのOperation >USB >Error Checkを
Onにすると、クリップの書き込み後、リード
チェックエラーを行うことができます。

ポータブルストレージ／ USBメディ
アの初期化

メニューのOperation >USB >Format USBで
ポータブルストレージ／ USBメディアを初期化
（exFATでフォーマット）することができます。

1	メニューのOperation >USB >Format USB
を選択する。

2	 MENUつまみを回してExecuteを選択し、
つまみを押す。
初期化（フォーマット）が開始されます。

3	初期化完了のメッセージが表示されたら、
画面のOKを選択する。

ポータブルストレージ／ USBメディ
アの空き容量確認

ポータブルストレージ／ USBメディアの空き容
量は、メニューのOperation >USBを選択した
ときに表示される画面のMedia Remainの行に
GB単位で表示されます。

ポータブルストレージ／ USBメディ
アへの電源供給について

外部機器出力端子からポータブルストレージ／ 
USBメディアへの電源供給は、メニューの
Operation >USBのメニュー操作を行うと自動
的に開始されます。 
ただし、以下の表に示す状態ではメニューの
Operation >USBのメニュー操作を行っても、
電源供給は開始されません。電源供給を開始す
るには、表に示す対策を行ってください。

状態 対策
クリップ記録中、再生中、
サムネイル表示中、プロキ
シ記録中、ストリーミング
中、プロキシ転送中、本線
転送モード中

左記操作を終了す
る。

Network Client Modeが
On

Network Client 
ModeをOffにす
る。

カメラアダプター接続中 カメラアダプター
の接続を解除する。

［ご注意］

ˎˎ ポータブルストレージやUSBメディアのクリップをSxS
カードスロットに挿入されている記録メディアにコ
ピーすることはできません。
ˎˎ 外部機器出力端子への電源供給中は、クリップ記録は
できません。クリップ記録を開始する場合は、メニュー
のOperation >USBのメニュー操作を終了してくださ
い。
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撮影／収録システムを構成する
本機にHDカメラアダプター CA-FB70/TX70をマウントしてCCU（Camera Control Unit）と接続す
ることができます。
これにより、複数のカムコーダーやカメラエクステンションユニット、リモートコントロールユニッ
トと撮影／収録システムを構成することができます。

 ˜ CA-FB70およびCA-TX70について詳しくは、それぞれの取扱説明書をご覧ください。

［ご注意］

ˎˎ 本機をこのシステムで使う場合、本機にビデオライトを接続しないでください。
ˎˎ XAVC、MPEG HD記録にのみ対応しています。
ˎˎ プロキシ記録、ワイヤレスLAN接続機能には対応していません。
ˎˎ 本機はリターンビデオの表示には対応していません。

タリーとコールの表示

システムを構築したときのタリーやコール表示を示します。

システムからの受信データ HDVFのLED表示 VF画面内キャラクターによる表
示

Tally Green 
Tally

CAのCall CA以外の
Call

REC/
TALLY 
LED

GREEN 
TALLY 
LED

● ● CALL

OFF OFF OFF OFF 消灯 消灯 非表示 非表示 非表示
OFF OFF OFF ON 点灯 消灯 ● 非表示 CALL
OFF OFF ON OFF 消灯 消灯 非表示 非表示 CALL
OFF OFF ON ON 点灯 消灯 ● 非表示 CALL
OFF ON OFF OFF 消灯 点灯 非表示 ● 非表示
OFF ON OFF ON 点灯 点灯 ● ● CALL
OFF ON ON OFF 消灯 点灯 非表示 ● CALL
OFF ON ON ON 点灯 点灯 ● ● CALL
ON OFF OFF OFF 点灯 消灯 ● 非表示 非表示
ON OFF OFF ON 消灯 消灯 非表示 非表示 CALL
ON OFF ON OFF 点灯 消灯 ● 非表示 CALL
ON OFF ON ON 消灯 消灯 非表示 非表示 CALL
ON ON OFF OFF 点灯 点灯 ● ● 非表示
ON ON OFF ON 消灯 点灯 非表示 ● CALL
ON ON ON OFF 点灯 点灯 ● ● CALL
ON ON ON ON 消灯 点灯 非表示 ● CALL

［ご注意］
カメラアダプター CA-FB70/TX70を接続中は、警告表示に記載しているタリーランプによるアラーム表示は行いません。



000 9章　外部機器の接続：撮影／収録システムを構成する149

撮影／収録システム構成時の対応フォーマットと動作制限

本機とカメラアダプター、カメラコントロールユニットを接続して撮影／収録システムを構成する
場合の対応フォーマットを下表に示します。

メニューのOperation カメラアダプター／ 
カメラコントロール 
ユニットのシステム
フォーマット

カムコーダー
の動作制限

Format Input / Output リターン 
ビデオの 
表示

Frequency Rec Format Output Format
SDI

59.94 XAVC-I 3840×2160P 1920×1080i 1920×1080 59.94i ×
XAVC-L 3840×2160P
XAVC-I 1920×1080P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
XAVC-I 1920×1080i 1920×1080i 1920×1080 59.94i ×
XAVC-L 50 1920×1080i
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HQ 1920×1080i
HQ 1440×1080i
SP 1440×1080i 
XAVC-I 1280×720P 1280×720P 1280×720 59.94P ×
XAVC-L 50 1280×720P
HD 422 50 720P
HQ 1280×720P

29.97 XAVC-I 3840×2160P 1920×1080PsF 1920×1080 29.97PsF a)

1920×1080 59.94i
×

XAVC-L 3840×2160P
XAVC-I 1920×1080P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HQ 1920×1080P
HD422 50 720P 1280×720P 1280×720 59.94P ×

メニューのOperation カメラアダプター／ 
カメラコントロール 
ユニットのシステム
フォーマット

カムコーダー
の動作制限

Format Input / Output リターン 
ビデオの 
表示

Frequency Rec Format Output Format
SDI

23.98 XAVC-I 3840×2160P 1920×1080i  
(2-3PD)

1920×1080 59.94i ×
XAVC-L 3840×2160P
XAVC-I 1920×1080P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HQ 1920×1080P
HD422 50 720P 1280×720P  

(2-3PD)
1280×720 59.94P ×

50 XAVC-I 3840×2160P 1920×1080i 1920×1080 50i ×
XAVC-L 3840×2160P
XAVC-I 1920×1080P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
XAVC-I 1920×1080i 1920×1080i 1920×1080 50i ×
XAVC-L 50 1920×1080i
XAVC-L 35 1080i
XAVC-L 25 1080i
HD422 50 1080i
HQ 1920×1080i
HQ 1440×1080i
SP 1440×1080i 
XAVC-I 1280×720P 1280×720P 1280×720 50P ×
XAVC-L 50 1280×720P
HD 422 50 720P
HQ 1280×720P
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メニューのOperation カメラアダプター／ 
カメラコントロール 
ユニットのシステム
フォーマット

カムコーダー
の動作制限

Format Input / Output リターン 
ビデオの 
表示

Frequency Rec Format Output Format
SDI

25 XAVC-I 3840×2160P 1920×1080PsF 1920×1080 25PsF a)

1920×1080 50i
×

XAVC-L 3840×2160P
XAVC-I 1920×1080P
XAVC-L 50 1920×1080P
XAVC-L 35 1080P
HD422 50 1080P
HQ 1920×1080P
HD422 50 720P 1280×720P 1280×720 50P ×

a) カメラアダプター CA-TX70接続時はPsF設定を推奨します。

［ご注意］
撮影／収録システム構成時はプロキシ記録、ワイヤレスLAN接続機能、およびスロー＆クイックモーションなどの特殊記
録機能を同時に使用することはできません。
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外部入力信号の記録
本機のSDI IN端子に接続した機器からのSDI信号を記録することができます。

カメラ画の代わりに入力信号を出力／記録するには、メニューのOperation >Input/Output 
>Source SelectをExternalに設定します。

［ご注意］

ˎˎ 外部入力信号を、スロー＆クイックモーションモードで記録することはできません。スロー＆クイックモーションのい
ずれかの記録モードを選択しているときに、メニューのOperation >Input/Output >Source SelectをExternalに設
定すると、上記の記録モードは解除されます。
ˎˎ オートブラックバランスなどの自動調整機能の実行中や、再生／レックレビュー／サムネイル表示中にメニューの

Operation >Input/Output >Source SelectをExternalに設定すると、実行中の調整および操作が終了し、本機が停
止状態になってからカメラ画を外部入力に切り換えます。
ˎˎ 外部入力の記録中に入力信号が乱れたときには、記録が停止する場合があります。入力信号が正常に戻ると、記録は自
動で再開します。
ˎˎ プロキシ記録、ワイヤレスLAN接続機能には対応していません。

外部入力可能な信号フォーマットと本機の記録フォーマッ
トの関係

HD/SD メニューのOperation 
>Format >Rec Formatの
設定

メニューのOperation 
>Format >Frequencyの
設定

外部入力が可能な 
信号フォーマット

HD XAVC-I 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

XAVC-I 1280×720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD/SD メニューのOperation 
>Format >Rec Formatの
設定

メニューのOperation 
>Format >Frequencyの
設定

外部入力が可能な 
信号フォーマット

HD XAVC-L 50 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

XAVC-L 50 1280×720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD422 50 1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HD422 50 720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HQ 1920×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

HQ 1440×1080i 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

SP 1440×1080i 59.94 HD 1920×1080 29.97PsF/59.94i 
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i 
HD 1280×720 50P

HQ 1280×720P 59.94 HD 1920×1080 29.97PsF/59.94i
HD 1280×720 59.94P

50 HD 1920×1080 25PsF/50i
HD 1280×720 50P

SD MPEG IMX 50 59.94 SD 486 59.94i
50 SD 576 50i

DVCAM 59.94 SD 486 59.94i
50 SD 576 50i



000152 10章　保守・点検

保守
ビューファインダーをク
リーニングする

筒部内のCRTスクリーンやミラーの表面からほ
こりを除去するには、ブロアーをお使いくださ
い。
レンズとプロテクトフィルターのクリーニング
には、市販のレンズクリーナーをお使いくださ
い。

［ご注意］
シンナーなどの溶剤は一切使わないでください。

バッテリー端子に関するご
注意

機器に搭載されているバッテリー端子（バッテ
リーパックやACアダプターとの接点部分）は消
耗品です。 
振動や衝撃によって端子が変形したり、曲がっ
たり、あるいは長期の屋外での使用などによっ
て表面が腐食したりすると、本体に電源が供給
されなくなります。
長期間機器を使用していただくために、定期点
検を実施することをお願いします。点検につき
ましては、ソニーのサービス担当者または営業
担当者にご相談ください。

内蔵時計用電池の交換

本機内に内蔵時計用のリチウム電池が装着され
ています。ビューファインダー画面に“BackUp 
Battery End”の表示が出たら電池の交換が必要
ですので、ソニーのサービス担当者、または営
業担当者にご相談ください。



000 10章　保守・点検153

本機では警告、注意、動作確認が必要な状況を、ビューファインダー画面のメッセージ表示、各種ランプの点滅、および警告音でお知らせします。
警告音の音量はALARMつまみで調整できます。ALARMつまみを最小にすると、警告音は聞こえなくなります。

エラー表示

次のような表示が出た場合は、本機は動作を停止します。
エラーメッセージ 警告音 WARNINGランプ タリー／ RECランプ 原因と対策
E＋エラーコード 連続音 ― 高速点滅 本機の異常の可能性があります。

電源を切り、接続している機器やケーブル類、メディアに異常がないか確認してください。
（POWERスイッチをOFFにしても電源が切れない場合は、バッテリーパックまたはAC電源を外してください。）
再度電源を入れてもエラーが継続する場合は、ソニーのサービス担当者にご連絡ください。

警告表示

次のような表示が出た場合は、メッセージに従って対策してください。
警告メッセージ 警告音 WARNINGランプ タリー／ RECランプ 原因と対策
メディア残量がわずかです
Media Near Full

断続音 点滅 点滅 SxSメモリーカードの残量が少なくなっています。
早い機会に交換してください。

メディア残量がありません
Media Full

連続音 点灯 高速点滅 SxSメモリーカードの残量がないため、記録、コピー、クリップ分割はできません。
交換してください。

バッテリー残量がわずかです
Battery Near End

断続音 点滅 点滅 バッテリーパックの残量が少なくなっています。
早い機会に充電してください。
（ビューファインダー画面のバッテリー表示も点滅します。）

バッテリー残量がありません
Battery End

連続音 点灯 高速点滅 バッテリーパックが消耗しました。
記録はできません。
DC INに電源をつなぐか、いったん操作を中止し、バッテリーパックを充電してください。
（ビューファインダー画面のバッテリー表示も点滅します。）

警告温度になりました
Temperature High

断続音 点滅 点滅 内部温度が上昇しました。
いったん電源を切り、温度が下がるまで使用を中止してください。

電源電圧が低下しています
Voltage Low

断続音 点滅 点滅 DC IN電圧が低くなっています（段階1）。
供給電源を確認してください。

電源電圧が不足しています
Insufficient Voltage

連続音 点灯 高速点滅 DC IN電圧が低すぎます（段階2）。
記録はできません。
他の電源に接続し直してください。
（ビューファインダー画面のバッテリー表示も点滅します。）

エラー／警告システム
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警告メッセージ 警告音 WARNINGランプ タリー／ RECランプ 原因と対策
クリップ数が上限です
Clips Full

連続音 点灯 高速点滅 SxSメモリーカードに記録できるクリップ数の上限に達しました。これ以上記録やコピーはできません。交換してください。

最終クリップ記録中
Last Clip Recording

断続音 点滅 点滅 記録中のクリップの記録を完了すると、記録可能なクリップ数の上限に達します。
新しいSxSメモリーカードをご用意ください。

クリップ数上限近くです
Clips Near Full

断続音 点滅 点滅 SxSメモリーカードに記録できる残りのクリップ数が少なくなっています。
早い機会に交換してください。

Media(Proxy)残量なし
Media(Proxy) Full

連続音 点灯 高速点滅 プロキシデータ記録用SDカードの残量がないため、プロキシデータ記録はできません。交換してください。

Proxyクリップ数が上限です
Clips(Proxy) Full

連続音 点灯 高速点滅 プロキシデータ記録用SDカードに記録できるクリップ数の上限に達しました。これ以上記録はできません。交換してく
ださい。

Media(Proxy)残量わずか
Media(Proxy) Near Full

断続音 点滅 点滅 プロキシデータ記録用SDカードの残量が少なくなっています。
早い機会に交換してください。

Proxy最終クリップ記録中
Last Clip(Proxy) Rec

断続音 点滅 点滅 記録中のプロキシデータの記録を完了すると、記録可能なクリップ数の上限に達します。
新しいプロキシデータ記録用SDカードをご用意ください。

Proxyクリップ数上限近く
Clips(Proxy) Near Full

断続音 点滅 点滅 プロキシデータ記録用SDカードに記録できる残りのクリップ数が少なくなっています。早い機会に交換してください。

Media(A)1)残量がありません
Media(A)1) Full

連続音 点灯 高速点滅 2スロット同時記録機能使用時

Media(A)1) クリップ数上限
Media(A)1) Clips Full

連続音 点灯 高速点滅 2スロット同時記録機能使用時

Media(A)1)残量がわずかです
Media(A)1) Near Full

断続音 点滅 点滅 2スロット同時記録機能使用時

Media(A)1) 最終Clip記録中
Media(A)1) Last Clip Rec

断続音 点滅 点滅 2スロット同時記録機能使用時

1) スロットBに入れたカードの場合は(B)
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注意・動作確認表示

画面中央部分に次のような注意・動作確認表示が現れることがあります。この場合は次表に従って
対処してください。

表示内容 原因と対策
このバッテリーは使用できません
交換してください
Battery Error
Please Change Battery

バッテリーパックに異常が検出されました。
正常なバッテリーパックに交換してください。

バックアップ電池残量がありません
交換してください
Backup Battery End
Please Change

バックアップ電池の残量が不足しています。
バックアップ電池を交換してください。

メディア(A)1)は使用できません
交換してください
Unknown Media(A)1)

Please Change

• パーテーションが切られているメモリーカードや、本機で
扱えるクリップ数を超えて記録されたメモリーカードが挿
入されました。

• ファイルシステムがFATのときにSxSカードを挿入しまし
た。

• ファイルシステムがexFATまたはUDFのときにSDHCカー
ドを挿入しました。

本機では使用できませんので、交換してください。
メディアエラーが発生しました
メディア(A)1)は修復が必要です
Media Error
Media(A)1) Needs to be Restored

メモリーカードに異常が発生し、修復が必要な状態になりま
した。
メモリーカードを一度抜いてから再挿入して、カードの修復
を行ってください。

メディアエラーが発生しました
メディア(A)1)は記録できません
Media Error
Cannot Record to Media(A)1)

メモリーカードが故障して、記録ができなくなりました。
再生は可能ですので、コピーを取るなどして、新しいメモリー
カードに交換することをお勧めします。

メディアエラーが発生しました
メディア(A)1)は使用できません
Media Error
Cannot Use Media(A)1)

メモリーカードが故障して記録も再生もできなくなりました。
本機では扱えませんので、他のカードに交換してください。

メディア(A)1)は使用できません
ファイルシステムが異なります
Cannot Use Media(A)1)

Unsupported File System

ファイルシステムの異なるカードまたはフォーマットされて
いないカードが挿入されました。
本機では使用できませんので、交換または本機でフォーマッ
トしてください。

表示内容 原因と対策
メディア(A)1)にエラーが発生しました。
再生を停止しました
Media(A)1) Error
Playback Halted

メモリーカードからの読み出しにエラーが発生したため、再
生を続けられません。
頻繁に起きる場合には、コピーを取るなどをして、メモリー
カードを交換してください。

メディア(A)1)にエラーが発生しました
Media(A)1) Error

メモリーカードに異常が発生したため、記録できません。
頻繁に起きる場合には、メモリーカードを交換してください。

異なるメディアが挿入されました
メディア(A)1)は使用できません
Different Media is Inserted
Cannot Use Media(A)1)

異なる種類のカードが挿入されました。後から挿入したカー
ドを前に挿入したカードと同じ種類のカードに交換してくだ
さい。

1) スロットBに入れたカードの場合は(B)
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操作時に表示されるメッセージ
ボタン、スイッチ、つまみなどを操作したときに表示されるメッセージとその意味を以下に示します。

［ご注意］

ˎˎ 操作と発生原因が一致したときに表示されるメッセージだけを記載しています。
ˎˎ メニュー項目が選択できない状態（グレーアウト状態）で操作を行ったときに表示されるメッセージは記載していません。

操作 メッセージ メッセージの意味／発生要因
RECボタンを押したとき Media not exist SxSカードスロットに記録メディアが挿入されていないため記録ができない。

Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

プロキシデータ記録モードはOnに設定されているが、プロキシ記録用SDカードが挿入されていないためプロキシデー
タが記録できない。

Media(Proxy)
Cannot Record
Media(Proxy) Error

プロキシ記録用SDカードのメディア異常により書き込みができないためプロキシデータが記録できない。

Media(Proxy)
Cannot Record
Media(Proxy): Write Protected

プロキシ記録用SDカードが書き込み禁止のためプロキシデータが記録できない。

Media(Proxy)
Cannot Record
NG: Preparing

プロキシデータ記録回路が準備完了前のためプロキシデータが記録できない。

XAVC Proxy Rec Startを割り当てたアサイナ
ブルスイッチを操作したとき

Media(Proxy)
Cannot Record
No Media in Slot(Proxy)

プロキシ記録用SDカードが挿入されていないためプロキシデータが記録できない。

Media(Proxy)
Cannot Record
Media(Proxy) Error

プロキシ記録用SDカードのメディア異常により書き込みができないためプロキシデータが記録できない。

Media(Proxy)
Cannot Record
Media(Proxy): Write Protected

プロキシ記録用SDカードが書き込み禁止のためプロキシデータが記録できない。

Media(Proxy)
Cannot Record
NG: Preparing

プロキシデータ記録回路が準備完了前のためプロキシデータが記録できない。

PREVボタンを押したとき First Clip Top! 再生開始位置が先頭クリップの先頭フレームにあるため実行できない。
F REVボタンを押したとき First Clip Top! 再生開始位置が先頭クリップの先頭フレームにあるため実行できない。
PREV+F REVボタンを押したとき First Clip Top! 再生開始位置が先頭クリップの先頭フレームにあるため実行できない。
PLAYボタンを押したとき Last Clip End! 再生開始位置が最終クリップの最終フレームにあるため実行できない。
NEXTボタンを押したとき Last Clip End! 再生開始位置が最終クリップの最終フレームにあるため実行できない。
F FWDボタンを押したとき Last Clip End! 再生開始位置が最終クリップの最終フレームにあるため実行できない。
NEXT+F FWDボタンを押したとき Last Clip End! 再生開始位置が最終クリップの最終フレームにあるため実行できない。
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操作 メッセージ メッセージの意味／発生要因
メディアスロット切り替え操作したとき Cannot Switch Slots 再生中のためスロットを切り替えできない。
記録メディアを抜いたとき Media removed 記録メディアへの読み書き動作中（ACCESSランプ点灯中)にメディアが抜かれた。
GAINスイッチを切り替えたとき Gain: xxdB

（「xxxx」は、ゲイン値）
ゲインの設定が変更になった。

DCCスイッチを操作したとき DCC:On DCCがOnになった。
DCC:Off DCCがOffになった。
Fixed By Hyper Gamma ! Gamma CategoryがHGまたはUserに設定されているためDCCをOnにできない。

ホワイトバランススイッチを操作したとき White: Preset xxxxK
（「xxxx」は色温度値）

ホワイトバランスがPresetの値に変更された。

White: A xxxxK 
（「xxxx」は色温度値）

ホワイトバランスがAメモリーの値に変更された。

White: B xxxxK 
（「xxxx」は色温度値）

ホワイトバランスがBメモリーの値に変更された。

White: ATW xxxxK 
（「xxxx」は色温度値）

ホワイトバランスモードがATWに変更された。

SHUTTERスイッチを切り替えたとき Shutter: 1/xxxx
（「xxxx」はシャッター値）

シャッタースピードが変わった（標準、Speedモード設定時）。

Shutter: xxx
（「xxxx」はシャッター値）

シャッタースピードが変わった（標準、Angleモード設定時）。

ECS: xxxxHz
（「xxxx」は周波数）

シャッタースピードが変わった（ECSモード時）。

メニューつまみを回したとき ECS: xxxxHz
（「xxxx」は周波数）

シャッタースピードが変わった（ECSモード時）。

Iris Override: +x.xx
（「xxxx」は数値）

アイリスオーバーライド量が変わった。

オートブラックスイッチを操作したとき Color Bars
Cannot Proceed

カラーバー信号を出力しているため実行できない。

Test Saw
Cannot Proceed

テスト信号を出力しているため実行できない。

Not Available
Recording

記録中のため実行できない。

Not Available
Playing back

再生中のため実行できない。

Not Available
Displaying Thumbnails

サムネイル表示中のため実行できない。
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操作 メッセージ メッセージの意味／発生要因
オートホワイトスイッチを操作したとき Color Bars

Cannot Proceed
カラーバー信号を出力しているため実行できない。

Not Available
Playing back

再生中のため実行できない。

Not Available
Displaying Thumbnails

サムネイル表示中のため実行できない。

White Balance Preset ホワイトバランスがPreset値固定であるため実行できない。
ATW Hold機能を割り当てたアサイナブルス
イッチを操作したとき

ATW Hold ATWのHold機能が有効になった。
ATW Hold Off ATWのHold機能が解除になった。

Clip Continuous Recを割り当てたアサイナ
ブルスイッチを操作したとき

Cannot Proceed
Recording

記録中のため実行できない。

Cannot Proceed カメラアダプター CA-FB70/TX70とCCUが接続されているため実行できない。
Picture Cache Recを割り当てたアサイナブ
ルスイッチを操作したとき

Cannot Proceed
Recording

記録中のため実行できない。

Cannot Proceed 以下のいずれかの条件により実行できない。
• 再生中
• サムネイル表示中
• カメラアダプター CA-FB70/TX70とCCUが接続されている

Streamingを割り当てたアサイナブルスイッ
チを操作したとき

Cannot Proceed
Network Client Mode Setting is "On"

ネットワーククライアントモードが有効であるため実行できない。

Cannot Proceed
Network Function is Disabled

ネットワーク接続設定がOffであるため実行できない。

Cannot Proceed
Network Client Mode Setting is "On"
Network Function is Disabled

ネットワーククライアントモードはOnに設定されているが、ネットワーク未接続であるため実行できない。

Cannot Start Streaming
Streaming Disabled Temporarily

以下のいずれかの条件により実行できない。
• プロキシデータ再生中
• 記録フォーマット設定が1920×1080のときに1280×720クリップを再生中
• 記録フォーマット設定が1280×720のときに1920×1080クリップを再生中

Cannot Start Streaming
Please stop Recording or Playback

ワイヤレス機能回路起動中に記録・再生（サムネイル表示を含む）を開始したため実行できない。
記録・再生（サムネイル表示を含む）を停止すると実行できる。
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操作 メッセージ メッセージの意味／発生要因
ネットワーククライアントモード有効時に
Streamingを割り当てたアサイナブルスイッ
チを操作したとき

Cannot Proceed
Streaming Setting is "On"

ストリーミング中のため設定できない。

Cannot Connect to CCM
Network Function is Disabled

ネットワーク未接続であるためConnection Control Managerに接続できない。

Cannot Record Proxy メニューのMaintenance >Network Client Mode >Preset 1、Preset 2、またはPreset 3のNCM with Proxyが
Disableに設定されているため、プロキシデータ記録開始の操作をしても記録ができない。

Proxy Recoding will be Stopped メニューのMaintenance >Network Client Mode >Preset 1、Preset 2、またはPreset 3のNCM with Proxyが
Disableに設定されているため、プロキシデータ記録が停止する。

Cannot Connect to CCM
Cannot Record Proxy

• ネットワーク未接続であるためConnection Control Managerに接続できない。
• メニューのMaintenance >Network Client Mode >Preset 1、Preset 2、またはPreset 3のNCM with Proxyが

Disableに設定されているため、プロキシデータ記録開始の操作をしても記録できない。
Cannot Connect to CCM
Proxy Recoding will be Stopped

• ネットワーク未接続であるためConnection Control Managerに接続できない。
• メニューのMaintenance >Network Client Mode >Preset 1、Preset 2、またはPreset 3のNCM with Proxyが

Disableに設定されているため、プロキシデータ記録が停止する。
Cannot Connect to CCM
Invalid User Name or Password

Connection Control Managerの認証がエラーになった。

Cannot Connect to CCM
Invalid Address or Port Number

Connection Control Managerのアドレス、またはポートナンバーの設定間違いのため、Connection Control 
Managerに接続できない。

Auto Upload(Proxy)を割り当てたアサイナブ
ルスイッチを操作したとき

Cannot Proceed
Network Function is Disabled

プロキシデータ記録回路、およびワイヤレス機能回路が起動完了前のため実行できない。

ONLINEボタンを長押し操作したとき Cannot Proceed ワイヤレス機能回路が起動遷移中、または電源断遷移中のため実行できない。
Zebraを割り当てたアサイナブルスイッチを
操作したとき、またはビューファインダーの
ZEBRAスイッチを切り替えたとき

Zebra: On ゼブラがOnになった。
Zebra: Off ゼブラがOffになった。

ビューファインダーのZEBRAスイッチを操作
したとき

Zebra: On ゼブラがOnになった。
Zebra: Off ゼブラがOffになった。

Makerを割り当てたアサイナブルスイッチを
操作したとき

Marker: On マーカーがOnになった。
Marker: Off マーカーがOffになった。

Video Signal Monitorを割り当てたアサイナ
ブルスイッチを操作したとき

Cannot Proceed 以下のいずれかの条件により実行できない。
• メニューのOperation >Input/OutputのSDI Out1 SelectとSDI Out2 Selectが両方ともOffに設定
• メニューのOperation >Input/OutputのOutput Formatが、720x480Pまたは、720x576Pに設定

OUTPUTスイッチをBARS位置（カラーバー表
示）へ操作したとき

Not Available
S&Q Motion: On

S&Qモーション記録モードが有効中のため表示できない。
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操作 メッセージ メッセージの意味／発生要因
NDフィルターを切り替えたとき 2: 1/4ND  xxxxK

（「2: 1/4ND」はND種類、「xxxx」は色温度値）
NDフィルターが切り替わった。

ND:3 CC: x  xxxxK
（「ND:3」は選ばれているNDフィルター種類、
「CC: x  xxxxK」は選ばれているCCフィルターと
電気色温度変換を行った後の色温度値）

ND Filter C.TempがOffで、いずれかのアサイナブルスイッチにElectrical CCを割り当てた状態でNDフィルターが切
り替わった。

Color Temp SW 3200Kを割り当てたアサイ
ナブルスイッチを操作したとき

Color Temp SW 3200K Color Temp SW 3200Kが有効になった。
Cannot Proceed
ND Filter C.Temp:On

ND Filter C.TempがOnのため変更できない。

Color Temp SW 4300Kを割り当てたアサイ
ナブルスイッチを操作したとき

Color Temp SW 4300K Color Temp SW 4300Kが有効になった。
Cannot Proceed
ND Filter C.Temp:On

ND Filter C.TempがOnのため変更できない。

Color Temp SW 5600Kを割り当てたアサイ
ナブルスイッチを操作したとき

Color Temp SW 5600K Color Temp SW 5600Kが有効になった。
Cannot Proceed
ND Filter C.Temp:On

ND Filter C.TempがOnのため変更できない。

Color Temp SW 6300Kを割り当てたアサイ
ナブルスイッチを操作したとき

Color Temp SW 6300K Color Temp SW 6300Kが有効になった。
Cannot Proceed
ND Filter C.Temp:On

ND Filter C.TempがOnのため変更できない。

Electrical CCを割り当てたアサイナブルス
イッチを操作したとき

ND:3 CC: x  xxxxK
（「ND:3」は選択されているNDフィルター種類、
「CC: x  xxxxK」は選択されているCCフィルター
と電気色温度変換を行った後の色温度値）

Electrical CCフィルターが切り替わった。

Cannot Proceed ND Filter C.TempがOnのため変更できない。
CC5600Kを割り当てたアサイナブルスイッチ
を操作したとき

CC 5600K 5600Kに設定された。
Cannot Proceed 以下のいずれかの条件により実行できない。

• ND Filter C.TempがOn
• いずれかのアサイナブルスイッチにElectrical CCを割り当ててあるが、Electrical CCに5600Kを割り当てていない。

Shot Mark1を割り当てたアサイナブルスイッ
チを操作したとき

Shot Mark1
（Planning Metadata適用時は、任意文字列）

ショットマーク1が付加された。

Cannot Record Essence Mark
Reached Essence Mark Limit

エッセンスマーク数の上限に達しているため付加できない。

Cannot Proceed 以下のいずれかの条件により付加できない。
• クリップが記録されているメディアに書き込み禁止などの理由で書き込みできない
• ピクチャーキャッシュレック機能がOn
• インターバルレック記録中
• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている
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操作 メッセージ メッセージの意味／発生要因
Shot Mark2を割り当てたアサイナブルスイッ
チを操作したとき

Shot Mark2
(Planning Metadata適用時は、任意文字列）

ショットマーク2が付加された。

Cannot Record Essence Mark
Reached Essence Mark Limit

エッセンスマーク数の上限に達しているため実行できない。

Cannot Proceed 以下のいずれかの条件により付加できない。
• クリップが記録されているメディアに書き込み禁止などの理由で書き込みできない
• ピクチャーキャッシュレック機能がOn
• インターバルレック記録中
• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

Clip Flag OKを割り当てたアサイナブルス
イッチを操作したとき

OK Clip Flag クリップフラグ（OKマーク）が付加された。
Delete Clip Flag クリップフラグ（OKマーク）が削除された(スイッチ2度押し操作したとき)。
Cannot Proceed 以下のいずれかの条件により実行できない

• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

Clip Flag NGを割り当てたアサイナブルス
イッチを操作したとき

NG Clip Flag クリップフラグ（NGマーク）が付加された。
Delete Clip Flag クリップフラグ（NGマーク）が削除された (スイッチ2度押し操作したとき)。
Cannot Proceed 以下のいずれかの条件により実行できない

• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

Clip Flag Keepを割り当てたアサイナブルス
イッチを操作したとき

KEEP Clip Flag クリップフラグ（KEEPマーク）が付加された。
Delete Clip Flag クリップフラグ（KEEPマーク）が削除された(スイッチ2度押し操作したとき)。
Cannot Proceed 以下のいずれかの条件により実行できない

• メディアが書き込み禁止になっている
• 対象クリップがSDカードに記録されている

Flash Band Reduceを割り当てたアサイナブ
ルスイッチを操作したとき

Flash Band Reduce: On Flash Band ReduceがOnになった。
Flash Band Reduce: Off Flash Band ReduceがOffになった。

SLOT SELECTボタンを操作したとき Switched Slot 使用する記録メディアが切り替わった。
スロー＆クイックモーションに対応しない
記録フォーマット設定で、Slow & Quick 
Motionを割り当てたアサイナブルボタンを
操作したとき

Cannot Proceed
S&Q Unsupported Rec Format

Slow & Quick Motionに対応していないフォーマットのため実行できない。
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ユーザーデータに保存される項目
表凡例
○：保存する
○*：保存する（Clear All Presetは対象外）
×：保存しない
―：保存しない（一時的動作メニュー）
Default：  リファレンスファイルには保存されない項目ですが、メニューのFile >Referenceを実行

するとメニューの初期値としてプリセット層に保存されます。

Userメニュー

項目 細目 保存先ファイル
All Scene Reference Lens

Edit User Menu ○ × × ×

Operationメニュー

項目 細目 保存先ファイル
All Scene Reference Lens

Format Frequency ○* × × ×
File System ○* × × ×
Rec Format ○ × × ×
Aspect Ratio (SD) ○ × × ×
Audio Length (IMX) ○ × × ×

Base Setting Shooting Mode ○ × × ×
HDR Setting 4K(QFHD) Rec/Out ○ × × ×

HD Rec/Out ○ × × ×
SDR Gain ○ × × ×
S-Log Color Space ○ × × ×

Format Media(A) ― ― ― ―
Media(B) ― ― ― ―
SD Card(Utility) ― ― ― ―
SD Card(Proxy) ― ― ― ―

項目 細目 保存先ファイル
All Scene Reference Lens

Input/Output Output Format ○ × × ×
Source Select ○ × × ×
SDI Out1/3 Output ○ × × ×
SDI Out2/4 Output ○ × × ×
HDMI Output ○ × × ×
4K(QFHD) SDI Out Super ○ × × ×
SDI Out2/4/HDMI Super ○ × × ×
Video Out Super ○ × × ×
Down Converter ○ × × ×
Wide ID ○ × × ×
Wide Mode(Ext.) ○ × × ×

Super Impose Super(VF Display) ○ × × ×
Super(Menu) ○ × × ×
Super(Marker) ○ × × ×

LCD LCD Color ○ × × ×
LCD Marker&Zebra ○ × × ×

Rec Function Slow & Quick Motion ○ × × ×
Frame Rate ○ × × ×
Clip Continuous Rec ○ × × ×
Picture Cache Rec ○ × × ×
Cache Rec Time ○ × × ×
Interval Rec × × × ×
Number of Frames ○ × × ×
Interval Time ○ × × ×
Pre-Lighting ○ × × ×
Simul Rec ○ × × ×
4K & HD (Sub) Rec ○ × × ×
HD (Sub) Playback Mode ○ × × ×

XAVC Proxy Rec 
Mode

Setting ○* × × ×
Size ○* × × ×
Frame Rate ― ― ― ―
Bit Rate ― ― ― ―
Audio Channel ○* × × ×
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項目 細目 保存先ファイル
All Scene Reference Lens

Assignable 
Switch

<0> ○ × × ×
<1> ○ × × ×
<2> ○ × × ×
<3> ○ × × ×
<4> ○ × × ×
<5> ○ × × ×
Lens RET ○ × × ×
Online ○ × × ×
Zoom Speed ○ × × ×

VF Setting Color ○ × × ×
Color Mode ○ × × ×
Peaking Type ○ × × ×
Peaking Frequency ○ × × ×
Peaking Color ○ × × ×
VF Detail Level ○ × × ×

Marker Setting ○ × × ×
Color ○ × × ×
Center Marker ○ × × ×
Safety Zone ○ × × ×
Safety Area ○ × × ×
Aspect Marker ○ × × ×
Aspect Select ○ × × ×
Aspect Mask ○ × × ×
Aspect Safety Zone ○ × × ×
Aspect Safety Area ○ × × ×
100% Marker ○ × × ×
User Box ○ × × ×
User Box Width ○ × × ×
User Box Height ○ × × ×
User Box H Position ○ × × ×
User Box V Position ○ × × ×

項目 細目 保存先ファイル
All Scene Reference Lens

Gain Switch Gain<L> ○ × × ×
Gain<M> ○ × × ×
Gain<H> ○ × × ×
Gain <Turbo> ○ × × ×
Shockless Gain ○ × × ×

Auto Iris Iris Override ○ × × ×
Mode ○ × × ×
Level ○ × × ×
Speed ○ × × ×
Clip High light ○ × × ×
Detect Window ○ × × ×
Detect Window Indication × × × ×
Iris APL Ratio ○ × × ×
Iris Var Width ○ × × ×
Iris Var Height ○ × × ×
Iris Var H Position ○ × × ×
Iris Var V Position ○ × × ×

Zebra Zebra Select ○ × × ×
Zebra1 Level ○ × × ×
Zebra1 Aperture Level ○ × × ×
Zebra2 Level ○ × × ×
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項目 細目 保存先ファイル
All Scene Reference Lens

Display On/Off Video Level Warning ○ × × ×
Shutter Setting ○ × × ×
ND Filter Position ○ × × ×
Gain Setting ○ × × ×
Rec/Play Status ○ × × ×
Color Temp. ○ × × ×
Frame Rate/Interval ○ × × ×
Battery Remain ○ × × ×
Timecode ○ × × ×
Audio Level Meter ○ × × ×
Media Status ○ × × ×
SD Card(Utility) ○ × × ×
Focus Position ○ × × ×
Iris Position ○ × × ×
Zoom Position ○ × × ×
Extender ○ × × ×
ALAC ○ × × ×
AE Mode ○ × × ×
Focus Mode ○ × × ×
White Balance Mode ○ × × ×
CC5600K ○ × × ×
Rec Format ○ × × ×
Gamma ○ × × ×
Timecode Lock ○ × × ×
Network Condition ○ × × ×
Proxy Status ○ × × ×

項目 細目 保存先ファイル
All Scene Reference Lens

Display On/Off NW Client Mode Status ○ × × ×
Streaming Status ○ × × ×
GPS ○ × × ×
Video Signal Monitor ○ × × ×
Clip Name ○ × × ×
Focus Assist Indicator ○ × × ×
Focus Area Marker ○ × × ×
Lens Info ○ × × ×
WRR RF Level ○ × × ×
Clip Number ○ × × ×

"!"LED Gain <!> ○ × × ×
Shutter <!> ○ × × ×
White Preset <!> ○ × × ×
ATW Run <!> ○ × × ×
Extender <!> ○ × × ×
Filter <!> ○ × × ×
Iris Override <!> ○ × × ×

White Setting White Switch<B> ○ × × ×
Shockless White ○ × × ×
ATW Speed ○ × × ×
ATW Mode ○ × × ×
AWB Fixed Area ○ × × ×
Filter White Memory ○ × × ×

Offset White Offset White<A> ○ × × ×
Warm Cool <A> ○ × × ×
Warm Cool Balance<A> ○ × × ×
Offset White <B> ○ × × ×
Warm Cool <B> ○ × × ×
Warm Cool Balance<B> ○ × × ×

Shutter Mode ○ ○ × ×
Slow Shutter Setting ○ ○ × ×

Number of Frames ○ ○ × ×
Time Zone Time Zone ○ × × ×
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項目 細目 保存先ファイル
All Scene Reference Lens

Clip Clip Naming ○ × × ×
Title Prefix ○ × × ×
Number Set × × × ×
Clip Naming ○ × × ×
Title Prefix ○ × × ×
Number Set × × × ×

Update Media Media(A) ― ― ― ―
Media(B) ― ― ― ―

GPS GPS ○ × × ×
Planning 
Metadata

Load Media(A) ― ― ― ―
Load Media(B) ― ― ― ―
Properties ― ― ― ―
Clear Memory ― ― ― ―
Clip Name Disp ○ × × ×

USB Select Folder ― ― ― ―
View Clip List ― ― ― ―
Rename Folder ― ― ― ―
Error Check ○ × × ×
Format USB ― ― ― ―
Copy to USB ― ― ― ―
Media Remain ― ― ― ―

Flash Band 
Reduce 

Setting × × × ×

Paintメニュー

項目 細目 保存先ファイル
All Scene Reference Lens

Switch Status Gamma ○ ○ Default ×
Black Gamma ○ ○ ○ ×
Matrix ○ ○ ○ ×
Knee ○ ○ ○ ×
White Clip × ○ × ×
Detail(QFHD) ○ ○ Default ×
Detail(HD) ○ ○ Default ×
Aperture ○ ○ Default ×
Flare ○ ○ Default ×
Test Saw ○ × × ×

HDR Paint 
Setting

HLG Look ○ ○ ○ ×
HDR Black Offset ○ ○ ○ ×
HDR Knee ○ ○ ○ ×
HDR Knee Point ○ ○ ○ ×
HDR Knee Slope ○ ○ ○ ×

White Color Temp <A> ○ ○ ○ ×
Color Temp Balance <A> ○ ○ ○ ×
R Gain <A> ○ ○ ○ ×
B Gain <A> ○ ○ ○ ×
Color Temp <B> ○ ○ ○ ×
Color Temp Balance <B> ○ ○ ○ ×
R Gain <B> ○ ○ ○ ×
B Gain <B> ○ ○ ○ ×

Black Master Black ○ ○ ○ ×
R Black ○ ○ ○ ×
B Black ○ ○ ○ ×

Flare Setting ○ ○ Default ×
Master Flare ○ ○ ○ ×
R Flare ○ ○ ○ ×
G Flare ○ ○ ○ ×
B Flare ○ ○ ○ ×
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項目 細目 保存先ファイル
All Scene Reference Lens

Gamma(HDR) Gamma Select × × × ×
Gamma Setting ○ ○ Default ×

Step Gamma ○ ○ ○ ×
Master Gamma ○ ○ ○ ×
R Gamma ○ ○ ○ ×
G Gamma ○ ○ ○ ×
B Gamma ○ ○ ○ ×
Gamma Category ○ ○ ○ ×
Gamma Select ○ ○ ○ ×

Black Gamma Setting ○ ○ ○ ×
Range ○ ○ ○ ×
Master Black Gamma ○ ○ ○ ×

Knee Setting ○ ○ ○ ×
Point ○ ○ ○ ×
Slope ○ ○ ○ ×
Knee Saturation ○ ○ ○ ×
Knee Saturation Level ○ ○ ○ ×

White Clip Setting × ○ × ×
Level ○ ○ ○ ×

Detail(QFHD) Setting ○ ○ Default ×
Level ○ ○ ○ ×
H/V Ratio ○ ○ ○ ×
Crispening ○ ○ ○ ×
Level Depend ○ ○ ○ ×
Level Depend Level ○ ○ ○ ×
Frequency ○ ○ ○ ×
Knee Aperture ○ ○ ○ ×
Knee Aperture Level ○ ○ ○ ×
Limit ○ ○ ○ ×
White Limit ○ ○ ○ ×
Black Limit ○ ○ ○ ×
V Black Limit ○ ○ ○ ×
V Detail Creation ○ ○ ○ ×

項目 細目 保存先ファイル
All Scene Reference Lens

Detail(HD) Setting ○ ○ Default ×
Level ○ ○ ○ ×
H/V Ratio ○ ○ ○ ×
Crispening ○ ○ ○ ×
Level Depend ○ ○ ○ ×
Level Depend Level ○ ○ ○ ×
Frequency ○ ○ ○ ×
Knee Aperture ○ ○ ○ ×
Knee Aperture Level ○ ○ ○ ×
Limit ○ ○ ○ ×
White Limit ○ ○ ○ ×
Black Limit ○ ○ ○ ×
V Black Limit ○ ○ ○ ×
V Detail Creation ○ ○ ○ ×

Detail(SD) Setting ○ ○ Default ×
Level ○ ○ ○ ×
H/V Ratio ○ ○ ○ ×
Crispening ○ ○ ○ ×
Level Depend ○ ○ ○ ×
Level Depend Level ○ ○ ○ ×
Frequency ○ ○ ○ ×
Knee Aperture ○ ○ ○ ×
Knee Aperture Level ○ ○ ○ ×
Limit ○ ○ ○ ×
White Limit ○ ○ ○ ×
Black Limit ○ ○ ○ ×
V Black Limit ○ ○ ○ ×
V Detail Creation ○ ○ ○ ×
Cross Color Suppress ○ ○ ○ ×

Aperture Setting ○ ○ Default ×
Level ○ ○ ○ ×

Skin Detail Setting ○ ○ ○ ×
Area Detection ― ― ― ―
Area Indication × × × ×
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項目 細目 保存先ファイル
All Scene Reference Lens

Skin Detail Level ○ ○ ○ ×
Saturation ○ ○ ○ ×
Hue ○ ○ ○ ×
Width ○ ○ ○ ×

Matrix Setting ○ ○ ○ ×
Adaptive Matrix ○ ○ ○ ×
Tracing Matrix ○ ○ ○ ×
Preset Matrix ○ ○ ○ ×
Preset Select ○ ○ ○ ×
User Matrix ○ ○ ○ ×
Level ○ ○ ○ ×
Phase ○ ○ ○ ×
User Matrix R-G ○ ○ ○ ×
User Matrix R-B ○ ○ ○ ×
User Matrix G-R ○ ○ ○ ×
User Matrix G-B ○ ○ ○ ×
User Matrix B-R ○ ○ ○ ×
User Matrix B-G ○ ○ ○ ×

Multi Matrix Setting ○ ○ ○ ×
Area Indication × × × ×
Color Detection ― ― ― ―
Reset ― ― ― ―
Axis × × × ×
Hue ○ ○ ○ ×
Saturation ○ ○ ○ ×

V Modulation Setting ○ × Default ×
Master V Modulation ○ ○ Default ×
R V Modulation ○ ○ Default ×
G V Modulation ○ ○ Default ×
B V Modulation ○ ○ Default ×

Low Key 
Saturation

Setting ○ ○ ○ ×
Level ○ ○ ○ ×
Range ○ ○ ○ ×

項目 細目 保存先ファイル
All Scene Reference Lens

Saturation 
Mode

Saturation Mode ○ ○ ○ ×
Knee Saturation ○ ○ ○ ×
Black Gamma ○ ○ ○ ×
Low Key Saturation ○ ○ ○ ×

Noise 
Suppression

Setting ○ ○ ○ ×
Level ○ ○ ○ ×
Gain Link ○ ○ ○ ×
－9dB ○ ○ ○ ×
－6dB ○ ○ ○ ×
－3dB ○ ○ ○ ×
0dB ○ ○ ○ ×
3dB ○ ○ ○ ×
6dB ○ ○ ○ ×
9dB ○ ○ ○ ×
12dB ○ ○ ○ ×
18dB ○ ○ ○ ×
24dB ○ ○ ○ ×
30dB ○ ○ ○ ×
36dB ○ ○ ○ ×
42dB ○ ○ ○ ×

Thumbnailメニュー

項目 細目 保存先ファイル
All Scene Reference Lens

Display Clip 
Properties

― ― ― ― ―

Set Index 
Picture

― ― ― ― ―

Thumbnail 
View

Essence Mark Thumbnail ― ― ― ―
Clip Thumbnail ― ― ― ―
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項目 細目 保存先ファイル
All Scene Reference Lens

Set Shot Mark Add Shot Mark1 ― ― ― ―
Delete Shot Mark1 ― ― ― ―
Add Shot Mark2 ― ― ― ―
Delete Shot Mark2 ― ― ― ―

Set Clip Flag Add OK ― ― ― ―
Add NG ― ― ― ―
Add KEEP ― ― ― ―
Delete Clip Flag ― ― ― ―

Lock/Unlock 
Clip

Select Clip ― ― ― ―
Lock All Clips ― ― ― ―
Unlock All Clips ― ― ― ―

Copy Clip Select Clip  ― ― ― ―
All Clips ― ― ― ―

Copy Sub Clip All Clips ― ― ― ―
Delete Clip Select Clip ― ― ― ―

All Clips ― ― ― ―
Transfer Clip Select Clip ― ― ― ―

All Clips ― ― ― ―
Transfer 
Clip(Proxy)

Select Clip ― ― ― ―
All Clips ― ― ― ―

Filter Clips OK ― ― ― ―
NG ― ― ― ―
KEEP ― ― ― ―
None ― ― ― ―

Customize View Thumbnail Caption ○ ○ × ×

Maintenanceメニュー

項目 細目 保存先ファイル
All Scene Reference Lens

White Shading Channel Select ○ × Default ×
White H Saw × × × ×
White H Para × × × ×
White V Saw × × × ×
White V Para × × × ×
White Saw/Para ○ × Default ×

Black Shading Channel Select ○ × Default ×
Black H Saw × × × ×
Black H Para × × × ×
Black V Saw × × × ×
Black V Para × × × ×
Black Saw/Para ○ × Default ×
Master Black ○ ○ ○ ×
Master Gain (TMP) ― ― ― ―

Battery Near End:Info Battery ○ × × ×
End:Info Battery ○ × × ×
Near End:Sony Battery ○ × × ×
End:Sony Battery ○ × × ×
Near End:Other Battery ○ × × ×
End:Other Battery ○ × × ×
Detected Battery ― ― ― ―

DC Voltage 
Alarm

DC Low Voltage1 ○ × × ×
DC Low Voltage2 ○ × × ×
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項目 細目 保存先ファイル
All Scene Reference Lens

Audio Front MIC Select ○ × × ×
Rear XLR Auto ○ × × ×
Front MIC CH1 Ref ○ × × ×
Front MIC CH2 Ref ○ × × ×
Rear MIC CH1 Ref ○ × × ×
Rear MIC CH2 Ref ○ × × ×
Line Input Ref ○ × × ×
Min Alarm Volume ○ × × ×
Speaker Attenuate ○ × × ×
Headphone Out ○ × × ×
Reference Level ○ × × ×
Reference Out ○ × × ×
CH1&2 AGC Mode ○ × × ×
CH3&4 AGC Mode ○ × × ×
AGC Spec ○ × × ×
Limiter Mode ○ × × ×
Output Limiter ○ × × ×
CH1 Wind Filter ○ × × ×
CH2 Wind Filter ○ × × ×
CH3 Wind Filter ○ × × ×
CH4 Wind Filter ○ × × ×
1kHz Tone on Color Bars ○ × × ×
MIC CH1 Level ○ × × ×
MIC CH2 Level ○ × × ×
Rear1/WRR Level ○ × × ×
Rear2/WRR Level ○ × × ×
Audio CH3 Level ○ × × ×
Audio CH4 Level ○ × × ×

WRR Setting WRR Valid CH Sel ○ × × ×
WRR CH Select × × × ×
WRR Delay Comp ○ × × ×

項目 細目 保存先ファイル
All Scene Reference Lens

WRR Setting TX ― ― ― ―
TX Audio Peak ― ― ― ―
TX Input Level ― ― ― ―
TX ATT Level ― ― ― ―
TX LCF Frequency ― ― ― ―
TX System Delay ○ × × ×
TX RF Power ― ― ― ―
TX Power Save ― ― ― ―
TX-Cam Power Sync ○ × × ×

Timecode TC Out ○ × × ×
DF/NDF ○ × × ×
LTC UBIT ○ × × ×
Counter Display ○ × × ×

Essence Mark Find Mode ○ × × ×
Camera Config HD SDI Remote I/F ○ × × ×

Color Bars Select ○ × × ×
User Menu Only ○ × × ×
User Menu with Lock × × × ×
RM Common Memory ○ × × ×
RM Rec Start ○ × × ×
Detail Control(RM/RCP) ○ × × ×
SET Key on Thumbnail ○ × × ×
ALAC ○ × × ×

Preset White Color Temp <P> ○ × × ×
Color Temp Balance <P> ○ × × ×
R Gain <P> ○ × × ×
B Gain <P> ○ × × ×
AWB Enable <P> × × × ×
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項目 細目 保存先ファイル
All Scene Reference Lens

White Filter ND Filter C.Temp ○ × × ×
ND FLT C.Temp<1> ○ × × ×
ND FLT C.Temp<2-4> ○ × × ×
Electrical CC<A> ○ × × ×
Electrical CC<B> ○ × × ×
Electrical CC<C> ○ × × ×
Electrical CC<D> ○ × × ×

DCC Adjust DCC Function Select ○ × × ×
DCC D Range ○ × × ×
DCC Point ○ × × ×
DCC Gain ○ × × ×
DCC Delay Time ○ × × ×
DCC Peak Filter ○ × × ×

Flicker Reduce Mode ○ × × ×
Frequency ○ × × ×

Genlock Genlock ○ × × ×
Reference ― ― ― ―

Auto Shading Auto Black Shading ― ― ― ―
Reset Black Shading ― ― ― ―
Master Gain (TMP) ― ― ― ―

APR APR ― ― ― ―
Reset ― ― ― ―

Basic 
Authentication

User Name × × × ×
Password × × × ×

項目 細目 保存先ファイル
All Scene Reference Lens

Network Setting ○* × × ×
Wi-Fi Mode ○* × × ×
NFC ― ― ― ―
WPS ― ― ― ―
Channel ○* × × ×
SSID & Password ― ― ― ―
SSID ― ― ― ―
Wi-Fi 
Station 
Detail 
Settings

Scan Networks ― ― ― ―
SSID × × × ×
Password × × × ×
DHCP ○* × × ×
IP Address ○* × × ×
Subnet Mask ○* × × ×
Gateway ○* × × ×
DNS Auto ○* × × ×
Primary DNS 
Server

○* × × ×

Secondary DNS 
Server

○* × × ×

Device Name (Wi-Fi) ― ― ― ―
IP Address (Wi-Fi) ― ― ― ―
Subnet Mask (Wi-Fi) ― ― ― ―
MAC Address (Wi-Fi) ― ― ― ―
Regenerate Password ― ― ― ―
Modem ○* × × ×
Wired LAN ○* × × ×
Wired LAN Remote ○* × × ×
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項目 細目 保存先ファイル
All Scene Reference Lens

Network Wired 
LAN 
Detail 
Settings

DHCP ○* × × ×
IP Address ○* × × ×
Subnet Mask ○* × × ×
Gateway ○* × × ×
DNS Auto ○* × × ×
Primary DNS 
Server

○* × × ×

Secondary DNS 
Server

○* × × ×

Network Client 
Mode

Setting ○* × × ×
Preset 
Select

○* × × ×

Preset 1 Display Name ○* × × ×
CCM Address ○* × × ×
CCM Port ○* × × ×
User Name × × × ×
Password × × × ×
NCM with Proxy ○* × × ×
Camera Control ○* × × ×
Camera Setting × × × ×

Preset 2 Preset 1と同じ
Preset 3 Preset 1と同じ

File Transfer File Transfer ― ― ― ―
Remote File Transfer ○* × × ×
Auto Upload (Proxy) ○* × × ×
Default Upload Server ○* × × ×
Clear Completed Jobs ― ― ― ―
Clear All Jobs ― ― ― ―
View Job List ― ― ― ―

項目 細目 保存先ファイル
All Scene Reference Lens

Streaming Setting × × × ×
Preset Select ○* × × ×
Preset1 Size ○* × × ×

Bit Rate ○* × × ×
Type ○* × × ×
Destination 
Address

○* × × ×

Destination 
Port

○* × × ×

Preset2 Preset 1と同じ
Preset3 Preset 1と同じ
Audio Channel ○* × × ×

Clock Set Date Mode ○ × × ×
12H/24H ○ × × ×
Date ― ― ― ―
Time ― ― ― ―

Language Select ○ × × ×
Hours Meter Hours (System) ― ― ― ―

Hours (Reset) ― ― ― ―
Reset ― ― ― ―

Network Reset Reset ― ― ― ―
Fan Control Setting ○ × × ×
VF Display 
Setting

Chara/Marker Brightness ○ × × ×

Option Type 1 ― ― ― ―
Type 2 ― ― ― ―
Type 3 ― ― ― ―
Install Option ― ― ― ―
Remove Option ― ― ― ―

Version Number ― ― ― ―
Version Up ― ― ― ―
Net-Func Version Number ― ― ― ―
Net-Func Ver.Up ― ― ― ―
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Fileメニュー

項目 細目 保存先ファイル
All Scene Reference Lens

User File Load SD Card ― ― ― ―
Save SD Card ― ― ― ―
File ID × × × ×
Recall User Preset ― ― ― ―
Store User Preset ― ― ― ―
Clear User Preset ― ― ― ―
Load Customize Data ○ × × ×
Load White Data ○ × × ×

All File Load SD Card ― ― ― ―
Save SD Card ― ― ― ―
File ID ○ × × ×
All Preset ― ― ― ―
Store All Preset ― ― ― ―
Clear All Preset ― ― ― ―
3Sec Clear Preset × × × ×

Scene File Recall Internal Memory ― ― ― ―
Store Internal Memory ― ― ― ―
Load SD Card ― ― ― ―
Save SD Card ― ― ― ―
File ID × ○ × ×
Scene White Data ○ × × ×

Reference File Store Reference ― ― ― ―
Clear Reference ― ― ― ―
Load Reference(SD Card) ― ― ― ―
Save Reference(SD Card) ― ― ― ―
File ID × × ○ ×

Lens File Display Mode × × × ×
Recall Internal Memory ― ― ― ―
Store Internal Memory ― ― ― ―
Load SD Card ― ― ― ―
Save SD Card ― ― ― ―

項目 細目 保存先ファイル
All Scene Reference Lens

Lens File File ID × × × ○
File Source ― ― ― ―
Clear Lens Offset ― ― ― ―
Lens Auto Recall ○ × × ×
Lens Serial Number ― ― ― ―
Lens Name ― ― ― ―
Lens Manufacturer ― ― ― ―
Master V Modulation × × × ○
Lens Center H × × × ○
Lens Center V × × × ○
R Flare × × × ○
G Flare × × × ○
B Flare × × × ○
White Offset R × × × ○
White Offset B × × × ○
Shading Ch Select ○ × × ×
Shading H SAW × × × ○
Shading H PARA × × × ○
Shading V SAW × × × ○
Shading V PARA × × × ○

User Gamma Current Settings ― ― ― ―
Load SD Card ― ― ― ―
Reset ― ― ― ―
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フォーマット別の特殊記録対応

フォーマット 通常記録

特殊記録1)

ピクチャー 
キャッシュ 
レック

インターバル 
レック

スロー＆ 
クイック 
モーション

クリップ 
コンティニュアス

レック

2スロット 
同時記録

1スロット 
同時記録

1スロット同時記
録＋ピクチャー
キャッシュレック

QFHD XAVC-I QFHD exFAT 〇 〇 〇 〇 － － 〇2) －
XAVC-L QFHD 〇 〇 〇 〇 － － 〇2) 〇2)

HD XAVC-I HD exFAT 〇 〇 〇 〇 〇 〇 － －
XAVC-L422 HD 50 〇 〇 〇 〇 〇 〇 － －
XAVC-L422 HD 35 〇 〇 〇 〇 〇 〇 － －
XAVC-L422 HD 25 〇 〇 〇 － 〇 〇 － －
MPEG HD422 〇 〇 〇 〇 〇 〇 － －

UDF 〇 〇 〇 〇 〇 － － －
MPEG HD420 HQ exFAT 〇 〇 － － － 〇 － －

UDF 〇 〇 － － － － － －
FAT 〇 〇 － － － － － －

MPEG HD420 SP 〇 〇 － － － － － －
SD MPEG IMX 50 exFAT 〇 〇 － － － － － －

UDF 〇 〇 － － － － － －
DVCAM exFAT 〇 － － － － － － －

UDF 〇 － － － － － － －

1) 対応している画サイズ、フレームレート、および機能詳細は「応用操作」（54ページ）をご覧ください。 
特殊記録を複数同時に動作させることはできません。

2) 同時に記録されるサブクリップのフォーマットはMPEG HD422です。
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ピクチャーキャッシュレックモード設定
メニューのOperation >Format Cache Rec Time
Frequency Rec Format 0－2 sec 2－4 sec 4－6 sec 6－8 sec 8－10 sec 10－12 sec 12－14 sec 13－15 sec
59.94
50

XAVC-I 3840×2160P － － － － － － － －
XAVC-I 1920×1080P ○ ○ － － － － － －
XAVC-I 1920×1080i ○ ○ ○ ○ － － － －
XAVC-I 1280×720P ○ ○ ○ ○ － － － －
XAVC-L 3840×2160P* ○ ○ ○ ○ － － － －
XAVC-L 50/35/25 ○ ○ ○ ○ ○ ○ ○ ○
MPEG HD422 ○ ○ ○ ○ ○ ○ ○ ○
MPEG HD420 HQ/SP ○ ○ ○ ○ ○ ○ ○ ○
MPEG IMX50 ○ ○ ○ ○ ○ ○ ○ ○
DVCAM － － － － － － － －

29.97
25
23.98

XAVC-I 3840×2160P ○ － － － － － － －
XAVC-I 1920×1080P ○ ○ ○ ○ － － － －
XAVC-L 3840×2160P* ○ ○ ○ ○ ○ ○ － －
XAVC-L 50/35 ○ ○ ○ ○ ○ ○ ○ ○
MPEG HD422 ○ ○ ○ ○ ○ ○ ○ ○
MPEG HD420 HQ ○ ○ ○ ○ ○ ○ ○ ○

［ご注意］
* 1スロット同時記録時のCache Rec Timeは0～ 2 secになります。
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使用上のご注意
ファン、バッテリーは有寿命部品として定期的
な交換が必要です。
常温でのご使用の場合、5年を目安に交換して
ください。ただし、交換時期は目安であり、部
品の寿命を保証するものではありません。交換
の際はお買い上げ店 にご相談ください。

ACアダプターと電解コンデンサの寿命は約5年
です。
（常温で1日に8時間、1カ月で25日間、通常に
使用すると想定した場合）
したがって、使用時間が上記より長い場合は、
その分寿命は短くなります。

取り扱い・保管上のご注意

強い衝撃を与えない
ˎˎ 内部構造や外観の変形などの損傷を受けるこ
とがあります。

ˎˎ アクセサリーシューに装着した部品に強い衝
撃が与えられた場合、アクセサリーシューが
損傷する場合があります。この場合は使用を
中止し、ソニーのサービス担当者、または営
業担当者にご相談ください。

動作中は布などで包まないでください
内部の温度が上がり、好ましくありません。

使い終わったら
POWERスイッチをOFFにしてください。

長時間使わないときは
バッテリーを外しておいてください。

輸送
ˎˎ 記録メディアは必ず取り出しておいてください。

ˎˎ トラック、船、航空機など、本機を貨物とし
て扱う輸送では、お買い上げ時の梱包材をご
使用ください。

お手入れ
レンズや光学フィルターの表面に付着したゴミ
やほこりは、ブロアーで吹き払います。
ブロワ―によるカメラ内部の掃除は行わないで
ください。空気中に含まれるほこり等が部品に
入り込み、故障の原因となることがあります。
外装の汚れは、乾いた柔らかい布で拭き取ります。
ひどい汚れは、中性洗剤液を少し含ませた布で拭い
た後、から拭きします。アルコール、ベンジン、シ
ンナーなどの薬品類は、表面が変質したり、塗料が
はげることがありますので、使わないでください。

万一、異常が生じたときは
ソニーのサービス担当者、または営業担当者に
ご相談ください。

医療機器に近づけない

本製品(付属品を含む)は磁石を使用しているた
め、ペースメーカー、水頭症治療用圧可変式シャ
ントなどの医療機器に影響を与える恐れがあり
ます。本製品をこれらの医療機器をご使用の方
に近づけないでください。これらの医療機器を
使用されている場合、本製品のご使用前に担当
医師にご相談ください。

使用場所・保管場所

水平な場所、空調のある場所に保管してください。
次のような場所での使用・保管は避けてください。

ˎˎ 極端に寒い所、暑い所（使用温度は－5℃～
+40℃） 
真夏、窓を閉め切った自動車内は50℃を越え
ることがあります。

ˎˎ 湿気・ほこりの多い所

ˎˎ 雨があたる所

ˎˎ 激しく振動する所

ˎˎ 強い磁気を発生するものの近く

ˎˎ 強力な電波を発生するテレビやラジオの送信
所の近く

ˎˎ 直射日光が長時間当たる場所や暖房器具の近く

携帯電話などによる電波障害を防止する
ために
携帯電話などを本機の近くで使用すると、誤動
作を引き起こしたり、映像、音声などに影響を
与えることがあります。
本機の近くでは、携帯電話などの電源はできる
だけ切ってください。

レーザービームについてのご注意

レーザービームはCMOSイメージセンサーに損
傷を与えることがあります。レーザービームを
使用した撮影環境では、CMOSイメージセンサー
表面にレーザービームが照射されないよう、また
その反射光や散乱光にも充分注意してください。

結露について

本機を寒いところから急に暖かいところに持ち
込んだときなど、機器表面や内部に水滴がつく
ことがあります。これを結露といいます。結露
が起きたときは電源を切り、結露がなくなるま
で放置し、結露がなくなってからご使用くださ
い。結露時のご使用は機器の故障の原因となる

場合があります。

ズームレンズの取り付け

ズームレンズの取り付けかたを誤ると損傷する
ことがあります。必ず「レンズの取り付けと調整」
（28ページ）をご覧ください。

ビューファインダーについて

ビューファインダーの接眼レンズを太陽に向けて
放置しないでください。 
太陽光が接眼レンズを通して内部に焦点を結び、
ビューファインダー内部を溶かすことがあります。

LCD（液晶）画面について

本機のLCD（液晶）パネルは有効画素99.99%以上
の非常に精密度の高い技術で作られていますが、
画面上に黒い点が現れたり（画素欠け）、常時点
灯している輝点（赤、青、緑など）や滅点がある
場合があります。また、LCD（液晶）パネルの特
性上、長期間ご使用の間に画素欠けが生じること
もあります。これらの現象は故障ではありませ
んので、ご了承の上本機をお使いください。なお、
これらの点が記録されることはありません。

CMOSイメージセンサー特有の現象

撮影画面に出る下記の現象は、CMOSイメージ
センサー特有の現象で、故障ではありません。

白点
CMOSイメージセンサーは非常に精密な技術で
作られていますが、宇宙線などの影響により、
まれに画面上に微小な白点が発生する場合があ
ります。これは撮像素子の原理に起因するもの
で故障ではありません。
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また、以下の場合、白点が見えやすくなります。

ˎˎ 高温の環境で使用するとき

ˎˎ マスターゲイン(感度)を上げたとき
ˎˎ スローシャッターモードのとき
なお、ブラックバランスの自動調整を行うこと
により、補正機能が働き、現象が改善すること
があります。

折り返しひずみ
細かい模様、線などを撮影すると、ぎざぎざや
ちらつきが見えることがあります。

フリッカー
蛍光灯、ナトリウム灯、水銀灯などの放電管に
よる照明下で撮影すると、画面が明滅したり、
色が変化したり、横縞が流れるように見えるこ
とがあります。

このようなときは、フリッカー補正機能をAuto
にしてください（124ページ）。
撮影しているフレームレートが電源周波数に近
い場合は、フリッカー補正機能が働いてもフリッ
カーを完全に補正できない場合があります。こ
の場合は、電子シャッターを使用してください。

フォーカルプレーン
撮像素子(CMOSイメージセンサー )の映像信号
を読み出す方法の性質により、撮像条件によっ
ては、画面をすばやく横切る被写体が少しゆが
んで見えることがあります。

フラッシュバンド
フラッシュ光や、すばやく点滅する光源を撮影
したときに、画面の上下で輝度が変化すること
があります。
フラッシュバンドが発生したフレームを含むク
リップは、専用アプリケーションソフトウェア
を使用して補正することができます。

ファイルの断片化について

画像が正しく記録・再生されないときは記録メ
ディアをフォーマット（初期化）してください。
長期間、映像の記録・クリップの消去を繰り返
していると、記録メディア内のファイルが断片
化（フラグメンテーション）して、映像が正し
く記録・保存できなくな る場合があります。こ
のような場合は、クリップのバックアップを
取ったあと、メニューのOperation >Format 
Media（105ページ）で記録メディアのフォー
マット（初期化）を行ってください。

セキュリティに関するご注意

ˎˎ 通信を行う機器でセキュリティ対策を行わな
かった結果、または、通信仕様上の、やむを
得ない事情により、データ漏洩等、セキュリ
ティ上の問題が発生した場合、弊社ではそれ
によって生じたあらゆる損害に対する責任を
負いかねます。

ˎˎ 使用環境によってはネットワーク上の意図せ
ぬ第三者から製品にアクセスされる可能性が
あります。本機をネットワークに接続する際
には、セキュアなネットワークであることを
ご確認の上ご使用ください。

ˎˎ 利用者が気付かないうちに、電波が届くとこ
ろから意図せぬ第三者に通信内容を盗み見ら

れてしまうおそれがあります。 無線LAN通信
を利用する際は、通信内容を保護するために、
適切なセキュリティ対策をしてください。

ˎˎ セキュリティの面から、製品をネットワーク
に接続してご使用になる際は、ブラウザでコ
ントロール画面にアクセスし、アクセス制限
設定を工場出荷時の設定値から変更して設定
することを強く推奨します。（84ページ） 
また、定期的にパスワードを変更することを
推奨します。

ˎˎ 設定作業中または設定作業後のブラウザで他
のサイトを閲覧しないでください。 
ブラウザにログインした状態が残りますので、
意図しない第三者の使用や悪意のあるプログ
ラムの実行を防ぐために、設定作業が完了し
たら必ずブラウザを終了してください。

GPSについて

GPS（Global Positioning System）とは、米国
の高精度な航空衛星を利用した、地球上のどこ
にいても自分の正確な位置を知ることができる
システムです。
GPS衛星は、高度20,000kmの6つの軌道上に各
4個、24個以上が設置されています。
GPS衛星からの電波を受信し、衛星の軌道情報
（アルマナックデータ）と電波の伝播時間のデー
タなどから自分の位置を計算します。
位置を計算することを測位と呼び、衛星を3機
以上受信できれば、経度、緯度がわかります。

ˎˎ GPS衛星の配置は常に変化しているため、ご
使用になる場所や時刻などの条件によっては
測位に時間がかかったり、測位できないこと
があります。

ˎˎ GPSは衛星から電波を受信し、測位するシス
テムです。ビルや木立の陰など、電波を遮断・

反射してしまう場所を避け、できるだけ上空
の開けた場所でご使用ください。

ˎˎ GPS衛星からの電波が届かない以下のような
場所や状況では、測位情報を記録できないこ
とがあります。

 – トンネルの中・屋内やビルの陰
 – 高層ビルの間・建物の間の狭い道路
 – 地下・密集した樹木の間・高架の下・高
圧電線など、近くに磁気を発生するもの
がある場合

 – 1.5GHz帯の携帯電話など、近くに同じ周
波数帯の電波を発生するものがある場合

ˎˎ GPSがOnの状態で撮影した画像をインター
ネットに公開、共有すると、意図せずに撮影
場所が第三者に知られる場合があります。そ
の場合はGPSをOffにして撮影してください
（112ページ）。

誤差について
ˎˎ GPSをOnにした直後に移動すると、移動しな
かった場合に比べて、測位までの時間が長く
なることがあります。

ˎˎ GPS衛星自体による誤差 
本機は、3個以上のGPS衛星からの電波を受
信すると自動的に現在地を測位します。 
GPS衛星自体による誤差は、約10m程度です
が、測位する周辺の環境によってはさらに大
きな誤差を生じることがあります。このよう
な場合は、実際に居た場所と地図上での位置
が異なることがあります。また、GPS衛星は
米国国防省により管理されており、意図的に
精度が変更されることがあります。

ˎˎ 測位時間による誤差 
本機では、測位中に測位情報を定期的に取得
しています。
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規制について
使用する国や地域の規制に従ってGPS機能をお
使いください。

測地系について
本機では、測地系として、「WGS-84」を採用し
ています。
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主な仕様
一般

質量 約3.6 kg（本体のみ）
外形寸法 （単位：mm、突起部含まず、本体のみ）1)

17
0

26
9

332

1) 寸法は概算値です。

電源電圧 DC 12 V（11 V～ 17.0 V）
消費電力 約24 W（本体のみ、XAVC-I記録時、

LCDモニター点灯時）
  約26 W（ビューファインダー CBK-

VF02、マニュアルレンズ、マイク
装着、XAVC-I記録時、LCDモニター
点灯時）

［ご注意］

ˎˎ 消費電力が50 Wより大きいビデオライトを接続しない
でください。
ˎˎ バッテリー使用時、周辺機器を装着して使用する場合
は、周辺機器の消費電力の合計が40 W以内になるよう
にしてください。
ˎˎ AC-DN10使用時、周辺機器を装着して使用する場合は、
周辺機器の消費電力の合計が50 W以内になるようにし
てください。
ˎˎ AC-DN2B使用時、周辺機器を装着して使用する場合は、
周辺機器の消費電力の合計が85 W以内になるようにし
てください。
ˎˎ DC OUT端子には消費電流が1.8 A以下の機器を接続し
てください。

動作温度 0 ℃～ 40 ℃
保存温度 －20 ℃～＋60 ℃
ファイルシステム
  exFAT、UDF、FAT
連続操作時間
  約150分（BP-FLX75使用時）
記録フォーマット（ビデオ）
 XAVC Intra
  MPEG-4 AVC/H.264
  XAVC-I QFHD：VBR、最大600Mbps
  XAVC-I HD：CBG、最大223Mbps
 XAVC Long
  MPEG-4 AVC/H.264
  XAVC-L QFHD：VBR、最大150Mbps
  XAVC-L 50：VBR、最大50Mbps
  XAVC-L 35：VBR、最大35Mbps
  XAVC-L 25：VBR、最大25Mbps
 MPEG-2 Long GOP
  MPEG HD422モード：CBR、

50 Mbps、MPEG-2 422P@HL
  MPEG HD420 HQモード：VBR、 

最大35 Mbps、MPEG-2 MP@HL
  MPEG HD420 SPモード：CBR、 

25Mbps、MPEG-2 MP@H-14
 MPEG IMX
  CBR、50 Mbps
 DVCAM
  CBR、25 Mbps
 XAVC Proxy
  AVC/H.264 Main Profile 4:2:0 Long 

Gop
  1920×1080：9 Mbps、6 Mbps
  1280×720：9 Mbps、6 Mbps
  640×360：3 Mbps
  480×270：1 Mbps、500 Kbps (VBR)
記録フォーマット（オーディオ）
 XAVC Intra
  LPCM 24ビット、48 kHz、4チャンネ

ル

 XAVC Long
  LPCM 24ビット、48 kHz、4チャンネ

ル
 MPEG-2 Long GOP
  MPEG HD422 モード：LPCM 24ビッ

ト、48 kHz、4チャンネル
  MPEG HD420 HQ モード：LPCM 16

ビット、48 kHz、4チャンネル
 MPEG IMX
  LPCM 16/24ビット、48 kHz、4チャ

ンネル
 DVCAM
  LPCM 16ビット、48 kHz、4チャンネ

ル
 XAVC Proxy
  AAC-LC、128 Kbps、2チャンネル
記録・再生時間
 XAVC Intra
  XAVC-I QFHD
   約22分：SBP-120F/SBP-128E使用

時
  XAVC-I HD
   約57分：SBP-120F/SBP-128E使用

時
 XAVC Long
  XAVC-L QFHD
   約86分：SBP-120F/SBP-128E/

SBS-128G1C使用時
  XAVC-L200
   約66分：SBP-120F/SBP-128E使用

時
  XAVC-L422 HD 50
   約230分：SBP-120F/SBP-128E/

SBS-128G1C使用時
  XAVC-L422 HD 35
   約315分：SBP-120F/SBP-128E/

SBS-128G1C使用時
  XAVC-L422 HD 25
   約420分：SBP-120F/SBP-128E/

SBS-128G1C使用時

 MPEG-2 Long GOP
  MPEG HD422
   約220分：SBP-120F/SBP-128E/

SBS-128G1C使用時
  MPEG HD420 HQ
   約330分：SBP-120F/SBP-128E/

SBS-128G1C使用時
 DVCAM
   約405分：SBP-120F/SBP-128E使

用時

［ご注意］
記録・再生時間は、1クリップとして連続記録したときの
ものです。記録するクリップ数によっては記載の時間より
短くなる場合があります。

記録フレームレート
 XAVC Intra
 　XAVC-I QFHD
  3840×2160/59.94P、50P、29.97P、

25P、23.98P
 　XAVC-I HD
  1920×1080/59.94P、50P、59.94i、

50i、29.97P、25P、23.98P
  1280×720/59.94P、50P
 XAVC Long
 　XAVC-L QFHD
  3840×2160/59.94P、50P、29.97P、

25P、23.98P
 　XAVC-L 50
  1920×1080/59.94P、50P、59.94i、

50i、29.97P、25P、23.98P
  1280×720/59.94P、50P
 　XAVC-L 35
  1920×1080/59.94P、50P、59.94i、

50i、29.97P、25P、23.98P
 　XAVC-L 25
  1920×1080/59.94i、50i
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 MPEG-2 Long GOP
 　MPEG HD422
  1920×1080/59.94i、50i、29.97P、

25P、23.98P
  1280×720/59.94P、50P、29.97P、

25P、23.98P
 　MPEG HD420 HQ
  1920×1080/59.94i、50i、29.97P、

25P、23.98P
  1440×1080/59.94i、50i
  1280×720/59.94P、50P
 　MPEG HD420 SP
  1440×1080/59.94i、50i
 MPEG IMX
  720×486/59.94i
  720×576/50i
 DVCAM
  720×480/59.94i
  720×576/50i
XAVC Proxy
  本線 1920×1080時 : 59.94i、50i、

29.97P、25P、23.98P
  本線 1280×720時 : 59.94P、50P、

29.97P、25P、23.98P

入出力部

入力
GENLOCK IN：
  BNC型、1.0 Vp-p、75 Ω、不平衡
TC IN： BNC型、0.5 V～ 18 Vp-p、10 kΩ 
AUDIO IN CH1/CH2：
  XLR型、3ピン、凹
  LINE / AES/EBU / MIC / MIC+48V切

り換え可能
  LINE：+4、0、－3 dBu
  AES/EBU：AES3準拠

  MIC：－70 dBu～－30 dBu
MIC IN： XLR型、5ピン、凹、－70 dBu～ 

－30 dBu
WRR： D-sub 15ピン
  アナログ CH1：－40 dBu
  デジタル CH1/CH2：－40 dBFS
SDI IN： SMPTE ST292-1/259規格準拠
  オーディオ4チャンネル

出力
VIDEO OUT：
  BNC型、SDアナログコンポジット/

HD-Y切り換え
SDI OUT 1/2/3/4：
  BNC型、0.8 Vp-p、不平衡（3G/1.5G/

SD切り換え） 
  SMPTE ST424/425、ST292-1/259規

格準拠
  オーディオ4チャンネル
AUDIO OUT：
  XLR型、5ピン、凸、+4/0/－3dBu（平衡）
TC OUT： BNC型、1.0 Vp-p、50 Ω
EARPHONE（ステレオミニジャック）：
  －11 dBu (基準レベル出力、モニター

ボリューム最大、16 Ω負荷時)
HDMI： TypeA、19ピン

その他
DC IN： XLR型、4ピン、凸、DC 11 V～ 17 V
DC OUT： 丸型4ピン、DC 11 V～ 17 V、最大定

格電流1.8 A
LENS： 12ピン、レンズへの電源供給（DC 

11 V～ 17 V、最大定格電流 1.0 A）
REMOTE： 8ピン
LIGHT： 2ピン
USB： 4ピン（Aタイプ）×2、4ピン（Bタイプ）
VF： 角型26ピン（CBK-VF02用）、丸形20ピ

ン（HDVFシリーズ用）

ネットワーク端子：
  RJ45型、100BASE-TX（IEEE 802.3u）、

10BASE-T（IEEE 802.3）

カメラ部

撮像素子 2/3型、“Exmor R”CMOS イメージセ
ンサー

  3840（H）×2160（V）
NDフィルター
  1：クリア
  2：1/4ND
  3：1/16ND
  4：1/64ND
感度 F10（システム周波数：59.94i）（Typical）
  （2000 lx、反射率89.9%、3200K）
最低被写体照度
  0.019 lx（F1.4、＋42 dB、16フレーム

蓄積）
映像S/N 61 dB（Noise Suppression On, 1920

×1080 59.94i）（Typical）
水平解像度 1000TV本以上（1920×1080 59.94i）
黒レベル 3 ±1%（メニューのBlackを［±0］に設

定したとき）
シャッタースピード
  59.94i/P、50i/P：1/60 ～ 1/2000秒
  29.97P：1/40～ 1/2000秒
  25P：1/33～ 1/2000秒
  23.94P：1/32～ 1/2000秒
スローシャッター
  2 ～ 8、16フレーム
ダイナミックレンジ
  600%（SDRモード時）
  1300%（HDRモード時）

オーディオ部

サンプリング周波数
  48 kHz
量子化特性
  16/24ビット
ヘッドルーム
  20 dB（工場出荷時）（20、18、16、

12 dB）、EBUL
周波数特性
  20 Hz～ 20 kHz（±3 dB以内）
ダイナミックレンジ
  90 dB（Typical）
ひずみ率 0.08%以下（入力レベル－40 dBu時）
内蔵スピーカー
  モノラル、出力：300 mW

表示部

LCDモニター
  画面サイズ 

対角8.8 cm （3.5型）
  アスペクト比 

16:9
  画素数 

960（H）×540（V）

メディア部

SxSカードスロット
  形状：Express Card34
  スロット数：2
  端子：PCMCIA Express Card準拠
  書き込みレート：50 Mbps以上
  読み出しレート：50 Mbps以上
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SDカードスロット
  Proxy用×1、Utilty用×1

レンズ部（PXW-Z450KCに
付属）

レンズマウント
  ソニー 2/3インチ型バヨネットマウン

ト
焦点距離 7.6 mm～ 137 mm
ズーム 電動／手動切り換え可能
ズーム比 18x
最大口径比 1:1.8
絞り 自動／手動切り換え可能 F1.8～ F16お

よびC（クローズ）
フォーカス範囲
  手動：560 mm～∞（マクロOFF）、

10 mm～∞（マクロON）
フィルター径
  M82 mm、ピッチ0.75 mm （フード内）
マクロ ON/OFF可能

付属品

ショルダーベルト（1）
コールドシューキット（1式）
レンズマウントキャップ
USBワイヤレスLANモジュール（IFU-WLM3）
保護キャップ（1）
ガード（1）
ご使用になる前に（1）
取扱説明書（CD-ROM）（1）
ビューファインダー取扱説明書（PXW-Z450KC付
属CD-ROM）（1）
レンズ（PXW-Z450KCに付属）（1）
フランジバック調整用チャート（1）

ステレオマイク（PXW-Z450KCに付属）（1）
ビューファインダー（PXW-Z450KCに付属）（1）
ステレオマイク防風スクリーン（PXW-Z450KCに
付属）（1）

関連機器

アップグレードライセンス

CBKZ-Z450QL (QUAD-LINK 3G-SDI Upgrade 
License)

電源関連

ACアダプター
  AC-DN10/DN2B
バッテリーパック
  BP-FLX75
バッテリーチャージャー
  BC-L70/L90/L70A

レンズ、ビューファインダーおよび
関連機器

レンズ 2/3型バヨネットマウントレンズにの
み対応

ビューファインダー
  HDVF-20A/L750/EL20/EL30
ビューファインダー回転収納機構
  BKW-401

リモートコントロール用機器

リモートコントロールユニット
  RM-B170
  RCP-1000/1500/1530
  RCP-1001/1501

［ご注意］
コマンドネットワークユニット（CNU）には対応していま
せん。

HDカメラアダプター

CA-FB70/TX70

［ご注意］
CA-FB70装着時にSDI OUT2と併用する場合は、L字アン
グルの変換アダプターを使用してください。

メディアアダプター

MEAD-SD02（SDカード用）

XQD ExpressCardアダプター

QDA-EX1（XQDメモリーカード用）

記録メディア

SxSメモリーカード
  SxS PRO Xシリーズ
  SxS PRO+シリーズ
  SxS PROシリーズ
  SxS-1シリーズ

オーディオ機器

マイクロホン
  ECM-678/674/673/680S
マイクホルダー
  CAC-12
デジタルワイヤレスレシーバー
  DWR-02DN/DWR-S03D
UHFシンセサイザーチューナーユニット
  URX-S03D

その他の周辺機器

三脚アタッチメント
  VCT-14/U14

ビデオライト
  UC-D200A（日本ビデオシステム社製）
  ウルトラライト（アントンバウアー社製）
パッド ソフトタイプショルダーパッドCBK-

SP01
ワイヤレスLANアダプター
  CBK-WA02
ネットワークアダプターキット
  CBK-NA1
USBアダプター
  CBK-DL1

保守用製品、操作／取り扱いを容易
にするための製品

アタッチメント金具
  A-2092-367-

仕様および外観は、改良のため予告なく変更す
ることがありますが、ご了承ください。
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ˎˎ 必ず事前に記録テストを行い、正常に記録
されていることを確認してください。本機
や記録メディア、外部ストレージなどを使
用中、万一これらの不具合により記録され
なかった場合の記録内容の補償については、
ご容赦ください。

ˎˎ お使いになる前に、必ず動作確認を行って
ください。故障その他に伴う営業上の機会
損失等は保証期間中および保証期間経過後
にかかわらず、補償はいたしかねますので
ご了承ください。

ˎˎ 本製品を使用したことによるお客様、また
は第三者からのいかなる請求についても、
当社は一切の責任を負いかねます。

ˎˎ 本機内、記録メディア、外部のストレージ
等に記録されたデータの損失、修復、複製
の責任は負いかねます。

ˎˎ 諸事情による本製品に関連するサービスの停
止、中断について、一切の責任を負いかねます。

ソフトウェアのダウンロー
ドについて

本機をPCと接続して使用する際は、必要に応じ
てデバイスドライバーや各種プラグインソフト
ウェア、アプリケーションソフトウェアを下記
サイトからダウンロードしてお使いください。

ソニープロフェッショナル/業務用製品サイト
ホームページ：
アメリカ合衆国 http://pro.sony.com
カナダ http://www.sonybiz.ca
ラテンアメリカ http://sonypro-latin.com
ヨーロッパ http://www.pro.sony.eu/pro
中東、アフリカ http://sony-psmea.com
ロシア http://sony.ru/pro/
ブラジル http://sonypro.com.br
オーストラリア http://pro.sony.com.au
ニュージーランド http://pro.sony.co.nz
日本 http://www.sonybsc.com
アジア http://pro.sony-asia.com
韓国 http://bp.sony.co.kr
中国 http://pro.sony.com.cn
インド http://pro.sony.co.in

Sony Creative Software社のソフトウェアダウ
ンロードページ
http://www.sonycreativesoftware.com/
download/software_for_sony_equipment

周辺機器・アクセサリー一覧図

マイクロホン
ECM-680S/678/ 
674/673

4Kモニター／ HDモニター／ SDモニター

HDカメラアダプター CA-FB70

HDカメラアダプター CA-TX70

バッテリーパック
BP-FLX75

バッテリー
チャージャー
BC-L70A

ACアダプター
AC-DN10/DN2B

SxSメモリーカード
SBS-32G1C、SBS-64G1C、SBS-128G1C、
SBP-64E、SBP-128E、SBP-256E、 
SBP-120F、SBP-240F

メディアアダプターMEAD-SD02

XQD ExpressCardアダプター QDA-EX1

UHFシンセサイザーチューナーユニット
URX-S03D
デジタルワイヤレスレシーバー DWR-S02DN/
DWR-S03D

マイクホルダー
CAC-12
ビューファインダー
CBK-VF02

リモートコントロールユニット
RM-B170
RCP-1000/1500/1530
RCP-1001/1501

PXW-Z450

ビューファインダー
HDVF-20A/L750/EL20/EL30

三脚アタッチメント
VCT-14

http://www.sonycreativesoftware.com/download/software_for_sony_equipment
http://www.sonycreativesoftware.com/download/software_for_sony_equipment
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MPEG-4 AVC Patent 
Portfolio Licenseについて

本製品は、MPEG LA, LLCがライセンス活動を
行っているAVC PATENT PORTFOLIOLICENSE
の下、次の用途に限りライセンスされています：
（i） 消費者が個人的又は他の報酬を受けていな

い使用目的で、MPEG-4 AVC規格に合致し
たビデオ信号（以下、AVC VIDEOといいます）
にエンコードすること。

（ii） AVC VIDEO（消費者が個人的又は他の報酬
を受けていない目的でエンコードしたもの、
若しくはMPEG LAよりライセンスを取得
したプロバイダーがエンコードしたものに
限られます）をデコードすること。

なお、その他の用途に関してはライセンスされ
ていません。プロモーション、商業的に利用
することに関する詳細な情報につきましては、
MPEG LA, LLC.のホームページをご参照くださ
い。

END USER LICENSE 
AGREEMENT

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
CAMCORDER, PLEASE READ THIS END USER LICENSE 
AGREEMENT (“EULA”) CAREFULLY. BY USING THE 
SOFTWARE YOU ARE ACCEPTING THE TERMS OF THIS 
EULA. IF YOU DO NOT ACCEPT THE TERMS OF THIS 
EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and 
Sony Corporation (“SONY”). This EULA governs 
your rights and obligations regarding the software 
of SONY and/or its third party licensors (including 
SONY’s affiliates) and their respective affiliates 
(collectively, the “THIRD-PARTY SUPPLIERS”) 
contained in the camcorder, together with any 
updates/ upgrades provided by SONY, any printed, 
on-line or other electronic documentation for such 
software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”). 

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU 
General Public license and Lesser/Library General 
Public License) shall be covered by such applicable 
separate end user license agreement in lieu of the 
terms of this EULA to the extent required by such 
separate end user license agreement (“EXCLUDED 
SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE 
is protected by copyright and other intellectual 
property laws and international treaties. 

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, 
animation, video, audio, music, text and “applets” 

incorporated into the SOFTWARE) is owned by SONY 
or one or more of the THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the 
SOFTWARE solely in connection with the camcorder 
and only for your individual use. SONY and the 
THIRD-PARTY SUPPLIERS expressly reserve all rights, 
title and interest (including, but not limited to, all 
intellectual property rights) in and to the SOFTWARE 
that this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of the 
SOFTWARE, whether in whole or in part, or create 
any derivative works from or of the SOFTWARE unless 
such derivative works are intentionally facilitated 
by the SOFTWARE. You may not modify or tamper 
with any digital rights management functionality of 
the SOFTWARE. You may not bypass, modify, defeat 
or circumvent any of the functions or protections 
of the SOFTWARE or any mechanisms operatively 
linked to the SOFTWARE. You may not separate 
any individual component of the SOFTWARE for 
use on more than one camcorder unless expressly 
authorized to do so by SONY. You may not remove, 
alter, cover or deface any trademarks or notices 
on the SOFTWARE. You may not share, distribute, 
rent, lease, sublicense, assign, transfer or sell the 
SOFTWARE. The software, network services or other 
products other than SOFTWARE upon which the 
SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that 
the SOFTWARE, network services, contents or other 
products will continue to be available, or will operate 
without interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE may 
include EXCLUDED SOFTWARE. Certain EXCLUDED 
SOFTWARE may be covered by open source 
software licenses (“Open Source Components”), 
which means any software licenses approved as 
open source licenses by the Open Source Initiative 
or any substantially similar licenses, including but 
not limited to any license that, as a condition of 
distribution of the software licensed under such 
license, requires that the distributor make the 
software available in source code format. If and to 
the extent disclosure is required, please visit www.
sony.com/linux or other SONY-designated web site 
for a list of applicable OPEN SOURCE COMPONENTS 
included in the SOFTWARE from time to time, and the 
applicable terms and conditions governing its use. 
Such terms and conditions may be changed by the 
applicable third party at any time without liability to 
you. To the extent required by the licenses covering 
EXCLUDED SOFTWARE, the terms of such licenses will 
apply in lieu of the terms of this EULA. To the extent 
the terms of the licenses applicable to EXCLUDED 
SOFTWARE prohibit any of the restrictions in this 
EULA with respect to such EXCLUDED SOFTWARE, 
such restrictions will not apply to such EXCLUDED 
SOFTWARE. To the extent the terms of the licenses 
applicable to Open Source Components require 
SONY to make an offer to provide source code in 
connection with the SOFTWARE, such offer is hereby 
made.

USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use content 
created by you and/or third parties. Such content 
may be protected by copyright, other intellectual 
property laws, and/or agreements. You agree to 
use the SOFTWARE only in compliance with all 
such laws and agreements that apply to such 
content. You acknowledge and agree that SONY 
may take appropriate measures to protect the 
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copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup 
and restoration through certain SOFTWARE features, 
refusal to accept your request to enable restoration 
of data, and termination of this EULA in the event of 
your illegitimate use of the SOFTWARE.

CONTENT SERVICE
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND 
THAT CONTENT IS SUBJECT TO THE TERMS OF SERVICE 
OF THAT CONTENT SERVICE. IF YOU DECLINE TO 
ACCEPT THOSE TERMS, YOUR USE OF THE SOFTWARE 
WILL BE LIMITED. You acknowledge and agree that 
certain content and services available through the 
SOFTWARE may be provided by third parties over 
which SONY has no control. USE OF THE CONTENT 
SERVICE REQUIRES AN INTERNET CONNECTION. THE 
CONTENT SERVICE MAY BE DISCONTINUED AT ANY 
TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet 
connection for which you are solely responsible. 
Further, you are solely responsible for payment of 
any third party fees associated with your Internet 
connection, including but not limited to Internet 
service provider or airtime charges. Operation of the 
SOFTWARE may be limited or restricted depending 
on the capabilities, bandwidth or technical 
limitations of your Internet connection and service. 
The provision, quality and security of such Internet 
connectivity are the sole responsibility of the third 
party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and 
re-export restrictions and regulations of the area 
or country in which you reside, and not to transfer, 

or authorize the transfer, of the SOFTWARE to a 
prohibited country or otherwise in violation of any 
such restrictions or regulations. 

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not 
designed, manufactured or intended for use or 
resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, aircraft 
navigation or communication systems, air traffic 
control, direct life support machines, or weapons 
systems, in which the failure of the SOFTWARE could 
lead to death, personal injury, or severe physical or 
environmental damage (“HIGH RISK ACTIVITIES”). 
SONY, each of the THIRD-PARTY SUPPLIERS, and each 
of their respective affiliates specifically disclaim any 
express or implied warranty, duty or condition of 
fitness for HIGH RISK ACTIVITIES. 

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you are 
responsible for use of the SOFTWARE. The SOFTWARE 
is provided “AS IS,” without warranty, duty or 
condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS 
(for purposes of this Section, SONY and each of 
the THIRD-PARTY SUPPLIERS shall be collectively 
referred to as “SONY”) EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, 
NONINFRINGEMENT AND FITNESS FOR A PARTICULAR 
PURPOSE. SONY DOES NOT WARRANT OR MAKE ANY 
CONDITIONS OR REPRESENTATIONS (A) THAT THE 
FUNCTIONS CONTAINED IN ANY OF THE SOFTWARE 
WILL MEET YOUR REQUIREMENTS OR THAT THEY 
WILL BE UPDATED, (B) THAT THE OPERATION OF ANY 
OF THE SOFTWARE WILL BE CORRECT OR ERROR-
FREE OR THAT ANY DEFECTS WILL BE CORRECTED, 
(C) THAT THE SOFTWARE WILL NOT DAMAGE ANY 
OTHER SOFTWARE, HARDWARE OR DATA, (D) THAT 
ANY SOFTWARE, NETWORK SERVICES (INCLUDING 

THE INTERNET) OR PRODUCTS (OTHER THAN 
THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE.

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE 
OF THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. 
SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, SO THESE 
EXCLUSIONS MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS 
(for purposes of this Section, SONY and each of the 
THIRD-PARTY SUPPLIERS shall be collectively referred 
to as “SONY”) SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL OR CONSEQUENTIAL DAMAGES FOR 
BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, 
BREACH OF CONTRACT, NEGLIGENCE, STRICT 
LIABILITY OR UNDER ANY OTHER LEGAL THEORY 
RELATED TO THE SOFTWARE, INCLUDING, BUT NOT 
LIMITED TO, ANY DAMAGES ARISING OUT OF LOSS 
OF PROFITS, LOSS OF REVENUE, LOSS OF DATA, LOSS 
OF USE OF THE SOFTWARE OR ANY ASSOCIATED 
HARDWARE, DOWN TIME AND USER’S TIME, EVEN 
IF ANY OF THEM HAVE BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, EACH 
AND ALL OF THEIR AGGREGATE LIABILITY UNDER ANY 
PROVISION OF THIS EULA SHALL BE LIMITED TO THE 
AMOUNT ACTUALLY PAID FOR THE PRODUCT. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE 
and (ii) the software applications, contents and 
peripheral devices that interact with your camcorder 
and the SOFTWARE (“Information”). Information 
includes, but is not limited to: (1) unique identifiers 
relating to your camcorder and its components; 
(2) performance of the camcorder, the SOFTWARE 
and their components; (3) configurations of your 
camcorder, the SOFTWARE and the software 
applications, contents and peripheral devices that 
interact with the camcorder and the SOFTWARE; 
(4) use and frequency of use of the functions of (x) 
the SOFTWARE, and (y) the software applications, 
contents and peripheral devices that interact with 
the SOFTWARE; and (5) location data, as indicated 
below. SONY and its affiliates, partners and agents 
may use and disclose Information subject to 
applicable laws in order to improve its products 
and services or to provide products or services to 
you. Such uses include, but are not limited to: (a) 
administering the functionalities of the SOFTWARE; 
(b) to improve, service, update or upgrade the 
SOFTWARE; (c) improving, developing and enhancing 
the current and future products and services of SONY 
and other parties; (d) to provide you with information 
about the products and services offered by SONY 
and other parties; (e) complying with applicable laws 
or regulations; and (f ) to the extent offered, providing 
you with location-based services of SONY and other 
parties, as indicated below. In addition, SONY retains 
the right to use Information to protect itself and third 
parties from illegal, criminal or harmful conduct.

Certain services available through the SOFTWARE 
may rely upon location information, including, 
but not limited to, the geographic location of the 
camcorder. You acknowledge that for the purpose 
of providing such services, SONY, the THIRD-PARTY 
SUPPLIERS or their partners may collect, archive, 
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process and use such location data, and that such 
services are governed by the privacy policies of SONY 
or such third party. By using any such services, you 
agree that you have reviewed the privacy policies 
applicable to such services and consent to such 
activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will 
be in accordance with the privacy policies of SONY 
or such third party. Please contact applicable contact 
address of each area or country for SONY’s current 
privacy policy.

Please contact applicable third parties for privacy 
policies relating to personally identifiable and other 
information you provide when you use or access 
third party software or services.

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical 
and organizational steps to prevent unauthorized 
access to or disclosure of Information, but does not 
warrant it will eliminate all risk of misuse of such 
Information.

AUTOMATIC UPDATE FEATURE 
From time to time, SONY or the THIRD-PARTY 
SUPPLIERS may automatically update or otherwise 
modify the SOFTWARE, including, but not limited to, 
for purposes of enhancement of security functions, 
error correction and improvement of functions, 
at such time as you interact with SONY’s or third 
parties’ servers, or otherwise. Such updates or 
modifications may delete or change the nature of 
features or other aspects of the SOFTWARE, including, 
but not limited to, functions you may rely upon. You 

acknowledge and agree that such activities may 
occur at SONY’s sole discretion and that SONY may 
condition continued use of the SOFTWARE upon 
your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part 
of, the SOFTWARE for purposes of this EULA. By 
acceptance of this EULA, you consent to such 
update/ modification. 

ENTIRE AGREEMENT, WAIVER, SEVERABILITY 
This EULA and SONY’s privacy policy, each as 
amended and modified from time to time, together 
constitute the entire agreement between you and 
SONY with respect to the SOFTWARE. The failure of 
SONY to exercise or enforce any right or provision of 
this EULA shall not constitute a waiver of such right 
or provision. If any part of this EULA is held invalid, 
illegal, or unenforceable, that provision shall be 
enforced to the maximum extent permissible so as to 
maintain the intent of this EULA, and the other parts 
will remain in full force and effect. 

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this 
EULA. This EULA shall be governed by the laws of 
Japan, without regards to conflict of laws provisions. 
Any dispute arising out of this EULA shall be subject 
to the exclusive venue of the Tokyo District Court in 
Japan, and the parties hereby consent to the venue 
and jurisdiction of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA 
to the contrary, you acknowledge and agree that 
any violation of or non-compliance with this EULA 
by you will cause irreparable harm to SONY, for 
which monetary damages would be inadequate, 
and you consent to SONY obtaining any injunctive 
or equitable relief that SONY deems necessary or 
appropriate in such circumstances. SONY may also 
take any legal and technical remedies to prevent 
violation of and/or to enforce this EULA, including, 
but not limited to, immediate termination of your 

use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any 
other remedies SONY may have at law, in equity or 
under contract.

TERMINATION
Without prejudice to any of its other rights, SONY 
may terminate this EULA if you fail to comply with 
any of its terms. In case of such termination, you 
must: (i) cease all use, and destroy any copies, of 
the SOFTWARE; (ii) comply with the requirements 
in the section below entitled “Your Account 
Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, 
BY EMAIL NOTIFICATION TO AN EMAIL ADDRESS 
PROVIDED BY YOU, BY PROVIDING NOTICE AS PART 
OF THE PROCESS IN WHICH YOU OBTAIN UPGRADES/ 
UPDATES OR BY ANY OTHER LEGALLY RECOGNIZABLE 
FORM OF NOTICE. If you do not agree to the 
amendment, you should promptly contact SONY for 
instructions. Your continued use of the SOFTWARE 
after the effective date of any such notice shall be 
deemed your agreement to be bound by such 
amendment. 

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
third-party beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to 
the SOFTWARE of such party.

Should you have any questions concerning this 
EULA, you may contact SONY by writing to SONY at 
applicable contact address of each area or country.

Copyright © 2012 Sony Corporation.

オープンソースソフトウェ
アのライセンスについて

本製品には、弊社がその著作権者とのライセン
ス契約に基づき使用しているソフトウェアが搭
載されています。
当該ソフトウェアの著作権者の要求に基づき、
弊社はこれらの内容をお客様に通知する義務が
あります。
ライセンスの内容に関しては、付属のCDROM
に収録されている「License」フォルダー内の
「License1.pdf」をご覧ください。
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商標について

ˎˎ“XDCAM”はソニー株式会社の商標です。
ˎˎ“XAVC”および  はソニー株式会社の登
録商標です。

ˎˎ“XQD”はソニー株式会社の登録商標です。
ˎˎ Android 、Google Chrome は、Google 
Inc. の商標または登録商標です。
ˎˎ Microsoft、Windows は、米国Microsoft 
Corporation の米国及びその他の国における
登録商標です。

ˎˎ Apple、Macintosh、Safari およびiPhone 
の名称およびそのロゴは、米国Apple Inc. の
米国およびその他の国における商標または登
録商標です。

ˎˎ HDMI、High-Definition Multimedia 
Interface、およびHDMIロゴは、米国お
よびその他の国におけるHDMI Licensing 
Administrator, Inc.の商標または、登録商標
です。

ˎˎ Wi-Fi、Wi-Fiロゴ、Wi-Fi Protected Setupは
Wi-Fi Allianceの商標または登録商標です。
ˎˎ NマークはNFC Forum,Inc.の米国およびその
他の国における商標あるいは登録商標です。

ˎˎ その他、本書で登場するシステム名、製品名は、
一般に各開発メーカーの登録商標あるいは商
標です。なお、本文中で®、™マークは明記し
ておりません。
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